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Saia-Burgess Controls AG About this Manual

1 About this Manual

Saia PCD® Supervisor is a supervisor tool for Saia PCD devices. It is based on the
powerful Niagara V4.14 software framework and uses the Saia PCD® S-Bus over Eth-
ernet.

This manual describes how to install Saia PCD® Supervisor and configure the SaialP-
Network to allow Saia PCD devices data to be made accessible to the Niagara frame-
work.

It consists of the following main sections:

2 About Saia PCD® Supervisor
This section gives an introduction to basic system principles and the
Saia PCD® Supervisor user interface.

3 Securing Saia PCD® Supervisor
This section provides guidance on security issues to be considered when in-
stalling and using Saia PCD Supervisor.

4 Installing Saia PCD® Supervisor
This section describes how to install Saia PCD® Supervisor

5 Licensing Saia PCD® Supervisor
This section describes how to obtain and install Saia PCD® Supervisor license
files.

6 Creating/Enginering a project
This section describes the process of engineering Saia PCD® Supervisor.

6.1 Initial Setup
This section covers the procedures that must be followed to get Saia PCD®
Supervisor ready for use.

6.2 Manual creation of data points
This section covers the process to create communicated datapoints manually.

6.3 Using the “Saia PG5 Data Import Wizard”
This section covers the process to import the datapoints from the PG5 project
using the Saia PCD Data Import Wizard.

6.4 General functions
This section describes general function can be used inside of the Saia PCD
Supervisor. For example how to configure Saia PCD® Supervisor to control
schedules times in the Saia Burgess Controls system.

6.5 Connect to 3rd Party Systems
This section covers the process to import the datpoints and communicate with
third party Devices. For example BACnet devices.

6.6 Creating Schematics (Operator Views)
This section gives basic guidance on creating dynamic operator views that en-
able end users to navigate and access the system.
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1-2

This section describes how to backup/restore the Saia PCD® Supervisor con-

6.7 Set Up for Saia PCD® Supervisor Users
This section describes how to configure users in Saia PCD® Supervisor to
ensure each user only has access to the appropriate information.

6.8 Backup & Restore
figuration.

7 Using Saia PCD® Supervisor

This section covers general day-to-day operating procedures aimed at end
users.

It is assumed that you understand how to use Niagara V4.14. For further
information you should refer to the Niagara documentation which is installed
during the Saia PCD® Supervisor installation. It can be accessed from the
Saia PCD® Supervisor Help menu.
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1.1

Conventions Used in this Manual

Conventions Used in this Manual

There are numerous items and instructions in this manual, the conventions below are
designed to make it quick and easy to find and understand the information. n

- Menu commands are in bold type.
- Buttons, and options in dialogue box that you need to select are in bold type.
- The names of text boxes and dialogue boxes are in bold type.

- Key combinations that you should press appear in normal type. If joined with a plus
sign (+), press and hold the first key while you press the remaining one(s). For ex-
ample CTRL+S indicates holding down the control key while pressing S.
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2 About Saia PCD® Supervisor

Saia PCD® Supervisor is a supervisor tool for Saia PCD Control Systems. It is based

on the powerful Niagara V4.14 software framework. This section describes the key

features of Saia PCD® Supervisor and its user interface, and introduces some of the
terminology used. n

Using the supplied SaialPNetwork (SBC Communication Driver), Saia PCD® Supervi-
sor can connect to multiple Saia PCD devices and access device data in order to moni-
tor or adjust the operation. System data is held within a database and is accessible in
raw format or presented in specially-designed graphical pages known as schematics or
Operator Views (PX view).

Saia PCD® Supervisor connects to the Saia PCD devices network over Ethernet. This
gives access to the Saia PCD devices on the associated LAN (Local Area Network)
and through S-Bus Gateway functionality serial networked devices.

Ethernet

PCD1.M2220-C15
as Gateway

PCD7.D410DT5F
PG5 programmable
MB Web-Panel

PCD1 E-Line programmable I/O modules PCD1 .M2110R41 as Sub-Station

Ethernet communication to PCD’s and on PCD’s over RS-485
which are connected behind a gateway.
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2.1
211

21.2

Saia PCDe® Supervisor Architecture

Platform

In computing, a platform describes some sort of hardware architecture or software
framework (including application frameworks), that allows software to run. Typical
platforms include a computer’s architecture, operating system, programming languages
and related runtime libraries or graphical user interface

The Platform is the topmost level of configuration and may be compared to the control
panel on a PC. In this area of Saia PCD® Supervisor where you can set up:

- Communications

- Install Licenses

- Find fault issues

- Start / Stop stations

- Copy stations

- Backup stations

- Handling certificates

- Handling Lexicons for multilingual projects

- Checking the TCP/IP configuration of the Host computer
- Accessing Remote File system

Access to the Platform requires the user to login, using the same credentials required
to login to the Windows PC. In case of some modification Passphrase is also needed.

Station

Software running on a Niagara platform that is the main unit of server processing in
the Niagara architecture. A station runs the components of the Niagara framework and
provides the access to view and control these components via the Workbench or web
browser. Think of the station as the application built by the engineer to integrate the
data and design a user interface.

The Station manages communications with the Saia Burgess Controls system(s) and
acts as a ‘container’ for all other configuration settings and functions. These include:

Services  such as alarm listening and monitoring and the Saia PG5 Data Import

Wizard

Drivers for managing access to data in the Saia Burgess Controls system(s)
and other systems.

Files schematic/Operator Views used to present system information on

remote client devices
many other services are possible
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2.1.5

Saia PCD® Supervisor Architecture

Access to the Station settings requires the user to login (different to platform login).
Initial system configuration is achieved using a default admin/engineering user account
which is set up when the Station is created. Once configuration is complete further
accounts can be added that grant different users specific access rights according their

role (see 6.7 Set Up Saia PCD Supervisor Users).

Platform Daemon
A program that is executed as service in the background.
In an other way it is compact executable program that enables a user to access plat-

form tools through the Workbench. The Platform Daemon enables to run the stations
on the local PC.

SBCIpNetwork driver

The SBClpNetwork driver defines the communication settings to a Saia Burgess Con-
trols system and provides access to data held in its controllers and devices, including:

Points Input, Output, Register, Flag, Timer, Counter, DataBlock and text Block.
Histories  values logged in HD log modules.
Alarms for monitoring alarm messages generated within the

Saia Burgess Controls system.

Other Drivers (open points)

The Saia PCD® Supervisor is based on the Tridium Niagara V4.14 framework. There-
fore it supports a wide range of additional drivers, suitable for interfacing with other
manufacturer’s building automation systems and products. This enables the monitor-
ing and control of these systems to be fully integrated with the management of a Saia
Burgess Controls system within a common supervisor.

Support for other drivers requires one or more additional open driver packs. For de-
tails of order codes and point counts refer to the Saia PCD® Supervisor Data Sheet
(34-001-08_DS_Saia-PCD-Supervisor).

e such an open driver can be: BACnet, Modbus etc.
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User Interface Application (Host PC)

2.2

2.2.1

2.2.2

User Interface Application (Host PC)

This section introduces the main features of the Saia PCD® Supervisor user interface.

Menu Bar Fle €t Sewch Bookmaks Tools Window Help
Tool Bar — O-B A s -- B EEEES )
s - \/iew Changer
Locator Bar Nav “
n o @ e SbC"
NaV Tree o 3‘ 4‘ .;;: (VewTest
)
supervisor
Saia PCD* .
aette View Pane
- XD &
Palette e O

Help Contents Rl
Thicd Pac Liceacss agara
End User Licence Agreement Version: 410136

Nav Tree (navigation panel)

The Nav tree (or navigation panel) provides navigation around the elements, folders
and files in Saia PCD® Supervisor. It is configurable under “user” by “user”. Once con-
figured, you can view devices and points in a Saia Burgess Controls system.

For help on using the Nav tree, refer to chapter 7.2.2.2 Nav Tree.

Palettes
It is a collection (or library) of components in a hierarchical view that can be copied
and pasted where needed — Wire Sheet, Property Sheet, Px View or Palette side bar.

Palettes are useful when configuring certain elements in the system. There are many
Palettes available, but the most commonly used in Saia PCD® Supervisor are:

o Alarm for configuring Alarm handling

* Schedule ......cccccceeeiiiiniin for configuring Time Schedules

o History ..o for configuring Histories (Plots)

* kitControl ......ccccceeeeeeeil. for creating control logic in Saia PCD® Supervisor

* bajaui....ccccieeiiiiiii for configuring Graphics and accessing default images
o KItPXeoiiiii for configuring Graphics and accessing default images
e KitHVAC .....cooovvvieiieeeee for configuring Graphics and accessing default images
o KitPXN4Svg.....ccceveiiiinns for configuring Graphics and accessing default images
* WebChart.....ccovevveeerrnnns for configuring Graphics and accessing default images

+ SBCOfflineEngineering .... service to import easily resources of a Saia PCD device
from PG5 project

* SDBC.iiiiiiiiii e, for devices and points
* sbclconGallery.................. for images to build user screens
* honBACnetUtilities ........... for getting detailed information of BACnet points.

For help on opening and closing Palettes, refer to chapter 7.2.2.3 Palettes
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User Interface Application (Host PC)

Locator Bar

There is a fundamental navigation model in the Workbench which is similar to the URL
navigation used in the Web browsers. n

When the URL is changed the URL referenced content is shown in the browser. A re-
membered history of the URLs is allowing back & forward navigation.

The ORD (Object Resolution Descriptor) is the universal identification system of Niaga-
ra and it is used throughout the Niagara framework. It unifies and standardizes access
to all information. And it is designed to combine different naming systems into a single

string.

The ORD can be:

absolute station:|slot:/Drivers/SBC$20Systems/SBCIpNetwork Demo/Device1/
points/Heating1/Outside/Temperature/PhysVal”

relative slot:Outside/Temperature/PhysVal”

The locator bar provides similar functionality to the Nav tree. As you navigate around
the file system the locator bar will update to show the current location and view. It
shows the ORD (Object Resolution Descriptor)

For help on using the locator bar, refer to chapter 7.2.2.4 Locator Bar

View Pane & View Changer

The view pane is the principle work space for Saia PCD® Supervisor. When you first
run Saia PCD® Supervisor it will display the home page (shown above). As you navi-
gate through the system and select different items in the Nav tree, the view pane will
change to show different information or configuration pages.

Some elements may provide more than one type of view. For help on selecting the
required view, refer to chapter 7.2.2.5 View Pane & View Changer
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2.2.5 Client Devices

Saia PCD® Supervisor can be accessed via web clients while an IP connection is pos-
sible between the client device and the PC running Saia PCD® Supervisor.

ence to the user as when it is accessed on the main PC depending on the device being

n Once accessed Saia PCD® Supervisor via Web client, it provides a similar user experi-
used to access. The Web Server - Client connection can use JAVA or HTML5.

4 Config x + ——
€ © P8 nips/flocalhost/ord/stationslo: @ Qsearch B ¥ A 9@

B

[E3]

Config o @ 14 PropertySheet [+
[ Station O ctions &Topics B slot Details
@ | »© config
& Files Display Name Value Commands
@ Hierarchy W Station Name
W Sysinfo ¢
@ services Service Container
© Drivers Driver Container

© Apps App Container
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3 Securing Saia PCD® Supervisor

3.1 Introduction
The purpose of this section is to provide the information necessary for those involved
in the installation and maintenance of a product or system to understand the require-
ments for configuring and managing the security of the product or system. n

General Security Best Practice for Saia Burgess Controls IP Based Product manuals
,26-776_Manual_TCP-IP-Ethernet* and ,26-867_ Manual _TCP-IP-Enhancements®.

Both documents are available from the Saia Burgess Controls support web site
www.sbc-support.com.

3.2 Disaster Recovery Planning

It is a documented process or set of procedures to recover and protect a business IT
infrastructure in the event of a disaster. Such a plan, specifies procedures an organiza-
tion is to follow in the event of a disaster.

When developing the disaster recovery plan ensure that it includes ALL data required
to restore system operation, including:

- Configuration files for platform(s) and station(s)
- Database objects

- License and certificate files

- Station Backup

- Station Copies

See book 27-651 chapter 6.8 Backup & Restore for details.

3.3 Physical and Environmental Considerations

The PC running Saia PCD® Supervisor should, where possible, be secured against
unauthorised physical access.

3.4 Security Updates and Service Packs

Ensure the PC running Saia PCD® Supervisor and any client devices have the latest
operating system updates installed, and the latest version of Saia PCD® Supervisor is
being used.

Saia Burgess Controls software is tested against the latest service packs and up-
dates applicable at the time of release. For significant operating system and Java
updates / service packs, please check the Saia Burgess Controls support web site
www.sbc-support.com for any compatibility issues.
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3.5

3.6

3.7

Virus Protection

Ensure the PC running Saia PCD® Supervisor and any client devices are running virus
protection software, and the virus definitions are kept up-to-date.

Some virus protection software may have an adverse impact on the performance of
Saia PCD® Supervisor. In such cases request that the Saia PCD® Supervisor directory
be excluded from on-access scan.

Further details can be found on the Saia Burgess Controls support web site
www.sbc-support.com.

Network Planning and Security

It is recommended that the Ethernet network used by the Building Management Sys-
tem (BMS) is separated from the normal office network using an air gap (separated wir-
ing and devices or layer 3 switches or virtual private network (VPN)). Physical access
to the Ethernet network infrastructure must be restricted. You must also ensure that the
installation complies with your company’s IT policy.

The use of a firewall and Intrusion Detection System (IDS) from a reputable provider
of security products is recommended for any Saia PCD® Supervisor installation. Fol-
low best practice for the products chosen as well as any corporate IT policy where the
installation is made. Lock down the products to the particular port you've configured for
Saia PCD® Supervisor HTTPS and HTTP.

Always follow the guidelines PDF-Documents:

Manual.........occcvieieeeeeieee 26-776_Manual_TCP-IP-Ethernet
manual............cccooeeeii 26-867_Manual_TCP-IP-Enhancements.
manual...........cccc 26-620_Manual_Security-Rules
manual.........ccccoveeeeeeeieeecee Niagara®™ Hardening Guide
instruction................................... 30-002_Internet-Security-Instructions_SBC

instruction for using VPN router .. 30-004_VPN-Router

You must also take steps to ensure the security of any other networks connected to
Saia PCD® Supervisor (e.g. BACnet).

Virtual Environments

Follow best practice for the products chosen as well as any corporate IT policy where
the installation is made.
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3.8

3.9

3.10

3.1

Securing Wireless Devices

If a wireless network is being used it must be secured according to your company’s IT
policy.

System Monitoring

For any Saia PCD® Supervisor installation, especially when connected to the internet,
Saia Burgess Controls recommends the use of an Intrusion Detection System (IDS)
from a reputable provider of security products. Follow best practice for the products
chosen as well as any corporate IT policy where the installation is made.

Saia PCD® Supervisor logs (Audit History) changes made to its own configuration
and adjustments to the Saia Burgess Controls control system. Many IDS and firewall
products offer a complete solution for recording all the traffic coming in and out of the
Saia PCD® Supervisor PC, providing users with the ability to record all activity at the
lowest level.

Securing Access to the Operating System

Ensure the PC running the Saia PCD® Supervisor and any PCs used for Saia PCD®
Supervisor clients are secured according to your company’s IT policy.

Access Control

All Saia PCD® Supervisor files should be protected from read and write access by
people and software not authorized. Saia Burgess Controls recommends following best
practice for securing system objects, such as files, and using access control appropri-
ately.

If Windows users are granted access to the filing system location of the Saia PCD® Su-
pervisor project then it is possible for them to inadvertently (or deliberately) open, de-
lete or edit any of the configuration and data files of independently of their Saia PCD®
Supervisor workgroup settings.
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3.12

3.12.1

3.12.2

3.12.3

Securing Saia PCD® Supervisor

The Saia PCD® Supervisor software should be configured during installation and
operation following best practice. Follow the installation procedure as described in this
manual. In addition, refer to the Niagara 4 help system and Niagara 4 security guide-
lines.

Default Admin User of a Station

Initial system configuration is achieved using a default admin/engineering user account
which is set up with a strong password when a Station is created.

Passphrase

The passphrase, specified during the Saia PCD® Supervisor installation process, pro-
tects sensitive data on any station that you create and will be required if the Saia PCD®
Supervisor station is to be moved to another PC e.g. moved to the site PC, or restored
after a PC failure.

Set up Other Users for the Station

Once configuration is complete (using the default admin user) further user accounts
must be added that grant different users specific access rights according their role.
Saia PCD® Supervisor enforces the use of strong passwords.

For further details, see book 27-651 chapter 7 Using Saia PCD® Supervisor
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3.13 Setting up Google 2 factor authentication

The Google Authentication Scheme is a two-factor authentication mechanism that re-
quires the user to enter their password as well as a single-use token when logging in to
a station. This protects a user’s account even if their password is compromised.

This authentication scheme relies on TOTP (Time-based One Time Password) and the
Google Authenticator app on the user’s mobile device to generate and verify single-use
authentication tokens. Google authentication is time based, so there is no dependency
on network communication between the user’s mobile device, the Station, or external
Servers. Since the authenticator is time based, the time in the station and time in the
phone must stay relatively in sync. The app provides a buffer of plus or minus 1.5 min-
utes to account for clock skew.

Prerequisites:

m The user’s mobile phone requires the Google Authentication app.
m  You are working in Workbench.
m The user exists in the station database.

Perform the following steps:

1. Open the GAuth palette and add the GoogleAuthenticationScheme to the Ser-
vices > Authenticationservice node in the Nav tree.

2. Right-click Userservice, and double-click the user in the table.
The Edit view for the user opens.

3. Configure the Authentication Scheme Name property t0 GoogleAuthenticationScheme and
click Save.

4. Click the button next to secret Key under the user’s authenticator and follow the
prompts.

5. To complete the configuration, click Save.
Depending upon the view you are using, you may have to open the user again or
refresh after saving.
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3.14 Saia PCD® Supervisor Security Check List

a
a

EI

00O

O

Latest version of Saia PCD® Supervisor is being used.

Saia PCD® Supervisor installation files, configuration files (including station back-
up), certificates and licenses are included in disaster recovery plan.

The PC running Saia PCD® Supervisor should, where possible, be secured against
unauthorized physical access.

The Ethernet network (and any other networks) that the PC is connected to is se-
cured, e.g. by the use of firewalls and intrusion detection systems.

The PC is running the latest version of the Windows operating system, with all
updates and service packs.

The PC is running virus protection software.

Appropriate user accounts are set up on PC and access to files is restricted to only
those who are authorized.

Saia PCD® Supervisor is configured to use HTTPS using a certificate from a trust-
ed Certificate Authority.

Saia PCD® Supervisor users are configured as required.

Ensure Saia PCD® Supervisor is configured to backup data regularly to a secure
location as per your company’s backup policy.
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General Data Protection Regulation (GDPR)

General Data Protection Regulation (GDPR)

The General Data Protection Regulation (EU) 2016/679 (GDPR) is a regulation in EU
law on data protection and privacy for all individual citizens of the European Union (EU)
and the European Economic Area (EEA). It also addresses the transfer of personal
data outside the EU and EEA areas. The GDPR contains provisions and requirements
related to the processing of personal data of individuals (data subjects) inside the EEA,
and applies to any enterprise established in the EEA or (regardless of its location and
the data subjects’ citizenship) that is processing the personal information of data sub-
jects inside the EEA.

Under the terms of the GDPR personal data includes any information that may be used
to identify an individual. This includes (but is not limited to):

m user names,

passwords,

phone numbers,

email addresses,

work or residential addresses.

Any such information entered into Saia PCD® Supervisor is encrypted and stored

on the PC where the Saia PCD® Supervisor application is installed on a customer’s
premises. Neither Honeywell or Saia Burgess Controls have any involvement with the
storage and/or processing of personal data within Saia PCD® Supervisor.

Responsibility for compliance with the requirements of the GDPR lies fully with the sys-
tem integrator or system administrator and, as such, they must ensure that adequate
technical and organisational systems are in place to:

m obtain explicit consent from each data subject for personal data to be stored, used
and/or processed,

allow individuals to have access to their personal data in order to verify accuracy,

allow individuals to withdraw their consent at any time and to have their personal
data to be permanently erased,

maintain the security and integrity of data storage and access at all times,

report any breaches of data security (that may affect user privacy) to the relevant
authority within 72 hours of the breach occurring.
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4 Installing Saia PCD® Supervisor

This section describes how Saia PCD® Supervisor should be installed to ensure that it
operates correctly. The following steps are required to install Saia PCD® Supervisor:

4.1

Installation Requirements

4.2

4.3

Obtaining the Saia PCD® Supervisor Software n

Installing the Saia PCD® Supervisor Software

4.4

Installing the Platform Daemon

4.5

Configuring the Windows Firewall

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05 4-1



Installing Saia PCD® Supervisor Saia-Burgess Controls AG

Installing the Software

4.1 Installation Requirements

Before installing, or upgrading, ensure that the PC meets the system requirements.
Refer to the Saia PCD® Supervisor Data Sheet (34-001_DS_Saia-PCD-Supervisor).

The PC on which Saia PCD® Supervisor is to be installed must have TCP/IP access to
the Saia Burgess Controls network.

4.2 Obtaining the Saia PCD® Supervisor Software

n Navigate to the Saia Burgess Controls Technical Support web site at
http://www.sbc-support.com --> Software / Saia PCD® Supervisor
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4.3 Installing the Saia PCD® Supervisor Software

1. Log in to the PC as someone with Administrator rights.

It is recommended that you close all other programs before installing
Saia PCD® Supervisor. However, do not close any virus protection soft-

ware.

Installing the Software

2. Presently the installer works from the local hard drive only. Therefore the installer

must be copied to a local folder first (e.g. C:\Tem

P)

3. Run ‘Installer_x86.exe’ (for 32-bit operating systems) or

‘Installer_x64.exe’ (for 64-bit operating systems),
wait for the first installation screen to appear.

Organize » Open New folder

and

I Favorites MName Date medified Type Size
B Desktop L dew 4/18/2017 4:20 PM File folder
4 Downloads . dist 4/18/2017 4:20 PM File folder
2| Recent Places | docs 4/18/2017 4:20 PM File folder
. install-data 4/18/2017 4:20 PM File folder
74 Libraries .. javadoc 4/18/2017 4:20 PM  File folder
@ Documents . modules 4/18/2017 4:20 PM File folder
J‘F Music L overlay 4/18/2017 4:21 PM File folder
[E] Pictures |% Installer_x64 4/13/2017 11:15 AM  Application 518 KB
B8 videos %‘ Installer_xB6 4/13/2017 11:15 AM Application 480 KB
ﬁ Uninstaller_x64 4/18/2017 2:17 PM Application 395 KB
18 Computer ﬁ Uninstaller_x86 4/13/2017 11:15 AM  Application 366 KB

£, Local Disk (C)

4. Follow the on-screen instructions

@ User Account Control

Do you want to allow the following program to make

changes to this computer?

@ Program name:  Installer_x54.exe
= Verified publisher: Niagara (Tridium, Inc.)

File arigin: Hard drive on this computer

\:f Show details Yes ] [ Mo ]

Change when these notifications appear
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")
supervisor

Sala PCD" SAI BURG

‘welcome ta the Saia PCD Supervisor Install

This program will install the S aia PCD Supervisor 4,110,142 software onto
your computer.

Build 4.11.0.142
Tue Nov 16 21:07:53 Coordinated Universal Time 2021

niagara’t

framework

< Back Neat > Cancel

Saia PCD Supervisor Installation Program X

Read and accept the license agreement.

Please read the following license agreement:
End User License Agreement October 20, 2020 -~

TRIDIUM, INC. ["TRIDIUM") HAS DEVELOPED A STANDARDIZED ARCHITECTURE AND
RELATED SOFTWARE FOR INTERCONNECTING DEVICES AND CONTROLLERS THAT
INCLUDES ELEMENTS SOLD UNDER THE NAME “NIAGARA FRAMEWORK(TM)" . THESE
ELEMENTS TOGETHER WITH THE PRINTED OR ONLINE DOCUMENTATION
FURNISHED BY TRIDIUM IN CONJUNCTION WITH THEM, WHETHER ACQUIRED BY
YOU AS A SOFTWARE ITEM OR EMBEDDED IN HARDWARE ARE REFERRED TO
BELOW AS THE "LICENSED SOFTWARE" AND ARE LICENSED UNDER THIS END USER
LICENSE AGREEMEMNT. TRIDIUM IS WILLING TO PROVIDE A LIMITED LICENSE OF THE
LICENSED SOFTWARE TO YOU ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF
THE TERMS IN THIS AGREEMENT. PLEASE READ THE TERMS AND CONDITIONS OF
THIS AGREEMENT CAREFULLY BEFORE CLICKING DN THE "1 ACCEPT" BUTTON. BY

CLICYIRME NM TUC " ACCCOTY DLITTOM SMOLEACYRIMG A CRCE TUAT VNI UM IC DCAN
Dio you accept this agreement? @®vYes OMNo

< Back Next > Cancel

Sala PCD Supervisor Installation Program x
(.’ FaS
supervisor SocCH
Sala PCD" SAIA BURGESS CONTROLS

Change the destination folder (if required). The default path is

"C:\SBC\SaiaPCDSupervisor".

If you enter a new path it must not contain spaces
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Saia PCD Supervisor Installation Program
W) ik
supervisor soc:
Sala PCO" SAIA BURGESS CONTROLS

Destination Folder
[C:\SBE\S aiaPCDSupervisor-4.11,0.142

Default Browse...
Space Required 1386303 K
Space Available 32214888 K L

[ This instance of Wiorkbench will be used as an installation tool
(606218 K)

[ Install Documentation
(373585 K)

< Back Next > Cancel

6. Add shortcuts to the Start Menu and Desktop.

Saia PCD Supervisor Installation Program

" IS
supervisor soc*

Sala PCD" SAMA BURGESS CONTROY

[ Install Start Menu Shortcuts
[Ains H

< Back Next > Cancel

Installing the Software

7. Once the installation is complete the following screen is displayed.

Saia PCD Supervisor Installation Program

FES

"
supervisor SoCc:r

a PCO" SALA BURGESS CONTROLS

Saia PCD Supervisor installation is complete!

‘Would you like ta?
[ Launch Saia PCD Supervisor
[] Install and Start Platform D aemeon

= Copy Daemon D ata From Prior Version
C:\ProgramData\Niagarad. S\SBC

< Back Finish Cancel
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4.4

ensures sensitive data on any station that you create is protected. En-
sure that you remember it and keep it safe as it will be required to move
the configured Saia PCD® Supervisor to another PC.

n During the installation you will be prompted to create a passphrase which

Leave all three check-box checked and click the

Finish button. Then the software is installed and two %ﬂ) %;
icons are placed to the Desktop Sl piein) M aiid)
¢

Installing the Platform Daemon

If there are other instances of Saia PCD® Supervisor (or Niagara) on the same PC then
the Platform Daemon must be installed. This will typically be set up during the installa-
tion process. It can also be installed and run manually.

1. Click Start and choose All Programs.
2. Navigate to the Saia PCD Supervisor folder.
3. Click Install Platform Daemon.

After a few seconds a command window should briefly appear with the following mes-
sage:

installdaemon: Niagara service successfully installed.

To check if the Platform Daemon is already running go to
Windows Control Panel - Administrative Tools = Services -
Niagara Services running

The running Niagara service can block communication ports depending on what type
of communication is configured.
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4.5 Configuring the Windows Firewall

You may need to configure the Windows Firewall to allow Saia PCD® Supervisor to
communicate correctly.

To configure the Windows Firewall

1. Open the Windows Firewall.
- In Windows 10 or 8, type ‘Windows Firewall’ in the Search box

- In Windows 7, click the Windows Start button, type ‘Windows Firewall’ in the
Search box. n

- Click Windows Firewall from the list of search results.

2. Click Allow a program or feature through Windows Firewall. The Allowed pro-
grams and features list is displayed.

Allow programs to communicate through Windows Firewall

To add, change, or remove allowed programs and ports, click Change settings.

What are the risks of allowing a program to communicate? %) Change settings
{0 For your security, some settings are managed by your system administrator.
Allowed programs and features:
Name Domain Home/Work (Pri.. Public Group Policy *

Networking - Router Solicitation (ICMP...
Networking - Timestamp Request (ICM
Networking - Timestamp Request (ICM...

Niagara Runtime Launcher
Niagara Station Launcher
Nizgara Workbench

WMOUTTO0R
O Performance Logs and Alerts

M Portl

Yes
Ves
Ves

No
No
No

= =

=
No B
Ves
Yes

O No v
O No Mo =
5. e

Allow another program...

HOQEE®EORO

NEEOOFOOOKRORX
ODRREOOFOOOROR

Miagara Runtime Launcher
Niagara Station Launcher
Miagara Workbench

3. Scroll down the list and check that entries exist for Niagara Runtime Launcher,
Niagara Station Launcher, and Niagara Workbench for your Saia PCD® Supervisor
installation folder. If these programs do not appear in the list you will need to add
them (see procedure below).

KX &
—|jgono

n Each installed instance of Niagara requires its own entries in the Firewall
settings.

4. If you need to change any settings click Change settings and edit the checkboxes
as required.
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Configuring the Windows Firewall

To add programs to the firewall:

1. Open the Allowed programs and features list as described above.

2.

Click Change settings.

3. Click Allow another program. The Add a Program dialogue box is displayed.

© ® N o o

10.

Add a Program =]

Select the program you want to add, or dick Browse to find one thatis not
listed, and then didk OK.

Brograms:
S -
[ Access 2013 [
I8 7dobe Bridge C55
| Adobe Device Central CS5

% Adobe ExtendSeript Toolkit CC
[Ed Adobe Extendseript Tookit €55
|8 Adobe Extension Manager CS5
[l Adobe Help
[l Adobe Hlustrator €55
B dobe InDesign €55
-L?L-Adobe LiveCyde Designer ES 8.2 IR

Path: C:\Program Files\Trend Control Systems\863}

What are the risks of unblocking & program?

You can choase which netwark location types to add this program to.

[ add ][ cancel |

[ Networklocaten types..

Click Browse and navigate to the Saia Burgess Controls Control Systems |

Saia PCD Supervisor | bin folder.

Double click the program to be added.

To add Niagara Runtime Launcher select nre.exe
To add Niagara Station Launcher select station.exe

To add Niagara Workbench select wb_w.exe

The program will appear highlighted in the Add a Program dialogue box. Click
Add to add the program to the firewall list. The dialogue box will close.

Repeat steps 3 through 6 to add the other programs.
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5.1

5.2

Licensing Saia PCD® Supervisor

Before Saia PCD® Supervisor can be used, it must be licensed. The license will allow
you to run the application on a single PC.

Obtain a Saia PCD® Supervisor License and Certificate

When an unlicensed installation of Saia PCD® Supervisor is run you will be prompted to
email certain details to Saia Burgess Controls in order for them to provide the relevant
license and certificate files.

To obtain a license:

1.

3.

Launch the Saia PCD® Supervisor ap-
plication, e.g. from the Start menu point
to All Programs > Saia Burgess Con-
trols Systems > Saia PCD® Supervisor
and then click Saia PCD® Supervisor.
The Request License dialogue box is
displayed. The pop up pictures shows
you the so called Host ID of the com-
puter. The Host ID is strictly connected
to that hardware of the PC. If the hard-
ware is changed a new license must be
obtained.

...........

::::::

zzzzz

Email the requested information (list what is required....) to your local sales office
including the email address you would like the license files sent to.

Click Exit to close the dialogue box.

The Order Management Team will process your request, and email the license and
certificate files to the specified email address.

Install the Saia PCD® Supervisor License

Your Saia PCD® Supervisor license is mailed to you as a ZIP file containing a num-
ber of license and certificate files which need to be installed on the PC containing
Saia PCD® Supervisor, this can be done in two ways:

5.2.1 Automatic Licensing

5.2.2 Manual Licensing
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5.2.1 Automatic Licensing

Saia PCD® Supervisor can be licensed automatically via the [
global license server providing the PC has internet access. |
If this is the case when Saia PCD® Supervisor is run after
your license request has been processed it will automati-
cally be licensed and the files copied to the required folder. 1 | ris machine is now licensed.

Manual Licensing

To install the license and certificate files:

1.
2.

Copy the ‘Licenses.zip’ file to the PC hard disc.

Extract all the files from ‘Licenses.zip’ to an empty folder. The folder should now
contain six files.

Copy the three ‘license’ files to the
“C:\SBC\SaiaPCDSupervisor\security\licenses” folder.

. Copy the three ‘.certificate’ files to the

“C:\SBC\SaiaPCDSupervisor\security\certificates” folder.

You will now be able to launch the Saia PCD® Supervisor (Workbench) application.

5.3 Updating a License

If you purchase a license upgrade, e.g. for additional points, you will be emailed the
updated license files as a ZIP file containing a number of license and certificate files
and it will be necessary to upgrade the Saia PCD® Supervisor license. If the Saia PCD®
Supervisor PC PC is connected to the internet this should happen automatically - see
chapter 5.2.1 Automatic Licensing, alternatively the files can be copied manually -

see chapter 5.2.2 Manual Licensing.
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Creating/Engineering a project (application, site, ..)

Building a site within Saia PCD® Supervisor involves creating a database that reflects
the structure, devices and points within the associated Saia Burgess Controls system.
In the Saia Burgess Control System mainly the S-Bus communication protocol is used.
However it is possible to use third party communication protocols depending on the
used license. A Point in the Saia PCD® Supervisor represents a value or state of an
item in the Control System (e.g. a point represents a value or state of a symbol from
the PCD controller).

For example:
“Outside_Air_Temperature_Sensor_Value” is the point name in the Saia PCD® Supervi-
sor, but it is actually communicated as “Register 100” from the proper PCD device.

The communication connection is based on Media type and Media address
("Register 100") not on the symbol name.

There are two methods to build up the point database within Saia PCD® Supervisor:

* Manual creation of data points
* Using Saia PG5 data import wizard

You can use either one or both methods to build up your point database, according to
your requirements.

It is the best practice to only add the points required for use in the Saia PCD® Supervi-
sor. Adding unwanted points will increase the memory usage and affect the remaining
license count. Keep in mind that the points for HDLogs are imported to get it working

properly.

Goto ..

6.1 Initial Setup

6.2 Manual creation of data points

6.3 Using the “Saia PG5 Data Import Wizard”
6.4 General functions

6.5 Connect to 3rd Party Systems

6.6 Creating Schematics (Operator Views)
6.7 Set Up Saia PCD® Supervisor Users

6.8 Backup & Restore
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6.1 Initial Setup

When Saia PCD® Supervisor is run for the first time you will need to work through an
initial setup procedure which involves the following steps:

6.1.1 Launch the Saia PCD® Supervisor Application
1. Click Windows Start button and choose All Programs.

2. Navigate to the Saia PCD® Supervisor and open it.

3. Click Saia PCD® Supervisor. The Saia PCD® Supervisor application window will be
opened. This program is called as Workbench in relation of Niagara N4 environment. (It

n can happen that the start of the program takes a bit more time, please be patient.)
O- o n O - - R g M % s
=
supervisor
p Saia PCD®
* Palette
mE D # e
© service
© Authentication:
Host ID: Win-7735-8ADC-FCAS5-6C6B
Version: 4.10
Hle c. e niagara®
Srccment Version: 4.10.1.36

- |
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6.1.2 Open the Platform

1. In the Nav tree of the Saia PCD® Supervisor tree right-click on MyHost and choose
Open Platform. The Connect dialogue box is displayed.

[« Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

My Host : SZ43L TJOSGIF2.global.ds.honeywellcom  © SBChomehtml

Nav
[ e} ) My Network
(@ My Host: S243L TI06GWF2.global.ds.honeywell,
Disconnect
@ vy modules Open Platform
Open Station
My Spy
Refresh Tree Node
B n
W Connect b4 % Connect b4
Open Platform with TLS Open Platform with TLS

Connect to the host's cecure platform daemon Connect to the host's secure platform daemon

Session Session

Type @v Platform TLS Connection Type g Platform TLS Connection

Host |IP SZ43LTJ06GWE2. gl - Hosi Platform TLS Connection -

Trr Platf C cti
Port 5011 Port ,,_,“ﬁ orm Connection

OK Cancel OK Cancel

2. In the Type box select Platform TLS Connection. Leave other settings at their
default values.

3. Click OK. The Authentication dialogue box is displayed.

<™ Aythentication *
% Authentication

Logon required for access
Realm

MHame GLOBAL

Scheme  HTTP-Basic
Credentials

Username EE1

Password [TTTTTYT]

[# Rememberthese credentials

oK | Cnncel|

If a ‘Cannot display page’ error appears, ensure that the Platform Dae-

mon has been installed.
See chapter “4.4 Installing the Platform Daemon”
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4. Enter the Username and Password that you would normally use to login to the

Windows PC.

For security it is recommended that the Remember these credentials box
is left unchecked.

. Click OK.

A “Platform” item will now appear in the Nav tree and various platform objects will
appear in the view pane.

®» Saia PCD® Supervisor

Tools  Window

Search  Bookmarks Help

File Edit

/  MNavContainerView -

My Host: SZ43LTJO6GWF2.global.ds.honeywell.com . Platform

- Nav Platform § objects

= o () My Network Name Description =

@ Application Director Controlapplications and access console output
(@ MyHost: SZ43LTI0GGWF2.global.ds.honeywell.com

» @ MyFilesystem
b @ MyModules
b g Platform ou [ d certificates

Q) Platform Administration  Update the platform daemon's portor credentials, or setits date and time

) Certificate Management  Manage X.502 Certificates and Host Exemptions.

@) Lexicon Installer Install lexicans to support additional languages

@ station Copier Transferstationsto and from the remote host
€ TCPAP Configuration  Manage the host's TCP/IP settings

& RemoteFile System The remote host's file system

- Palette
W [X] B @ sbeofflineEngineering

b B ssia PGS Data Import Wizard
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6.1.3 Create a New Station

1. From the Tools menu select New Station. The New Station Wizard is displayed.

<#> Saia PCD® Supervisor

File Edit Search Bookmarks - Window  Help

Options

06GWF2.global.ds.honeywell.con

C - s “®» New Station Wizard X
- Nav et o

L C & My Network " s New Station Wizard

@ My Host: 5243LTJ06GWF2.global.ds.ho
&) My File System
O My Modules
HT Platform

Station Name
Demo_Station

Station Directory

C:\Users\H474735\Niagarad4.10\SBC\stations\Demo_Sta

rsion Tool Station Templates
Name Vendor Version Description =
NewControllerStation.ntpl Tridium 1.6

NewJACEProvisioningStation.ntpl Tridium 14
NewSupervisorStationLinuwx.ntpl Tridium 1.8
NewSupervisorStationWindows.ntpl Tridium 1.8

SaiaPCDSupervisor.ntpl SBC 31 Saia PCD Supervisor System

4 Back P Next / Finish X cancel

2. Under Station Templates click SaiaPCDSupervisor.ntpl to highlight it.

3. Type a suitable name in the Station Name box.

If a station already exists with that name you will be prompted to delete
the existing station or you can go back and specify an other name for
your new Station. You must select Yes to proceed.

«® New Station Wizard >

g New Station Wizard
sl

Station Name
Demo_Station

Station Directory

C:\Users\H474735\Niagara4.10\5BC\stations\Demo_Sta'

Station Templates

Name Vendor Version Description =
NewControllerStation.ntpl Tridium 1.6

NewJACEProvisioningStation.ntpl Tridium 14

NewSupervisorStationLinux.ntpl Tridium 1.8
NewSupervisorStationWindows.ntpl Tridium 1.8

SaiaPCDSupervisor.ntpl SBC 31 Saia PCD Supervisor System

4 Back P Next  Finish ¥ cancel

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05 6-5



Creating/Engineering a project

Saia-Burgess Controls AG

Initial Setup

4. Click Next.

@ New Station Wizard X

ﬁ New Station Wizard
—

Username Role(s) Modified? ®

admin admin

< Set Password X

Reset Password for admin

Password:

reessses
Confirm:

When 'Finish’ is pressed, save the station and oK cancel

4 openitinuserhome

<> copy itto secure platform for "localhost" with Station Copier
> closethe wizard

4 Back P Next

 Finish | ¥ cancel |

5. Type a password in the Password for admin User box.

The password must have a minimum of 10 characters and include at
least one capital letter, one lowercase letter and one numeral (digit).

As example:

username: admin

password: Manager123 (it can be later changed)
Retype the password in the Confirm Password for admin User box.

This password is for the ‘admin’ and should be reserved for engineers. It
grants access to everywhere and to everything inside of a Station.

6. Select the copy it to secure platform for “localhost” with Station Copier option.
7. Click Finish.

8. If you have not already logged in to the Platform the Authentication dialogue box is
displayed, go to step 10

4 Ajthentication X

% Authentication
Logon required for access
Realm

Mame GLOBAL
Scheme  HTTP-Basic

Credentials
Username [EZ1
Pazzword ssssases

¥ Rememberthese credentials

0K | Cancel |

If you have already logged into the Platform, go to step 11.
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9. Enter your Username and Password (login credentials of the PC) and click OK.

10. If a station with the same name already exists, you will first be prompted how to
proceed.

<@ Station Transfer Wizard X

£ Transferring station "Demo_Station"
How do you want to deal with any existing files?

< Delete the existing "Demo_Station" directory before copying

& Overwrite existing station fileswith new files, while leaving otherfilesintact

Y —

/' Finish ¥ cancel

11. Specify the required option.

12. Click Next. A dialogue box enabling you to specify the start-up options is displayed. H

“®» Station Transfer Wizard X

('\ Transferring station "Demo_Station™
Station Startup Options

[#] START AFTER INSTALL: Start the station immediately after it is copied
[#] AUTO-START: Start the station every time the platform daemon starts

4 Back

' Finish x Cancel

13. Select the required start-up options.

START AFTER  Select this option if you want to start the station as soon as
INSTALL it has copied (recommended).

AUTO-START Select this option if you want the station to be started when
the PC is restarted (recommended).

When developing several Supervisors other stations will need to be
stopped.

14. Click Next.

“®» Station Transfer Wizard X

('\ Transferring station "Demo_Station™
Please review your changes

Allstation files will be copied from the local computerto "localhost”

Please select the "Finish" button to start the transfer.

4 Back b Next  © o/ Finish | 3¢ cancel
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15. Click Finish. A progress update is displayed.

«® Transferring station X

‘u Transferring station

Completingtransfer:

@ Transferfiles  Success
@ Startstation(s)  Success
Transfer complete.

Transferring files...

Sending ~stations/Demo_Station/config.bog
FileStore::commit

Wrote ,,C:\P; iagarad. 7\tridi i
FileStore::commitInstance commit complete
Station "Demo_Station" starting.

i[:ansfe: complete.

Demo_Stati ig.bog“.

Close

16. When the process is complete, click Close. The Open Application Director dialogue
box is displayed.

< Open Application Director? >

@ Open the Application Director now?

17. Click Yes. The Application Director is displayed. Check that a ‘Station Started’ mes-
sage is shown.

[« saia PCD® Supervisor

File Edit Search Bookm:

Tools  Window  Help

My Host:S243LTJ06GWF2.global ds honeywellcom  : Platform
- Nav Application Director
¥ o © my nework Connected o localhost
Name Type Status  Details Auto-Start  Restart on Failure [
@ My Host: S243L TI0SGNF2 globalds.honeywellcom
S certlab oz station ldle foxen/a foxsns hitp-n/s ittpsnfa false true
& myFile system
(oo B saceoe station ldle foxen/a foxsn/a hitp-n/a ttpsnfa false true
1y Modules
i [ saceos final station ldle foxen/a foxsn/s hitp-n/s ittps-nfa false true
[ sec_saus_Test1 station ldle foxen/a fox4511 hittp-n/a,hitps—443  false true
B sec_TM2016_workshop  station  Idle fox=n/afoxs=n/s http=n/shttps=nfa false true
E stationsupoa station  Idle fox=n/a,foxs=n/a http=n/ahttps=nfa  false true
[ Training_center_v1 station ldle Foxen/a foxe4511 hittpmn/a, hitps—443  false true
S attila_test2 station ldle foxn/a fox4511 hittp-n/a,hitps—443  false true
== pemo_station station Running fox-1911,foxs=4911 http=n/a,https=4s3 false true
ac 1 sava:a7) L] Auto-Start
2t a L1avazed)
£ fema £ o: ce.java:1262) @ Restorton Failure
= ot i3 (e Java:165)
ac dium, = £ Foxa ( Java:104) Stare
= G £ 100 (F Java:2s)
&C com.cridium, fox.session Java:3se) =
2t Java.lang.Thread.run (Thread.java:745) —
WARNING [09:09:28 11-Apr-17 CEST] [fox] Unable to start foxs, enabling fox connectivicy! |
SEVERE [09:09:25 11-Rpr-17 CEST] [fox] FOXS server failed to starc on port. [4911] Reboat
pcion: cket: Address a1 in ! Bin
:28 11-Apr-17 CEST] [sys} Nisgara Funtize T.2.35.5% Kill
03128 11 Apr_17 CEST][sys] +** Station Started (L03Ims) [6632ms total] *++
= niagara>INFG [09:09:28 11-Epr-17 Dump Threads
- Palette INFO (09:09:28 11-Apr—17 CEST] [fox] FOK server svarted om\gort [1911]

Java.net.BindException: Address already in use: JVM B)nd!\\ Save Bog
D )

= TS cackel bind0 (Nacive Hechod
W X B |@ beofiinerngineering =

o DuarStacksl Tzp1_gava:106) _Verify Software |
= i : SnSocketupl . bina inSocketInpl. 1ava: 387)
Saia PGS Data ImportWizard at Pl ket Impl.bind (F1 ketImpl.java:130)

ac bind Jave:375) Clear output
= Sava:237) Pause Output
&% JevalnerServessocier e (7 MIGGELG RUNGINT SHVIEUMISHGT ¥TETausoE
2% Jevax.net.asl SSServerSocker - Output Dialog
at sun.security.ssl.SsLServersocy **%* Station Started (1031ms) [6698ms total] ***
at sun.security.ssl.SSLServerSoch - Stream To File
at & TI LEnar] moezT rum d
a2 om0 o > ce.yavai1285)
= atom. = = e Java:165) Output Settings
e rom o B Foxs (Foxserver. qavariod)
2% Sevaiucil ThreadPoolExecutor. java:1142)

St mva nnilosonenrrent ThreadPon] ExecnrareWnrke . run (ThresdPeol Exacnor-qavs: 6171
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6.1.4 Open the Station
1. In the Nav tree right-click on MyHost and select Open Station. The Connect dia-

logue box is displayed.

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

LTJ06GWF2.global.ds. ell.com . Platform

P () My Network

My Host: 53

e vhe Disconnect
@ myFil
[AYORIY Open Platform

&T Platfor Open Station

My Spy
h Tree Node
Go Into

2. In the Type box select Station TLS Connection. Leave other settings unchanged.

3. Click OK.
The Authentication dialogue box is displayed with the default ‘admin’ user

selected.

) Authentication x
% Authentication

Logon required for access
Realm

Name local:|foxs:
Scheme  Fox(n4digest)

Credentials . admin

Username

Change User
Password YTTTTYYTYS Manager‘123
[] Rememberthese credentials

oK Cancel

4. Type the appropriate password in the Password box (i.e. the password specified
when the Station was created).

For security it is recommended that the Remember these credentials box
is left unchecked.

5. Click OK
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6. After a short delay, the chosen station name will appear in the Nav tree and the
view pane will show a summary of Station parameters (Station Summary view):

«® Saia PCD Supervisor = [} X

File Edit Search Bookmarks Tools Window Help

1 O-no A O 0 w- R

My Host : [E67LTIGIZXD3.global.ds.honeywell.com (Demo_Station) ~ : Station (Demo_Station) ,/ Station Summary ~
- Nav Station (Demo_Station) 6 objects
t#f C ) My Network Name Description ]

A Alarm Alarm Database
v O My Host : IE6TLTIGIZXD3.global.ds.honeywell.com (Demo_Station) -

= e My File System e Config The station configuration database

) h SysHome e Files File System accessed over Fox session
) O UserHome & sy Diagnostics information forremote VM
) ° e @ Hierarchy Hierarchy views of remote station
b © vyModules @ History  History database
b §T Platform
» ' Station (Demo_Station)
- Palette Summary Properties 11 objects
[ ] E] @ ‘ sheOfflineEngineering Property Value B
b a Saia PG5 Data Import Wizard Station Name Demo_Station
Host /10.68.81.114
Host Model Workstation

HostModel Version
HostProduct
Hostld Win-AODA-2500-6DF 1-A482

Niagara Version 4.10.1.36

JavaVersion Java HotSpot{TM) 64-Bit Server VM 25.301-b09
0SVersion amd64 Windows 10 10.0
Locale en_US
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6.1.5 Increase the memory space assigned to Workbench and station

In order to obtain enhanced performance and handle multiple devices, user need to
increase the reserved memory space assigned to the Workbench and station.

1. Go to the installer location.
2. Open the SaiaPCDSupervisor folder and then open the etc folder.

OSDisk [C:) » SBC » SsiaPCDSupervisor » etc »

Mame Date mpdified pe Size

:'gl..:‘f 1 File lodde
i

md [113] File folde
- A

sources File folde

Ll‘.’ brand.properties 10415200 l PROPERT

¢ o etensionsproperties 27171980 1200 AM  PROPERTIES File KB
# nf:.n:m oo 2018 lcon 265 KB
& H lpading-splash.gif 21/1980 12 Wb GIF File 9 KB

of moduledev.properties I M PR

o i 10/1/2019 111PM  PROPERTIES F
o - mtprcl_kmm
o siaprig’ 10412018 PM PNG File
¢
M sboSplashlogo.png 112018 P PRG File i K]

3. Open nre.properties file.

B CASBO\SaisPCDSupervisodete\nre properties - Notepad+
Fle Edt Search Miew Enpcoding Language Seifings Tooks Macro Bun  Plugins Window 2

cHEHBERGE& sMhlselaygl ax BEER T ENEAe= O ENER DEExEav=E

o 57 3| Bl e . <3| Wl Bor ina bt 1| Bl e 56 3] Bl modhieca | propeties (3] Bl 58 3| e 59 13| B new 50 21| Blew 81 3| Ble
1 FETERTERETEIERRETRRERRIRTERRTARentrinatrtrinsasirintns
#

File: nre.properties

This file contains properties which used
the NRE launch executable

#

#

#
6 #
T
8 # Revision History

# 17 Feb 04 Brian origimal

F

#

tetftedri et adaat e AL AR ERIRSRAERERROLEREIROLAS

13 # The list of options separated by spaces to pass thru to the WM
14 station.java.options=-Dfile.encoding=UTF-8 -Xs55512K -Xmx1024M
15 wb,java,options=-Dfile.encoding=UTF-8 -X55512K —xm.x1024l-11|

4. Update the memory space reserved for the Station in the second last line to
station.java.options=-Dfile.encoding=UTF-8 -Xss1024K -Xmx2048M.

5. Update the memory space reserved for the Workbench in last line to
wb.java.options=-Dfile.encoding=UTF-8 -Xss1024K -Xmx2048M.
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6.2

6.2.1

Manual creation of data points

This chapter describes the manual creation of the point database.
The following steps are needed to create the data point:

1. Add a Saia Burgess Controls Driver (it is named as “sbc” in the Palette)

2. Configure the driver

3. Add device(s) manually (mainly PCD or other S-Bus communicating devices)
4

. Add the required points to the database. Take care of the conversion. Building au-
tomation mainly using integer numbers multiplied with factor 10 in the PCD control-
ler. While Saia PCD® Supervisor is using normalized floating point.

5. Check (or modify if necessary) the speed of the communication of the point

This is a tedious process with the possibility to make mistakes easily. However it is
advantageous for every System Integrator to understand the process.

It makes sense to arrange a PCD controller - connected to Saia PCD® Supervisor - with
a simple user program to follow up the explanation.

The user program can be for example a simple PCD device with media mapped
PCD3.S100 Workshop Simulator Unit. (Who does not understand this sentence please
go through the SBC PG5 User Manual or better to take part of a Basic SBC PG5 work-
shop.)

Important: The communication connection is based on “Media type” + “Media Address”
(e.g. Register 100). Best practice is to use explicit addressing (so called “hard address-
ing”) in the PCD controller. Dynamic addressing can be also used (makes no so much
sense) but the System Integrator must understand, that the dynamically allocated ad-
dresses in the PG5 can be any time overwritten by the PG5 programming tool.

From SBC V3.0 onwards, the default Data Point View changes from
Hon BACnet View (Web application View) to Hon Data Point View (UX/
HTMLJ5). Different views still can be selected by choice.

Add a Saia Burgess Controls driver (SBClpNetwork)

We need to define at least one SBCIpNetwork for S-Bus over Ethernet communicated
devices. Under the SBCIpNetwork driver many PCD devices can be configured to com-
municate with. It is possible to define other SBClpNetwork networks in order to distrib-
ute the PCD devices better and decrease the load of each SBClpNetwork.

The Saia Burgess Controls Driver controls the communications and flow of data to and
from the PCD devices.

It is possible to communicate with serial S-Bus networked devices using the SBC
S-Bus gateway function in the PCD controllers.
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On larger sites it may speed up data transfer to utilise two or more separate SBC
S-Bus drivers (SBCIpNetwork)

6.2.1.2 Create a folder for Saia Burgess Controls Driver
1. In the Nav tree open the Station folder.
2. Open the Config folder.

3. Right-click on Drivers and select New > Folder. The Name dialogue box is dis-
played.

o Mame > n
® =

oK Cancel

4. Type SBC and click OK. The new folder will appear in the Nav tree.

5. Right-click the SBC folder and select Rename. The Rename dialogue box is

displayed.
i®» Rename >
® SBC Syatems
OK Cancel

6. Type SBC Systems and click OK.
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6.2.1.3

Add the Saia Burgess Controls Driver

1.
2.

In the Nav tree open the Station folder.

Open the Config folder.

Double click on Drivers. The view pane will show a list of installed Drivers
(Driver Manager).

Click on the New button. The New dialogue box is displayed.

File Edit Search Bookmarks

¥ O

@ My Network

ools  Window

Manager  Help

Driver Manager

Name Type

[a] okl tue

@ Wy File System

@ vy Modules

& Platform

& station (Demo_Station)
A alam
© config

~ Palette
- T

O sscipnetwork

[ - 125

@ Pcosubstation
Q AlarmList

& HoLog

I PCDDeviceFolder
[ scrointrolder

O roms

In the Type to Add box select ‘SBCIpNetwork’.

Click OK. The following dialogue box is displayed

© My Hast: S243LTI06GWF 2 globalds.hone:

@ New X

Typetohdd € AaPhp StarNetwork
Numberto Add | €9 Modbusas etwork

6 Modbusslave Network
— 6 mModbus Tep Gateway
6 ModbusTep Network

© Rapid Eye Network
 RdbmsNetwork

SBCIpNetwark
@ -

# e

B, Tapit

L objects

Status Emabled Fault Cause

®

o Mew

Mame

m Name
[i Type

(gl Enabled

Type Enabled

€9 sBCIpNetwork_[ SBCIpNetwork  true

SBCIpNetwork Demo
SBCIpNetwork

. true

OK | Cancel |

x

Do not rename the SBCIpNetwork if you are using or want to use the
Saia PG5 Import Wizard.
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7. Click OK. The Driver Manager will now show the Saia Burgess Controls driver.

<#r Saia PCD® Supervisor

Edit

File Window

4 mO- o n C 0 =-

My Host : S743LTJ06GWF2.global.ds.honeywell.com (Demo_Station)

+ Nav

G

w (@ My Host: S743L TJ06GWF2 global.ds.honeywell.com (Demo_Station)
) 1y File System

) vy Modules
& Platform

() My Network

& station (Demo_station)

A e

© config

b @ services

v eDrivers
» 9 NiagaraNetwork
» O seCsystems
» 6 seCipNetwork_Demo

» eApps

Q Files

E Hierarchy

@ History

- Palette
wE D #w

 seciphetwork
@ rco

©) peosubstation
© alarmList

2% HDLog

I PCDDeviceFolder

[ sECPointFolder

0 Points

8. Right-click the driver and select Cut.

- Nav
¥ o () My Network
v @ My Host: S743L TJ0GGWF2.globaldshoneywell.com (Demo_Station)
b @ My File System
b @ vyModules
b & Platform
v & station (Demo_station)
A Alarm
v © config
b @ services
v ) Drivers
>  NisgaraNetwark
» (D secsystems [N
) sBCipNetwork EEGTLES
» Apps
© op New
b & Files
» [ Hierarchy Edit Tags
L oH‘mw Make Template
Cut
. pQIEtte _

: Station (Demo_Station)

% @

: Config

Driver Manager

Name
) niagaraNetwork

) secipnetwork_Demo

I Drivers

0 B X a [ @
Driver Manager ~

2 objects

Type Status Enabled FaultCause E

NiagaraNetwork {ok}  true

SEClpNetwork  {okl  true

QA Mew | #FEdit @ Tazn
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9. Inthe Nav tree, right-click the SBC Systems folder and select Paste.

- Nav
e o & My Network

@ My Host: SZ43LTJ0BGWF2.globalds.honeywell.com [Dema_Station)
@ iy File system
O My Modules
& Platform
& ststion (Demo_Station)
A alarm
© config

rrrrrr

- Palette
w X T |#sbte

It is possible to create folder to the points to make nicer structure.
However when the Saia PG5 Data Import Wizard is used the default
SBCIpNetwork folder is generated. This folder can be renamed. The
next import then will be done to the renamed folder. The target folder
of the import can not be freely chosen.

10. In the Nav tree, right-click to the SBClpNetwork_Demo in the SBC Systems
folder.

11. You now need to configure the communications of (each - if you have many)
Saia Burgess Controls Driver.

6.2.1.4 Duplicated physical device

During import of a PG 5 project for each physical Saia PCD® controller device one de-
vice note will be added in the Saia PCD® Supervisor below the SBClpNetwork Network
driver.

It is possible to have the same physical Saia PCD® controller device duplicated below
the imported SBCIpNetwork driver network or to have the same physical device used in
different SBCIpNetwork drivers on the Saia PCD® Supervisor station.

For constellations to have one physical Saia PCD® controller device present several
times below SBCIpNetwork drivers in the Saia PCD® Supervisor you should not exceed
5 instances on the Saia PCD® Supervisor per physical Saia PCD® controller device.
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Configure the Saia Burgess Controls Driver(s)

Saia PCD® Supervisor connects to the Saia Burgess Controller network (Ethernet
networked PCD devices) using S-Bus over Ethernet communication. It is necessary

to configure Saia PCD® Supervisor with the IP Address (or hostname) and the S-Bus
station address of the device to communicate with. Inside of the PCD device the Media
can be addressed by specifying the type and memory slot.

At this point it is recommended to have a Saia PCD® device (a controller with the cor-
rect application running inside, with the correct Ethernet parameters set in the PCD and
also in the PC) connected to the Saia PCD® Supervisor.

In the Nav tree right-click on the Saia Burgess Controls driver (e.g. SBClpNetwork_
Demo) and choose Views > AX Property Sheet. The view pane will show a list of driver
properties:

@ Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window Help

My Host: S243LTJ0SGWF2.global.ds.honeywell.com (Demo_Station) ~ © Station (Demo_Station) ~ © Config ~ © Drivers  © SBCSystems  : SBCIpNetwork_Demo
- Nav Property Sheet
Eo Is) @MyNEtwurk e SI;CIpNelwnrkiDemn (SBCIpNetwork)
Status {ok}
(@ My Host: SZ43LTI08GIF2. global.ds.honeywell.com (Demo_Station) [ Enabled @ e
Oy Flesystem [ Fault Cause
O vy wodules L Kealth Ok [11-Apr-17 1552 PM CEST]
:Ptaﬁnrm [l Down ® false
Station (Demo_Station)
Alarm @ falee
A slem i
é[ . [l Last Ok Time 11-Apr-2017 01:52 PM CEST
onfig
@se [ LastFail Time  [mull
rvices
Ao [ Last Fail Cause
rivers
O R—. © Alarm Source Info  Alarm Source Info
iagaraNetworl
o [ Alarm Class Default Alarm Class
SBC Systems
sparent.displayNames
9 sacipNetwork_Demo [ Source Name & = 0]
X TuningPolicies [ To Fault Text ®
@ apps
& ries [l ToOffnormal Text | Blexicon(driveripingfail)s ®
[ Hierarchy W To Normal Text tlexicon (driver:pingSuccess)s ®
@ istory
null @ - (Defaultview) - P
Hyperlink Ord
: [ Hyp > o-
- Palette i
[ Sound File null )
m ¥ A [E
[ Alarm Icon null - o)
) seCipetwork
(- (@ Alarm Instructions ~ Onstructions 3
© pcosubstation [ Meta Data » -
Q nlarmList L3 Monitor Ping Monitor
2k HoLog [ PingEnabled @ true
I PCDDeviceFolder T Ping Frequency 00000k 05w 003/
I sBcPointFolder (W Alarm On Failure @ e
O pans [J Startup Alarm Delay ~ [+00000h 05m 00s/3}

¥ Tuning Policies Tuning Policy Map
Y DefaultPolicy Tuning Policy
[l Min Write Time 00000k 00m 0082} [oms-+inf]
m Max Write Time 00000h 00m 003 [0ms- +inf]
[ Write On Start ® true

[ write On Up ® e
[ Write On Enabled @ true
(W Stale Time 00000k 00m 00s|2} [oms-+inf]

Basically the default parameters are good for starting.

The driver must be enabled. Status must be OK. It can happen that the status at the
beginning is “down” it will be “ok” right after the communication is established with the
SBC Device.
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6.2.3 Adding Device to the Saia Burgess Controls Driver(s)

Each physical networked SBC controller needs at least one PCD (device) added to the
Saia Burgess Controls Driver (SBCIpNetwork_Demo) with unique name.

1. Open the Palette sidebar if it not yet opened.
Menu bar — Window menu — Sidebars — Palette

2. Open the “sbc” palette.

- Palette

w X D dw
H  sBCipNetwork
@ rco

© rcosubstation
© alarmList

<% HDLog

I PCDDeviceFolder
A secPointFolder

D Points

3. Copy PCD from palette. Right click to PCD and select copy.
4. Right mouse click to the driver “SBClpNetwork_Demo” and paste it.

5. Name it as Device1 (- or CPU1 - or respectively to the app running in the device
e.g. AHU1 as Air Handling Unit 1).

6-18 Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05



Saia-Burgess Controls AG Creating/Engineering a project

Manual creation of data points

6. Double click to the Device 1 will bring up the following screen.

® Ssia PCD® Supenvisor

File Edit Search Bookmarks Tools  Window

Help

My Host : 5743LTJ06GWF2.global.ds.honeywell.com {Demo_Station) © Station (Demo_Station) . Config © Drivers . SBClpNetwork_Demo : Devicel

~ Nav Property Sheet
I O [X 6 myhetwork @ Devicel (SBCHeadstation)

li Status {down, alarm,unackeda.
v (@ My Host : SZ43L TJI06GWF2.global.dshoneywell.com (Demo_Station) [l Enabled @ e

b @ vy File System

[ Fault Cause
A e

w [ Health Fail [11-Apr-17 2:31 PM CEST] Timed out \...
b & Platform @ Dovn O
v station Demo_station)
Alarm @ true
A dlam W
v O coric [ LastOkTime  (null
® li Last Fail Time 11-Apr-2017 02:31 PM CEST
b @ sewvices
eD_ li Last Fail Cause  Timed out waiting for response.
v fivers
b On R, w @ Alarm Source Info Alarm Source Info
iagaraNetwors
S [ Alarm Class Default Alarm Class
v ems
sparent.parent.displaylizne 3parent.dis
+ 6 s6CipNetwork_Demo [ Source Name = & ey = 4 0]
» X TuningPolicies T To Fault Text ®
» @ Devicel
e [ ToOffnormal Text  $1exicen{driver:pingfail)s ®
b @ aps
b @ Files [l To Normal Text $lexicon (driver:pingSuccess) ®
b [ Hierarchy
® null W - (Defaultview) + P
> @ History [ Hyperlink Ord y o
D -
- Palette
[l Sound File null o)
XD #oe
[l Alarm Icon null o)
» 6 seciphetwork
Alarm Instructions  Olnstructions
» @rco L] »
» © Peosubstation [ Meta Data » O~
b Q aamList » B¢ Poll Scheduler N Poll Scheduler
b o Hdlog [ Poll Frequency Normal
> A PCoDeviceFolder b [l Ip Address 127.00.1:5050
» A sBcPointFolder [ station 1d i
b Qpoints b % Points SBCPoIntDeviceExt
b (@ Alarms Alarms
» @ Histories Histories

] li Device Information  SBCDevicelnformation
li Fip Username
(W Ftp Password
[ Http Password
» Qll DataPoll Frequency  30secs {Sun Mon Tue Wed Thu FriSat}

i Refresh | [7] save
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7. Setup the IP address and the S-Bus Station ID of the Device 1
The Device1 must be enabled.
Keep the default parameters in.

Property Sheet
© Devicel (SBCHeadStation

m Status

[l Enabled
[ Fault Cause
L Health

m Down
[ Alarm

[l Last Ok Time
[l Last Fail Time
[ Last Fail Cause
© Alarm Source Info
(@ Alarm Class

[l Source Name
(M To Fault Text
[l To Offnormal Text

[l To Normal Text
(@ Hyperlink Ord

(@ Sound File

[l Alarm lcon

[l Meta Data
B¢ Poll scheduler
@ Poll Frequency

[ Ip Address
@ IpAddress 172
(@ Port Ou
[ Station Id
& roints

@ Alarms

Histories

)

[down, alarm, unacked®’

. true

Fail [11-Apr-17 2:36 PM CEST] Timed out \..
.true
.true
null
11-2pr-2017 02:36 PM CEST
Timed out waiting for response.

Alarm Source Info

Default Alarm (lass

tparent.parent.displayName: %parentc.displ @

%lexicon{driver:pingFail) %
%lexicon{driver:pingSuccess) &

null

» 0O-

null

null

[@ Alarm Instructions  Olnstructions 3

» O-
N Poll Scheduler
Mormal
127.0.0.1:5050
.23.13.19
nspecified 5050 [-1-65536]
14
SBCPointDeviceExt
Alarms

Histories

@
@
@

[ Device Information
m Ftp Username

[l Ftp Password

[ Http Password

SBCDevicelnformation

Gl Data Poll Frequency

30secs {Sun Mon Tue Wed Thu Fri Sat }

@ - (DefaultView) ~ P
- o)

- o)

7 Refresh | [ save |

The FTP credentials and HTTP password need to be manually config-
ured here. If these credentials are missing, then the HDLog and Alarm
data retrieval are not working.

The status can be OK or Down. When it is OK the communication is well estab-
lished. When it is down it can happen that he initial telegrams were not correct
answered (wrong IP or S-Bus station number). Check and correct - if needed - the
settings. Save the settings. Press the Refresh button at the bottom of the page.

Disable the Device and save the settings. Enable the Device and save the settings.
These actions are initiating telegrams which must be answered by the Device.
Navigate to the Device Information. This will surely initiate telegrams to be sent
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in order to get back the basic information of the connected Device. After that the
“Status” of the Device must be OK. If not the parameter settings is not correct, or
the Device is not correctly connected to the network. Try to ping the Device (keep
in mind that the Windows firewall can block the ping). Step by step check of the
settings in the SBC Device and also in the Saia PCD® Supervisor is needed.

Last step is to restart the Platform Daemon,
See chapter 4.4 Installing the Platform Daemon

[“® Saia PCD® Supervisor

File Edit Search Bookmarks Teols Window  Help

My Host : 5243LTJO6GWF2.global.ds.honeywell.com [Demo_Station) : Station (Demo_Station) . Config . Drivers : SBC Systems ! SBClpNetwork_Demo
- Nav Property Sheet
L:” O @ My Network [l Device Information (SBCDevicelnformation)
) Services li PCD Status Run
 Drivers [ PCD Type PCD3.M&86D
 nisgaraNetwork (M PCD Clock 17-04-11T14:47:17
Q) sBCsystems [ Firmware Version  [1.26.15
© sBCipNetwork_Demo [ Time Zone uTC (<0}
:l,' Tuning Policies
° Devicel

o Alarm Source Info
B¢ Pollscheduler
e Points

@ Alarms

@ Histories

& Device Information

“ Data Poll Frequency
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6.2.4 Add Points to the Device to get the data from the PCD

First of all it is not possible to “Discover” the points from the PCD device.
The points must be added manually.

Let us create a “SBCRegister” and some “SBCFlag” type of points.

1. Navigate to the Points folder of the Device1. It is empty.

2. Navigate to the Palette — sbc — Points. In this folder there are templates for
every each possible type of points. This means these type of variables can be
found inside of the SBC Device depending on the user program. The template
points are nicely colored so it is easy to distinguish the different types.

n 3. Drag the “SBCRegister” type from the Plaette “sbc” and drop it to the Device1/
Points folder. In the pop-up window name it “Analoglnput_1”

i Mame >

OK Cancel

Name it in such a way that it will connect here the physical analogue input 1 of
the PCD3.S100 workshop module. Of course there is a corresponding program
downloaded to the PCD device.
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4. The address has to be set for that point. In this case, the first analogue input of
the selected Device is mapped to the Register 100. (In this application this is a
potentiometer of the PCD3.S100 simulator unit)

o bk wbd-~

Double click to the Analoglnput_1.

Open the Proxy extension.

Setup the Memory Address to 100.

Data Format can be as it was “Signed Integer”.
Save it.

@ Saia PCD® Supervisor
File Edit Search Bookmarks Tools Window Help

4 o O- o n O [ [ “

€D sBCTextRam

units=null,precision=1,min=-infmax=-inf 3 D -

module://sbc/resources/images/register.png

My Host : SZ43LTJ0BGWF2 global.ds.honeywell.com (Demo_Station) ~ : Station (Demo_Station)  : Config @ Drivers @ SBCSystems
- Nav Property Sheet
E o @MyNetwurk Q Analoglnput_1 [Numeric Writable)
6 (W Facets
Drivers
[ Proxy Ext SBCProxyExt
O nicgaraNetwork m
Status {ok}
© sBC systems
[ Fault Cause
6 sacipNetwork_Demo
Enabled true
X TuningPolicies o e
© Devicet [l Device Facets > O
© Alarm Source Info M Conversion 12 efautt
[ Pollscheduler [ Tuning Policy Name  [Default Policy
& roints == Read Value 957.00 [ak}
(@ Ansloginput 1 = Write Value - {mll} @ def
@ Alarms [l Memory Address 100
© istories [l Data Format Signed Int
[l Device Infarmation out 957.0 {ok} B def
- QU .0 {ol e
Q Data Poll Frequency - Ini {null}
- {nu
Apps
- @ apo - In2 - {null}
Files
- In3 - {null}
[E) Hierarchy J—— - [null}
Histo
@ History = In5 - {null}
- Palette e e
- In7 - {null}
b
X B | = Ing - {mal1}
©) PCDSubstation - Ing {null}
- {nu
AlarmList
Q Al == In10 - {null}
& HDLe
og == In11 - {mull}
A FcDpeviceFolder - In12 {null}
A sBCPointFolder - n13 - {null}
Paint:
Q raints - In1d — {null}
SBCFl;
@ secrizg - In15 - {null}
@ sacrlsgvolatile In16 {mll}
- - {nu
SBCRegist
(v} ‘egister = Fallback - {mull}
%SBEReg\sterHuat (Ml Override Expiration (21l
SBCInput
npul [l Media Type Register
© sscoutput [l comments
@ sscTimer
© sEcCounter W feon
(D sacDBRam
© sacoe
) ssctext

7 Refresh [ save

: SBClpNetwork Demo -

SECIpNetwork_Demo

HoH W W

WO WM MW

5. The Status must be {ok}. It can be seen that the “Read Value” and the “Out” are
following the content of the “Device1/Register 100”.
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6. The Conversion is set automatically to 0.1. The Conversion is set to Linear
and the Scale is set to 0.1. This will remove the 10 multiplication factor we use
conventionally in the Building Automation. This scaling can be seen on the
“‘Read Value” and the “Out”.

Property Sheet

@ Analoginput_1 {Numeric Writable)

E Facets units:null,precision=1,min=inf,maF—i@ L -
3 Proxy Ext SBCProxyExt
[i Status {ok]

(@ Fault Cause

(@ Enabled @ true
n [l Device Facets » o -

[i Conversion

/4 Linear

Scale 0.1

[l Tuning Policy Name
== Read Value

e Write Value

Default Policy
957.00 {ok}
- [null} @ def

(@l Memory Address 100
[i Data Format Signed Int
= Qut 95.7 {ok} @ def

It is possible to set the Engineering Unit, precision, and the limits of the value, in

the Facets.
«#» Config Facets |
= Type Value ®
units Unit null l:l I
precision Integer 1
min Double —inf
IBEID Double +inf
@ X| 9 -]
_ ok | _canca |
> =
temperature (K) celsius (°C) ’9 .
OK Cancel

7. For the SBCFlag types. Copy the “SBCFlag” type of point from the Palette.
Right click to the Device1/Points folder. Select “Paste Special’.

6-24 Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05



Saia-Burgess Controls AG

Creating/Engineering a project

Manual creation of data points

8. In the pop-up set the “Number of copies” to 8. Other settings must be un-

touched.

et

> Paste Special

D Paste Special

Mumberof copies |
[] Keepalllinks

[] keep allrelations

OK ‘ Cancel

9. 8 points are generated with the name “SBCFlagx”

10. | want to change the names of the generated points. Select the points. Right
click to the selection. Select rename from the context menu. Fill up the “Search
for” and the “Replace with” fields. Press ok.

My Host : SZ43L TJD6GWF2.global.ds.honeywell.com (Demo_station)

: Station (Demo_Station)

: Config

o Drivers

: SBCSystems

: SBCIpMetwork_Demo  © Devicel

© Points

() My Network

X TuningPolicies
© pevicel
© Alsrm Source Info
¢ Pollscheduler
& Points
© ancloginput_1
0 secrlae
0 secriegt
0 secrioz
0 secriazs
0 secrlags
0 secrlaes
@ secrlees
0 sacrlagr
@ alarms
© Histories
[ Device Information

Qll Data Poll Frequency
-~

- Palette
w X B |# b

& PCDSubStation
© alarmuist

£& HDLog

I PCDDeviceFolder
A sBCPointFolder
O paint

Database

Name
© analoginput_1
© secrlag

© secrlagt

Q secrlag

© secrlags

© secrlags

© secrlags

Q secrlags

Q secrlag?

Type
Numeric Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable
Boolean Writable

Boolean Writable

Out

957.0{ok] @ def

false [ok} @ def
false [ok} @ def
false [ok} @ def

false [ok} @ def

Tuning Policy Name
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy

defaultPolicy

false[ok} @
false[ok} @
false[ok} @

false[ok} @

“® Rename

Old New

SBCFlag? Digitalinput_7

SBCFlagl Digitalinput_1
SBCFlag2 Digitalinput_2
SBCFlag3 Digitalinput_3
SBCFlagd Digitalinput 4
SBCFlag5 Digitallnput_5
SBCFlagé Digitalinput_6

SBCFlag  Digitalinput_

Search for:
SECFlag
Replace with:
Digitallnput_
[ Match Case

[ Match Word

oK Cancel

11.

12. Setup the address of each “Digitallnput_” points.

Right click to the “Points” folder of the Device1 = Views = AX Property Sheet
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13.

The Status must be {ok}. The “Read Value” and the “Out” of the generated
points are following the content of the Flag 100 to 107 of the Devcie1.

@ 52z PCD® Supervise

File Edit Search Bookmarks  Tools  Window Help

LS

My Host: SZ43LTJ06GWF2 global.ds.honeywell.com (Demo_Station)

&) My Network

X TuningPalicies
@ Devicel
0 lsrm source Info
e poll scheduler
& Points
© ansloginput_1
B oigitalinput_
@ vigitalinput_1
@ Digitalinput 2
© oigitalinput_3
© oisitalinput 2
© oigitalinput 5
© oisitalinput_6
@ oigitslinput 7
@ Alarms
O Histories

[ Device Information

© Station (Demo_Station)

: Config @ Drivers

Property Sheet
%% Points [SBCPointDeviceExt)

o Analoginput_1  957.0 {ok} @ def
true {ok} @ def

© Digitalinput_
li Facets
Q Proxy Ext
[ status
li Fault Cause
[ Enabled

[ Device Facets

li Conversion
@i Tuning Policy Name
== Read Value
== Write Value
li Memory Address
li Data Format

= Qut

= Inl

= In2

: SBCSystems

: SBClpNetwork_Demo : Devicel I Points

trueText=true,falseText=false 3 @ ~

SBCProxyExt
{ok}

@ true
» O-

1= Default
Default Policy
true {ok}
- [null} @ def
100
Boolean
true {ok} @ def
- {null}
- {null} ¥

6-26

@l vata Poll Frequengy . —— z

The same way it is possible to create every needed points and connect it to the corre-
sponding media element of the Saia PCD® device.

Remember that Saia PCD® Supervisor is licensed for use up to a specific number of
points. It is good practice to only add points that are actually required. Adding points
that won't be used by Saia PCD® Supervisor will not only waste resources but also
generate unnecessary extra network traffic.

6.2.5 Add Alarming to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is an Alarm Service which can be used to set Alarms
for individual datapoints, regardless if the datapoint is considered alarm or not at the
start of the engineering.

For example the Outside Air Temperature can generate an alarm when it goes under
—20°C. For that we need to set the monitoring in the Saia PCD® Supervisor. So the
Alarm is generated in the Saia PCD® Supervisor not in the PCD controller.

There is an other way of alarming, which is described in details later in this manual.
The Alarms are generated in the PCD Device and the Saia PCD® Supervisor takes
these alarms over.
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6.2.5.1 Steps to set alarming to a datapoint

1. In the Nav tree open the 127.0.0.1/Station(Demo_Station)/Config/Services folder.
And double click to the AlarmService.

< Saia PCD'® Supervisor

File  Edit Search Bookmarks Tools Window  WireSheet Help

| oD O- o O 0 - [2 O
127.0.0.1 (Demo_5Station) . Station (Demo_Station) . Config : . AlarmService
- Nav Wire Sheet
L o () My Network
— - Alarm Db Config ™ l
File Alarm Db Config
@ services [ J
O alarmservice Default Alarm Class | o ConsoleRecipient B
i Alarm Clazs Console Recipient
@ BackupService ‘Alarm Route Alamm
@ CategoryService
@ JobService
@ RoleService
G UserService

The default view (Wire Sheet) will be displayed with the default settings. (Alarm Db
Config, Default Alarm Class and the Console Recipient).

The Default Alarm Class is already used for system alarms (for those alarms which
is generated in the Saia PCD® Supervisor). Most of the cases we do not want to
see the Supervisory system generated alarms together with the alarms which is
coming from the controlled process. So we need a new alarm class to be placed.

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05 6-27



Creating/Engineering a project Saia-Burgess Controls AG

Manual creation of data points

2. Place a new alarm class to the Wire Sheet from the palette. It can be named as
you it is proper. (here it is named Critical Alarms)

<®» Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Wire Sheet

127.0.0.1 (Demo_Station) . Station (Demo_Station) I Config I Services o AlarmService
- Nav Wire Sheet
h@ o @ My Network
Alarm Db Config &
File Alarm Db Confij
b @ My Host : 5Z43LTJO6GWF2.global.ds.honeywell.com
v (@ 127.0.0.1 (Demo_Station) T T O
Alarm Class A

v ’ Station (Demo_Station) .

n . o
v e Config =
Critical Alal y
Alarm Class - [_"
Alarm

v @ Services
v °Alarm5ervice

4 l__.' Default Alarm Class
4 l__.' Critical Alarms

@ BackupService

® CategoryService

@ JobService @ Name x

@ RoleService @ Critical Alarms

o UserService

o AuthenticationService OK Cancel

Q’ DebugService

@ BoxService

8 FoxService

@ HierarchyService
@ HistaryService

O nuditHistoryService
A~

- Palette
[~} E] E ialarm

4 o AlarmService
» | & AlarmClass
4 o AlarmClassFolder

F v ¥ v ¥ ¥ ¥ ¥ ¥ ¥ ¥ Ww W
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3. There Console Recipient is already placed. It is possible to use this recipient (re-
name it to proper name) or place a new one.

This Console Recipient is coming form the SaiaPCDSupervisor.ntpl tem-
plate file.

The alarm console is one way to inform the User about alarm occurred in the sys-
tem. There can be other way like sending E-mail or SMS.

File  Edit

127.0.0.1 (Demo_Station)

Search

Bookmarks  Tools

. Station (Demo_Station)

() My Network

@ Services

© alsrmservice
& Default Alarm Class
A& Critical Alarms
E AlarmConsoleSbus
@ sackupSenvice
O CategoryService
@ sobservice
€D Roleservice
© usersenvice
O Authenticationsenvice
LT pebugservice
® soxservice
¥ Foxservice
® vierarchyservice
) HistoryService
© nuditHistoryService
© LogHistoryService
@ rrogramservice
© searchservice
©Q Taepictionaryservice

o BN e

- Palette
w X A

Q alarmservice
& AlsrmClass
&) alarmClassFol

© Recipients

# starm

der

b consoleRecipient

-
& StationRe

Q) exdensions

O rrinterrecipie

cipient

nts

window

I Config

Wire Sheet

L Services

Help

© AlarmService

Wire Sheet

Alarm Db Config )
File Alarm Db Config

Default Alarm Class

Alsm Clazs 4
[Marm
N
[l:rit’-:.l Alarms I
Alsrm Clazs L
[Blzrm |
L I
Alar
Consols Recipiznt b
Route Alarm.
Status (dﬁlJ
<> Name X
@ 2larmConsoleSbus
oK Cancel

4. Wire the Alarm console and the Alarm Classes together as the next image shows.
The system has to know what to do with the alarms so that the Alarm Classes
(container of alarms) and the Alarm Console (a way to display them) has to be con-

nected.

Wire Sheet

)

Config

Alarm D
File Alarm Db Confis

Default Alarm Class
Alarm Class

[Atarm

L

Critical Alarms

AlarmConsoleSbus

‘Console Recipient E
Routs Alarm

Status {ok]

5. Copy the BooleanChangeOfStateAlarmExt from the Palette / Alarm / Extensions
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to the data point where alarm has to be added. (Boolean datapoint called: Points/
Heating1/Supply/Pump/Alarm)

In the pop-up Name field give a proper name (or just leave it default)

(®> Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Help

e ip:127.0.0.1|foxs:|station:|slot:/Drivers/SBC stems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Sup
= Nav
l=° O @ My Netwark

b B PollScheduler

v @ Paints

-~ | Heatingl
v ° Ack
[ ] G Proxy Ext

» H opMode
» H outside
» H Rreturn
[ ] mTemDerature
v B valve
b @ pi_signal
2 oswgnal
b oThre-ernt?close
2 GThreePomt_open

« [H supply
v B Pump
b oAlarm
» QmeyExt
b @ Feedback
g eMotoertectlon
» @ output
o B Ternnarsties
- Palette
] [z] E i alarm
b © Alsrmservice
» L[4 AlarmClass > Name %
b oALarmCLassFolder @ Alarm
b ORecipients
v © bxtensions LM

2 Q OutOfRangeAlarmExt

b Q StringChangeOfvalueAlarmExt

2 Q BooleanChangeOfStateAlarmExt
2 Q BooleanCommandFailureAlarmEst
2 Q EnumChangeOfStateAlarmEst

2 Q EnumCommandFailureAlarmEsxt

b Q StatusAlarmExt

» 0 PrinterRecipients
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6. Set up the properties of the Alarm Extension

Alarm inhibit

Alarm Enable

false

x toOffnormal ; o toFault

Manual creation of data points

[<®> Saia PCD'® Supervisor

] [Z] @ ialarm

» Q) AlamSenvice

) AlarmClass

» D AlarmClassFolder
] 0 Recipients
- 0 Extensions

» gstatusAlarmExt
] OPnnterRecip\ents

File Edit Search Bookmarks Tools Window Help
4 B O- o A O [0 = -
Station (Demo_Station) Config . Drivers
- Nav
¥ C ) My Network
» [ pollscheduler
b4 ePomts
v [ Heatingt
v oAck
» GmeyExt
» [ opMode
» [ outside
w [ Return
b B Temperature
~ Evalve
] OPI_S\gnEL
] osignal
» @ ThreePaint_close
] GThreePoint_open
w [ supply
+ [ Pump
v enlarm
[ ] gProxyBct
] QAlarm
» @ Feedback
] GMotorProtection
P N
- Palette

» Q OutOfRangeAlarmExt

» gstrlngchangeUfValueAlarcht

» Q BooleanChangeOfStateAlarmExt
Q BooleanCommandFailureAlarmExt
Q EnumChange0fStatetlarmExt

b &7 EnumcommandFailureAlarmext

. SBC Systems

Property Sheet

Q@ A
]
»

W
]
li

li Set Min Inactive Time On Start

]

]
]
~ &

rm (Boolean Writable)
Facets

Proxy Ext
Out

In10

In11

In12

Inl13

Inl4

Inl5

In16

Fallback
Override Expiration
Min Active Time
Min Inactive Time

Icon

Media Type

Comments

Alarm

== Alarm Inhibit

W Inhibit Time

[l Alarm State

[l Time Delay

(W Time Delay To Normal
W Alarm Enable

(W To Offnormal Times
(W To Fault Times

[ Time In Current State

M Source Name

: SBClpNetwork_Demo

. Devicel . Points . Heatingl

trueText=true falseText=false ) ©) ~
SBCProxyExt

true [alarm,unackedAlarm} @ def
- {null}

- {null}

- {null}

{null}
- {null}

{null}
{null}
- {null}
[null}

- {null}
- {null}

{null}
- {null}

{null}
- {null}
- {null}

- {null}
null

+00000h 00m 00s|3
+00000h 00m 003 j

® false

module://sbc/resources/images/flag.png
Flag

Error message pump

Alarm Source Ext

false {[ok} ¥
00000h 00m 0032 [Oms-+inf]

Offnormal

00000h 00m 0032 [Oms-+inf]
00000h 00m 0032 [Oms-+inf]
[ toofinormal [#] toFault
Alarm Timestamps

Alarm Timestamps
+00000h 00m 17s

$parent.displayName$ ®

g Refresh

A

m Save

 Supply

HoH oo

«

H oW H M MW M
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Property Value Meaning
Alarm inhibit True/false Alarm is activated / deactivated
Inhibit Time hours / minutes / Stages of the alarms

seconds
Alarm state - Fault - Fault: value is invalid e.g hardware fault

- offNormal - offNormal: value is valid but out of the its

- Normal borders

- Normal: value is valid and inside of the border.

Time Delay hours / minutes / Delay before alarm is generated

seconds
Time Delay To hours / minutes / Delay before alarm state goes away (if the alarm
Normal seconds in the corresponding device is already cleared)

Alarm Enable

ToOffNormal / To Fault

Enables the Alarm stages to be monitored

To Offnormal Times

Alarm Timestamp

The details of the last occurred offNormal alarm

To Fault Times

Alarm Timestamp

The details of the last occurred Fault alarm

Time in the Current

hours / minutes /

The elapsed time since the state was changed

state seconds
Source name Y%parent.display- It takes the name from the parent object name.
Name%
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To Fault Text — Pump fault (it is unchecked, we do not have info if the value is reli-
able or not. If there is communication error between the Saia PCD® Supervisor and
the PCD device then the state will be different)

To Offnormal Text

To Normal Text

Offnormal Algorithm / Alarm value

Alarm Class

= Pump Error (this will be the alarm)

= Pump OK (text when the alarm leaves)
= true

= Critical Alarm class (created earlier)

Property Sheet

&7 Alarm (Alarm Source Ext)
= Alarm Inhibit
Wl Inhibit Time
[l Alarm State
(Ml Time Delay
@ Time Delay To Normal
8 Alarm Enable
Ml To Offnormal Times
Ml To Fault Times
[l Time In Current State

m Source Name

Ml To Fault Text

Ml To Offnormal Text

8 To Normal Text

W Hyperlink Ord

@ sound File
[l Alarm Icon

Ml Alarm Instructions

[l Fault Algorithm

Ml Offnormal Algorithm
W Alarm Value

[l Alarm Class

@ Meta Data

- [null}

00000h 00m 005 < [0ms-+inf]
Offnormal

00000h 00m 005 < [0ms-+inf]
00000k 00m 0032l [Oms-<inf]
[ toOffnormal [] toFault
Alarm Timestamps

Alarm Timestamps
+00000h 02m 10s

iparent.displayNames

Pump Fault
Pump Error
Pump Ok
null

» O~
null
null

O lnstructions >>

Fault Algorithm
Boolean Change Of State Algorithm

. true

Critical Alarms

» O~

" n

@ - (DefaultView) - P

- )
- o)

0 Refresh D Save
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Property Value Meaning

To Fault Text Any text which refers to the state | User defined / can be seen in the Alarm Console

To Offnormal Text Any text which refers to the state | User defined / can be seen in the Alarm Console

To Normal Text Any text which refers to the state | User defined / can be seen in the Alarm Console

Hyperlink ORD ORD, BQL Query or path When an alarm is reported in the console, the Hy-
perlink button activates. Clicking this button links to
the location you specify here.

Sound File Path text Path of the sound file for audible alarm.

Alarm Icon Path text Path of the picture which is displayed in the "times-
tamp" column in the Console Recipient view.

Alarm Instructions | Instruction text It is possible to define instructions what tod when
alarm occurs.

Fault Algorithm Fault Algorithm Algorithm to generate alarm on Reliability of the
associated point. This property when available,
displays fault parameters. Different options are
available here, depending on the alarm extension
being used.

Offnormal Algo- Boolean Change Of State Algorithm of generating the alarm. Inside it is possi-

rithm Algorithm ble to set parameters to define the way of the alarm
generation

Alarm Class Any proper Alarm Class Which Alarm Class is used to collect the alarm

Meta Data Text Allows you to enter new facets for the extension.
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8. Open the Alarm console (double click on it).
It is possible to check the behavior of the Alarming of the
Points/Heating1/Supply/Pump point.

% Saia PCD'® Supervisor

File Edit Search Bookmarks Tools Window Alarm  Help

127.0.0.1 (Demo_Station) ~ © Station(Demo_Station) @ Config  © Services @ AlarmService  © AlarmConsoleSbus
- Nav [Z]1 = SBCAlarm Console
¥ O ) My Network Time Range to? (O

@ My Host: 5243LTJ066WF2.global.ds.honeywell.

Timestamp Source State Ack State Source Alarm Class Priority Message Text
@ 127.0.0.1 {Dema_station)
) M 13-Apr173:3B:00PMCEST  Offnormal  1Acked /1Unacked  172.23.13.19:19/ myAlarmList/1 DefaultAlarm Class 255 Errorin Pump Heating
& station (Demo_station)

A Ao A 13-4pr173:38:00PMCEST  Offnormal  OAcked /1Unacked  172.23.13.19:19/myAlarmList /¢ Default Alarm Class 255 Window open

© confie A 13-4pr173:36:27PM CEST  Normal 1Acked /1Unacked 172.23.13.19:19/ myAlarmList/2 DefaultAlarm Class 255 Short dircuit

@ services M 13-Apr173:36:20PM CEST  Normal 0Acked /1Unacked 172.23.13.19:19/myalarmList/3 DefaultalarmClass 255 Power breakdown
O Aarmsenvice M 13-Apr172:37:58PMCEST  Offnormal  OAcked/4Unacked  Alarm Critical Alarms 255 Pump Error
A DefaultAlarm Class A 12-Apr-179:43:29 AMCEST  Offnormal 1Acked /0 Unacked 172.23.13.19:19/myAlarmList/6 DefaultAlarm Class 255 Erroré
Critical Al
Liustag B 12-4pr172:43:29AMCEST  Offnormal  1Acked/0Unacked  172.23.13.19:19/myAlarmList/5 DefaultAlarm Class 255 Generalerror
b Alarmcansolesbus

® BackupSenvics
@ categoryService
@ Jobservice

€D Roleservice

O userservice

@ authenticationservice
LT Debugservice
® Boxservice

¥ FoxService

® HierarchyService
@ Historyservice

- Palette %]
w X 3 #odm

O alarmservice
A& AlarmClass

&) AlsrmClassFolder

O Redipients
| consoleRecipient
£ StationRecipient

© extensions

© PrinterRecipients

& Acknowledge | . Hyperink Pinotes | @silence | Vritter |

When new alarm comes there is an audible sound to indicate it. This feature can
be deactivated with the Silence button.

The Alarm can be Acknowlwedged, the list is updated accordingly.
It is possible to add notes to the alarm stored in the Saia PCD® Supervisor.

Possible to define filter the Alarms, for example filter only the Alarms which is rele-
vant to the operator sitting front of the screen.
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6.2.6

6.2.6.1

Add History to a data point in the Saia PCD® Supervisor

In the Saia PCD® Supervisor there is a History Service which can be used to set history
log for individual datapoints.

For example the values of the Outside Air Temperature can be logged (history) then
later the logged values can be displayed as trend curve or just a plain text table with
the values in time order. It is also possible to export the values (in a defined time span)
to external file.

There is an other way of logging the history, which is described in details later in this
manual. The histories (called HD Logs) are generated in the PCD Device and the
Saia PCD® Supervisor appends the content to history files located in the Saia PCD®
Supervisor.

Steps to setup History for a datapoint in the Saia PCD® Supervisor

1. Check the History Service in the Services folder of the Station

<M Saia PCD @ Supervisor

File Edit Search Bookmarks Tools Window  History Ext Manager Help

O 0O-oa C 0 =~

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config I Services I HistoryService

- Nav History Ext Manager
E o @ My Network Point Extension History N
e Config
@ Services
o AlarmSenvice

@ BackupService

@ CategoryService

@ JobService

m RoleService

0 UserService

0 AuthenticationService
EI’ DebugService

@ BoxService

v FoxService

@ HierarchyService

) HistoryService

O suditHistoryService
o LogHistoryService
@ ProgramService

0 SearchService

° TagDictionaryService
TemplateService

@ WebService

n Saia PG5 Data Import Wizard
T PlatformServices

e Drivers
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2. Open the history Palette and copy the Numericlnterval extension to the datapoint
called Points/Heating1/Outside/Temperature/PhysVal.

In the pop-up window it is possible to rename the extension to a suitable name.

It is also possible to choose other type of history, for example Numeric COV or
Boolean Interval etc. Please check the different type of History Extensions in the
Niagara documentation.

® Saia PCD® Supervisor

File Edit Search

Bookmarks Tools Window  History Ext Manager  Help

127.0.0.1 (Demo_Station) ~ : Station (Demo_Station)  : Config

L o () My Network

X TuningPolicies

@ Devicel

- Palette
W X T | sy

B Historyservice

© AuditHistaryService

© LogHistoryService

© HistoryPointList

L HistoryPointListitem

© extensions
[ numericinterval
[F numericcov
[F Bocleaninterval
[F Bacleancov
[F Enuminterval
[F Enumcov
[F stringinterval
[F stringtov

@ History Group

[ History Nav Shortcuts

© Alarm Sourcz Info
[+ Datapoints Poll scheduler
& points
A Heatingy
Qs
[ opMode
H outside
A Temperature
© Physval
[ rroy et
A Return
A supply
H rump
Q@ alarm
3 Proxy xt
b7 alarm
@ Feedback
» @ MotorProtection

. Services  © HistoryService

[l History Ext Manager

Point Extension History Name Statul n

@ Name X
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3. setup the parameters of the Numericlnterval extension.

Enabled True

History name = %parent.parent.parent.name%_%parent.parent.name%__
%parent.name%

1 min

Interval

<® Saia PCD'® Supervisor

File  Edit Search Bookmarks Tools Window  Help

127.0.0.1(Demo_Station) . Station [Demo_Station)  : Config  © Drivers  : SBCSystems  :© SBCIpNetwork _Demo : Devicel  : Points  : Heatingl  : Outside
- Nav Property Sheet
¥ O ) My Netwark [Z Numericinterval (Numeric Interval History Ext)

TRy Alarms li Status [ok}
O Histories [ Fault Cause
m Device Information m Enabled .true

Qll Alarms Poll Frequency [ Active Period Daysof week [#] sun [# Mon [# Tue [ Wed [ Thu [# Fri [ sat
ive Perio

OPseuduiPuints TimeRange |12:00:00 M CEST 3 to |12:00:00 M CEST |2
) sacnetietwork [ Active [
Aphps T History Name tparent.parent.parent.namet_tparent.parel (3)
Schematics
& (W History Config Interval: 15mins, Record Type: numerict...
& Hli::archy [ 1d /Demo_Station/Outside_Temperature_PhysVal
e o li Source station:|slot:/Drivers/SBC£20Systems/SBCIpNetwork |
e [ Time Zone Europe/Berlin (+1/+2)
AA_uthismry [ Record Type history NumericTrendRecord .
A LogHistory (W Capacity Record Count 500 [0- max] recards
A\ outside_Temperature_Physval [W Full Policy Roll
(@i Interval regular +00000h 15m 00s
- Palette m System Tags
W X B #§ histoy [l minRollovervalue null 0.00
[l maxRollovervalue null |0.00
(Dnrogem= (@i precision 32bit
°AuditHistorySerwce
O LogHistoryService (@ valueFacets units="C precision=3*C,min=-inf “Cmax==inf*c 3 ) -
OH\storyPointList [ Last Record 12-Jun-2017 03:15 PM CEST |[] Hidden |0.00
3 HistoryPointListitem (@ Interval 00000h 15m 003|% [tms-+inf]
Q) Bxdtensions [ Precision 32bit
[3 numericinterval li Min Rollover value [ null 0.00
[ numericcov [ MaxRolloverValue [# null |0.00
/2 Booleaninteryal
Property Value Meaning
Status Enabled/Disabled | Show if the history is enable or not. It is always dis-
abled after configuration. The user has to enable it.
Fault Cause Any kind of system | Error occurred during History creation. For example
generated fault the name of the history is too long (more than 67
chars)
Enabled true / false Switch to Enable / Disable the history of that point
Active period Days of Week / Possible to schedule when the historization of that
Time range datapoint should be switched on
History name Defined name of It is possible to give name to the history or generate
the history the name from the datatpoint name.
For example:

%parent.parent.parent.name%_%parent.parent.
name%_%parent.name%

will generate the following name
Outside_Temperature_PhysVal

History Config .. Summarized set- It is possible to navigate one step down and modify the
tings of the History | settings in detail.

..ID ID of the History Generated by the system, should be unique.

.. Source Source of the The full ORD of the history.
History
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.. Time Zone Time zone The configured time zone of the PC where the
Saia PCD® Supervisor is running

.. Record type Record type It is preconfigured in the Palette / Extensions

.. Capacity Record count / The number of the records allowed to create / unlim-

Unlimited ited. It depends where the History is created. Limit-

ed size of memory device can be used to store the
History.

.. Fill policy Roll/Stop Roll — the oldest history will be overwritten with the
newest log
Stop — when the record count is reached the logging is
stopped

.. Interval Interval of the It is possible to setup the interval between two logs

logging

creation.

.. System Tags

e.g.: NorthAmerica;
Region1; Cities.

This property allows you to assign additional metadata
(the System Tag) to a history extension.

.. minRolloverValue | number It takes over the settings from the same property
below.

.. maxRolloverValue | number It takes over the settings from the same property
below.

.. precision 32 bit / 64 bit It takes over the settings from the same property

below.

.. valueFacets

e.g.: units, pre-
cision, min, and
max.

Facets contain additional data applied to input and
output values.

Last Record

Date and time

The date and time of the last value is stored.

Interval Interval of the Same as above: It is possible to setup the interval

logging between two logs creation.

Precision 32 bit / 64 bit The same as above: Precision of the floating point
value which is used for that history.

Min Rollover Value | number Related parameter for "Delta" logging for e.g. electric
consumption for displaying the difference not the abso-
lute value. It is valid for NumericChangeOf Value and
for Numeric Interval. See Niagara documentation.

Max Rollover Value | number Related parameter for "Delta" logging for e.g. electric

consumption for displaying the difference not the abso-
lute value. Itis valid for NumericChangeOf Value and
for Numeric Interval. See Niagara documentation.

4. Save the settings
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5. The following History is created

> Saia PCD® Supervisor

File Edit Search Bookmarks Tools  Window

Help

4 O- o & O [ &= -

127.0.0.1 (Demo_Station) . Station (Demo_Station) - History - Demo_Station
~ Nav
L O ) My Network

b @ My Host: SZ43LTI0EGWF2.global.ds.honeywell.com
v (@ 127.0.0.1 {Demo_Station)
h ” Station (Demo_Station)
! Alarm
b e Config
b & Files
b E Hierarchy
v D History
v ; Demo_5Station
A AuditHistory
A LogHistory
A\ outside_Temperature_Physval

6. Double click to the name of the History
The Chart of the logged values will be opened.

Additional features can be checked in the Niagara documentation.

@A @ B Today @ Qa ADoOO
Outside_Temperature_PhysVal

A outside Tempersture_Physval

@ Outside_Temperature_PhysVal

4.000

3.000

2.000

1.000

~ Palette
= & A [§ ey

15 30 a5 34 15 30
61212017 pm

>

-1.000

-2.000

-3.000

-4.000
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Using the “Saia PG5 Data Import Wizard”

Using the “Saia PG5 Data Import Wizard”

The import wizard an offline add-on tool to import the symbols from one or more Saia
PCD® device(s) to the Saia PCD® Supervisor point database. The Import Wizard is in-
tegrated into the Saia PCD® Supervisor (it is not a standalone tool). The Import Wizard
gives the possibility to import the “symbols” from one or more SBC PG5 project, which
can content of course many PCD devices per each.

The symbols, to be imported, can be filtered by type, by name.

The symbols can be re-imported any time or after modification has been done in the
PG5 project. User can decide if the imported symbols are overwriting the points in the
Saia PCD® Supervisor, or not.

The import procedure can be cancelled and new-started any time.

During import an error check is done, which ensures that only the good formed sym-
bols are imported. The absolute necessity of using unique point names are ensured
through the PG5 symbol table. The PG5 project can be buildable if the symbol table is
correct. The downloaded PG5 program and the Saia PCD® Supervisor imported points-
must be all the time consistent.

When symbols from multi project are imported the System Integrator must make him-
self sure, that there no the very same named symbols (points) are getting imported.
For example there are two PG5 project created, one is called Building_A and the other
Building_B. Inside of both projects there are PCD devices called CPU1, CPU2, CPU3.
This happens because the Building_B project is just a copy of Building_A project. Let
us assume that the Building_A project has been already done. During import of the
Building_B project e.g. the CPU1 symbols from Building_A are getting overwritten while
the symbol name structure are the same in both projects. To avoid such a situation it is
recommended to have a unique ID for each PCD device in the projects to be imported.
Or use dedicated “Saia Burgess Controls Driver® for each PG5 project.

The points in the Saia PCD® Supervisor point database are structured hierarchically ac-
cording to the symbol groups in the symbol table of PG5 project.

The following different type of symbols and other information/data can be imported from
a PG5 project to the Saia PCD® Supervisor point database.

1. PG5 symbols or datapoints
2. Alarm list generated in the PG5 project

3. Historically logged data so called HD Logs.

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC Suite based
alarms are not supported. Before importing the Alarm list and the HD Logs the web
project in the Web-Editor 8 must be compiled. Take care to select the language for the
Alarm list before compile in the Web-Editor 8. The up to date configuration files (csv
files) must be available for import.
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The 'Saia PG5 Data Import Wizard' is not supported on the Honeywell Optimiser
Advanced Controller.

6.3.1 Important information about import wizard process
in Saia PCD® Supervisor 2.1

Prior to version 2.1, projects were imported in Saia PCD® Supervisor by using CPU
device name as slot in the ORD path from the PG5 project. This could cause an issue
when importing device with the same CPU device name from different PG5 project into
the same SBC supervisor station where unique name are required.

DS @ e wE
Slot Sheet ;aglasJ@mE%e\n

Slot # Name Display Name { Project Tree [ 6 Device Properties -
Project 'DDC Suite 27 ML - 1

() Property 16 $398520AllS20FEBoxes 98 All FBoxes & Properties
88 TCP/IP Settings Table Device Name:
@3 Common Files
@ Library Manager 98 All FBoxes
3 B 98 All FBoxes - PCD3.M6860 -
Lé‘ EE DE_GO01_RO01 - PCD3.M5560 - 192.168.10.71, S-Bus Stn 72

With the current newer version Saia PCD® Supervisor 2.1 the PG5 import wizard pro-
cess apply a rule to compare the CPU device name and IP-Address as configured in
PG5 device configuration. During the import process the device will be now mapped
within the SbclpNetwork applying a unique name conversion through SbcHeadstation
or SbcSupstation appending to that a suffix number.

Slot Sheet 4 TCP/IP
—————— Channel Number 9
Slot # Name Display Name TCP/IP Enabled Yes
O Property 13 SbcHeadstation FR_BO1_LO1 Ethernet RIO Network None
IP Address 192.168.10.71
O Property 14 SbcHeadStationl DE_BO1_LO1
O Property 15 SbcHeadStation2 98 All FBoxes

In case customers require to still use the old naming convention, we recommend
performing that via Rename feature. The system as it is designed now will resolve the
unique address by suing, as explained above, the combined reference of IP address
and device name, independently from the name.

© saCipNetwork (P Rename « Rename
x Tuning Policies @ @ oe_so1_toil
@ FrR_B01_LO1 ok | cancel | ok | concel
@ DE_Bo1_LO1

Views >

@ 938 AllFBoxes
Actions

Rename

For further detailed information please refer to the Saia PCD® Supervisor manual or
contact SBC technical support to get additional support.
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6.3.2

Preparation

Using the “Saia PG5 Data Import Wizard”

For importing the Symbols from PG5 project we need to use the Saia PG5 Data Import

Wizard tool.

The “Saia PG5 Data Import Wizard” is installed together with Saia PCD® Supervisor.

- Nav
h@ G @MyNetwork

@ My Host: SZ43LTJ06GWF2.global.ds.honeywell.com
@ 127.0.0.1 (Demo_station)
# Station (Demo_Station)
.‘ Alarm
e Config
@ Services

o AlarmService
@ BackupService
@ CategoryService
@ JobService
m RoleService
0 UserService
0 AuthenticationService
,EF DebugService
@ BoxService
v FoxService
@ HierarchyService
@ HistoryService
O suditHistoryservice
o LogHistoryService
@ ProgramsService
0 SearchService
0 TagDictionaryService
TemplateService
@ WebService
T PlatformServices
B Saia PG5 Data Import Wizard
6 Drivers
e NiagaraMetwork
O sBcsystems
Apps
g Files
- Palette
] E] ,@ . sbcOfflineEngineering

B4 Saia PG5 DataImport Wizard

It is a fact that the PG5 project (the program of the PCD controller) — from where the
symbols, to be imported - is developed in a completely different tool, and this tool is not
integrated presently in any way into the Saia PCD® Supervisor. Due to this fact at the
beginning the Saia PCD® Supervisor has no information about the PG5 project and its

symbols.
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It is needed to copy the actual up to date and compiled PG5 project under to the Sta-
tion where it will be used.
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Typical shared folder of a station would be like this:

C:\ProgramData\Niagara4.7\SBC\stations\Demo_ Station\shared

So the complete PG5 project has to be copied there.

- - o x [ 119 = | shared - - o x
L] Home s View (2]
= X - Open

i) X =] L @ wopen - FHselecan Ty New i @ ; Elselectan
* - Eait e £ Fasy access it Select
jove Copy Delete Rename  New Properties Move Copy  Delete Rename  New Properties
T Gy B ol PSS @ ristory | B invert selection o S folder ErieS G History | 2 invert selection
Clipboard Organize Ne Open Select Clipboard Ne open Select
< © 4[> ThisPC > OSDISK(C) > ODSBC > 10_PGS Projects > PGSV2220 > Projects Vo | sanpoects o) | € © 4 |« OSDISK(C) » ProgramData > Niegarad3 » SBC » stations > Demo Station » sharet v 0| | searchshared P
B Music A Name o sze A A Name o Type E
= Projects T e folder
=] Pictures o Jm B DDC Suite 27 EN Template Master File folder
[ Videos e e & Images File folder
Project? 1 e folder ] s 9
. OSDISK (C) N 290920171626 Eiefalder
Projects T e folder s " S
= EB14666 (\SZ43W0001\Users) (P:) Projectd 1 e folder offlin e
e x Sort by >
= TemporaryTransfer (\SZ43W0001) ( Project1d T e folder ctores P . Yb ]
= Applications (\SZ43W0001) (5:) Saia_PCD_Supenvisor_Sbus_Demo. 1 lefolder o mmyae, e . g
deos Saia_PCD._Supenvsar_Sbus_Demo_HC 2 Refresh
= PROJECTS (\SZ43W000T) (V:) Saia PCD Supervisor Sbus Demo HC 1 7 File folder oD
Samples T File folder = Customize ths folder.
= Departments (\SZ43W0001) (Z) P!
Test PR registers T File folder = EBIAGE6 (NSZABWOO0T\Users) (P) o
¥ Network WS Station02 1 File folder v = TemporaryTransfer (\SZ43W000T) ( e ——
v < > = Applications (\SZ43WCO0T) (5 v
1 '8 = feel h hE Undo Copy CtriZ
| 2sitems  1item selected [E= | 7iems

The copy procedure has to be repeated at each time when modification was made.
(When compile of the PG5 project was happened, so the content of the symbol table
could have been changed).

Naturally when the symbol table is changed, it is necessary to re-import the symbols
from the PG5 project to the Saia PCD® Supervisor point database.

During new import the Saia PG5 Data Import Wizard will retain all user defined con-
figuration of a datapoint, except memory address and comment. User can choose to
overwrite comment or address&comment during the process.
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6.3.3 Importing symbols from PG5 projects

For importing symbols from the PG5 project the “Saia PG5 Data Import Wizard” has to
be started. This tool will do an offline symbol import. When the symbols are imported to
Saia PCD® Supervisor then we can call them "Points". Discovery of the symbols in the
Saia PCD device and do online symbol import is not possible.

1. Double click to the Saia PG5 Data Import Wizard under the currently used Sta-
tion. The Wizard opens.

At the beginning nothing is selected.

Choose the project to import data

null File

Enable all
Datapoints
Alarm List
HD Logs

® X B @ sboofineengineenng

Seia PG Data Import Wizard
bl o S Cancel

2. Chose the right PG5 project. Click to the “File” button and select the PG5 pro-
ject file of the project copied to the shared folder of the Station. Press OK.

D Saia PCD Supervisor Sbus Demo HC.saiaSpj

file:"Sata PCD_Supervisor_Sbus Demo_HC/Saia PCD_Supervisor_Sbus Dem

(W Station
© Config
@ Files

O px

0 1esources
Q Saia_PCD_Supervisor_Sbus_Demo_HC
Q© CPUDOL
Q Libs
O _lastopen
» [0 Saia_PCD_Supervisor_Shus_Demo_HC.saia5pj

OK Cancel
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3. Check the datapoints and press Scan

Saia PG5® Data Import Wizard

Scan Datapoints Alarmlists HD Logs Import Finish

Choose the project file (.saiaSpj) to import data

file:*Saia PCD_Supervisor_Sbus Demo_HC/Saia_PCD_Supervisor_Sbt File

Enable all
V| Datapoints
Alarmlists
HD Logs

At this window press Proceed n

Verify Code Page

Code Page

]
g

1252 : Western European (Windows)

Data Point Sample Text

Code page detected from PGS project

PROCEED CANCEL

n It is possible but please try to avoid accented or special characters.
Not supported characters $,# and %.

For others proper code page has to be selected then they are cor-
rectly visible.

4. The amount of the possible symbols are calculated. Press Next.

Saia PG5® Data Import Wizard

Datapoints Alarmlists HD Logs Tmport Finish

Scanning complete

Datapoints Alarmlists HD Logs
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5. The symbol list is populated.

Saia PG5® Data Import Wizard
4 5 6 7
Data Paints Alarm HD Logs Import Finish
|
Choose datapoints to import
Derice count: 1 Y Dasapoints count: 219 Selected Points: 13
Device Point Name Media Point Name Device
~ CPUDOL
A A Alarm myAlarmList Flags ¥ Heating] Ack cPUOL
Alorming A Alarm myAlarmList Handl R
arm myAlarmList Handle
EDL"E . Heating] OpMode Day CcPU00L
10“““! A Alarm myAlarmList MyName TEX
s A HDLog DateTime Day R Heating] OpMode HeatPeriod €PU00L
N
Web A HDLog DateTime HMSM R Heating ] Outside. Temperature PhysVal CPU001
A HDLog DateTime Millisecond R
Heating] Return Temperature PhysVal U0t
A HDLog DateTime Month R
A HDLog DateTime YMD R Heating] Return Valve ThreePoint close €PU00L
Back Next Reset Selection

The top of the Wizard window can be seen that the procedure is at the stage of
datapoints.

Alarm Tist HD Logs Tmport Finish

The left side of the Wizard window the found Devices with the symbol groups
of the selected device. There is also a filter icon which pops up the possible
filter settings.

Device count: 1 Y

Device

A
Alarming
HDLog
Heatingl
10

S

s
Web
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In the middle of the Wizard window the symbols are shown with full names and

Using the “Saia PG5 Data Import Wizard”

details. It is possible to zoom the window by clicking the icon at the right top-

most corner.

Datapeints count: 219

Point Name

A Alarm myAlarmList Flags
A Alarm myAlarmList Handle

A Alarm myAlarmList MyName
A HDLog DateTime Day

A HDLog DateTime HMSM

A HDLog DateTime Millisecond
A HDLog DateTime. Month

A HDLog DateTime Sec1970

A HDLog DateTime. Week

A HDLog DateTime. Year

A HDLog DateTime YMD

Media Type

E

AR AR A AR

Memory Address

6166
2175
3000
2334
2335
2336
2337
2338
2339
2340
2341

Data Format

Boolean
Signed Int
String
Signed Int
Signed Int
Signed Int
Signed Int
Signed Int
Signed Int
Signed Int

Signed Int

Comment

Alarmflags
Handle-ID

Name of list

Day
Hours/Minutes/S___
Milliseconds
Month

Seconds since 1970
Week of year

Year
Year/MonthDay

The symbols can be selected one by one by checking the checkbox beside the
symbol. Or at the top beside the Point Name by checking the checkbox all the
symbols are getting selected in the actual group.

The Data Format can be changed per Points. For example, when Register is
the data type from the PG5 project the format of the data in the register can be

Signed / Unsigned Integer or Motorola / IEEE float.

6. The right side of the Wizard window shows those symbols which are selected
therefore are getting imported. This window can also be zoomed. Beside the
symbol the big X icon is used to remove the symbol from the selection.

Selected Points: 3

Point Name

Heatingl Ack
Heatingl OpMode Day

Heatingl OpMode HeatPeriod

Device

CPU001

CPU001

CPUO01
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7. Because in the middle window of the wizard shows all the symbols the System
integrator has to be able to select the symbols which are needed to be import-
ed. Filter can be defined, so only the interesting symbols will be shown.

|
Filter Data Points by X

Select All
¥| Registers
Y| Flags

Counters

I/'Os

Timers

DB

Text

n RESTORE DEFAULTS APPLY

It is possible to select the type of the symbols to be filtered.

Or it is possible to define symbol groups not to be displayed. For that user must
click to the + icon at the right side of the list and define the Group name (e.g.
Web). There are some default symbol groups predefined.

[ |
Filter Data Points by X

Select All
Y| Re gisters
M Flags

Counters
1'0s
Timers
DB

Text

Hide Data Points Starting with

A S, o] s

Web|

RESTORE DEFAULTS APPLY

Click to Apply to make the filter settings effective.

Device count: 1 Y  Datapoints count: 2 E Selected Points: 17 E
Device v Point Name Media Type Point Name Device
CPUO00L
A v Web HMS R
Alarming Heating1 Supply Pump Alarm CPU001
HDLog v Web. YMD R
Heatingl Heating] Supply Pump Feedback CPU001
10
S Heating1 Supply Pump MotorProtection CPUNO1
s
.
Heating1 Supply Pump.Output CPUNO1
Heating1.Supply. Temperature PhysVal CPU0O01
Heatingl.Supply. Temperature. SetPt CPU001
WebHMS CPUO00L
Web.YMD CPUO00L
Back Next Reset Selection

Or you can Restore Defaults settings when it is needed.

8. We need the symbols from the Heating1 group and also from the Web group.
Select them and press the Next.
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9. Pop-up window is displayed to warn you to overwrite or not the datapoint (the
first one in the list).

It is possible to select the action for the remaining conflicts of the point data-
base.

Check the “Do this for all conflicts” and press Overwrite.

Presently it works this way

- Overwrite = it overwrites the addresses and also the comments

- Skip = it overwrites the addresses only

[jo nﬁ = n

Do you want to overwrite datapoint (EnTrend) for the device (CPU0O01) during import 1f exists?
OVERWRITE - Overwrite Memory Address & Comments
SKIP - Skip Comments only

Do this for all conflicts

Overwrite Skip

user defined configuration of a datapoint, except memory address and
comment.

n During new import the Saia PG5 Data Import Wizard will retain all
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10. The SBCIlpNetwork driver folder is automatically generated under the Drivers
folder of the Station. The datapoints were imported to the Points folder of the
SBClpNetwork driver. The datapoints are hierarchically structured as they are
in the PG5 symbol table. The main folder of the Points are named according to
the Device name in the PG5 project.

PCD device name can be the same in different PG5 Projects. Take
care of it and make it sure that the imported Device names are unique
in the Saia PCD®Supervisor.

The Import Wizard always put the points in the SBCIpNetwork folder.
This folder can be renamed. The next import then will be done to the
renamed folder. The target folder of the import can not be freely cho-
sen.

- Nav
b@ O @ My Metwork

@ HierarchyService
@ HistoryService
Q) suditHistoryService
o LogHistoryService
@ ProgramService
o SearchService
° TagDictionaryService
TemplateService
@ WebService
T PlatformServices
n Saia PG5 Data Import Wizard
6 Drivers
6 NiagaraMetwork
QO sBCsystems
6 SBClpNetwork_Demo
I Tuning Policies
) seCipNetwork
:l: Tuning Policies
@ cruom
o Alarm Source Info
Id- Poll Scheduler
e Points
Fa Heatingl
G Ack
A opMode
H cutside
3 Return
A supply
H web
@ Alarms
@ Histories
ﬁ Device Information
Q Data Poll Frequency
Apps
e Files
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11.
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It can happen that the generated structure is not fitting to the predefined struc-
ture of the Saia PCD® Supervisor.

Then it is possible to move the points to an other “SBClpNetwork” with simple
cut and paste action.

@ HistoryService
© AuditHistoryService
© LogHistonyservice

TemplateService
© Webservice

O sBe systems
6 ssCipNetwork

X o Cut

g Delete

Link Mark

Relation Mark

Rename

The not used “SBClpNetwork” then can be deleted.

It is also possible to rename the element of the folder structure. It makes
mainly sense to rename the PCD Device (the top folder). The folders under are
having the right names since the PG5 project is also built up with structured
symbol names. Let us rename it to “Device1”

© niagaranetwork
© sacsystems

Duplicate
Delete

@ apps
@ Files
(& Hierarchy

@ History

Rename

Set Display Name

Presently the Saia PG5 Data Import Wizard is not capable to follow up
the Folder structure changes. So at the next import it will again import
the symbols under the SBCIpNetwork under Drivers.
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12. During the import a Conversion with factor 0.1 is applied automatically to
every Registers which has data type Signed or Unsigned Integer. This con-
version is used because the numbers in the Registers of the PCD device are
usually multiplied with 10. This multiplication is a kind of standard conven-
tion in case of Building Automation Projects. Of course the conversion can be
removed or modified by hand. For example, we need to modify the conversion
when we are working with time values. Then the division between minutes and

seconds would be 60.

figuration of a datapoint, except memory address and comment. User can choose to

n During new import the Saia PG5 Data Import Wizard will retain all user defined con-
overwrite comment or skip during the process.
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6.3.3.1

Properties of an imported datapoint

It can be seen in the AX Property Sheet of the datapoint that, there are many properties

available.

We already touched the “Conversion”.

In this chapter the others will shortly be described.

Using the “Saia PG5 Data Import Wizard”

Let us double click to symbol which is “Numeric Variable” type.

For example:Device1/Points/Heating1/.Outside/Temperature/PhysVal.

The AX property Sheet will come up because this is the associated page (default by the

system, but changeable) to the datapoints.

- Nav

¥ G

@ My Network

@ WebService
T PlatformServices
n Saia PG5 Data Import Wizard
e Drivers
e MiagaraMetwork
© sBC Systems
e SBCIpNetwork_Demo
I Tuning Policies
° Devicel
o Alarm Source Info
Id- Poll Scheduler
ﬁ Points
[1=5] Heatingl
e Ack
A opMode
G Day
G HeatPeriod
A outside
1] Temperature
G PhysVal
A Return
1] Temperature
o PhysVal
3 valve
© ri_siznal
o Signal

o ThreePoint_clo:

° ThreePoint_opt

A supply
E web
@ Alarms
@ Histories
E Device Information
Q Data Poll Freguency

Property Sheet

© Physval (Numeric Writable)

F. Facets
[3 Proxy Ext
(W status
(M Fault Cause
M Enabled
m Device Facets

m Conversion

Ml Tuning Policy Name

Read Value
Write Value
[l Memory Address
Ml Data Format
Qut
In1
In2
In3
In4
In5
In6
In7
In8
In9
In10
In11
In12
In13
Inl4
Inl5
In16
Fallback
(M Override Expiration
W Media Type
ﬁ Comments

[ 1con

units=null,precision=1,min=-inf,max=+inf )) ’9 -

SBCProxyExt
{ok}

.tru&
» -

R Linear Scale 0.1
Default Policy
-133.00 {ok}
- {null} @ def
102
Signed Int

-13.3 [ck} @ def

- {null}

- {null}

- {null}

- {null}

{null}

{null}

H o H H W

- {null}
- {null}
- {null}
- {null}
- {null}
- {null}
- {null}
- {null}
- {null}
- {null}

H O H H H H W HH

- {null}
mll

Register
Actual physical value outside air temperi

module: //sbc/resources/images/register.png

Offset 0.0
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6-56

Short description of the properties (top to down, row by row):

1. Name of
the data-
point

2. Facets

without group structure and the type in bracket. The type of the
datapoint is determined by the Saia PG5 Data Import Wizard dur-
ing import. (changeable)

This property allows you to configure how the value of the compo-
nent is displayed. For example, on a Numeric Writable component
you can set the units, precision, minimum and maximum value for
the Out property value.

In case of the example we can use the following settings. We use
three decimal precision. The “-inf and +inf” are the +/- infinity. As
it is @ measurement which comes from the PCD controller we do
not need to set min and max. But for a writable parameter for a
setpoint or for an output it makes sense to define the min / max
parameter in order to ensure the operator typed value never goes
out of its borders (e.g. by misstyping). The engineering unit can
also be selected.

Property Sheet
@ Physval (Numeric Writable)
(Wi Facets units="C,precision=3 *C,min=-inf *C,max=-inf*C | 3 =D -
[F Proxy Ext SBCProxyExt
[ status {ok} @ Config Facets
@ Fault Cause
= Key T Val [
[l Enabled @ true = = e
- units Unit c El
[ Device Facet: D -
M Device Facets » 0 precision Integer 3
I %
[l conversion A Linesr Scale 0.1 Offset|0.0 5 e Cinr
Ul Tuning Policy Name  Default Policy B Double int
Read Value -133.00 {ok}
Write Value - {mull} @ def
[ Memory Address 102 @ X| 9 -
[l Data Format signed Int o -
out -13.300 °C [ok] @ def
in1 - [null} - X
In2 ~ [null} ¥
3 = * temperature (K) celsius(-C) o -
Ina - [null} ¥ oK Cancel
In5 ~ (nul1} ¥

Unfortunately the Facets settings are not set automati-

ﬂ cally for the imported points. This means that the Facets
parameters must be set for every each imported points
manually.
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3. ProxyExt We use in the Saia PCD® Supervisor so called Proxy Points (this is
a feature of the Niagara framework). The function of the Proxy Point
is to show the values of the symbols from different controllers in a
uniformed way. The Proxy Points then are behaving in the same
way inside of the Saia PCD® Supervisor regardless if they come
from a Saia PCD controller or from a third party device.

1. Status {ok} communicating and ok
{fault} communicating but the value is
not correct
{down} no communication
{disabled} pointis disabled
{stale} the value of the point is not

trustworthy n

2. Fault cause Possible cause of the fault

3. Enabled Enable / Disable the communication of this
datapoint (Save it if modified)

4. Device In cases for drivers that support a “Dis-
Facets covery” mechanism, a proxy point may be
created with its facets (units) already de-
fined—these reflect its “Device Facets” (in
its ProxyExt). Not applicable for Saia PCD
Devices due to no discovery.

5. Conversion (Type, Scale and Offset): the raw value
comes from the PCD controller can be con-
verted using different mathematical transfor-

mation.
6. Tuning If other tuning policy has been defined it can
Policy be selected here. The Tuning Policy is used

to define how frequently the datapoint is
communicated.

7. Read Value Value from the controller as it is.

8. Write Value The type of the datapoint is Numeric Writ-
able. So it possible to write back value to
the PCD Controller. Because the connected
variable in the PCD controller is a freely
readable and writable Register. Other hand
it can happen the user program in the PCD
controller s just cyclically overwriting this
Register.

9. Memory The address of the memory slot in the PCD
Address controller to communicate with.

10. Data Format How the value is represented in the memory
slot in the PCD controller.
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4.

5.

9.

10.

Out

In1 to In16

Fallback

Override
Expiration

Media Type

Comments

Icon

This is the value which can be visible in the Saia PCD® Supervisor
and be used/connected to other place (e.g. creating logic in the
Wire Sheet”

These are inputs of this Proxy Point, if we see it as a Function
box. The inputs can be connected to somewhere to get values or
it is possible to define the value directly. There is a defined prior-
ity between the inputs (lowest In16). The values of the inputs can
be enabled / disabled with checking the checkbox “null”. Then the
values which is the highest priority will be downloaded to the PCD
controller.

. Property Sheet
Wire Sheet IR |
© rhysval (NumericWritable)
[ Facets units="C,precision=3 “C,min=-inf Cmax==inf'c ) D -
{3 Proxy Ext SBCProxyExt
PhysVal s i
humeric Writab i status ok
Out -13.300 °C fok} @ [ Fault Cause
Ini - {rull} [l Enabled @ e
Inz 32,000 °C {ok =
= n r{ll.l} [ Device Facets » -
Ina - [rull}] [l Conversion [ Linear Scale 0.1 Offset|0.0
In5 - {null} [l Tuning Policy Name  [Default Policy
:"'B—'%“_“uﬂ% Read Value ~133.00 [ok}
nT -
Write Val 320.00 {ok} @ 2
= Il = Write Value {ok}
) —{rull} . Memory Address 102
Inio - [null} [l Data Format Signed Int
Inii - [rwll] out -13.300 °C {ok] @ 2
Ini2 - {ull} In1 — (i
nEs ~{rull 2 32.000 °C [ok} S
Ini4 - {rull} " O null |32.000 c
i) =iy I3 ~ {muil} ¥
Ini6 = [rull} . .
Fallback —{rull} Ind R R RO
O null [274.000 €
In5 - {aull} ¥

When any of the Input are not applied the Fallback value is ap-
plied.

It is possible to command Permanent or Time-duration bound
override. When Time bound override is applied, then the Override
Expiration shows the time and date when the override goes back
to Auto automatically.

The type of the memory slot in the PCD controller. Needed for the
correct communication.

Imported comment from the PG5 project.

Internal picture associated to this type of variable.

Certainly the other type of datapoints have a bit different looking Property Sheets. | do
not describe every each of them. To get familiar with them needs self-study and read-
ing the manuals.

6-58
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6.3.4 Alarming
Importing Alarm list generated in the PG5 project

There are at least two possible ways to handle the Alarms in the Saia PCD® Supervisor.

1. The Alarms are generated in the PCD controller. They are organized to a memory
territory, with Alarm text, time stamp, status (Acknowledged, Deleted, New, etc.)
and comment. This information can be then imported to Saia PCD® Supervisor.

Only SBC Web-Editor 8 generated Alarm lists are supported. SBC DDC
n Suite based alarms are not supported. Before importing the Alarm list and
the HD Logs the web project in the Web-Editor 8 must be compiled. Take
care to select the language for the Alarm list before compile in the Web-
Editor 8. The up to date configuration files (csv files) must be available for n
import.

2. In the Saia PCD® Supervisor there is alarm service which can be used to set
Alarms for individual datapoints, regardless if the datapoint is considered alarm or
not at the start of the engineering. For example the Outside air temperature can
generate an alarm when it is crossing the -20°C. For that we need to set monitoring
of this temperature in the Saia PCD® Supervisor. So the Alarm is generated in the
Saia PCD® Supervisor not in the PCD controller. Therefore this alarm can not be
seen for example in the SWeb application.

Here in this chapter we will see how to import the Alarm list form the PCD controller.
1. The Saia PG5 Data Import Wizard must be started.
2. The right PG5 project file must be selected in the File edit field.
3. Check the Alarm List checkbox

Saia PG5® Data Import Wizard

Choose the project file (.saia5pj) to import data

file:"Saia_ PCD_Supervisor_Sbus_Demo_HC/Saia_PCD_Supervisor_Sby File

_FC_Superuisor_Sbus_eme_H[331a_FLU_Supervsor_Sbus_Uemo_H.s31a5p)

Enable all
Datapoints
v Alarmlists

HD Logs
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4. Press Scan. The Alarm list of the selected PG5 project is being scanned.

Saia PG5® Data Import Wizard
3 4 5 6 7
Data Points Alarm HD Logs Import Finish
Scanning complete
0 0
Datapoints Alarm List HD Logs
Back Next

n 5. Select the Alarm list to be imported.

Choose Alarmlist to import

v CPU00L

Vizualisation

Back

Device count: 1 Alarmlist count: 1 Selected Alarmlists: 1
Device o Alarm List Alarm Type DE EN FR Alarm List
v A Alarm myAlarmList MyName 1 A Alarm myAlarmList.._

Reset Selection

6. If the Alarm list is generated with more languages then select the required languge.

Choose Alarmlist to import

Device v Alarm List Alarm Type  DE EN FR
v A Alarm myAlarmList MyName 1 L]

~ CPU001

Vizualisation

Device count: 1 Alarmlist count: 1 Selected Alarmlists: 1

Language

EN

Reset Selecti

7. Press Next. And confirm to overwrite the Alarmlist.

Overwrite Alarmlist (A _Alarm myAlarmIist MyName) for the device (CPU001) during import if exists?

¥ Do this for all conflicts

OVERWRITE SKIP
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Using the “Saia PG5 Data Import Wizard”

Data import is in progress, this will take a while

00of0 1ofl
0% 100%
Datapoints Alarm List

00f0

0%
HD Logs

Import is ready. The details can be checked under the Device/Alarms folder.

More details are not available.

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window

127.0.0.1 (Demo_Station) . Station (Demo_Station) I Config
- Nav
h@ O @ My Network

e My Host : SZ43LTJ06GWF2.global.dz.honeywell.com
@ 127.0.0.1 (Demo_station)
# Station (Demo_Station)
‘ Alarm
@ Config
@ Services
e Drivers
e NiagaraMetwork
© s systems
6 seciphetwork
l Tuning Policies
@ cruon
o Alarm Source Info
Iﬁ Poll scheduler
e Points
@ Alarms
o A.Alarm.myAlarmList.MyName
@ Histories
m Device Information
Q Data PollFreguency
@ Apps
@ Files
E Hierarchy

@ History

. Drivers . SBClpNetwork o CPUDD1 o Alarms

. AAlarm.myAlarmList.MyMame

Property Sheet
© AAlarmmyAlarmListMyName (SBCAlarmList)
m Alarm List Name myAlarmlist
[ Alarm List Number 0
[ Memory Address 3000
m Language EN

9. Check the Alarming behaviour by generating test alarms in the corresponding Saia

PCD controller.
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6.3.5 Importing Historically logged data so called HD Logs

There are at least two possible ways to handle the Historically logged data in the
Saia PCD® Supervisor.

1. The HD Logs are generated in the PCD controller. The HD Log data can be saved
in different format and into different memory territory in the PCD device. The
Saia PCD® Supervisor supports only "csv" file based log data which are saved to
the Flash File System of the PCD device. (This means that, the HDLog 3.0 Fbox
generated logs, which are saved to INTFLASH, M1_2FLASH and SLOTO_3FLASH
can be imported.)

2. In the Saia PCD® Supervisor there is History Service which can be used to log the
interesting values to the hard drive of the PC. So the logged data then any time can
be retrieved and can be displayed e.g. as a trend curve. So the Historical Log is

H generated in the Saia PCD® Supervisor not in the PCD controller.

Here in this chapter we will see how to import the HD Logs form the PCD controller.
1. The Saia PG5 Data Import Wizard must be started.

2. The right PG5 project file must be selected in the File edit field.
3. Check the HD Logs check box, and press Scan

Saia PG5® Data Import Wizard

Choose the project file (.saiaSpj) to import data

file:*Saia PCD_Supervisor Sbus Demo HC/Saia PCD_Supervisor Sbt File

Enable all
Datapoints
Alarmlists

¥ HD Logs

4. Press Proceed or select the right codepage manually and press Proceed.

Venfy Code Page

Code Page

1252 - Western European (Windows)

Data Point Sample Text

Code page detected from PGS project

PROCEED CANCEL
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5. Summary of the found HD Logs is displayed, press Next

Saia PG5® Data Import Wizard

3 4 5 6 7

Data Points Alarm HD Logs Import Finish

Scanning complete

6. The detail view of the HD Logs is displayed. Select the needed HD Log files. Inside
of one HD log file can be many different data points logged (symbols). Then press
Next.

Choose HDLogs to import

Device count: 1 HDLogs count: 1 B Seclected HDLogs: 1 ]
Device % HDLog Name HDLog Name Device
v Logfile Points: 5
. Logfile CPU00L

Back Next Reset Selection

7. Check the check box and press Overwrite to proceed. The existing configuration
will be overwritten.

i Overwrite hdlog (Logfile) for the device (CPUO01) during import if exists?

v Do this for all conflicts

OVERWRITE SKIp

8. The Import Wizard reports the successful import.

Import complete

Datapoints Alamm List HD Logs

Import is ready. The details can be checked under the Device/Alarms folder.
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9. Check the result in the NAV tree / Device / Histories.

10. The default settings is to get the data from the PCD device (controller) once per
day. This can be changed to get the data faster for example every 10 minutes.

: Station (Deme_Station) : Config : Drivers : SBClpNetwork © cPUoO1 : Histories

-~ Nav Property Sheet
2 O @D My Network A& Logfile (SBCHDLog)
[l Hd Log Name Logfile

© my Host: S243LTI06GWr 2 global.ds.honeywell.com G Hd Log Poll Frequency  2:00 AM {Sun Mon Tue Wed Thu Frisat}

@ 127.0.0.1 (Demo_Station) Time Of Day 02:00:00 AM CEST|
(@ Trigger Mode Daily Randomization [+00000h 00m 0032

DaysOfweek  [# sun [ Mon B Tue [ wed [ Thu @ Fri [ sat

[l Last Trigger nu1l
[ Next Trigger 14-Apr-2017 02:00 AM CEST

© sBC systems
® secipretwork

X TuningPolicies

@ cpuooy
© alarm Source Info
B« Pollscheduler
Y raints

(@Y Alarms
@ Histories
<k | ogfile
[l Device Information
‘Gl Data Poll Frequency
© apes
& Files
&) Hierarchy
@ nistory.

6.3.6 Starting the communication after the import

Drivers can be seen effectively as language packs. After the execution of the

Saia PG5 Data Import Wizard we have got a new driver called the SBCIpNetwork.
Once a driver is in place and configured the Saia PCD® Supervisor can speak to that
protocol.

The PG import wizard works offline. It does not require a network connection to the
PCD.

If the IP address and S-Bus station number of the Saia PCD® Supervisor was correctly
configured in the Device configurator and the PCD with the Saia PCD® Supervisor
software is connected to the same network and if the network setup is correct, then the
communication should work directly after the execution of the “Import wizard” without
problems.
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Enabling the Saia PCD S-Bus IP-Driver
1.

In the Nav tree open the Station/Drivers/SBClpNetwork. Double click on the
Device1.

In the property sheet check the settings (red colour marked lines) and enable the

driver.

Save the modification.

» Saia PCDE Supervisol

File

127.0.0.1 (SBC_SBus_Project)

* Nav

2 o

Edit  Search

Bookmarks

@ My Network

w (@ My Host: WIN-IFESJGTEIUL
b @Y My File System
> 0 My Modules

b BT Platform
w (@ 127.0.0.1 (SBC_SBus_Project)
v BT Platform

2

@ Application Director

0 Certificate Management
9 Lexicon Installer

@ License Manager

o Platform Administration
e Station Copier

e TCPfIP Configuration
a Remote File System

w 3 station (SBC_SBus_Project)

.‘ Alarm
9 Config
] @ Services
v e Drivers
Y sBCIpNetwork
» X TuningPolicies
» ° Devicel- Copy
» ° Devicel
] e NiagaraNetwark
4 e Apps
a Files
] O offline

- Palette

. Station (SBC_SBus_Project)

Window

. Config

Help

. Drivers . SBClpMetwork
Property Sheet
 sBCIpNetwork (SBCIpNetwork)
[ status [{ok]
. Enabled ’ true

v v v w

v

m Fault Cause
[ Health

Ok [26-Apr-17 9:52 AM CEST]

© Alarm Source Info  Alarm Source Info

2 monitor
X Tuning Policies
(@ channel Type

@ Devicel - Copy SBCHeadStation
@ Devicel SBCHeadStation
m Status [down, alarm, unackeda]
[l Enabled @ true
@ Fault Cause
» [ Health Fail [26-Apr-17 9:52 AM CEST] Timed out ..

b @ Alarm Source Info

» Id- Datapoints Poll Scheduler
m Datapoints Poll Frequency

v . Ip Address

Ping Monitor
Tuning Policy Map
S5-Bus ICE/IP

Alarm Source Info
N Poll Scheduler
Normal

172.23.13.3:5050

[ Ip Address  [172.23.13.86

@ Port [ unspecified 5050 [-1-55538]
[ Station Id 5
b e Points SBCPointDeviceExt
b @ Alarms Alarms
» (D Histories Histories

» m Device Information
@ Ftp Username
@ Ftp Password
m Http Password

» Ql Alarms Poll Frequency

SBCDevicelnformation

30secs {Sun Mon Tue Wed Thu FriSat }
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6.3.6.2 Checking different settings to get the communication working

The following picture shows that the communication is not working the devices are
orange colored

Saia PCD® Supenviso

File Edit Search Bookmarks Tools Window Manager  Help

: Station (SBC_SBus_Project) @ Config @ Drivers @ SBClpNetwork
. =
Nav Database
¥ o @ My Network Name Type Exts Status Health

@ My Host: WIN-IFE3JSTBIUL @ Devicel-Copy  SBCHeadStation %  {down} Fail [26-Apr-17 2:27 AM CEST] Timed out waiting for response.SbcPacketTraceMessage

) 1y File System @ Devicel SBCHeadStation /%  {down} Fail [26-Apr-17 9:27 AM CEST] Timed out waiting for response.ShcPacketTraceMessage
@ My Modules
FT Platiorm

@ 127.0.0.1{SEC_SBus_Project)

FT Platform
® application Director
€ certificate Management
@ Lexicon Installer

© License Manager
© Platform Administration
@ station Copler
 TcP/IP Configuration
) Remote File System
& ststion (SBC_SBus_Project]
A Alsrm
© config
@ Services
 orivers
3 seCipNetwork
X TuningPolicies
@ Devicet - Copy

@ Devicer

The following steps are needed to do debugging communication problems.

1. Check the communication between PG5 and the Device
This only works if the PG5 is installed onto the same PC

It should be possible to go online to the PCD with the online configurator of PG5
over a “Socket connection”

{ File Edit View Project Device Online Tools Help
= = N e e s =
PR A= -3 4

i Project Tree

-IE Project 'Project_for_Niagara' : 2 Devices
- Properties
F2  TCP/IP Settings Table
[E3 Common Files
Library Manager [socker
-[E Devicel - PCD3.M6860 - 172.23.13.6, 0.0.0.0. 5-Bus Stn 6 o SOCKET
{-{%f Properties Channe
{1l Online Settings - 5-Bus USB: PGU

Select the channel

5-Bus Station Mumber

Eg Device Configurator Aute Station ko

& E“”d Opt:flns 1P Address or Host Name 17223136
-2 Program Files

-2 Listing Files
. [Z] Documentation Files
B Devicel - Copy - PCD3.M6860 - 172.23.13.5, 0.0.0.0, 5-Bus 5tn 5

Mumber of retries 3

IP Address or Host Name

Enter the IP Address or the domain name (without the http: part) of the
PCD.

The Host Name must resclve to an IP Address by the DMNS server.
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.7 [Devicel] - Saia PG5 Online Configurate

File Online Tools Options Help
Online Settings - I
SOCKET TCP/IP, 17223136, Sin b Soliing

| Online Setings... |

Information -

PCD Type: PCD3IMBEED Py 12615 | [ s —— |

Program Dievicel -

Dte: 264472017 Day: 3 | Howarenfo.. |

Time: 5:41-15 Week: 17 —_—

| Histaory: |

Status: Run -

| Clock... |

Help | | Fun | | Stop | | Festart | | Close |

2. Ifit's not possible to go online over Socket to the PCD, try to ping the IP-address of n

the PCD.

BN Chwindows\system32y e

Microsoft Windows [Uersion 6.1.76H11]
Copyright <(c» 288? Microsoft Corporation. All rights reserved.

C:\Users\EB146662>ping 172.23.13.6

Pinging 172.23.13.6 with 32 bytes of data:
i out .
out .
out .
Request timed out.

Ping statistics for 172.23.13.6:
Packets: Sent = 4, Received 4 (188» loss>,

C:\Users\EB14666>ping 172.23.13.6

Pinging 172.23.13.6 with 32 bhytes of data:
Reply from 172.23.13.6: bytes=32 time=17ms TTL=(C4
.13.6: bytes=32 time=14ms TTL=64
.23.13.6: byt 2 time=14ms TTL=bh4
Reply from 172.23.13.6: bytes=32 time=5ms TTL=64

Ping statistics for 172.23.13.6:
Packets: Sent = 4, Received = 4, Lost = B8 {(Bx
Approximate round trip times in milli-seconds:
Minimum = Sms,. Maximum = 17ms,. Average = 1Z2ms

GC:wUsers“EB14666>_

If it’s not possible to PING the PCD, there must be a problem with the
network setup (e.g. IP address or Subnet mask)

or there is a problem with cabling or switches

or there is problem with Windows Firewall Settings:
- File and Printer sharing must be enabled

- ICMP Echo Requests must be enabled
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3. If there is connection to the controller but PCD Supervisor reports communication
error, check the settings in the network driver.

: jia PCD® Superviso

File Edit Search Bookmarks Tools Window  Help

127.0.0.1(SBC_SBus_Project) ~ : Station (SBC_SBus Project) @ Confiz  : Drivers  : SBClpNetwork
- Nav Property Sheet
P o @ My Network 3 seCipNetwork (SBCIpNetwork)
(@ Status {ok}
v (@ My Host: WIN-IFE3JET6IUL [l Enabled @ true
b @ MyFile System [l Fault Cause
b @ vyModules b [ Health Ok [26-Apr-17 8:52 AM CEST]
> BT Platform » @ Alarm SourceInfo  Alarm Source Info
v O 127.0.0.1 (SBC_SBus_Project) b Q Monitor Ping Monitor
~ § Platform » X TuningPolicies Tuning Policy Map
@ Application Director (W Channel Type 5-Bus TCE/IE
© certificate Management » @ Devicel- Copy SBCHeadStation
@ Lexicon Installer v @ Devicel SBCHeadstation
@ License Manager m Status {down, alarm, unackedh’
° Platform Administration m Enabled . true
@ station Copier (@il Fault Cause
6 7cp/iP configuration b O3 Health Fail [26-Apr-17 9:52 AM CEST] Timed out ...
» @ RemoteFile System » o Alarm Source Info Alarm Source Info
= & Sstation (SEC_SBus_Project) » B+ Datapoints Poll Scheduler N Poll Scheduler
-! Alarm (@l Datapoints Poll Frequency Normal
v © config v [ Ip Address 172.23.13.3:5050
b @ services [Ml IpAddress  [172.23.13.6
v 6 orivers [ Port [ unspecified |5050 [-1-65536]
~ ) sBCipNetwork [l station 1d G
b X Tuning Polices » G Paints SBCPOintDeviceExt
] ° Devicel-Copy » @ Alarms Alarms
b @ Devicer b (O Histories Histories
b € NiagaraNetwork » [ Device Information SBCDevicelnformation
» @ apps [l Ftp Username
v @ Files [l Ftp Password
» Q offline [J Http Password
- Palette » Gl Alarms Poll Frequency 30secs {Sun Mon Tue Wed Thu Fri Sat}
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4. Restart the Platform Demon at last.
It is possible that restarting the Platform Daemon will help because the used net-
work adapter and ports settings are getting updated after restart.

E’j Windows Update
M Wireshark Legacy
M Wireshark
<4 XPS5 Viewer
. T-Zip
| Accessories
. FileZilla FTP Client
, Games
. LenMark

. Maintenance

. Motepad++
. PG5 Suite V2.2.221
. SaiaPCD5upervisor

£ Alarm Portal

E Console

[="] Demo Station

[ Instell Platform Daermon

“#> Saia PCD Supervisor Beta (Console)
“®> Saia PCD Supervisor Beta

G2 Uninstall

1 Back

| Search programs and files 2 |

e »

Attila

Documents

Pictures

Music

Computer

Control Panel
Devices and Printers
Default Programs

Help and Support

| | Shut down ,m

o K3

v v v w

Using the “Saia PG5 Data Import Wizard”

The communciation is ok when the Devices are not colored and their status is
{OKJ}. In addition, it is possible to see valid information of the PCD in the Nav tree
Device Information subdirectory.

127.0.0.1 (SBC_SBus_Project)  : Station (SBC_SBus_Project)

~ Palette
W X B @ schedule

» BB Booleanschedule

Property Sheet

[l Device Information (SBCDevicelnformation)

(@ PCD Status
(@ PCD Type
(4@ PCD Clock

Run
PCD3.ME860
17-04-26T10:13:01

(@ Firmware Version  |1.26.15

(@ Time Zone

Europe/Berlin (+1/+2)

Q_ data poll frequency

/'  AXProperty shest -
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6.3.6.3 Tuning the Saia PCD S-Bus IP-Driver

There are not so many possibilities given to fine tune the communication. It is possi-
ble to set three different kind of speeds (Fast Rate, Normal Rate, Slow Rate) as base.
Then it is possible to set up the rates for a complete device.

B¢ Datapoints Poll Scheduler N Poll Scheduler
(@l Poll Enabled @ true
[‘i Fast Rate 00000h 00m 01.0005 2 [1ms-+inf]
(@ Normal Rate 00000k 00m 05.00082) [1ms-+inf]
(@ Slow Rate 00000 00m 30.0008]3 [1ms-+inf]
[i Statistics Start 31-Aug-2017 10:31 RAM CEST
@ Average Poll 0.0ms
@l Busy Time -

n [ Total Polls 3109 over Oms

@ Dibs Polls 0% (1/3109)
[l Fast Polls 0% (0/3109)
[l Mormal Polls 99% (3108/3109)
[ Slow Polls 0% (0/3109)
[l Dibs Count current=0 average=0
F. Fast Count current=0 average=0
[l Mormal Count current=1 average=0
@ Slow Count current=0 average=0
(@ Fast Cycle Time average = 1000ms
[l Mormal Cycle Time  |average = 5001ms
@ Slow Cycle Time average = 1000ms

[l Datapoints Poll Frequency | Normal

The polling rate is the same for all datapoints within a Device.

For the Alarm list it is possible to set a polling rate. As default 30 seconds is set. Which
means, that the alarms located in the Saia PCD device are polled in 30 seconds. Then
the new alarms and/or acknowledgment are transferred. The polling rate can be ad-
justed or scheduled. The details of the different settings can be found in the Niagara

documentation.
@l Alarms Poll Frequency 30secs {Sun Mon Tue Wed Thu Fri Sat}
Interval 00000k 00m 3032 [Lms-+inf]
[i Trigger Mode Interval TimeOfpay [] StartTime 12:00:00 AM CEST  EndTime|11:59:59 BM CEST

Days Of Week [ Sun [ Mon [ Tue [ wed [ Thu [ Fri (4 sat
[ Last Trigger  |31-Aug-2017 02:18 PM CEST

Ol Mext Trigger  |[31-Aug-2017 02:18 PM CEST

0 Refresh D Save
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For the Histories (HD Logs) it is also possible to set a polling rate. The default set-
tings is Daily at 2 o'clock in the morning to retrieve the HD logs from the Saia PCD
Device. This setting can be changed to e.g.: Interval, 30 seconds. \Which means, that
every 30 seconds the HD Log data is polled, then the new values are uploaded to the
History files of the Saia PCD® Supervisor. The details of the different settings can be
found in the Niagara documentation.

(® Histories Histories
& Fuehlerl SBCHDLog
r‘ HD Log Mame Fuehlerl

Qll HD Log Poll Frequency  2:00 AM {Sun Mon Tue Wed Thu Fri Sat}
Time Of Day 02:00:00 AM CEST 4

F] Trigger Mode Daily Randomization |+00000h 00m 0032
DaysOf Week  [@] Sun [#] Mon [@] Tue [#] wed [@ Thu [#] Fri [@] sat
[ LastTrigger  |31-2ug-2017 09:27 EM CEST
F‘ Next Trigger 01-5ep-2017 02:00 AM CEST n

Starting with version 2.1 the Alarms Poll Frequency property is not visible below the
Ax Property Sheet of the SBus Device.

To make it visible and therefore adjustable, switch to the Ax Slot Sheet of the device
fo be adjusted...

\_J CIEENSCNATT &b ProjectName FTOJECT MaME EINEETTOrEN MM Dajaintrnng

O Eigenschaft 27 deviceName Device Name Eingefroren h baja:String

O Eigenschaft 28 isProgramCRCRead |z Program C R C Read Eingefroren rh baja:Boolean

O Eigenschaft 29 programCRCMismatcherror Program CR C Mismatcherror  Eingefroren baja:String

O Eigenschaft 30 statusErrorMessage Status Error Message Eingefroren baja:String

O Eigenschaft 31 uuid Vuid Eingefroren rhd baja:Juid Slot hinzufugen Ctri+A
O Eigenschaft 32 statusUuid Status Uuid Eingefroren  rhd baja:Uuid Kopieren Ctri+C
O Ausfihren 33 readAlarms Read Alarms Eingefroren hal void (void)

OAusthren 34 readMultiPoints Read Multi Points Eingefroren ha wvoid (void)

| O Eigenschaft 35 dataPollFrequency Alarms Poll Frequency Eingefroren h control:TimeTrigger Flag bearbeiten

O Eigenschaft 36 Home Home Dynamisch o baja:Pxview

O Eigenschaft 37 AlarmTextAssigner AlarmTextAssigner Dynamisch alarmTextAssigner:Ald Neuanordnen

O Eigenschaft 38 Link Link Dynamisch  t baja:Link Anzeigename

...and remove the "Hidden" flag with the function "Edit Flag" at the property:

> Flag bearbeiten x
[] operator ] Ne Audit
[] readonly [] composite

[ ] GanfirmReauired | | RemoveOn Clone
[] Execute On Change [] Metadata

[ ] Transient [ ] GinkTarget
[ summary [] Men-Critical
[ |'NeRun [ ] UserDefined/d
[] Fanin [[] userDefined 2

[ ] UserDefined 2
[] Defaulton Clone [ ] UserDefined4

[ Jsync

ok | Abbruch
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6.3.7 SbcLinear Conversion

6.3.7.1 Introduction
With the Patch 3127_1 for Supervisor Version 2.1, a new conversion type named
“SbcLinearConversion” will be introduced. This conversion is only valid for SBC specific
media types.

6.3.7.1.1 Before the Patch:

When for example a Register is created below the Points section the point gets the
conversion type linear set per default:

Property Sheet
@ sBCRegister (Numeric Writable)

n . Facets units=null precision=1,min=-inf,max=+inf )) ’9 -
v [ Proxy Ext SBCProxyExt
[ Status {down, sTale)
[l Fault Cause
(@ Enabled @ true
(W Device Facets > 0O-
[ conversion ) Linear Scale 0.1 Offset 0.0

[l Tuning Policy Name
== Read Value

= Write Value

(@ Memory Address
[ Data Format

6.3.7.1.2 With Patch:

Default Policy
0,00 {ok}

- {pull} @ def
=1

Signed Int

With the Patch all newly generated media gets automatically set the

SbcLinearConversion as conversion type:

Property Sheet
@ s8CRegisterl (Numeric Writable)

6-72

. Facets units=null precision=1,min=-inf, max=<inf >> ’9 v
v [ Proxy Ext SBCProxyExt
(W Status {down, stale}
(@l Fault Cause
l}i Enabled @ true
(Ml Device Facets > 0O~

(M Conversion

(Ml Tuning Policy Name

UMl SbeLinear Conversion Seale 0.1 Offset 0.0

Default Policy

== Read Value 0,00 [ok}

w Write Value = [null} B def
. Memory Address =1

(@l Data Format Signed Int
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6.3.7.2 Installing the Patch
Download the Patch from SBC Support page and extract the files:

» Downloads » Saia-PCD+Supervisor+2_1+Patch1.4.3127.1

~
Name Anderungsdatum

|/ sbe-rt.jar 14.04.2020 09:41
0 sbe-rt.jar.sig
£ sbc-uxjar

L] sbe-uxjar.sig
£ sbc-wb jar 14.04.2020 09:41
[ ] sbc-wb.jar.sig 14.04.2020 10:08

Copy all files to the modules folder of your Supervisor Install Path:

EOSOISK (C) » SBC 5 SawPCDSupeniser 2 » modules I v
# 4 Name a Bnderungsdstum  Typ Gralle
2+ i o T . : LR,
| shelconGallery-wh.jar Executable Jar File 1.246 KB
* | sbelconGallery-wh jor.sig SIG-Ditei 1KB
| sbeOfflineEngineering-rt.jar Executable Jar File 200 KB
| sbeOtflineEngineering-rt.jar.sig $1G-Datei 1KB
| £ sbcOfflineEngineering-uxjar Executable Jar File B42 KB
| sbeOfflineEngineering-uxjar.sig SIG-Datei 1KE
Lde) sbe-rtjar Executabie Jar File 184 KB
| she-rtjarsig SIG-Datei 1KB
e x| sbe-wjar Executabie Jar File 1MKB
| she-uxjar.sig SIG-Datei 1KB
Lia) sbcwh jar Executable Jar File 20KB
| she-wh jarsig SiG-Datei 1KB
|dis) schedule-rtjar Executabie Jar File 124 KB
| £ sehedule-uxjar Executable Jar File 165 KB
| sehedule-whjar Executable Jar File 53KB
| semreh-rt.jar Executable Jar File 42KB

After that uninstall/install Plattform Daemon and restart Workbench.

6.3.7.3 Import in newly generated stations (after installing the Patch)

After the Patch is installed, all newly generated DataPoints will get add the new SbcLin-
earConversion automatically during import. No special work is needed here:

4 Database
) My tetwork Mame Type Out Tuning Policy Name  Canversion
- 65.55-::,.«,"0,* ) Output  Numeric Writsble - 0.0{down,stale] @ def iy SbcLinear "0.10
» X TuningPolicies ©) volue  NumericWritsble 0.0[down,stale] @def  defaultPolicy SheLinear Convenion *0.10

» @ EN_Bo_RoL
» @ 0E_Go1_RoL
w (&) 38 Al FRoses {98 All FRawes)
v Q) Alarm source Info
b |+ patapoints poll scheduler
v I points
» B Alarming
= H analogue
» I Ansdig
b inary Bl
» 3 Binary_Bv
b H counter
~ [ DEc 0w
+ B reox
b 0 output
» D) value
b IGY in_Dec
» FRAnec o av
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6.3.7.4 Updating existing stations

This section describes two ways how to update existing Station.

6.3.7.4.1 Change conversion type manually

Go to a subsequent folder where you want to change the conversion type and open
there the SBC Point Manager view by right clicking on the folder:

0 iValue
0 walue_ai

EA senso
Ansichten

G Neu
Tags bearbeiten
0 e Make Template

Ausschneiden
Kopieren
Einfligen
Einfligen Spezial

Duplizieren

E rHe

: SBClpNetwork @ EN_BO1_RO1

0 ConvType  NumericWrital

0 Correction Numeric Writal

Point View Widget LRl
SBC Point Manag cWrital
Wire Sheet cWrital
AX Property Sheet  [SUliEl
Property Sheet cWrital
Category Sheet cWrital
AX Slot Sheet cWrital
Relation Sheet cWrital
Delete Points View  [SUiEl
cWrital

Neue Grafik
cWrital

Hilfe Leitfaden cWritsl
Bajadoc Hilfe
Spy lokal

Spy remote
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Open the table settings via click on the button in the upper right corner and set the
Conversion Column to be displayed:

I.pgonu-ersi.:.n

/ SBC Point Manager

16 Objekte

Spaltenbreite zuriicksetzen

Exportieren

Pfad
+»Name
+Iyp
+»Out

Enabled

Facets

»Tuning Policy Name

Device Facets

Fault Cause

Read Value

Write Value

Choose and select the desired data points and click on the Edit button:

Database

Hame Type Out Tuning Policy Mame  Conwversion
° AlaLimHigh Boolean Writable false {ok} @ def defaultPolicy Default

o AlaLimLow Boolean Writable false {ok} @ def defaultPolicy Default

©) convType  MumericWritable 2.0{ok} @ def defaultPolicy Default

0) comection  MumericWritable 0.0K{ok}@def  defaultPolicy Linear "0.10

0 GwHyst NumericWritable 2.0 K{ok} @ def defaultPolicy Linear "0.10
© cwver NumericWritable 10.0s{ok} @def  defaultPolicy Default

) LimHigh NumericWritable 50.0°C{ok]@def defaultPolicy Linear "0.10
[} LimLow NumericWritable -30.0°C[ok} @def defaultPolicy Linear "0.10
[} PhysVal MNumericWritable 15.0°C{ok}@def defaultPolicy Linear *0.10
) PhysvalYl  MumericWritable -30.0°C{ok} @def defaultPolicy Linear *0.10
i) Physvaly2  NumericWritable 50.0°C{ok] @def defaultPolicy Linear *0.10
©) Rowvalxi  MumericWritable 0.0{ok} @def defaultPolicy Default

0 Rawval{ MNumericWritable 4095.0{ok}@def defaultPolicy Default

© scenFact NumericWritable 10.0{ok} @def defaultPolicy Default

© scenTime  NumericWritable 1.0 s{ok} @ def defaultPolicy Linear"0.10
0 VoltGrp Mumeric Writable defaultPolicy Default

BE New Folder

[3] New | # Edit | ®
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In the upcoming window the changement to the conversion type SbcLinearConversion

can be done:

o Edit
Name Type Ensbled Facets

1) comection  NumericWritable tue units=K precsions=1,mine-10.00,mae=10.00  defaultPolicy
D owttyst  NumericWritable  true wnity=K, precisionsd,mine0.00muoet0.00  defaultPolicy

units'C, preciionsl mine-50.00,mam150.00  defaultPolicy
units="C, precisionsd, mine-50.00,max=150.00 defaultPolicy
defaultPolicy
units='C, precisgion=1,min=-inf,mue=100.00  defaultPolicy
unitse*C precisional mine-inf,maml00.00  defaultPolicy

D) UmHigh  NumericWritable true
D Limlow  NumericWritable true
© Fhywal  Numencwitable tue
1©) Bhysvalvl  HumericWritable true
D) PhysvalY2  NumericWritable true

units="C, precigion=1 min=-infmaessinf

Tuning Policy Name  Device Facets Conversion

Linear"0.10
Lingar 010
Linesr"0.10

Linesr*0.10

Name
Type
"M Enabled

[ Facets

Correction
Cannotedit

[

unitseK precisione] Kmine-10.0Kmami 00K @ -

(i Tuning Policy Name Defoult Folicy

[l Device Facets

» O -

@ Conversion [ Linear [ [peste 0.1 Offset 0.0
3 ”
oK | Cancel
[ #everse Polarity
Osant Chen Shunt NS Fdel defaultolicy Defaule
wvabe e
2 [ bulse Thermistor NS @def  defaultalicy Linear0.10
nfad ermistor Type 3NS
e Q vor def defaultPolicy Default
reric Tabular
ItGp ermistor Type 3

bular Thermistor
Chen Shunt
Ghm Shunt (nrio)

bulsr Thermistor (nrio)

istr Type 3 (nsia)

B New Folder

Enew | Ledie | B 1ape

After clicking on OK button, the changement will be applied to all selected items:

Database

Name

G AlaLimHigh
G Alstimiow
0 ConvType
0 Correction
0 GwHyst
e Gw\erz
© Limnigh
@ LimLow
0 Physval
@ Physvalry
© Physvalv2
© Rewvalxt
) rawvabi2
@ scenFact
© scanTime
© voltcrp

Type

Boolean Writable
Boolean Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable
Numeric Writable

Numeric Writable

Out

false {ok] @ def
false {ok] @ def
2.0{ok} @ def
0.0K{ok} @def
200K {ok} @ def
10.0s{ok} @ def
500,0°C {ok} @ def
-300.0 *C{ok} @ def
150.0°C {ok} @ def
-300.0°C{ok} @ def
500.0°C {ok} @ def
0.0{ok} @ def
4095.0{ok} @ def
10.0{ok} @ def
1.0s{ok} @ def

1.0{ok} @ def

Tuning Policy Name Conversion

defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy

defaultPolicy

Default

Default

Default
SbclinearConversion
SbcLinearConversion
Default
SbclinearConversion
SbeLinearConversion
SbeLinearConversion
SbeLinearConversion
SbelLinearConversion
Default

Default

Default

Linear=0.10

Default

6.3.7.4.2 Change conversion type automatically (PG5 projects without PointDefinition.csv)

To make the changement automatically done you need to reimport your project with
Saia PG5 Import wizard.

During import process select Overwrite:

Confirm

Do you want to overwrite datapoint (AD1 Alarm Groups CmdAlmAck) for the device (EN_BOI_R01) during import if exists?

OVERWRITE - Overwrite Memory Address & Comments
SKIP - Skip Comments only

¥ Do this for all conflicts

| . Overwrite P 1IN Skip
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6.3.7.4.3 Change conversion type automatically (PG5 projects with PointDefinition.csv)

If a PointDefinition.csv is part of the PG5 project you need to take care, if the right con-

version type is set for each the data point.

Example on macro [ DDC_SPINT2270] from DDC Suite 2.7

Before the patch:
The conversion was assigned during import like this:

ProxyExt:Conversion='Linear+Scale=0.01+0Offset=0.0'

|_Doc_seinTazm)

ProayExt:Conversion="Linear+Scale=0001+0f et =0.0"
ProayExt:Conversion="Lingar+5cale =001 +Of faet=0.0°
Facets=TrueText=Artive’
ProayERt:ConversionsLinearsScale=0 01 +0ffoet=0.0°
Faceis="TrueText=Active’

Value Walue Value Farets="Units=relsiug’
output Output output Fatets="Units=celsius’
PricdEn PrEOBEN PricgEn Fatets=FalseTeat=inactive’
Pricaval PriogVal Pricaval Farets=Unitssoelsius’
Priol5En Friol6En PriolSEn 'Fue'h:FalmTutﬂnadm'
The result was:
Database
G [ @ uyeeek Name Type out Tuning Policy Name  Conversion
* B omen 10 outout
b HisgaraMetwork 1 Priceen stale] @ def Default
~ @ sBcichetwork © priosval a ek oy ey
» ;“*-WFD:W O PrioleEn  Boslesnviitable Inactive [down stsle] @ del  defauliPoliey Detaslt
v EN_BO1_RO1

b Q) Alaem Sourceinfo
» [+ Datapoints Poll Scheduler
- D poines
= B
b B alam
* B ool
» Bl esdTime
(N - P
= [ uration
b 0 cutput

» @ erioten

) value

After patch was installed:

The conversion must be set like this:

Numericwritable  0.0°C{down stale} @def  defaultPolicy

ProxyExt:Conversion='SbcLinear+Scale=0.01+0Offset=0.0'

[_DDC_SPINTI2N]
Valua
Output
Prig8En
PriogWal
Priol&En

After import:

) My Mtk

» X TenngPoldes

Valisg valug
Cutpiat Output
PrigBEn PricEn
Priogival Pricgval
Priol&En Pricl&En

Database

Hamme Type Out

0 Cupst  Humerciiritsble 00°Cidownsiel@del  defaultPolioy
Q) Priotn  Boolesn Wiritable  Inactve [Sown stalel @ del  defauliPolicy
(0 Priokial  Mumercwitatle  00°Cidown el @del  defaulPolicy
O Pricistn Boolessviritable Insctive [Sownstale] B del  defaultPolicy
O slie  Humencwriasle 0.0°C idownstlel@del  defaubPolicy

Facets=UnitisalEiug
Facets=Unitisealsius
FacatssFalsaTestsinsrtive’
FacetseUnitsscalsius’
FacetseFalsaTectsinactive’

Timing Policy Hame _ Comversicn.

Th T
Il

ProayExtCormarsions S BLinpar e Scales0 0L +Oftset=0.0"
PeCayExXCoenersicns S brLinpareScales0 O+ sats0,00
Facatss TruaTextsictve’
ProayExtLorersions"Soolingars Sale=0 08 + Dt sat=0.0°
Facatss TrueTextsictne”
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6.3.8 Enhanced PG5 Import Wizard
m The datapoint filter can now also be applied to tags
m Alarms can be configured with the alarm class specified in the AlarmService
m All data points are displayed in the list

m  When importing very large projects, the data points no longer go to the status
"stale"

m Imported alarms now have the correct timestamp

m Array import working

n Filter Datapoints by X
|

Select All
¥l Registers
¥ Flags

Counters
IO
Timers
DB

Text

Hide Datapoints Starting with

S.

Show Datapoints with tags

alarm areal

Restore Defaults Apply

b o e o e L e e B e = A B B s e S o a4 s =

6-78 Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05



Saia-Burgess Controls AG

Creating/Engineering a project

6.3.9

6.3.9.1

6.3.9.2

General functions

Addition to the standard import
Starting with Saia PCD® Supervisor V2.1

In addition to the standard import, the extended import wizard from version 2.1 and
higher allows to add properties like facets, conversions, alarm, history extensions and
more to the points during the import process.

The additional properties are required to work with
the easy templating library DDC27

m To support the new import features PG5 2.3.175 and higher is required as well as
the start of projects is recommended to use the new multilingual DDC-Suite 2.7
starting project ending with ML.

m [n additional project not based on the new start project can get extend by the
necessary additional information’s using a helper application which allow to
generate the list of used macro names in the project.

The predefined graphical templates for DDC 2.7 are created
to support the DDC Suite 2.7 environment

m The easy Templating process itself can support various constellations of templates.

Important to know:
- Since Saia PCD® Supervisor 2.1 the CPU name from PG5 is no longer the import location in

the NAV tree.

The import location is now based on the IP-Address of the device and the CPU name is given
from PG5 on top as the display name.

During import the engineering point names are translated from different languages to English.

This makes it possible to use one set of templates for all different existing languages for DDC
Suite 2.7 projects.

On top of the engineering data point name a display name will be added which represents the
imported language in the NAV tree so the engineering and display name can differ.
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6.3.10

System consequences for duplicated CPU names
Starting with V2.1!

During Import the IP-Address of the imported devices configured in the PG5 device
configuration is used to identify the station below the S-Bus IP driver Network.

During import a unique naming convention is created for the device ORDs like
SbcHeadStationX(x=INT) or SbcSubStationX(x=INT). The display nhame of the ORD
from the imported note is set to the device name from the PG5 project.

'G3 DOC Suite 27 ML - Dec 2019 (FR_B01.L01] - $a1a PG oo o o) et
[ifile €t View Project Device Oniine Tools Help

T e —{m )
T = A

| Project Tree 2%
& Project 'DOC Suite 27 ML - Dec 2019 : 15 Devices o o O st
S Properties Slot Sheet
| 5 g:;n-r‘:’;e::os Tadble Sk * Nome Aeogoame  Defeston  Flags Typ
8 Ubrary Manager Qogenschatt ¢ st 220 Ongelores A9 Daacitanus
500 e Supervisor Template «-««e--— - PCOLG3600-C1S5 - S-Bus O Ggenscdolt 1 wnabled tranied Cogetreres SayxBooless
# 8 98 All FBoxes - PCOIMS360 - 192.168.10.80, 5-Bus St 80 Otemcn 3 tontause e Crne Sigdena ind” huidieg
# W BACnet Aliasing - PCOIMSS60 - 19216810152, -8us Stn 151 O RS R PRy IR SRR
3 M8 D _-vomevee VOAIQE - seneenes - PCD1G3600-C15 - S-Bus St 0 TR T et
i M DE_GOY_ROY - PCOIMSSEQ - 192168072, S-8uss Stn 72 OSuieheh 35 iibenitwoinés | Amisusindi: Brodrive e
& M8 OE Voriage - PCO3IMSSE0 - 192168071, $-8us Stn 71 Otemahad 3. monte s Bogriretes e e atpmom
5 M EN_--eeee Template ---------- - PCOLG3600-C1S5 - S-Bus Stn 0 Qaudtirom & pong g Ungrirecen & voud lvoud
+ M8 EN_BOY_RO1 - PCOIMSSED - 192168072, S-Bus S:n 72 O ruitidons 1 0 Ak Alaom Dngelroces h Bage Booless [alawrn AlarmRecoed
4 M EN_Template - PCOIMSS60 - 192162071, -Bus Stn 71 O bamecnat s bRt e ot iertie
o - PCDLGIE0-C15 - $-Bus Stn 0 Oty T s
+ B4 FR_BO1_LOL - PCD3.M5560 - 192.168.0.72, S-Bus Stn 72
i M FR Modele - PCOZMSSEO - 192.1680.156, S-Bus Stn 156 Q Bumachan 10 et SR ot ovasmmtl B st i
e | NL_--eveeeeee s}avoon_,,_,,,___ - PCDLG3600-C15 - S-Bus Stn O O(;vfw o 1 Dhanrel Toe Dagefrccet BasRnsg
+ I NL_GO1_RO1 - PCO3IMSS60 - 192168072, S-Bus Stn 72 Qogrnscran 12 ) L L) Baa Naverag
1 8 NL_Sjabioon - PCO3IMSS60 + 1921681785 5-Bus Stn § O tamidhs 13 3 MRBOLLOL  Oynassch ReDONsIOn
Qugesratt 14 Rowssiarosl DE_BIL_LOL Oynamach RCROWNI RO

This allows to import from different PG5 Projects having same device names applied
without changes to the project.

If a station with the same IP-Address is imported and already existing below the S-Bus
driver network, you will get asked to enter prefix before the import.
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6.4
6.4.1

General functions

General functions

Configure Scheduled tasks

This chapter describes how to configure Schedulers to control the automations system
during occupied and non-occupied time.

Scheduler

The Scheduler provides control of values and changes setpoints based on time and
date. Lights, Fans, and HVAC equipment are turned on and off based on the time, day
of week and date. The Scheduler is also used in process control and manufacturing
applications.

Presently there is no Saia PCD® Supervisor compatible Schedulers in the Saia PCD
Device. It means that, if the automation system needs high level scheduling functions,
this must be done “upstairs” in the Saia PCD® Supervisor not in "downstairs" in the
PCD Device. Which has the drawback that if the Supervisory computer fails to work
the Scheduling function fails too.

There is an exception. It is possible to use the Saia PCD Device as BACnet Control-
ler, in this way the BACnet standard scheduling functions can be used. This is com-
patible with the Saia PCD® Supervisor. However it needs to license and use the 3rd
party (BACnet) driver in the Saia PCD® Supervisor.

Schedules are created using schedule components found in the schedule palette.
Place these components in a station, configure, and link as needed to provide schedul-
ing control of other components.

Scheduling functionality is the same whether using Workbench or an HTML5 web
browser with one exception. Currently, in a web browser connection, you do not have
the options to copy or paste components.
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Schedule component categories

Component category Description

Weekly Boolean Weekly schedules define regular, repeating, events
Numeric by “time-of-day” and “day-of-week.” Also, you can
Enumerated | configure any number of “special events” on a weekly
String schedule. Weekly schedules are the most used sched-

ule components. Four different types vary by data
category (Boolean, Numeric, Enum, and String). Each
is identical except for input/output.

Calendar Calendar schedules define specific days. Use a cal-
endar schedule to define days with scheduling excep-
tions (e.g. holidays), and reference them in the “spe-

H cial events” setup of weekly schedules.
Trigger Trigger schedules fire actions or topics. With a set

of pre-configured schedules and a ScheduleSelec-
tor component, you can simply choose from a list of
valid schedules to setup or change the schedule of a
device.

Selectors Schedule Selector components provide an easy way
for you to select a schedule to use for controlling a
particular component. As needed, you typically link its
output to an action of a control point or extension.
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General functions

Weekly

Default view

for any weekly schedule component. In Work-
bench the Scheduler view provides four configura-
tion tabs:

Weekly Schedule

Sunday-through-Saturday (weekly) event times/
values. Use this to define the regular weekly
events.

Special Events

All exceptions to the defined weekly schedule, as
special events. Use this to define special event
times.

Properties Important properties such as default output,
schedule effective times, special event clean-up
operation, and schedule facets.

Summary for any selected day, provides a tabular summary

of all schedule events, with source. Also available
under the Scheduler view dropdown list:

Current Day
Summary

provides a simple 24-hour linear graph of schedule
event times and values for the current day.

Calendar

Default view

for a CalendarSchedule component. The Calendar
Scheduler view provides a calendar where you
can add, edit, or delete specific calendar days
(exceptions to the regular weekly schedule) and
establish relative priorities.

Trigger

Default view

for a TriggerSchedule component. The Trigger
Scheduler view provides a two-part view combin-
ing a “day picker” and an event “time picker” for
specifying when topics are fired on those days.

We configure a Weekly schedule and a Calendar Schedule in this chapter.

ule and Special Events.

n In a web browser the Scheduler view provides two configuration tabs: Weekly Sched-

While the Current Day Summary and Property Sheet views are available under Sched-
uler view dropdown list.
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Examples

e Weekly Schedule
The task is to configure a weekly schedule which switches on the Light in the nor-
mal office time from Monday till Friday and from 8:00 till 17:00. Friday the office time
is reduced only from 8:00 till 14:00.

There is special event on 1st of September 2017. In this day the Light must be
switched off from 9:00 till 11:35 due to test.

e Calendar Schedule
There are known official Holidays like Christmas or the Swiss National Day where
the office is unoccupied therefore the Light must be Switched off.

n The steps to add and configure Schedulers to the Saia PCD® Supervisor:

1. Creating folder for the scheduling components
. Add Weekly Scheduler component from Palette

. Configuring normal events weekly schedules

2
3
4. Configuring special events weekly schedules
5. Add Calendar Scheduler component from the Palette
6. Configuring Calendar Schedule

7

. Make the logic to control the physical point in the PCD device

or

8. Make the logic to control the physical point in the PCD device using reference be-
tween the schedulers.
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6.4.2 Creating folder for the scheduling components

Schedules can be created and added to any part of Saia PCD® supervisor. However, it
makes sense to manage these in a central location.

1. In the Nav tree open 127.0.0.1(localhost) > Station > Config
2. Create there a folder called Scheduler.

3. Double click to the folder. The associated Wire Sheet will be opened.

> 5ajia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Wire Sheet  Help

4 o O- o na O 00 =~ [

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Schedulers n
- Nav Wire Sheet
E@ o @Merztwork

el My Host: SZ43LTI06GWF2.global.ds.honeywell.com
@ 127.0.0.1 {Demo_Station)
# Station (Demo_Station)
._. Alarm
e Config
@ Services
e Drivers
@ Apps
0 Schematics
0 Schedulers
Q Files
E Hierarchy

@ History

More details of using Wire Sheet can be found inside of the Niagara docu-
mentation.
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6.4.3 Add Weekly Scheduler component from Palette
1. Open the schedule palette

4#» Open Palette *
- Palette Selectone or more palettes to open, orjust start typing: Browse...
EI E] E i schedule ? schedule
B Boolesnschedule Module Description ®
B8 Enumschedule schedule schedule Framework
B NumericSchedule
-::] StringSchedule
B calendarschedule
B Trigeerschedule

B BooleanScheduleSelector
B NumericscheduleSelectar
2::] stringscheduleSelector

v v e wvwwvwvwvvwew

BB EnumScheduleSelector

0K Cancel

2. Drag and Drop the BooleanSchedule component to the Wire Sheet of the Schedul-
ers folder.

3. In the pop-up dialog specify the name of the component (Weekly_Schedule_Light)

[ Saia PCD® Supervizar

“®» Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window  Wire Sheet Help

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Schedulers
- Nav Wire Sheet
h@ O @ My Network
b @MyHost:5243LTJGEGWF?_.global.ds.hone}.rwell.com Weekly_Schedule_Light m=
. . Boolean Schedule
v (@ 127.0.0.1({Demo_Station) e
; L Out Source
v ’ Station (Demo_Station) Out
In
A 2iarm NextTime
v © confie Next Value
g @Services
b eDrivers
» @ apps

4 OSchematirs
» osd'ledulers
b & Files
» EHierarch),r

p @ History
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6.4.4 Configuring normal events weekly schedules

1. Double click to the Weekly Schedule_Light function box to open the Scheduler
configuration window.

Saia PCD® supervisor Schedules operate Sunday to Saturday and times
are set from top to bottom.

2. In the weekly view specify the time range for Monday. For that go to Monday 8:00
press the mouse left button and drag the mouse down till 17:00 o’clock.
The defined time range will be shown as green stripe.

<®» Saia PCD® Supervisor

File Edit Search Bookmarks Tools

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Schedulers . Weekly_Schedule_Light K Scheduler ~

O ) My Netw

@ My Host : S743L TIO6GWF2.
@ 127.0.0.1 (Demo_Station)
’ Station (Demo_Statio
A Alsrm
e Config
@ Services
© orivers
Apps
D Schematics

- Palette
w X B | schedun

[ Booleanschedule
B Enumschedule
B8 Numericschedule
=::] StringSchedule
B calendarschedule
B Triggerschedule

EventStart |08:00 AM
EventFinish 05:00 BM

Event Output [] null () true

[P Weekly Schedule | [i] SpecialEvents  [8] Properties () Summary

[™] save 7 Refresh

3. Do not worry if you do not find the exact time. Below the graphical representation,
in the Event Starts and Event Finishes edit fields it is possible to type it.

In the headings of the green stripe and in the Event Output drop down box the
scheduled value can be seen (true). It is possible to invert it.

4. Define time schedule for Tuesday to Friday too in the same way. Take care the of-
fice time in Friday is until 14:00.
It is possible to do copy and paste. Right mouse click to the green stripe and select
copy day. The selected time span is then shown in blue colour. Right mouse click
to the remaining days and select paste day. Then set Friday 14:00 o clock.
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5. Click Save at the bottom of the page.

@ Saia PCD® Supervisor

File  Edit

127.0.0.1 (Demo_Station) Config Schedulers Weekly_Schedule_Light

o/ Scheduler -

¥ C D) My Netw

b @ My Host : SZ43LTI06GWF2.
v (@ 127.0.0.1 (Demo_Station)
v & ststion (Demo_statio
‘ Alarm
- @Conﬁg
b @ services
g eDnvers
3 eApps

0 Schematics

- Palette A
W X B |8 schedul

B8 Booleanschedule EventStart |08:00 AM 2
B EnumsSchedule EventFinish | 02:0 PM 2
B8 humericschedule EventOutput (] null (@ true
StringSchedule
: e B weekly Schedule ﬂ Special Events m Properties G) Summary
CalendarSchedule
m TriggerSchedule m Save | C Refresh

6.4.5 Configuring special events weekly schedules

1. Click to Special Events at the bottom of the page.

2. The Special Events summary page opens with the Today schedule visible.

@@ Saia PCD® Supenvisor

File Edit

4 o 0O-o @ O 0 =- M =

127.0.0.1 [Demo_Station) : Station (Demo_Station) Config . Schedulers

Scheduler ~

- v
Nav 4 PrevPage

Next Page p
¥ O @ My Netw Jul 2017

b @ MyHost: SZ43LTI0EGWF.
v (@ 127.0.0.1 (Demo_Station)
b4 , Station [Demo_Statio
._. Alarm
hd eCcnf\g
.4 @ Services
b @ orivers
6 Apps

O schematics Name Summary

- Palette
[ ] [Z] E ischedul-

8 Booleanschedule

EventStart 03:29 PM
B enumschedule EventFinish |03:29 PM
BB Numericschedule @Add Edit Priority Priority Rename Delete Event Output ] null .tme
m StringSchedule

B8 weekly Schedule m Spedial Events D Properties ®Summary
BB calendarSchedule

m TriggerSchedule

msave | cﬂefrsll
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3. Click to Add and specify the date 1st of September 2017.

@ Saia PO

File  Edit Windoew  Help

127.0.0.1 (Demo_Station) ! Stetion (Demo_Station)  © Config ! Schedulers  © Weekly_Schedule_Light

4 PrevPage 4 PrevMonth  Today | MNextMonth p  MextPage p

~
2 C @ My Netw Jul 2017 Sep 2017

@ My Host: SZ43LTJ0GGWF2.
@ 127.0.0.1 (Demo_Station)
& station (Dema_Statio
‘ Alarm
@ Config
@ services
e Drivers
© 2pes @ Add

© schematics Name  Summall ysme (Suitch OFf due test 3:00AM

E:00AM
Type |Date 9:00 AM
- Palette 12:00PM

Any Weekday Sep s 3:00PM

W X B | # schedul E:00PM

9:00PM

EHH Booleanschedule oK Cancel EventStart |03:29 EM

B8 Enumschedule EventFinish [03:29 BM
B NumericSchedule - Priority Priority Rename Delete Event Output[ ] null . true
B stringschedule

B colendarschedule
BB Triggerschedule [¥] save ‘ 3 Refresh

B weekly Schedule m Spedial Events m Properties Gsummary

4. Click OK

5. Specify the schedule to switch off the Light from 9:00 till 11:35. Do this at the right
side of the window by using the mouse and typing the values by hand.
Do not forget to specify the “false” value to switch off the light

«®> Saia PCD® Supenvisor A - m} ¥

File Edit

Tools  Window  Help

4 o O- o A O [ =~ 2 D |

127.0.0.1 (Demo_Station) ~ © Station(Demo_Station)  © Confiz  © Schedulers

4 Prev Page Next Page p

O (& hy Netw Jul 2017

@ My Host: 52431 TIOBGWF2.
@ 127.0.0.1 {Demo_Station)
’ Station [Demao_Statio
._. Alarm
© config
@ Services
e Drivers
@ Apps

O schematics Name Summary Unscheduled
3:00AM

6:00AM
9:00AM
- Palette 12:00PM
300PM

[} E] E ischeduh 6:00 PM

%:00PM

D Schedulers Switch_Off_due_Test Date:15ep 2017

8 Booleanschedule
B Enumschedule EventStart |04:06 EM

::: [ Schedul EventFinish [04:06 BM
umericSchedule

® Add ® Edit Priority Priority  [I] Rename 3¢ Delete Event Output [] null | false
m StringSchedule

BB calendarschedule ) Weekly Schedule | [] specialEvents  [8] Properties (D) Summary
2] TriggerSchedule

PR Roaleanscheduleselertar [™] save 77 Refresh

6. Save the configuration
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7. Check the summary. Click to Summary at the Bottom of the page. Navigate to 1st
of September 2017. Then in the text summary it can be seen the Special Event

entry.

@ Saia PCD® Supervisor

File  Edit

Scheduler ~

y_Schedule_Light

4 PrevMonth  Today | NextMonth p

: Config  © Schedulers

4 Prev Page Next Page p

K S (%] | MyNetw

b @ My Host : SZ43LTI06GWF2.
v (@ 127.0.0.1 (Demo_Station)

v & ststion (Demo_statio Sep 2017 Oct2017

! Alarm

Jul 2017 Aug 2017

- 9 Config
b @ services
g e Drivers
3 @ Apps

1
. AOEAH »
> DOAEE -
» M EE D~

AN »
» HEEEE -
~ R EEE »

» MEEEE
v DEEAE

N -E
» @ D@ -
» BEEEE@ »
» (A EEE »

» 0 Schematics
- 0 Schedulers
B Weekly,

> & Files

-

- JEDED~ |- D000 ||~ BSE0E~ |- 0

= [

- Palette
W X B | # schedul

B BooleansSchedule

BB Enumschedule

BB NumericSchedule

B stringschedule

BB calendarschedule

m TriggerSchedule

BB BooleanScheduleselector
BB numericscheduleselector

— m Save

Timestamp Output  Source

01-Sep-1712:00 AM CEST false{ok] Default Qutput

01-5ep-178&:00AMCEST  truefok} Week: friday

01-5ep-17 %O0AMCEST  false{ok} Specdial Event: Switch_Off_due_Test

01-Sep-17 11:35 AM CEST  true{ok} Week: friday

[ Weekly Schedule  [i] SpecialEvents  [8] Properties (D) Summary

7 Refresh
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6.4.6

1. Open the schedule palette

General functions

Add Calendar Scheduler component from the Palette

2. Drag and Drop the CalendarSchedule component to the Wire Sheet of the Sched-

ulers folder.

3. In the pop-up dialog specify the name of the component (Calendar_Schedule _

Light)

4. A Calendar Schedule function box is placed to the Wire Sheet.

™ Saia PCD'® Supervisor

File  Edit Search

Bookmarks Tools  Window

Wire Sheet  Help

4 O O-onfa O

127.0.0.1 (Demo_Station)
~ Nav
¥ O ®m

v (@ 127.0.0.1 (Demo_3t:
v ’ Station (Demao_

! Alarm

v 6 Config
b @ servic

b e Driver

- Palette
w X 3 ds

» B Booleanschedule
» BB Enumschedule
b BB NumericSchedule

O - - - [T AR

Wire Sheet

0 -

. Station (Demo_Station) . Config . Schedulers

Calendar_Schedule_Light m
Calendar Schedule

Weekly_Schedule_Light
Boolean Schedule
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6.4.7

Configuring Calendar Schedule

1. Double click to the Calendar_Schedule_Light function box to open the Scheduler
configuration window.

2. Click Add to schedule the Christmas holiday from 25th of December till 31th of

December.

File Edit Search

127.0.0.1 [Dema_Station)
- Nav
P o () My Netw

@ 127.0.0.1 (Demo_Station)
’ Station (Demo_Statio
A 2lerm
@ Config
@ Services
6 Drivers
9 Apps

0 Schematics
o Schedulers
FFH weekly,

- Palette
w X B | # schedul

B Booleanschedule
B Enumschedule

Bookmarks  Tools

: Station (Demo_Station)

Window  Help

I Config : Calendar_Schedule_Light

4 PrevPage

4 PrevMonth  Today | NextMonth p

Calendar Scheduler ~

Jul 2017 Aug 2017

10 11 12 13 14

17 18 19 20 21
23 LB 25 26 27 28
30 31

Sep 2017

Name Summary

o Add

Name Christmas_Holiday

Type DateRange

Any Year
Through

Dec Any Year

HE NumericSchedule

OK Cancel
B stringSchedule

B calendarschedule Edit
m TriggerSchedule

Priority [T] Rename Delete

m Save

Priority

c Refresh

3. Click OK and then click Save.

4. Then it makes sense to define a holiday for 1st of January.
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5. Then specify the holiday for the 1st of August (Swiss National Day)

@) Szia PC|

File  Edit Window  Help
4 O- o an C 0 - 2 D |
Config . Calendar_Schedule_Light

4 PrevPage 4 PrevMonth  Today | NextMonth p

Sep 2017

Calendar Scheduler ~

Next Page p

G @ My Net Jul 2017

v @ 127.0.0.1 (Demo_5tation)
- , Station (Demo_Statio
‘ Alarm
b4 e Config
] @Serwces
] eDrwers
4 eApps
0 Schematics
0 Schedulers
b B Weekly

Name Summary
FirstOfJan_Holiday DateilJan

Christmas_Holidsy ~Date Range: 25 Dec- 31 Dec

- Palette

w X B  § schedul

B8 BooleanSchedule
BB Enumschedule
BB numericschedule
=::] StringSchedule
FH calendarschedule
:::] TriggerSchedule

@ Add
Name|Swiss_National_Day_holiday

Type |Date

Any Weekday Aug

0K Cancel
G

Priority W Priority  [L] Rename

m Save c Refresh

¥ pelete

6. Click OK, Click Save, Click Refresh.

7. Check the settings. Green background of the dates means schedule is set.

«®) Saia PCD'® Supenvisor A ] 4
File Edit Window

O - [~ 0 |

. Station (Demo_Station) . Config

4 O- o n O
.1 ({Demo_station)

: Calendar_Schedule_Light

4 PrevPage 4 PrevMonth  Today | NextMonth p

Calendar Scheduler ~

Next Page

Sep 2017 Dec 2017

¥ G

() My Nety

v @ 127.0.0.1(Demo_station)
v , Station (Demo_Statio
‘ Alarm
'eg‘ﬁg 17 18 19 20 21 22 23

4 Services
4 eDrwers # EEEE
31
4 eApps .
0 Schematics
© schedulers
b B weekly

7
10 11 12 13 14

Name Summary
Swiss_Mational_Day_holiday Date: 1Aug
FirstOfJan_Holiday Date: 1Jan

Christmas_Holiday Date Range: 25 Dec- 31 Dec

- Palette
W X T § schedul

BB Booleanschedule
BB Enumschedule
B numericschedule
B stringSchedule
B calendarschedule
m TriggerSchedule

Priority Priority Rename Delete

m Save c Refresh

Short summary is in the middle of the page
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6.4.8

Make the logic to control the physical point in the PCD device

The previous steps are describing how to add and configure the needed schedulers.
It is needed to transfer the Schedulers combined Out value to the data point which

is really communicated to the PCD Device. This point is called Enable_Light in the
Saia PCD® Supervisor. In the PCD Device the application program monitors this Flag
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is
nobody in the building. During the specified time the Calendar Schedule output will be
high. We need to negate the output of the Calendar Schedule to get the correct logic.

1. Navigate in the Nav tree to the Scheduler folder.

2. Double click to the Scheduler folder. The Wire Sheet pops up.
3. Open the kitControl Palette.
4

. Drag and drop the “And” and “Not” function block form the Logic folder to the Wire
Sheet.

5. Connect the function block together as the picture shows.

<> Saia PCD® Supervisor

File Edit Search Bookmarks ools Window Wire Sheet Help

- Nav Wire Sheet

= o (D My Network

Calendar_Schedule_Light =
Calendar Schedule
Status

I
B+ Datapoints Poll Scheduler In ol
false

‘& Points hext Time O1-Pug 17 17:00AM
©) analoginput_1
© oigitalinput_
@ Digitalinput_1
@ oigitalinput_2
@ oigitalinput_3
@ oigitalinput_4 :-vt mﬁiﬂ
@ oigitalinput 5 ﬁm-; m.lll—.ﬂm;:![dq
0 oigitalinput & J
© oigitalinput_7
© enable_Light

3 Proxy Ext

@ alarms

O Histories

[l Device Infarmation

true {ok]|
true {ok])
“true jok]|

1]
B2
SR
B
[]

Weekly_Schedule_Light m
tatus Tok]

Gl Alarms Poll Frequency
6 secipnctwork
 BacnetNetwork
Apps
Q) schematics
© schedulers
B weekly_Schedule_Light
B calendar_Schedule_Light

The Out pin of the And Function box must be connected to the Enable_Light pin
IN16. But these Function Boxes are located in two different Wire Sheets.
We need to link these two pins together.

6. Open the Wire Sheet for the Scheduler folder (if it is not open). And select the And-
Function Box.
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7. Right mouse click to the Out pin of the And Function box, then select the Link
Mark command from the context menu.

Wire Sheet

Calendar_Schedule_Light E
Calendar Schedule
ok

Weekly_Schedule_Light

Boolean Schedule
Edit Tags
Make Template

Cut Ctrl+x
Copy Ctrl+C

Paste Ctrl+v

Paste Special
Duplicate
Delete

Link Mark

Link From "And"

Link To "And"

8. Navigate to the Points folder of the Device where the Enable_Light point is located.

9. Right mouse click to the Points folder and select the Wire Sheet form the views
menu.

10. Organize the Function Boxes on the sheet to get some spaces between them.

At first time you open this Wire Sheet the Function Boxes which are represent-
ing the Points in that folder are overlapping each other. The Function Boxes are
configured that way that the Out, In10, In16 pins are visible. Right now these pins
are enough for our work. But keep in mind that, the visibility of the pins are config-
urable, so many other pins can be set to be displayed.

The meaning of the pins can be checked deeply in the Niagara manual.

11. Right mouse click to the In16 pin of the Enable_Light Function Box.
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12. Select the Link from “And” command form the context menu.

< Saia PCD'® Supervisor

File  Edit Search Bookmarks Tools Window  WireSheet  Help

4 o 0O-oaC b - [ % © 0 B X %
127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Drivers I SBCSystems . SBClpMNetwork_Demo
- Nav Wire Sheet
Enable_Ligh!
¥ O ) My Network 'ﬁBuuleanWrihh
@ Services T
Views
6 Drivers -
6 MiagaraNetwork FpE LEEDTS

Eoolean Writab

© secsystems o
6 SBClpNetwork_Demo
1 TuningPolicies Make Template

6-96

°Devicel En e Cut
OAlarmSourcelnfo

IQ— Datapoints Poll Scheduler

Paste
% Foints
Paste Special
Q Analoginput_1 3 def
iy ica Ctrl+
G Digitallnput_ o] Duplicate Ctrl+D
0 pizitalinput_1 Delete Delete
@ pigitalinput_2 o
0@ pigitalinput_3 !
@ pigitalinput_4 BUMT  Link Mark
@ bigitalinput_s —_ LinkFrom "And"

Digitall nput_
@ oigitalinput_6

13. In the pop-up window the link between the two Function Boxes must be defined as

the picture shows. The link can be checked by reading the text at the bottom left
corner of the window.

@ Link X
And [Source] Enable_Light [Target]
Facets = In3
|— Out w0l
[ NullOn Inactive - In1l
Propagate Flags - nl2
e In A == nl3
w= In B e mld
= |nC = 15
== |nD e |n16
we Fallback
Owverride Expiration
Min Active Time
Min Inactive Time
[ SetMin Inactive Time On Start
LinkAnd.out-= Enable_Light.in16
OK Cancel

14. Click OK. The pop-up will be closed

15. In the Wire Sheet check the marks of the link and also check that the link is live. It
means that the Points/Enable_Light function box In16 pin follows the Schedulers/
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And Function Box Out pin of the And function box.

General functions

<® 53ia PCD® Supervisor

File Edit Search Bookmarks

BB Weekly_Schedule_Light
BB calendar_Schedule_Light
B ot
B and

] rrorchy
@ ristory

<@ Saia PCD® Supervisor

File  Edit

Search

rrrrrr

© sscsystems
O ssciphetwork_demo

Bookmarks  Tools  Window  WireSheet  Help

X TuningPolicies

© device:
© Alarm Source Info
¢ Datapoints Poll Scheduler
2 points

16. The state Out pin of the Enable

17. If the state of the Out pin has different value then the In16 pin the following can

happen.

A. The Out pin is forced by operator -> set back to Auto

' Light function box normally follows the state In16
pin. The Out pin shows directly which value is downloaded the PCD device.

Wire Sheet

Boolean Writab

diEnable_Light ()
1

®

Digitallmput_
Boolean Writab

Out true {alarmunach

Analoglnput_
Numeric Writab

Actions
Edit Tags
Make Template

Cut

Ctrl+C

Ctrl+X

4

Emergency Active
Emergency Inacti
Emergency Auto
Active

Inactive

Auto

B. - Other higher level of InX pin is getting value from somewhere.
- Check the logic if it is valid

Wire Sheet

fDigitallnput_ [F) Enable_Ligh
Boolean Writab Boolean Writab
Out false{dt}@deﬂ%ﬂut Talse [ok @ 10
Into - [rull} Into false [ok)
Inie — [} = Inie true {ok}
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C. - Inside of the Function Box other InX pin is selected with value to override
the output.

- To check it double click to the Function Box.
The prioritized override technique of the Out pin is described in the Niagara

manual.
- The picture shows that, In2 overrides In10 and In16 to command the Out
pin.
. Drivers I SBC Systems o SBClpNetwaork_Demo o Devicel . Points . Enable_Light
Property Sheet
@ Enable_Light (Boolean Writable)

[ Facets trueText=true falseText=false 3 ) -
[3 Proxy Ext SBCProxyExt

m Status {0k}

[ Fault Cause

@l Enabled @ true

(Ml Device Facets » ©-

M conversion 12 Default

Ml Tuning Policy Mame  |Default Policy

w= Read Value false [ok}

= \Write Value false {ok] @ 2

[l Memory Address 999

m Data Format Boolean
wQut false {ok} @ 2
= nl - [null}

false [ok}] E3
== In2 O null .fﬂls&
= |n3 - [null}
—nd - [null}
== In5 - [null}
== Inf - [null}
= n7 - [null} ¥
= |ng - [null}
= |ng - [null} ¥
= nl0 false [ok} ¥
= nll - [null} ¥
= nl2 - [null} ¥
= nl3 - [null} ¥
= nld - [null} ¥
= nl5 - [null} ¥
= nl6 true [ok}] ¥
we Fallback true [ok} ¥
W Override Expiration null
[l Min Active Time +00000h 00m 0032
(@ Min Inactive Time +00000h 00m 00s]3]
m Set Min Inactive Time On Start . false
[ Media Type Flag
[l comments
c Refresh B Save
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6.4.9

General functions

Make the logic to control the physical point in the PCD device
using reference between the schedulers.

The previous steps are describing how to add and configure the needed schedulers.
It is needed to transfer the Schedulers combined Out value to the data point which

is really communicated to the PCD Device. This point is called Enable_Light in the
Saia PCD® Supervisor. In the PCD Device the application program monitors this Flag
and according to its state enables the light on/off.

Keep in mind. In the Calendar schedules we specified the Holidays, when there is
nobody in the building. During the specified time the Calendar Schedule output will be
high. We need to negate the output of the Calendar Schedule to get the correct logic.

There is another more elegant way to make the connection between the Calendar
Scheduler and the Weekly Scheduler. The way is to define reference between them.

The Calendar Scheduler is higher in priority, so we need to make a reference from the
Weekly Scheduler to the Calendar Scheduler.

1. Navigate in the Nav tree to the Scheduler folder.
2. Double click to the Scheduler folder. The Wire Sheet pops up.

3. Double click to the Weekly_Schedule_Light. This will open the configuration win-
dow of the Scheduler.

4. Click to Special Events at the bottom of the page
5. Click to Add

6. In the pop-up window go to the Type and select Reference then click to OK.

o Add X

MName Event
Type Date

Date

Any Jul 2017 3
Date Range m

Week And Day
oK Cancel
Custom

7. In the next pop-up window it is possible to select to which Scheduler the reference
must be added. Here there is only one scheduler listed. Select Calendar_Sched-
ule_Light then click OK.

o Add X

Mame Ewvent

Type Reference

Calendar

slot:/Schedulers/Calendar_Schedule_Light

oK Cancel ‘
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8. The Event = Reference to the weekly scheduler is added. But it is “Unscheduled”,
can be seen in the right side.

@ S3ia PCD® Supervisor hd - m} X

File Edi

127.0.0.1(Demo_Station)  : Station (Demo_Station)  : : ers @ Weekly Schedule Light /' scheduler -

4 PrevPage 4 PrevMonth  Today | NextMonth b NextPage p
© vy Network Ju12017 Aug 2017 Sep 2017

e

tw it f s
b (O Histories ——

s
» [ DeviceInforn 23408 2
» Gl AlsrmsPollF 9

» 6 sBCipNetwork

» @ Bacnetietwork
b @ aoes 25.27 30
b © schematics
+ ) schedulers

b BB weekly_schedule_Light
» B3 calendar_schedule_Light Event Reference: slot:/Schedulers/Calendar_Schedule_Light

4 5 6
1 12 13 18
18 19 20 23

Name Summary Unscheduled

3:00AM

&00AM
b @ Files Switch_Off_due_Test Date:1Sep2017

200AM
b [ Hierarchy -
» @ History 3:00PM

6:00PM

2:00PM

- Palette
EventStart |02:24 EM
W [xX] B @ wtcontrol EventFinish |02:24 BM
s @ Add @ Edit Priority W Priority [I] Rename 3 Delete Event Output [ ] null | true
» O conversion

» O nergy [ Weekly Schedule | [if] specislevents  [] Properties  (©) Summary

» Qhvac

b O stches [ save ) Refresh

9. We need to define that during the Holidays, when the Calendar_Schedule_Light
is high the Weekly_Schedule_Light must be low. For that the complete time range
has to be defined to false.

«®» 53ia PCD

File  Edit ow  Help

127.0.01(Demo_Station) ~ : Station (Demo_Station)  : Config  : ers @ Weekly Schedule Light /' scheduler -

4 PrevPage 4 PrevMonth  Today | NextMonth b NextPage p

) wynetwork Jul 2017 Aug 2017 Sep 2017
F——
b (D Histories

s
W2 a3 2 5 3

» [ DeviceInforn A
6§ 7 8 9 9

smt w it f s

» gALarmsPolLF

» @ sBCipNetwork

b € Bacnethetwork
b @ aces 25.172.129 27 28 29 30
» OSchematir_s
+ © schedulers

b B weekly_Schedule_Light
» B calendar_Schedule_Light Event Reference: slot/Schedulers/Calendar_Schedule_Light

13 14 15 16
20 21 22 23

Name Summary

3:00AM
5:00AM
b Files Switch_Off_due_Test Date: 1Sep2017 a0aM
b [ Hierarchy T2:00BM
» @ History 300PM

6:00PM

EventStart |02:30 EM
W X DB #§ xicontrol EventFinish [02:30 EM
g @® add @ Edit Priority W Priority [T] Rename  3{ Delete Event Output[ ] null | false

- Palette

» O conversion

b O energy [ Weekly Schedule ] specialbvents  [H] Properties (D) Summary

» Qhvac
b O Latches [M] save 7 Refresh
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10.
11.

12.
13.
14.

Connect to 3rd Party Systems

Save the settings

Test the configuration by adding the today to the Calendar_Schedule_Light. This
means create today as Holiday day.

Check that the Weekly _Schedule_Light Out pin goes low.
Remove the test setting from the Calandar_Schedule_Light.

Create reference between the Weekly_Schedule_Light Out pin and the Enable_
Light In16 pin in the same way as it was described above.

As you see the Not and the And Function Boxes are not needed to realize the
same function.

«®r Saia PCD ® Supervisor

®» Saia PCD® Supervisor

File Edit Search Bookmarks  Tools  Window  WireSheet  Help

4 B O-Bon O [ e 2 0

File Edit Search Bookmarks  Tools  Window Wire Sheet  Help

127.0.0.1 (Demo_Station)  © Station (Demo_Station) ~ © Config  : Schedulers

127.0.0.1 (Demo_Station) ~ : Station (Demo_Station)

: Config  : Drivers ! SBCSystems|

~ Nav Wire Sheet
- Nav Wire Sheet
¥ O @ my Network Calendar_Schedule Light  [5) @3
= P Enable_Light
=4 o O &) My Network Eoaemniings @
O Histories n ~ [l _ Ot falsefo @3]
Out false. In10 ~{nuill}
[l Device Information Next Time O 17 1700 Al © alarm Source Info {ine =
NextValue true.
Gl Alarms Poll Frequency B¢ Datapoints Poll Scheduler
 seciphetwork % Points
6 BacnetNetwork © ansloginput_1
Apps @ oigitalinput_
Q) schematics @ oigitalinput_t
Q) schedulers @ vigitalinput_2
B Weekly_Schedule_Light @ oigitalinput_3
B8 Calendar_Schedule_Light A isitalinnut 4
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6.5 Connect to 3rd Party Systems

If you have purchased an OPEN license and want to use values from non-Saia Bur-
gess Controls systems it is necessary to connect to the 3rd-party systems and add the

required points to the Saia PCD® Supervisor database.

6.5.1 Add the Required 3rd Party Drivers
1.

2.
3.

In the Nav tree open the Station folder.

Open the Config folder.

Double click on Drivers. The view pane will show a list of installed Drivers (Driver

Manager).

Click on the New button. The New dialogue box is displayed.

amr Mew

Typeto Add e Bacnet Metwork
NMumberto Add |1 [1-100]

OK | Cancel |

x

In the Type to Add box select the required driver, e.g. ‘BacnetNetwork’.

Click OK. The following dialogue box is displayed.

W MNew

Name Type Enabled

eBacnetNetwork Bacnet Network  true

. Name BacnetNetwork

. Type Bacnet Network
. Enabled .trur:
0K Cancel

X

B

Change the default network Name to be a meaningful name.

Click OK. The Driver Manager will now show the driver.

Name Type

B MiagaraMetwork Miagara Metwaork

) Bacnethetwork  Bacnet Network

Status Enabled Fault Cause
{ok}
{ok}

. You now need to configure the driver
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6.5.2 Configure 3rd Party Drivers

The configuration of each 3rd party driver is different, refer to the Tridium Niagara docu-
mentation for the details of the driver.

6.5.3 Add 3rd Party Points to the Database

The method of adding points to the database for each 3rd party driver is different, refer
to the Tridium Niagara documentation for the details of the driver.

The ability to use values from a BACnet system is quite common and is supported by
Saia PCD® Supervisor. This section provides an overview of how to use the BACnet
driver with Saia PCD® Supervisor. For full details refer to the Tridium Niagara documen-
tation.

6.5.4 Using the BACnet Driver n

6.5.4.1 Configure the BACnet Driver
1. In the Nav tree open the Station folder.
2. Open the Config folder.

3. Double click on Drivers. The view pane will show a list of installed Drivers
(Driver Manager).

4. In the Nav tree open the folder for the already added BACnet driver (BacnetNet-
work) and double click Local Device.

5. Set the Object Id to the Saia PCD® Supervisor address on the BACnet network
(range 1-4194302).

Property Sheet
B Local Device (Local Bacnet Device)
[l status {fault}
[l Fault Cause Invalid Object ID

[l ObjectId device =il
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6. In the Nav tree open the BACnet Comm folder and double click Network and ex-
pand the IP port section also the adapter has to be chosen.

Property Sheet
E Bacnet Comm (Bacnet Stack)
[l comm Control  Enable

[l Registration Lifetime

ﬁ Broadcast Distribution Table
[l Foreign Device Table

@l Bbmd Debug

ﬁ Client Bacnet Client Layer
m Server Bacnet Server Layer
ﬁ Transport Bacnet Transport Layer
[ Network Bacnet Network Layer
[@l Router Table Bacnet Router Table
. Ip Port NetworkPort: id=1 net=1 enabled max=2...
@ Network Number |1
-. Link B/IP [none:0xBACO) Standard
. Adapter Thinkpad USE 3.0 Ethernet Adapter
@ Ip Address none
[l Udp Port 0xBACO
ﬁ Ip Device Type Standard
@l Bbmd Address null

+00000h 15m 003 3
BDT: 0 entries

Foreign Device Table

. false

[ status [fault}
[ Fault Cause
IC- Poll Service

java.lang.IllegalStateException: BACnet/
BacnetMultiPoll

[l Max Devices max

li Enabled . true

@ Portld 1

[l Portinfo Annex J IP
[ Routing Enabled @ true
[l Maintain Routing Enabled @ false
[ Minimum Router Update Time  [s00 ms
[ Router Discovery Timeout 5000 ms
li Termination Time Value 120 s

7. Set the Network Number to 1.
8. Set Enabled to true.
9. Click .

File  Edit

Bookmarks Tools Window  PxEditor Help
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Discover and add BACnet Devices

In the Nav tree, open the Drivers folder and double click the BACnet driver. The view

pane will display the Bacne

1. Click to Discover

The Configure Device

t Device Manager.

Discovery dialogue box is displayed.

127.00.1 (Demo_Station)  © Station [Demo_Station)  : Config

¥ O & My Network

@ My Host: 5743L TJ06GWF2.global.ds.honeywell.com
@ 127.0.0.1 (Demo_Station)
& station (Demo_station)
A Alam
© config
@ services
 orivers
@ niagaraNetwork
© sBC systems
) BacnetNetwork
Ml Local Device
B Bacnetcomm

[l client
[ Server
[ Transport
[l Metwork
[ Router Table
(i 1o Port
3 Monitor
X Tuning Policies
Apps
& Files
Hierarchy
@ History

- Palette
W [X] B | § sbeofflineEngineering

B Ssia PG5 Data Import Wizard

File Edit Search Bookmarks Tools Window Manager Help

. Drivers : BacnetNetwork

Discovered

DeviceMame DevicelD MNetwk MACAddr Vendor Model Objects

@ Configure Device Discovery x

(W Device Discovery Config
[l Device Low Limit o}
[ Device High Limit 4194302

send Globalz | SelectAll |  ClearAll

2 vetworks 0 seni: N I
™

(@i Wait Response Time 10 s

oK Cancel

Database

Mame Exts DevicelD Status MNetwk MACAddr Vendor Model FirmwareRev App SW Version

[ New Folder | [ New ‘ & Edit | §4 Discover M cancel

(@ Tsynch [ A pevicein

If the address range of controllers is known then the Device Low Limit and Device
High Limit can be edited to reduce discovery time.

2. Click OK.

The discovery process starts. A progress bar at the top of the pane indicates the

status of the discovery.

Once the discovery is complete the devices that have been

discovered are displayed in the Discovered list.

@ Job Log

Status Timestamp

o Running 13-Apr-17 11:00 AM CEST
m Message 13-Apr-17 11:00 AM CEST
m Message 13-Apr-17 1100 AM CEST

m Message 13-Apr-17 11:00 AM CEST

Message Details
Finding BACnet Devices...

Who-ls: Local Broadcast All Devices

Found BACnet device (object!d device:1) at address 1:172.23.13.4:47808...

Reading parameters for device:1, 1of 1

ok
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cess so far.

During the discovery process you can click on the > button at the top
right corner to display a Job Log giving details about the discovery pro-

In the Discovered list select the device(s) from which values are required. To
select more than one device hold down the CTRL key and click on the required

devices.

@ Saia PCD® Supervisor

Manager  Help

Search  Bookmarks Tools  Window

File  Edit

127.0.0.1(Demo_Station] ~ : Station(Demo_Station) @ Config @ Drivers  : BacnetNetwork

@/ Bacnet Discover Devices

~ Nav
¥ C

(@ My Host: S243LTJ06GWF2.global.ds.haneywell.com

() My Network Discovered

Device Name

@ 127.0.0.1 (Demo_Station] @ Trainingscenter  devies:l 1

& station (Demo_station)
A alzrm
© config
@ services
 orivers
 NisgaraNetwork
© sae systems
 Bacnethetwork
Bl LocalDevice

Device ID  Metwk MAC Addr
172.23.13.4:04BACO  SBC Saiz Burgess Controls  PCD3.M5560 244

Model Objects

Vendor

The discovery will also find SBC Saia Burgess Controls deivces that have
BACnet compatibility. In order to easily identify these devices sort the list
by Vendor by clicking on the Vendor column.

Click Add or drag the selected device(s) to the Database list.

The Add dialogue box is displayed.

[ Saia PCD® sup

s Window Manager Help

File Edit Search  Bookmarks

@ Bacnet Discover Devices

® My Network Discovered

¥ O
@ MyHost: S243LTJOBEWF2.global.ds.honeywell.com
© 127.00.1 {Demo_Station)

Device Name DevicelD MNebwk MACAddr Vendor

& Triningscenter  devicel 1

Model Objects

17223.13.4:0BAC0  SBC Saia BurgessControls  PCD3.MSS60 244

@ Add

Name Type

(8 Name
e

[ Device ID
[l Netwk
[l MAC Addr
[l Enabled
[ use Cov

& Triingscentert HonBacretevice deviest 1

(gl Max Cov Subscriptions

X

Device D Netwk MACAddr Enabled UseCov Max CovSubscriptions

RBBAOEAO tue  twe  max
r
ice
f
1 [0-65535]
172.23.13.4:0x8ac0
@
@

oK Cancel

Database

Name Exts DevicelD Status Nebwk MACAddr

& Teningscenter @O @O @ devieer B 1

172.22.13.40xBACO

© apps
@ Files
(& Hierarchy

@ History

- Palette
@ [x] B & sbeofflineEngineering

Vendor Model FirmwareRev App SW Version

Ko NewFolder | [ New | & Edit

@Add | b Hatch

4 Discover ‘ M Cancel

B Ssia PGS Data Import Wizard
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Review the settings for each device:

e |f required, change the device name in the Name box.

e |f multiple devices are listed, click on the device in the list (to highlight it) to view
its settings.

Check that the required devices have been added.

Add the required BACnet Points to the Database

This process allows you to add points, alarm configuration, schedules and histories
from previously discovered devices.

1. In the Nav tree, open the Drivers folder and double click the BACnet driver. The n
view pane will display the Bacnet Device Manager.

2. In the Exts column of the Database list double click the required icon.

@ = Points

© = Aam Configuration
= Schedules
© = Histories

The BACnet Point Manager is displayed.

[«® Saia PCD® Supervisor

File Edit Seach Bookmarks Tools Window Manager Help

- Nav

Database

¥ o @ My Network Name Out ObjectlD PropertylD Index Read Write

(@ My Host: SZ43LTJ06GIF2.global.dshoneywell.com
@ 127,001 {pemo_station)
B station (Demo_station)
A aem
© corfig
@ senvices

O nisgaraNetwork
© secsystems.

@ seps
& Files

(& Hierarchy
@ History
- Palette
W [X] B |@§ sbeoffiineEngineering
=X soic PGS Datalmport Wizard
K Newrolder | [ new | #Edit  ffpiscover | M cancel  (Dadd b wmarch B Tagi
B — S—

3. Click Discover
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. The discovery process starts. A progress bar at the top to the pane indicates the

status of the discovery.

Once the discovery is complete, points are displayed in the Discovered list:

Bookmarks Tools Window Manager Help

@ yetwork

0.1(Demo_Station)

@ / sanetdiscoverpoints

Discovered

Object Name ObjectID PropertylD Index Value Description

e o ns. multstatevaluet  presentisiue 1 secmuen sfungot

e ™ AKsas. multstatevslues pres 2 secmuen sfungot

sc___c ™ p— multstatevslue2 presentislue 2 sscwunen srungor

SBC. :TC, +PCD. ABSISBY:HMI multiStateValue:1  presentvalue 3 SBC Murten
— multstatevaluespresentisiue s secmuen
—y oop e 000 secMuren sfungot 02Regler
vE_RLT_PD oopss 10000 sechurten srungor Regler
VE_:PID loop:5 100.00  SBCMurten’ Luftung01 Regler
WT_:PID. loop:4- 15.00 SBC Murten aftung01 (¢ Regler

Ossc e, Lot KH_PID loop:3 000 SBCMurten aftungot

@ssc. c Lot FHRT_PID losp2 2300 SECMurten aftungor

Ossc C Lot ABLD_PID <@ Upating Bacnet Properien x| 000 SECHurten Liftungol

@sse e Lot RLT_PID 000 SBCMurten Gftung0L

Qe ™ p——— m o nsctive. SBCMurten sfungot

@ Qs e ™ T_MOTSHRM_ ;1 Inoctive SBCMurten sftungor

[ cancel
Database
Nome Out ObjectiD Property D Index Read Write

. In the Discovered list select the required points (values). To select more than one

point hold down the CTRL key and click on the required points.

Remember that Saia PCD® Supervisor is licensed for use up to a specific
number of points. It is good practice, therefore, to only add points that are
actually required. Adding points that won’t be used by Saia PCD® Super-
visor will not only waste resources but also generate unnecessary extra
network traffic.

. Click to Add or drag the selected point(s) to the Database pane.
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7. The Add dialogue box is displayed.

Creating Schematics (Operator Views)

Saia PCD® Supervisor automatically chooses the most suitable writable
point type. However, this can be manually changed by selecting a point in
the list and choosing a different Item Type

o Add *
Name Type Enabled Object ID Property I Index Tuning Policy
0 SBC, :TC, PCD AULT__ 1 MumericPoint  true analoglnput:0 PresentValue -1 defaultPolicy

E Name SBC, SHE :BCD,
m Type Humeric Point

m Enabled . true

[ object ID Lnalog Input 0
ﬁ Property ID Present Value

m Index =il

Q Tuning Policy Name Default Bolicy

[l pata Type REAL

[l Read unsubscribed

ﬁ Write readonly

ﬁ Device Facets min=-inf*C,max=80.0 °C,precision=1"C,units="C,re... )) -

[l Facets

ﬁ Conversion

min=-inf *C,max=80.0 °C,precision=1"C,units="C,re... >>

TE Default

OK Cancel

8. Click to OK

9. The selected point(s) is added to the database.

Fle  Edit

Manager

Help

- Nav B 0 sacnetooverroms sueess [
¥ O @ wyNework Discovered 152 0bjects
T R—— Oppctame ObectD  PropatyD index Valie Do .
@ 127001 (0emo_Sttion BOsec____ac____ o asuupm aw O— - om
& saton emo_Station) B 0 zuiu] A% X Buttmotorrehashi Rackmeidung
A o B () sec. e, w01, R0L:Tq chulungsraum Temperatur Sollwertsteller
- o Name Type Enabled ObjectD Property
orf B s o A2 Katteeraum Temp.
> @ services Eumpomt twe  musitevabes Presenty
B s o Schulungsraum Temperatur
- Oones re EumPomt e muliSitetobes presenty
e
[ pr— umpomt e mulisiteolez Presenty
uidnuck
O secsystems umPomt tme  mulisitevouei Presenty
v O cacnathetuork NorerhterRockauttemperatur
sessam EumPomt tme  multisiteteuen Presenty
i Localoevice [y —
Ro0cO2PD Nomercpant e loop presenty
B sscnetcomm
Nomercroint e loops Presenty
» (B Clen ” StaungsraumTemp.
3 Nomercroint e loops preseny
>l sener hussenlfemperstur
» WTensport Nomercpont e loop preseny
Raumtenmpersturbitshuertfo Frie Kahlung
» Dlinetwork Nomercpoint e loop3 ey B =
FahnungstempersturHiteluert
» Euonior FHRT_pID Nomercpoint e loop2 preseny
X Tuning pliies B s
» s AgLD_pD Nomercpont e loopt present
Tl Database RLT_piD Numercpoint  tue  loop) Presenty Oobjects
» © Alam sourceinfo
Name Out ObjectiD PropertylD Index Soclemnpant e a7 presenty e
» @ poins & perty ~
) Boclemnpont twe  biaolueds  presenty
> Qsierme Boolemnpoint e binaolueds  presenty
> © schedvles Boolempoint e binaluess  presenty
» O endioss FOLKLPS_RMA Goolemnpoint e binaweluess  Presenty
> @ conts AULKLPISM RNZ Soolenpoint e binaelue2  presenty
- AULIKLPSH_RUA Ssclemmpoint e bt Presenty
> B
v_su_ Soclemnpant e binaeledd  presenty
» @ tiersrchy
Soclemnpont e binaeluess  presenty
> @wisary
Boclemnpont e biaoluess  presenty
Bookempoint e binaoluesst  presenty
Goolemnpoint e binawolues  presenty
ok | concet
- Palette B2
™ D & bofinctnginesring
» EXseioposstaimportzrd
MaNewrolder | [ Wew | #cdit g viscover | @ Concel Puatch B Tagit

10. Repeat the above process to add points for each controller.
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6.5.4.4 Enable Honeywell BACnet Service

The Honeywell BACnet service must be enabled if you want to use the SBC specific
Add-ons provided by the SBC BACnet Utilities driver. This step must be done before
creating the BACnet network.

Enabling the service includes 2 steps:

1. Adding the service to the Services tree

2. Enabling the service on its Properties Sheet

In SBC NX 4.2.xx.xx.x.x and lower, the service is already added to the Services tree by
default. In SBC NX 4.3.xx.xx.x.x and higher, the service is not available by default and
must be added to the Services tree manually.

n When using a station from a previous project in SBC NX 4.4.xX.xX.X.X,
the Honeywell BACnet Service is available in disabled state as shown in
the Services tree and on the Properties Sheet. If available, the Honeywell

BACnet Service can be enabled/disabled at any time on the Properties
Sheet

6.5.4.41 Procedure to enable Honeywell BACnet Service

1. In the Palette tab at the bottom, select honBACnetUtilities from the drop-down
listbox, then open Services, and then drag&drop the HonBACnetService item to
the Services folder.

| &

|=0 O @ My Network

© config
Seivice
@ BackupService
G CategoryService
O JobService
o RoleService
© userservice
- Palette
W (X B | @ nhonBACnetutilities
O alsrm
O Services

[. HonBacnetService

Result: The Name dialog box displays.

i Name ﬁ‘

HonBacnetServicel

6-110  Manual Saia PCD® Supervisor VV4.14 | Document 27-651 ENG10 | 2025-05



Saia-Burgess Controls AG Creating/Engineering a project

Creating Schematics (Operator Views)

2. Change the name if desired, and then click OK.
Result: The service is added to the Services folder.

e Config
@ services
o AlarmService
@ BackupService
@ CategoryService

WebService
T PlatformSenvices

ﬁ HonBacnetService

3. Double-click the HonBacnetService in the tree.

- Nav [Z] | Property Sheet
L o ©) MyNetwork M HonBacnetService (Hon Bacnet Service)
= = : [ Enabled @ false
L @ TemplateService
© websarvice

Y PlatformServices

[l Running @ ialse
. Fault Cause

[l HonBacnetService

4. On the Property Sheet on the right, select "true’ in the Enabled drop-down listbox.

Property Sheet

[ @ HonBacnetService (Hon Bacnet Service)
M Enabled @ true
M Running @ fals=

. Fault Cause

5. Click the Save button at the bottom.

Result: The service will be started indicated by "true” setting in the Running drop-
down listbox.

Property Sheet

(Ml HonBacnetService (Hon Bacnet Service)
(@l Enabled @ tne
-.. Running . true
(@ Fault Cause

6. Continue by creating the BACnet network.

6.5.4.4.2 Procedure to change the user access of Hon Data Point View Read Only Users
for Honeywell BACnet Service

1. Double-click the HonBacnetService in the tree.

2. On the Property Sheet on the right, expand the Hon Data Point View Read Only
Users property.
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* Nav

t O [x] |® MyNetwork

° LogHistoryService

@ ProgramService

O SearchService

° TagDictionaryService
TemplateService

@ webservice

@ BatchJobService

E PointListViewService

¥ SignalService

E EasyDatabaseManagerService
[l EasyHealthyBuildingService
CarelmportWizardService
[l HonBacnetService

Y PlatformServices

v ¥ Vv VYV VY VYT VYT VYT VTV VT VT wTY

[x] / vice g Platf €03 services/Rol [ HonB: vice
Property Sheet
:i HonBacnetService (Hon Bacnet Service)

[ Enabled @ true

[l Running @ true

[—. Fault Cause

~ [ Hon Data Point View Read Only Users  Hon Bacnet User

Tl All @ false
(M admin @ true
[l BACnet @ folse
(M AHUOperator | false
(@ John @ false
[ Alexa @ false

[l Send1Am Telegram Frequency

+00000h 10m 00s|4

Result: The list of all assigned users name list along with default (All, admin, and
BACnet) user names displays.

3. Select True (to disable access) or False (to enable access) in order to change the
user access of Hon Data Point View.

~ Nav

tH O [x] | MyNetwork

» X TuningPolicies
~ g Galileo_CI_Automation

» @ Alamsourceinfo

« € roints

b 0 E1cse2 B2 AL

» @Ecsa2 B2 42
» @ e1csea2 2. 801
» D Ecsa2 B2 a02
» Qeicse e
» O r1Lcse2 2 82
» O r1cse2 g2 o1
» O e cse p2 802
» E1_CS42_E2_MSi1
» E1_CS42_E2_MSI2
» E1_CS42_E2_MSO1

Q i & Platform [x] ™
Property Sheet
ﬁi HonBacnetService (Hon Bacnet Service)
[ Enabled @ true
[ Running @ true

f—. Fault Cause

+ [l Hon Data Point View Read Only Users  Hon Bacnet User

[ All @ folse
(@ admin @ true
[ BACnet :fa\w
:i AHUOperator g o=
(@ John @ folse
[ Alexa @ folse

(M Send | Am Telegram Frequency +00000h 10m 008/

Result: As per the selection, users will see the parameters from Hon Data Point
View page and their parameters in editable or non-editable view.

Editable

Non-Editable

€3 services/Rol ‘m €3 services/t & Platform

Alarming I | Other Properties

Point Name: E1_CS42_E2 All

—Off-Normal Conditions

High Limit 150

Low Limit -150

Dead Band ¥

Suppress Alarm

Alarm Delay 10 [}

Limit Enable ¥ High Limit Enable ¥ Low Limit Enable

Description: Input point

Controller:  Galileo_CI_Automation

€ ser (g Ho

status: @ Ok

Point Type: Analog Input

—Present Value:

% 89.04 %

Status:
* Auto Manual |/ inAlarm * fault

o Alarming l | Other Properties |

—Off-Normal Conditions

r—Intrinsic Reporting
Notification Class |
Notify Type Alarm

Transitions:

i High Limit 150 |y
Low Limit -150
Dead Band 1

Suppress Alarm

Alarm Delay 10

Limit Enable # High Limit Enable ¥ Low Limit Enable

%
%
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6.6.1

6.6.1.1

Creating Schematics (Operator Views)

Creating Schematics (Operator Views)

Schematics within Saia PCD® Supervisor are known as Operator Views
(Presentation XML -- Px).

This section describes how to create the most commonly required features of Operator
Views. For more in depth information please refer to the Tridium documentation.

It is recommended that you create a template page that contains features that are
needed on each page, e.g. a logo, outside temperature, navigation buttons, etc. It is
also recommended that you create a folder to store all the Operator Views, and another
folder to store any images used on the pages.

The following steps are required to create Operator Views:

Prepare the folder structures

Preparing a good folder structure for the used Images and Operator views will help
keeping the project clear and understable. The engineering work will be faster because
used elements can be easily found.

Create a Folder for the Operator Views

Operator Views can be created at any point within Saia PCD® Supervisor e.g. added to
a folder, device or a module. However, this can make engineering unnecessarily com-
plicated so it is recommend that a folder is created to contain them.

1. In the Nav tree open localhost > Station.

2. Right click Config and select New> Folder. The Name dialogue box is displayed.

- Nav px
P o () My Network Name- Type
@ My Host: 57431 TID6GWF2.global.ds.honeywell.com
@ 127.0.0.1 (Demo_Station)
3 Station [Demo_Station)
A Alarm
e Config
@ services
© orivers <> Name x
6 NiagaraMNetwaork ® Schematicsl
© sBcsystems
O sacipnetwork_Demo oK Cancel
6 Bacnethietwork
€ secipNetwark
Apps
A Files
Hierarchy
@ History

Specify the folders’s name e.g. ‘Schematics’.

3. Click to OK.
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6.6.1.2

6.6.1.3

6.6.1.4

Create a Folder for the Images

1. In the Nav tree open 127.0.0.1(localhost)>Station(Demo_Station).

2. Right click Files and select New> Folder. The Name dialogue box is displayed.

-.
* Nav

h@ O @ My Network

@ My Host: SZ43LTJ0GGWF2.global.ds.honeywell.com
@ 127.0.0.1 [Demo_Station)
3 Station (Demo_Station)
.‘ Alarm
e Config
@ Services
6 Drivers
e NiagaraNetwork
© sBCsystems
e SBClpNetwork_Demo
e BacnetMetwork
 secipNetwork
Apps
O Schematics
B Files
@ Hierarchy

Wi

. @ Name for New Folder
@ History

@ Images

oK Cancel

3. Specify the folders’s name e.g. ‘Images’.

4. Click to OK.

Prepare Images

Any external images that are to be used on Operator Views must be created using a
3rd party graphics package and sized to the size required on the Operator Views.

Once the images have been added to Saia PCD® Supervisor they cannot be
changed. SVG (Scaled Vector Graphics) images can be used and scaled inside in the

Saia PCD® Supervisor.

Add Images to Saia PCD® Supervisor

To use images within Saia PCD® Supervisor they must exist within the file structure of

Saia PCD® Supervisor.

1. In the Nav tree open My Host > My File System and navigate to the file that is to
be added (this could be a folder containing multiple graphics).

2. Right click the file or folder and select Copy.

3. In the Nav tree open My Host > Station(Saia PCD Supervisor) > Files and navi-

gate to the location the image(s) are to be stored

4. Right click the location (e.g. images) and select Paste.

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05



Saia-Burgess Controls AG Creating/Engineering a project

Creating Schematics (Operator Views)

6.6.1.5 Customize the basic PX Template Page

Operator Views are created using the template PX Page (located - My Host > Sys
Home > defaults > workbench > newfiles > PxFile.px). By editing this page all future
Operator Views created will have this format.

1. In the Nav tree open My Host > My File System > Sys Home > defaults > work-
bench > newfiles.

2. Double click the PxFile.px file.

3. On the menu bar click the # icon to switch to PX Editor view.

File Edit Search Bookmarks Tools Window  PxEditor  Help

My Host: SZ4SLTIOBGNF2 globldshoneywellcom  © MyFileSystem @ SysHome @ defaults  © workbench  © newfiks @ Pfilepx
¥ C ) wy Network
@ iy File System
1 sysHome -
O usertome ® Properties X
Oc CanvasPane ‘ R
- £ Canvaspane
O background [ ] cefaut)
gz halign Center Width 200 [o‘oo-lmoom]i
oMmemH layer Height |600] [0.00- 10000.00]
! Flatform scale None ok | cancel
@ 127.0.0.1 (Demo_Station) walign Center
B station (Demo_Station) viewsize  |500.0,4000 E
A jiam visble  [tue
© config
@ seriees _ok | st
6 orivers T
6 NisgaraNetwork
Q sBCsystems
6 sBCipNetwork Demo
6 Bacnethietwork
6 saciphetwork
Aum
© schematics
B ries
Q resources
() saia_PCD_Supenvisor_Sbus Demo_HC
Q offline
I

n The grid in the middle of the screen is the viewable area of the page.

4. Design the page layout as required.

5. Save the file (select File> Save, or press CTRL+S).
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6.6.2 Create a PX Page

Operator Views are created by making a new view of an element in the Nav tree and
once a PX view is added it is the new default view of the element.

Operator Views are stored in the Saia PCD® Supervisor file structure, but are linked to
the element where the view has been attached.
To keep structure simple it is a good idea to create subfolders. These subfolders hold
the various schematics you want to create.
1. In the Nav tree open 127.0.0.1(localhost) > Station > Config and navigate to
where the PX Page is to be located

2. Right click the folder and select New > Folder. The Name dialogue box is dis-

n played.
3. §pecify the page’s name e.g. ‘HeatingCircuit1’.
- Nav

E@ '] @ My Metwark

@ My Host: SZ43LTJ06GWF2.global.ds.honeywell.com
& My File System
0 My Modules
& Platform
@ 127.0.0.1 {Demo_station)
’ Station (Demao_Station)
! Alarm
e Config
@ Services
e Drivers
Apps
0 Schematics
© HestingCircutil
Q Files
© imoges ®» Mame X

Oofﬂine ® HesatingCircuitl

O e

o ok | _cancet |
ES0UICES

° Saia_PCD_Supervisor_Sbus_Demao_HC
4. Click OK A folder is created.

5. Right click the folder you have just created and select Views > New View.
The New Px View dialogue box is displayed.

- Nav 1 slotSheet

Enter the name of the page (same as the folder just created) in the View Name
box.
6. Click OK The PX Page will be created based on the template page.
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6.6.3.1

6.6.3.2
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Edit a PX Page
The PX Editor is used to edit a PX Page.
1. In the Nav tree locate the PX file and double click on it.
2. On the menu bar click the # icon to switch to PX Editor view.
3. Change the page layout as required
4. Save the file (select File> Save, or press CTRL+S).

Create or Change PX Page Elements

After creating a new PX Page or opening an existing page for editing use the following
procedures to design the page layout and content.

Setting the Page Size and Background
To set the viewable area size:

1. Double click the layout grid to open the Properties dialogue box.
2. Click viewSize to set the visible screen size in pixels (maximum 10000 x 10000).

3. Click OK.

To set the background colour:

1. Double click the layout grid to open the Properties dialogue box.

2. Click the background as required and select either Solid or Gradient and use the
colour picker to set the required colour(s).

3. Click OK.

To set the background image:

1. Double click the layout grid to open the Properties dialogue box.
2. Click the background as required and select Image.
3. Select the required image file and alignment settings.

4. Click OK.
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6.6.3.3 Add Text
1. Right click the page and select New > Label. A label is added to the page.

2. Double click the label. The Properties dialogue box is displayed.

“®» Properties X
Label u. ‘%1 H!
% Label

background l:l #ffffcd

blink false

enabled true

font (default)
foreground l:l (default)

halign Center

image null
layer

layout 300.0,20.0,130.0,30.0
s

textlconGap 4.00

textTolconAlig Right
valizn Center
visible frue

wordWrapEna false

OK Cancel

3. Enter the required text in the text box.

4. Click OK.

6.6.3.4 Add an Image

Add your own image

Images are sized on the screen based on their native dimensions (pixel size) - you can-
not scale the image. Therefore, you may need to resize the image using your preferred
graphics editor before adding to the page.

1. Navigate to the required image using the Nav tree.

2. Click and drag the file to the layout grid and position as required.

It is recommended that any images you intend using in Saia PCD® Su-
pervisor are first copied into a folder within the Station.

As you drag the item on the page two green lines indicate the top left
corner where the item will be positioned.
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Add an Saia PCD® Supervisor Image

Saia PCD® Supervisor has some built in images that can be added to a PX Page.
Open the palette containing the required graphics. The following palettes contains use-
ful images, but there are others available

kitPx Covers elements like — logoff, buttons, PxInclude, line, rectangle
etc

kitPxHvac s a library of various hardware graphics — pumps, boilers etc

kitPxN4svg is similar to kitPx but all the graphics are SVG
(scalable vector graphics)

1. Navigate to the required image using the palette.

2. Click and drag the image to the layout grid and position as required. n

6.6.3.5 Add a Dynamic Object (Value)

1. Navigate to the required value using the Nav tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.

4. Select Bound Label.

«®> Make Widget >

" Make Widget
Make a new widget that is bound to the ord.

station:|slot:/Drivers/SBC520Systems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Outside/Temperature/Physval

& Bound Label BoundLabel o g 3!
<> Include PxFile 2 Bound Label

<> From Palette background [ (defautt)

<> Workbench View — false

<> Properties
&> Actions
&> TimePlot

border 0.0 none black
enabled true

font (default)

[# Format Text |2out.Value$ foreground [ (defauly)
[ Status None halign Center

[ Hyperlink imosge null

] Mouse Over |None \ayer

[ sorder 0.0 none black mouseOver |None

[#] Make Display Mame Label padding 0.0

AinpEnREnE

text <ord>

texticonGap | %- 00

textToleanalig Right
valign Center
visible true

wordWrapEnal false

% Bound Label Binding
ord <ord>

degradeBehay MNone

hyperlink null
mmmmm . adisplayName?typeDisplayNz
popupEnable frue

statusEffect |None

oK Cancel

5. Select Format Text and choose %out.value% to display the value.
6. Select Make Display Name Label to display the label.
7. Click OK.
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6.6.3.6 Add an Animated Image

Saia PCD® Supervisor has some built in images that can be animated depending on
value from the system.

1. Navigate to the value that is to be linked to the image using the Nav tree.

2. Click and drag the value to the layout grid and position as required.

3. When you release the mouse button the Make Widget dialogue box is displayed.
4

. Select From Palette.

80000000

z
HI

. Open the palette containing the required graphics
. Navigate to the required image using the palette.
. Select the required image.

. Click OK.

0 N O O
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6.6.3.7 Add a Setpoint Slider
A slider can be added to enable an analogue value to be adjusted.
1. Navigate to the value that is to be linked to the slider using the Nav tree.
2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.
4

. Select From Palette.

@ Make Widget X

File Edit Search Bookmarks Tools Window PxEditor  Help

'\ Make Widget
Make a new widget that is bound to the ord.

<
’ o - ) ) - . station:|slot:/Drivers/SBCS20Systems/SBCIpNetwork_Demo/Deviee Lipoints/ 1/Room/ : Offset
127.0.01 (Demo_Station)  : Station (Demo_Station)  : Config  : Schematics  :
= <> Bound Label Slider o 2 5
- < Include PxFile 2 Slider
K o (D My Network @ FromPalette enabled true
5 . .
= < Workbench View increment 1.0
) RIID & Properties
H Hesting! layer
£ Actions
0 o 100.00
< TimePlot
EH opMode min 0.00
H outside w X B § ke orientation | Horizontal
A Return
3 suppl (B eoundiabel thumbBrush [ (default
upply
o ActionButton trackBrush |<0rd>
oom
B8 remperature HyperlinkButton value [s0.00
[®) saveButton visible true

© Basesetpoint
() setpointoffset

(s ]

O RefreshButton
2 2 setPoint Binding
= ExportButton

E e 7 ord <ord>
BackButton
@ Alarms. degradeBeha, None
© Histories P ForwardButton
‘ M@ Logoffautton hyperlink | null
e RebootButtan summary  %displayName?typeDisplayNe J
Qll Data Poll Frequency :
ButtonG EnablestTue
© pseudo_Points [ uttoncroup popupEnables
6 Bacnetietwark @ snaloghieter widgetEvent  actionPerformed
@ secipnetwork 11 sargresh widgetProper value
@ hops = setPointslider
© schemat setPointTogeleButton
ematics
O HeatingCircuts SetPointCheckBox
£ i1
@ Properties %
Slider | o (5o
2 Slider
Physval 5.4 enabled true
increment  |9-50
layer
layout 20.0,260.0,20.0,150.0
max 3.00
min -3.00
orientation  |Vertical
thumbBrush 1] (default
trackBrush | station:slot:/Drivers/SB IpNetwork_Demo/Devicel/points/Hi
value 0.00
visible true
% setPointBinding x
ord station:|slot:/Drivers/SBC IpMetwark_Dx D¢ 1/points/He
0.0
degradeBehay None
hyperink  |null
summary 95displayName?typeDisplayNamed =%.%
popupEnable| e
widgetEvent |ectionPerformed
widgetProper{ Value
oK Cancel

5. Open the KitPx palette
6. Select SetPointSlider.
7. Click OK.
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6.6.3.8 Add a Button to Adjust a Value
1. Navigate to the value that is to be adjusted using the Nav tree.

2. Click and drag the value to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.
4

. Select Actions.

| <> Make Widget

P Mo widger
st i et e )

IpNetwork 1 /RoomT:

Actions

O cocnethictmork
© secipnetwork

ok Cancel

5. Select Set.
6. Click OK.
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6.6.3.9 Add a Link to Another Page
1. Navigate to the PX Page that is to be linked to using the Nav tree.

2. Click and drag the PX Page to the layout grid and position as required.
3. When you release the mouse button the Make Widget dialogue box is displayed.

4. Select From Palette.

< [ =R I e/ 0 =- @ B ¥ @ B X N a2 ¢ 0- Thaaanx g en

el omsacnain

|| oefautview -
=t L oA

- Widget Trd n
c .

ok | cancet

<@ File Chooser x

DFileSpaces (2 _
m

R Bookmarks [
o
o

stes
18-4pr-17 10:38 AM CEST

Fllename:  Hoze.px Open
Cancel

Flesoftype: AllFiles )

ok | cancel

Open the KitPx palette.
Select HyperlinkButton.
Select the Hyperlink check box.

Enter the required text in the text box.

© ® N o o

Click OK.

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05 6-123



Creating/Engineering a project

Saia-Burgess Controls AG

Creating Schematics (Operator Views)

6.6.3.10

2
3.
4

Add a Graph

1. Navigate to the required history using the Nav tree.

. Click and drag the history to the layout grid and position as required.

When you release the mouse button the Make Widget dialogue box is displayed.

. Select From Palette.

127.0.0.1 (Demo_station)  : Station (Demo_station) © Config
o () My Network
O niagaranetwork
Q secsystems
 secipietwork_bemo
X TuningPolicies
@ Devicel
© 4larm Source Info
¢ Poll scheduler
& Points
@ Alarms
© Aalerm.myalarmListMyName
@ nistories
& Logfile
(i pevice Information
Qll Data Poll Frequency
© Pseudo_Points
6 BacnetNetwork
@ Apps
© schematics
© HeatingCircuitt
& Files
(& Hierarchy
& History
- Palette
X 3§ ke
[A) BoundLabel
ActionButton
HyperlinkButton
™ savegutton
Z Refreshutton
[3 Exportutton
4 BackButton
P ForwardButton

: Schematics

© HeatingCircuitl

[ wbViewBinding
@ circulsrGauge

[ Hyperlink

@ Make Widget x
'\ Make Widget
Make 3 newwidget thatis bound to the ord.
station:[slot:/Drivers/SBCS20Systems/SBCIpNetwork_Demo/Devicel/histories/Logfile
<> Bound Label WebWidget " 2 8
<> Include PxFile 2 Web Widget
& From Pslette enabled true
< Workbench View s viewwebChart:ChartWidget
<> Properties
layer
& Actions
visible true
W X B | # webchart 2 whViewBinding
<ord>
@ chart erd

oK Cancel

degradeBehay Mone

5. Open the webChart palette

6.
7.

Select Chart.
Click OK.
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6.6.4 Reuse Operator Views
Operator Views can be reused, saving significant engineering time.
Normally Operator Views are created by using a new view attached to a folder in a
centralised structure. However, as each PX Page is created in the file system in the ‘px’

folder, it is possible for a page to be reused by copying the file in the px folder and at-
taching it to the required folder.

1. Create a PX Page as required - see chapter 6.6.2 Create a PX Page

. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Files > px.

2
3. Right click the PX Page that is to be reused and select Copy.
4

. Right click px and select Paste. The Name dialogue box is displayed. n
127.0.0.1 [Demo_Station) . Station (Demo_Station) : Files Lopx
- Nav
E@ o @MyNetwork

D Pseudo_Points
e BacnetNetwork
@ apps
0 Schematics
O HeatingCircuit,
OHa
Qe
@ Files
0 Images
Q offline
Q px

Hoge
Q resourcs  Copy
Q saia_rcj
Hi h:
(& ierarchy Duplicate
@ Histary
— Delete

- Palette Rename

I~ BEICIE WES Refresh Tree Node

Go Into

@ HistoryService

@ Name X

@ ==

0K Cancel

5. Enter a name for the pasted PX Page.
6. Click to OK. The PX Page will be added.

7. In the Nav tree open 127.0.0.1 (localhost) > Station(Demo_Station) > Config
and navigate to where the new PX Page is to be located.
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8. Right click the folder and select New> Folder.
The Name dialogue box is displayed.

. Station (Demo_Station) : Config . Schematics

127.0.0.1 (Demo_Station)

) My Network

o Pseudo_Points
e BacnetMetwork

| cditTags lconFolder
1 TextBlock
Make Template
BooleanWritable
cut NumericWritable
Copy

EnumWritable

Paste

Paste Special

& Name *

@ Jslosr]|
OK Cancel

9. Specify the folder’s name e.g. ‘HC2'.
10. Click OK A folder is created.

11. Right click the folder you have just created and select Views > New View.

The New Px View dialogue box is displayed.

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config

- Nav
E@ o @ My Network
D Pseudo_Points
6 BacnetNetwork
ADDS
D Schematics
© HeatingCircuit1
QHa
O Hea
@ Files ire Sheet
© images AX Property Sheet
Q offline [T roperty Sheet
O e :
] Edit Tags
Bh \ake Templat telation S
UEL plate Relation Sheet
(7]
&) 1 Cut New View
Copy
O resoun By Guide Help
DSaia_P Paste )
Bajadoc Help
[E) Hierarchy [ Special
o~ Spy Local
Duplicate
- Palette plica Spy Remote
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> Mew Px View b4

m New Px View
Create a new view on the component using a px file

View Name HC2

View lcon module://icona/xlé6/views,/view.png [

TargetMedia < Workbench PxMedia

Source & PxFile [~}
<> DynamicView
0K | Cancel |
12. Enter the name of the page created above in the View Name box. n

13. Click OK The File already exists dialogue box is displayed.

™ File already exists. x

File already exists.

A Reuse existing file unmodified.

Owverwrite existing file contents.

Reuse | Overwrite Cancel

14. Click Reuse.

15. Edit the page as required.
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6.6.5 Easy Templating Simple Objects
6.6.5.1 Create simple objects

1. Using the standard PxEditor, design a PxPage using graphics, labels or any com-
ponent you would usually use to design the page. Manually bind any points so the
graphics are a live representation of the object.

Bulb Simple Object

Demand Aus{faultstalel @ def

2. Using the Tools > Easy Templating Simple Object Creator, select the PxPage cre-
ated in step 1, and generate the Simple Object. The new object will appear in the
Easy Templating Sidebar when created — any errors will be shown in a toast popup.

Window  PxEditor  Help % Fac Termmlating - Srmmle
Alarm Portal Click folder icon to browse Px files:

Selected file: local:|foxs:[file:*Demo/Bulb.px

Easy Templating Simple Object Creator Lo ‘ Cancel

Easy Templating
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6.6.5.2 Using generated Simple Objects

1. On a new PxPage, drag one of the Simple Objects from the Easy Templating Side-
bar onto the page.

B

- Properties

Bulb Simple Object paneisce | &

2 Pxincude

Feedback
enabled true

layer

layaut 550.0,430.0,400.0,300.0

e local: file:~etsoFiles/Bulb/Bulb.etso

Lk

variables Control=

wvisible true

2 Easy Templating Binding
data CLICK_HERE_TO_CHOOSE_BINDING

1

2. Using either the Properties Sidebar, or the Properties Popup (double click), there
will be a Easy Templating Binding on the Simple Object with a property reading
“CLICK_HERE_TO_CHOOSE_BINDING”. Clicking this will bring up matching loca-
tion which meet all the points used in the Simple Object.

4 Ih e

| Please select location to bind Simple Object to...
| |]station: |slot: /MotorTemplateDeploy
: station:|slot:/ImportedPoints/System3

| station:|slot:/ TemplateDemo

station:|slot:/MotorTemplateDeploy

3. Once a selection has been made, the resources needed for the Simple Object will
be copied over the from the Simple Object directory, into the running station. The
variable will then be set, linking the graphic to the chosen location.

|2| Pxinclude [station:|slot:/]

Motor... - propertes
Princlude | J 91 =L
% pPxinclude
> enabled true

1 Runtime i) layer

FbSignal J
Signal ord local:|foxs:[file:“etsoFiles/Motor/Motor.etso J
variables Control=station:|slot:/Imported Points/System3 J
wisible
% Easy Templating Binding X
dats CLICK_HERE_TO_CHOOSE_BINDING J

4. If at any time you want to change where the Simple Object is bound to, repeat step
2 above and the variables location will be updated.
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6.6.6 Reuse a Generic PX Page

Saia PCD controllers often have the same control program and the associated Opera-
tor Views are identical, but reference data from different controllers. Or it is also possi-
ble that one controller has the same control program multiple times for multiple equip-
ment.

To reduce engineering time a PX Page with generic references to data in the controller
can be re-used for multiple controllers by attaching it to the required controllers (points)
in the Nav tree. In order to do this every reference from the PX page to the controller
(points) must be made generic, and the PX Page must be associated with the controller
or points folder.

Create generic PX page and make the ORDs relative:

1. Create a PX Page as required - see chapter 6.6.2 Create a PX Page.

2. Open the Bound Ords pane.

3. Double click on the first ord that references a value in the controller. The Edit ord
dialogue box is displayed.

AM» ool

atation: |slot:/Drivers/SBCS205ystems/SBCIpNetwork_Demo/Devici [ —  (Defaultview) - |

» -
OK Cancel :

Original ORD in the Editfield:
"station:|slot:/Drivers/SBC$20Systems/SBClpNetwork_Demo/Device1/points/Heat-
ing1/Outside/Temperature/PhysVal"

4. Edit the ORD to make it generic by removing references to the site, LAN, and con-
troller. For example

1 Untitled - Notepad - O x

File Edit Format VYiew Help
station: |slot: /Drivers/SBC$28Systems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Outside/Temperature/PhysVal

o grd W
slot:butaside/Temperature/Phyaval B - (DefaultView) ~
> 0O-
OK Cancel
5. Click OK.

6. Press CTRL+S to save the page.
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Using Text Editor to make the ORDs relative

Text Editor can be used if more ORD has to be modified or the Relativize command
can be used.

1. Right mouse click to the page in the px folder to relativize
2. Select Views » Text Editor

3. The content of the px file is shown in XML format.

[ Saia PCD® Supervisor — g X
File Edt Seach Gookmarks Tools W
127001 (0emo_Stston)  © Stston Demo_Sstion) ¢ Flles ¢ pe ¢ HC_generic 7 teatior -
¥ O E (@unewor
» @ secnenietwork
-
v O schematis
> O Hestingcruis
» Qe 5
° 14+  <CanvasPane name="content" viewsize="800.0,600.0">
» Ona k
© O 26 cPicture Layout-"270.0,265.0,165.0,150.0" inage="File: Inages/SBC_svp_11es/GES002_6 M. Vg scale="Fit"/>
b
> O mages 1 Chicture Lavout"360.0,130.0,150.0,60.0" irsge-"File: Inages/SOC_sve_Files/GE001_6 M. sve" scale
1
» Qoffine 20 cricture Lavout290.0,395.0,250.0,150.0" rsge-"File: Inages/SOC_sve_Files/GEI002_3 W, sve" seale
o (B =
OFEJ 22 <hicture layout-"180.0,440.0,250.0,150. "¢ Images/SOC_sve_Files/GE9002_6 M. 5vg" scale-"Fit"/>
HCLpx 23
36 <oicture loyout-150.0,235.6,150.0,230.4 -nfile:~Tmages/SBC_Sve_Fi1es/GEOO1_1 M. SVE" Scale-"Fit/>
3 HestingCruitox e
B emens % .0,20.0,130.0,3%. ating Circuit * beckground="sFFFFce"/>
-
Bz 3 50.0,100.0,20.
3
(B He_genericax 30+ 30.0,100.0,100.0,20.0%>
) O reoures as Sristation: noners
2 ObjectTostring name-"Sext" formate Hout Valuek-/>
» O ssi_pep_supenisor_sbus_Demo_HC 5 </oounaLstertinine
3 snoumlanens
» [ Hierarchy =
36+ <Shder 1y0ut-"750.0,240.0,20.0,150.0° min="-3.0" px-"3.0% increment="0.5" value="3,0" orientstion-"yertical®s
~ Palette B 7. ords* i “TpNetwork 0 i widgetEvent= y="value™>
E CIStatusTonruzn namecrackirusn® />
3 </setreintinaing
X D # ey r Gishonotation nase-wshnnotation” value-"Sé,54,8"/>
a4 st
> @ ristonsenice 2
B30 CInsgeButton leyout="6%.0,100.0,100.0,20.0° text="Set™>
» © AuditistoryService: a "station: |slot:/oré Iohetuork T s int/set” widgetEvent=" >
» O Lopistonysenice ol | Simmitton>
» O ristonpoiniat 57 Cclabel layout-"630.0,60.0,100.0,20.0" texteBaseSetpoint®/>
@
» & Historypointistitem 49 <BoundLebel layout-"630.0,80.0,100.0,20.
v O bammions s0- e avel o [stots/or se— ; inte statusterect-mnone®>
a “onjectiostrin ormate out NeLuek/>
> O Numerinimcal 2 </BounaLabe1sinaings
S il
> 2 tumercow 2
» 3 sootesnintenat 5. <Imageutton Layout="10.0,560.0,100.0,30.0° text-"Hone">
] elussinaing yerlinc.-iiei pejHone.px
» 3 ockeancor E Waammotation nane-"wsATnotation valse-o
= T $ memsiition
» 3 mumcov 8 <Picture layout="290.0,155.0,140.0,100.0" inage="File: Tnages/SBC_svE_Files/ACSO00S.51E"
&
» O sl B2 clabel layout-"640.0,290.0,100.0,20.6" text-"SetpointOfsset />
&
> 3 sumgcon G- coowdLaber 1o 200 >
» @ vty Group G- Soundabel ation: Is16t5/05 so— 3 ; statusEstect-"none>
5 OnjectTostring name-"text- format- Aaut. Veluek"/>
» Y Hisory NavShortuts @ </BounaLabe1sinsings
B csoumdmels
o

webEd tors-TextFlcEdtorttheme=

<> Saia PCD'® Supervisor

File Edit Search  Bookm Tools  Window TextEditor

127.0.0.1 (Demo_Station) ! Station (Demo_Station)
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5.

fill up the Find edit filed and the Replace with edit field.

000000

<Slider layout="75@.8,248.8,28.8,158.8" min="-3.8" max="3.8" increment="8.5" value="3.8" orientation="vertical
37~ <SetPointBinding ord="slot:/Drivers/SBC§285ystems/SBCIpNetwork_Demo/Devicel/points/Heatingl/Room/Temperature,
<IStatusToBrush name="trackBrush®/>

ReplaceAll

Associate a PX Page with a controller:

1.

o a &~ »

Right click the PX Page that is to be reused and select Copy.

Right click the px folder in the Nav tree and select Paste. The Name dialogue box
is displayed.

Enter a name for the PX Page (e.g. HC_generic).
Click OK.
In the Nav tree navigate to the controller that the page is to be associated.

Right click the controller and select Views > New View. The New Px View dia-
logue box is displayed.

o New Px View x

m New Px View
Create a new view on the component using a pxfile

View Name

View lcon module://icons/x16/views/view.png ]

Target Media  <#» Workbench PxMedia

@ PxFile file:~pu/HC generic.px -
Source
&> DynamicView
0K Cancel
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7. Enter the name of the page created above in the View Name box.

8. Click OK

The

File already exists dialogue box is displayed.

™ File already exists.

Reuse | Overwrite

File already exists.
A Reuse existing file unmodified.

Owverwrite existing file contents.

X

Cancel

File Edit Search Bookmarks

<4 B O- o n

¥ o © by Network

© s systems

© auditHistoryservice
© LogHistoryservice
O HistorypointList
O HistoryPointlistitem

© Extensions

3 strngintenval
P strngeov

Tools

< o - B % © B X a ¢ 0- Thaaarx <68

<@ Properties X
BoundLabel | . BRI
2 Bound Label
badkground [_] (default
B¢ pollscheduler i ol
@ roints border 0.0none black ]
[::] :;mgn enabled [trUe
Ack
B3 oprode (T e fort facreuts ol
3 outside foreground ] (defouty
B Tempersture halign Center
A Retum A mege null ]|
I supply layer
3 Room izt o 1300,1000,100.020.0 ]
000
B web 77777 ) mouse Over |None
@ atarms Physval
i 7 - slotOutside Temperature/PhysVol C]
- Palette texticoncap |4-00
WX D | sy textTolconAlig RIEN
i Center
@ Historyservice
visible [true

indow  PxEditor  Help

: SBCIpNetwork_Demo

:Devicel  : Points  : Heatingl

wordWrapEna 215

2 BoundLabel Binding
4 on slotOutside/Temperature/Physval

degradeBehayNone

hyperlink | null

el

7| summary | %displayName?ty peDisplayNamed=%.%
| popupEnableytrue

statuskffect |NOne:

oK Cancel

9. Click Reuse

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05

6-133



Creating/Engineering a project

Saia-Burgess Controls AG

Set Up Saia PCD® Supervisor Users

6.6.7 New Px / responsiv elements

B Menu bar automatically jumps to
another position

—)
f

#

B "Station" and "Hierachy" fold-
ers are no longer included in the

browser nav tree

. Glatian

A Home

A Histories

(&) iy
E Managers
E Properties
& ron
(=) soH

ﬂ Home
A Histories
E] Managers

E] Properties

&) FoH
[E) eoH

B New "Flow Pane" offers the pos-
sibility to define the number of
columns and the pagination by
yourself

6.6.8 Dashboards

"
M

|
3333

A Dashboard is an element on a PX Page which each user can customise to their re-

quirements.

To use dashboards the Dashboard palette needs to be opened and the Dashboard
Service needs to be added to the Services section of Saia PCD® Supervisor.

Dashboard panes are added to the PX view like any other Graphic, but it requires

some extra configuration.
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6.6.8.1 Add the Dashboard Service

1. In the Nav tree open 127.0.0.1(localhost)>Stataion(Demo_Station) > Config >
Services.

2. Open the Dashboard palette and drag DashboardService onto Services. The
Name dialogue box is displayed.

127.0.0.1 (Demo_Station) . Station (Demo_Station) . Config . Drivers

- Nav

be O @ My Network

’ Station (Demo_Station)
‘. Alarm

@ Config

@ Services
o AlarmService
@ BackupService
@ CategoryService

@ JobService

m RoleService

O UserService

0 AuthenticationService

£|’ DebugService

@ BoxService

v FoxSery| <#» Name o

@ Hierard

@ DashboardService
@ History:
© auditHi T —

© LozHisthrymermes
@ Programservice
0 SearchService

° TagDictionaryService
TemplateService
; @ WebService

- Palette
[} @ E .dashboard

{ ] DashboardService
. DashboardPane

3. Click OK.
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6.6.8.2 Add a Dashboard to a PX Page
1. Create the PX Page as required.

2. Open the Dashboard palette and drag DashboardPane onto the page.
3. Open the webChart palette.

4. Drag either Chart or Circular Gauge onto the content of the Dashboard pane in
the widget tree.

+ Widget Tree

v DScrollPanel:Rootj
hd E‘CanvasPaneiContent]

v . DashboardPane
@mntent

< o O0-oaC 0 w- @0 B % © X N o ¢ 0o- Qaak s o8
" Station) : station (Demo_Stat s c.

5] - Bound Ords 5]

Heating Cirautt

«
i

‘
IEEEEEDREE 0
& G

3
%

Home - Pxlayers 7]
WL

- Properties 2]
fe— EN R
* webwndget

5. Go online
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6. Drag & Drop an analog value to the gouge

A
=
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6.7

Set Up Saia PCD® Supervisor Users

Security of Saia PCD® Supervisor is controlled by users. The access rights of each
user determines what information the user can access and what things they are able to
change/configure.

To achieve this the security within Saia PCD® Supervisor is managed using three ser-
vices:

1. Categories

Categories define what areas of the system a user can access.

2. Roles

Roles are used to group the categories together that are required for a particular
job and to define the level of access to those categories.

E.g. a boiler engineer would only need access to the boilers but would require a
high level of access. Therefore a role would be required for the engineers that gave
high level access to the category that gave access to the boilers.

An energy manager would need information from all the plant but with a lower level
of access. Therefore a role would be required for the energy manager that gave
low level access to a number of categories covering all the plant.

Categories are assigned to roles using the Category Browser which is just another
way of looking at the Nav tree.

. Users

Users define which roles the user has, their password, expiry, web access view.
The ‘admin’ user is a superuser level access which has access to the whole sys-
tem. Because of this details of the admin user’s password should carefully con-
trolled.

To configure users the required steps should be followed:
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Configure Categories

Before creating the necessary categories it is necessary to plan what is required, you
should consider the users and the distinct areas, then work out ‘\Where’ needs to be
granted access and create a category for each of these.

To configure categories the required steps should be followed:

Add a Category

User and Admin categories are created by default and additional categories are added
using the Category Manager.

The Admin category does not relate to the Admin user used to engineer Saia PCD®
Supervisor.

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Double click CategoryService
The CategoryBrowser is displayed in the view pane.

3. Click the view changer box and select Category Manager.
The Category Manager is displayed in the view pane.

® Saia PCD® Supervisor

File  Edit Search Bookmarks Tools

~ Nav Category Browser
P o () My Network Inherit User Admin Category3 Category4 Categorys Category6 Category7 Categorys
- & Ao B Aram s )
© confiz Oconfig /2 )
@ senvices Eriles n/a )
© alsrmservice @History  n/a L]
@ BackupService
® categoryservice
D User
D admin
@ sobsenvice
€ Roleservice
© usersenvice

Category Browser

Inherit User Admin Category3 Category4 Categorys Categorys Category7 Categorys

Aderm  nfa [ ] t.

Config  nfa L]
S Property Sheet
Ories e °
@risory 2 @
ot Sheet
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4. Click New The New dialogue box is displayed.

o Pew >

Typeto Add ';5 Category
Mumberto Add (1 | [1-100]

OK | Cancel |

5. Click OK The dialogue box changes.

< New *

Index Name B
@3 Heating_Circuits

m Index 3

m Name |Heating Circui sl

oK Cancel

6. Enter the name of the category in the Name box.

7. Click OK.

6.7.1.2 Set up the Categories

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Double click CategoryService
The CategoryBrowser is displayed in the view pane.

[<® Saia PCD® Supenvisor
File Edit Search Bookmarks Tools Window CategoryBrowser Help
- Nav [Z1 categoryBrowser
P C Inherit User Admin Heating Circuits Category4 Categorys Category6 Category7 Categorys
- Aslerm M e e @
O config nia o o
Services v
Drivers v
Apps. v
QO schematics ) )
HeatingCircuit v
HeL v
HC2 v
S riles nfa o
Images v
@ Authenticationservice offline v
O ocbugsenvice O e o o
HCLpx v
HCZpx v
HC_generic.p v
HeatingCircuitL.p: v
O Logristoryservice Home.px v
@ progamservie b Oresourees v
© Searchsenvice Saia_PCD_Supervisor_Shus_Demo_HC v
) © TagDictionaryService @ristory s o e
- Palette 5] & Demo_ststion e o o
W X B | § webChat AuditHistory v
Hestingl_Outside_Temperature_PhysVal
@ chart
@ cirularcauge LosHstory v
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3. Grant each category access to the required areas of the system by clicking the
required rows in the column for each category. To grant access to elements lower
in the hierarchy expand the appropriate row and click.

Categories are a parent child system so selecting the top level will grant
access to every child element under that level.

The inherit feature enables the access of the User category to be copied to another
category. If there is a tick on the Inherit column for a row when that row is selected
for another category the access from the User category is copied to the other cat-
egory and removed from the User category. To reinstate access to the User cat-
egory click the row in the User column.

n Due to this it is potentially easy to accidentally remove rights. n

A dot in a cell indicates access to that specific area. If the dot is black the access
will not be affected by the Inherit tick, if it is grey it will be affected.

It is recommended that the Admin category is given the same access in the Config
row as the User category i.e. leave the Inherit rows in the Config row are they are.
For the other rows (Alarm, Files, and History) the Inherit rows can be unticked to
enable you to specify the access more easily.

n By default the ‘Admin’ and ‘New’ categories will have no access.

It is recommended that the ‘Admin’ category has access to some of
the more complex areas of Saia PCD® Supervisor but not the whole of
Saia PCD® Supervisor.

4. Click M.

L]
fmx Saia PCD® Supenvisar

Edit Search Bookmarks Toolt  Window  Categoryg

{ noO-o N b w- [
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6.7.2 Configure Roles

Roles use the categories to define what areas of the system can be accessed. They
can have multiple categories assigned. It is best to configure Roles with job roles in
mind rather than specific areas like categories.

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Double click RoleService The Role Manager is displayed in the view pane.

[® Saia PCD® Supenvisar
File Edit Search Bookmarks Tools Window CategoryBrowser Help
ion) ¢ ation) : Sewvices  © CategorySemvice
- Nav [ category Browser
¥ O @ My Network Inherit User Admin Heating Circuits Category4 Category5 Categoryé Category7 Categorys
T Mnem Asem o e e e
O confie © config nfa e e
@ services Services v
© Alarmsenvice Drivers v
@ Backupservice Apps v
@ categonysenvice Q) schematics e o L]
g u:” HeatingCircuitL v
Adm
@ testng_ciuis - j
© Jobservice
S iles nfa L]
Images v
jon offline v
LT pebugservice O o o )
® sosservice HeLex v
¥ Foxservice
@ Hierarchyservice :EZ‘DX j
@ HistoryService e
© huditHistoryservice HeatingCircuitLpx V4
Home.px v
v
@ searchservice Saia_PED_Supervisor_Sbus_Demo_HC v
» © TagbictionaryService @ tistory W @ @
- Palette 5| & Demo_Station e o o
w X 3§ weschert AuditHistory v
Py Heating1_Outside_Temperature_PhysVal o
3. Click New The New dialogue box is displayed.
W MNew x
Typeto Add m Role
Mumberto Add 1 [1-100]
oK | Cancel |
4. Click OK The dialogue box changes.

W New X
Name Permissions  Viewable Hierarchies B
[ HVC O None

ﬁ Name HVC Operators
m Permissions [ superUser{access entire station, file system) »

ﬁ Viewable Hierarchies ))

0K Cancel
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5. Click >> next to Permissions.

Set Up Saia PCD® Supervisor Users

It is recommended that the SuperUser (access entire station, file system)
check box is NOT selected.

The Permissions dialogue box is displayed.

<@ Permissions

Admin
RIwl 1|

Operator

Category RIwl |

User

Admin

Heating_Circuits « « « « # «#
Category 4

Category 5

Category 6

Category 7

Category 8

0K | Cancel |

6. Specify the permissions for each category by clicking the appropriate column for

each category.

When you assign permissions, higher-level permissions (green check marks)

automatically include the lower level ones (grey check marks). For example, if you
enable admin level write (W), the system automatically enables admin level read
(R), as well as operator level read and write (RW).

The first column, Category, lists the groups to which you may grant permission.
The Operator and Admin columns relate to the permissions level configured on
each component. Below these headings are the cells to use for assigning one of
three permissions to each category:

R Read allows the user to view the object.

W  Write allows the user to change the object.
I Invoke allows the user to initiate an action related to the object.

Depending on how the permission level is set on the role, six permissions are de-

rived:

Permission Description
To allow a user to view operator level Check the Operator config flag on the slot and select the Operator R
information column on the permission map.

To allow a user to modify operator level
information (if it is not read only)

Check the Operator config flag on the slot and select the Operator
W column on the permission map.

To allow the user to view and invoke
operator-level operations (actions)

Check the Operator config flag on the slot and select the Operator |
column on the permission map

To allow the user to view admin level
information

Leave the Operator config flag unchecked on the slot and select the
Admin R column on the permission map.

To allow the user to modify admin level
information (if it is not read only)

Leave the Operator config flag unchecked on the slot and
select the Admin W column on the permission map.

To allow the user to view and invoke
admin-level operations (actions)

Leave the Operator config flag unchecked on the slot and select the
Admin | column on the permission map.
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7. Click OK.
8. Click OK A confirmation dialogue box is displayed.
9. Click Yes.

6.7.3 Configure Users

To configure users the required steps should be followed:

see chapter 6.7.4 Add Users 6.7.4

n 6.7.3.1 Configure NAV Files

NAV files are used to define the PX Page that is displayed when a user logs in. Each
user must have a NAV file assigned. It is recommend that a folder is created to store all

the NAV files.

6.7.3.2 Create a Folder for the NAV Files
1. Right click Files and select New> Folder. The Name dialogue box is displayed.

“® Name for New Folder x

Q=

OK Cancel

2. Specify the folders’s name e.g. ‘NAV'.
3. Click OK.
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Create NAV Files

1.

In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config and
navigate to where the NAV file is to be located

2. Right click the folder and select New> NavFile.nav. The Name dialogue box is

o a &~

displayed.

127.0.0.1 (Demo_Station)  : Station (Demo_Station)  © Files

K C @ My Network

@ apps
© schematics
© HeatingCircuits
QHcL
(=]
& Files
© Images
(=1
[ HeLex
[ HeatingCircuitL.px
[ Home.px
[ Hez.px
[ He_genericpx
O resources
© saia_PCD_Supenvisor_Sbus_Demo_HC

O offline

New Folder

cut BogFilebog
copy HemlFilehtml

Paste

Duplicate

- Palette
Delete ri y
X O . tteFile.palette
@ chot Refresh Tree Node P
@ CircularGauge ReportPxFile.px

GoInto

SyntheticModule.sjar

TextFile.xt

@ MName for Mew File x

@ Homel. nav
OK Cancel

Specify the file’s name e.g. ‘Home’.

Click OK The file is created.

Open the folder containing the NAV file.

Double click the NAV file. The Nav File Editor is displayed in the view pane.

® Saia PCD® Supenvisor s - O X

File  Edit

Search  Bookmarks Tools  Window

Help

4 oD O- o O 0 - 2 0 =

127.00.1(Demo_Station)  © Ststion (Demo_Station)  : Files  : NAV | Homenav #  NavFileEditor ~

Result Tree 1objects

& My Network Display Name Target Ord B

© schedulers
@ Files

Q) images

QO offline

Qex

Q resources

Q) seia_PCD_Supervisor_Sbus_Dema_HC

Q nav

=) Home.nav

(&) Hierarchy
~

~ Palette

&= G o (M ktcontrol ®New | #Edit  JDelete 4 MoveUp ¥ MoveDown [ Show Components | [=] Show Files

P Home  station:slots
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7. Click Show Components.

8. In the Result Tree double click to the NAV file. The Edit dialogue box is displayed.

™ Edit X
Dizplay Name [Ffems
station: |slot:/ & - (DefaultView) -
Target Ord
» O-
lcon module://icons/x16/home.png ]
0K Cancel

9. Click ™ - next to DefaultView. The Select Ord dialogue box is displayed.

n < Select Ord X

9 Config
E Station Name
m Sys Info
@ Services
. Save
e Drivers
Apps
0 Schematics

Type
@ slot
<> Handle

oK Cancel

10. Navigate to the PX Page that is to be referenced by the NAV page and select it.
11. Click OK.
12. Click OK.
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6.7.4 Add Users

1. In the Nav tree open 127.0.0.1(localhost) > Station(Demo_Station) > Config >
Services.

2. Right click UserService and select Views > AX User Manager. The Ax User Man-
ager is displayed in the view pane.

<@ Saia PCD® Supervisor s [m} bod

File Edit Search Bookmarks

Tools  Window  UserManager Help

4 o O0O-on o O - B a0 & XK

127.0.0.1(Demo_Station) ~ : Station (Demo_Station)  : Config  © Services  : UserService /  UserManager -

~ Nav a Name Full Name Enabled Expiration Allow Concurrent Sessions Network User Languagv

G () My Network guest false Never true false

@ 127.0.0.1{Demo_Station)
& station (Demo_station) BACnet true Never true false

admin true Never true false

A 4o User Operator 1 true Never true true

© config
@ services
Q alarmservice

@ Backupservice

® catezoryservice
@ Jobservice

€D Roleservice

O userservice

O authenticationSery

- Palette
wm X A # Kitcontrol # EDIT ¥ REMOVE By DUPLICATE

https://127.0.0.1/bajaux/webwidget/viewswebEditors:UserManagertheme=SBC&formFactor-maxguseL ocalWbRe=trueattachAfterinit=False

3. Click New. The New dialogue box is displayed.

™ New X

Typeto Add a User
Mumberto Add 1 [1-100]

OK | Cancel

Several users can be added at the same time. However, it is recommend-
ed to add users individually to prevent confusion when specifying pass-
words.

4. Click OK The dialogue box changes.
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5. Double click of the new user

Station (Demo_Station) . Config I Services : UserService

Property Sheet

& Userl {User)
[ Full Name Operator 1
[ Enabled @ true
[ Expiration @ NeverExpires <> ExpiresOn [24-Jul-2017 11:59 BM CEST
[ Lock Out @ e
@ Language
[ Email

Password esssssss
Confirm essssses
W Authenticator
Force Reset At Next Login .fﬁlse

& NeverExpires < ExpiresOn [24-Jul-2017 11:59 EM CEST

Time Farmat (default)
m Facets
Unit Conversion | Mone
[ Nav File null - )

m Prototype Name defaultPrototype
[l Network User ® true
@ Cell Phone Number

m Authentication Scheme Name DigestScheme

admin

[ Roles Engineer >
Energy manager

[ Allow Concurrent Sessions ® true

Type HTMLS Hx Profile

HxTheme SBC
Enable HxWorkbench Views . Yes

Enable Nav Tree Side Bar . Yes
Enable Search Side Bar . Yes
Enable Palette Side Bar . Yes
ﬁ Default Web Profile
Enable Nav File Tree . Yes
Enable Config Tree . Yes
Enable Files Tree . Yes
Enable Histories Tree O
Enable Hierarchies Tree . Yes
Enable View Selection . Yes
Mobile Mav File mull - - )
m Mobile Web Profile Type Default Hx Profile

HxTheme

[ User Pin Level Galileo User Pin

c Refresh E Save

6. Enter the user’s username in the Name box.
7. Enter the users full name in the Full Name box.

8. If the user is to expire on a specific date select the Expires On option and specify
the required date.

9. Select the roles for the user in the Roles box.

10. Enter the user’s password in the Password box.

n Passwords must be 10 digits alpha numeric with one or more capital
letter.

11. Re-enter the user’s password in the Confirm box.
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13.

14.

15.

16.

17.
18.

19.
20.

21.
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To force the user to change the password when they next login set Force Reset At
Next Login to frue.

To force the user to change the password on a specific date, select the Expires On
option and specify the required date.

If the password is to expire on a specific date select the Expires On option and
specify the required date.

Specify the NAV file that is linked to the PX Page that is to be displayed when the
user logs in in the Nav file box.

Specify what happens when a user logs in from a web browser in the Default Web
Profile box.

In the Type box select the required option. n

It is recommend that you select HTML5 Hx Profile as it will render the graphics in a
HTML5 format avoiding Java issues.

In the Hx Theme box select “SBC”.

Select Yes or No to specify whether the user has access to the following features:

- Hx workbench views
- Nav tree side bar

- search side bar

- palette side bar

- Nav file tree

- Config tree

- Files tree

- Histories tree

- Hierarchies tree

Click OK.
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6.8 Backup & Restore

To ensure that the Saia PCD® Supervisor configuration can be restored in the event of
hardware or software failure it is recommended that the Saia PCD® Supervisor station
is backed up. To reduce the risk it is recommended that the backup is performed in two

ways:

visor installation, platform password (normally PC login credentials) and the password
for the ‘admin’ user (specified when creating the Saia PCD® Supervisor station) are
available for use during any restore procedure.

n It is also important to ensure that the passphrase entered during the Saia PCD® Super-
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Backup the Configuration

Using the Station Copier

The Saia PCD® Supervisor configuration can be copied from the localhost back to the
local computer. This is not a true back up but it is useful as it makes the configuration
available offline and thus reusable in future Saia PCD® Supervisor installations.

1. In the Nav tree right-click on Platform and select Views > Station Copier. The
Station Copier is displayed in the view pane.

® Saia PCD® Supervisor

File Edit Search Bookmarks Tools Window
4 O- o A O - - B b
My Host :SZ43L TJ0SGWF2 globalds.honeywellcom  : Platform #  Station Copier -
- MNav Station Copier
¥ o © wyetwork @ Stationson this computer & Stationson "localhost”
_ B /C:/Users/EB14666/Niagarad.2/tridium/stations Q ~stations
My File Syst
© vy iiesystem Attila_test2 Attila_test2
© wyHodules Certlab_04 Certlab_oa
® application Director JACEDS JACEDS
© certificate Management JACED4 final JACED4.final
O Loicon Installer SBC_SBUS_Test1 SBC_SBUS_Test
© License Manager SBC_SBUS Test2 SBC_TM2016_Workshop
© Platform administration SBC_TM2016_Workshop StationSup04
O e StationSup04 Training_Center_V1

Training_Center_V1
@ 1criip Confizurstion B-center

@ Remote File System
@ 127.0.0. (Demo_station)
& station (Demo_station)
A Alsm
© config
@ services
© Alamservice
@ BackupSenvice
@ categoryService P copy
@ sobservice 4 copy
€ roleservice
© userservice M
b @ AuthenticationService X velete

- Palette
W X B | #§ webchart
@ chart

@ circularGauge

2. In the right-hand column (Stations on “localhost”) click the station to be copied (e.g.
Saia PCD® Supervisor).

The Localhost is the live version of Saia PCD® Supervisor. Copying from left to
right will overwrite the live version with an older PC version. To copy the live ver-
sion to the PC it is RIGHT to LEFT

3. Click < Copy. The Station Transfer Wizard is displayed.

<®» Station Transfer Wizard X

™% Transferring station "Demo_Station™
What name would you like the new station to have?

Station name Demo_Station

4 Back P Next / Finish ¥ cancel
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“®> Station Transfer Wizard X

™ Transferring station "Demo_Station™
Which station files are to be copied?

&> Copy files from selected directories
&> Copy every file in the station directory and its subdirectories
& Copy only the "config.bog" station databasefile

Y —

' Finish X cancel

4% Station Transfer Wizard X

h Transferring station "Demo_Station™
How do you want to deal with any existing files?

&> Delete the existing "Demo_Station" directory before copying

& :Overwrite existing station fileswith new files, while leaving other files intact;

4 Back P Next / Finish X cancel

4. Enter the name of the backup copy (e.g. Saia PCD® Supervisor Backup).
5. Click Next.

Select Copy every file in the station directory and its subdirectories.

Click Next.

If the station already exists in the destination you will be prompted to delete the
entire station, or just overwrite duplicate files. Select the required option and click

Next.

<& Station Transfer Wizard X

f'\ Transferring station "Demo_Station®”
Please review yourchanges

Allstation files will be copied from "localhost” to the local computer

Please select the "Finish" button to start the transfer.

“ Back ’ Next - \/ Flnish x Cancel
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9. Click Finish to start copying the files. Once the copy is complete the following dia-

10.
11.

12.
13.
14.

logue box is displayed.

“#» Transferring station

‘U Transferring station

Completing transfer:

° Savestation  Success
€D Transferfiles  Success

L T e R L i T e e e e e e e L P e Ll o)
~3tations/Demo Station/shared/Saia PCD Supervisor Sbus Demo HC/CPU001/ TCPIPDBX.src
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CFU001.inc
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CFU001.src
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPFU001_HLEKSE M1
~3tations/Demo_Station/shared/Saia PCD Supervisor Sbus Demo HC/CEUO001/_ CPU001 HLESE M1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPU001_Heating 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPU001_Heating 1
~atations/Demo_Station/shared/Saia PCD Supervisor Sbus Demo HC/CEU001/_CPU0O1_Heizung 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/_ CPFU001_Heizung 1
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/hdlog.fxp
~3tations/Demo_Station/shared/Saia PCD Supervisor Sbus_Demo HC/CFUO01l/hdlogl.fxp
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/CPU001/heating circuit.fs
~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/Libs

~stations/Demo Station/shared/Saia PCD Supervisor Sbus_Demo HC/Saia PCD Supervisor Sbus
~stations/Demo Station/shared/Saia PCD Supervisor Sbus Demo HC/ lastopen
~3tations/Demo_Station/shared/offline/alarmdata/CPU00L.xml
~3tations/Demo_Station/shared/offline/engineering/system.bog

~3tations/Demo Station/shared/offline/hdlogsdata/CPU00L.xml
~3tations/Demo_Station/shared/offline/pointdata/CPU00L.xml

~stations/Demo Station/shared/px/HCl.px

~gtations/Demo_Station/shared/px/HC2.px

~3tations/Demo_Station/shared/px/HC generic.px
~3tations/Demo_Station/shared/px/HeatingCircuitl.px
~3tations/Demo_Station/shared/px/Home.px
~3tations/Demo_Station/shared/resources/AlarmTexts/CPU001.xml

~stations/Demo Station/shared/resources/encodings.xml

Transfer complete.

Close

Click Close.

In the Nav tree open My File System and navigate to

C:/Users/MyUserName/Niagara4.7/Saia Burgess Controls/stations

Right-click the required station folder and select Copy.

Navigate to the required storage location (e.g. a plug-in memory device).

Right-click and select Paste.
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6.8.2 Using the Backup Service

Using the Backup Service the backup file has not only the content of the station but
also the default settings of the Workbench where the station was created and backed

up.
The user can as well specify, if the alarm or histories database should be a part of the
backup .dist file.

Doing a station backup, will prevent data-lose of the running station in case of hard-
ware or system failure.

Station backups are stored as ‘.dist’ files in
C:/Users/MyUserName/Niagara4.7/Saia Burgess Controls/backups

n 1. In the Nav tree open Station > Config > Services.
2. Right click BackupServices and choose Views > Ax Property Sheet.

<@ Saia PCD'® Superviser - x
File Edit Search Bookmarks Tools Window Help
14 o O- o A C 0 - B =
127.0.0.1 (Demo_Station) ~ : Station (Demo_Station)  : Config  © Services @ BackupService #  AXProperty Sheet +
~ Nav Property Sheet
h. s} @Mywﬁwmk @ BackupService (Backup Service)
- - [ status {ok}
@ services [ Fault Cause
O sarmservice [ Enabled @ e
@ Backupsenvice [ Exclude Files +.hdb; *.adb; *. 1ock; *backup#*; console. *; col
CategoryService
6 carezors filesnshistory ® X
@ Jobservice -
file:rralarm
@ Roleservice [ Exclude Directories
O userservice
© AuthenticationService
& pebugservice [ Offline Exclude Files *.lock; *backup*;console. *;config.bog.b*
® Boxservice ® X
¥ Foxservice
@ Hierarchyservice (W Offline Exclude Directories

@ HistoryService
© auditHistoryService
O LogHistoryservice
@) Programservice
© searchsenvice
© Tsebictionanysenvice
TemplateService
@© websenvice
' Saia PGS Data Import Wizard
T PlatformServices

» { ] pashboardservice

~ Palette
w X B @ webchart
@ chart

® circulsrGauge

7 Refresh [™) save

3. In the Exclude Directories box click file:*history and click X.
4. In the Exclude Directories box click file:Aalarm and click .

5. Click Save.
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6. In the Nav tree double click BackupService. The Backup Manager is displayed in

the view pane.

[@ Saia PCD® Supervisor

127.0.0.1{Deme_station)

P o () My Network

v @ services
O Alermservice

rvice
© authentication:
L pebugservice
® Boxservice

¥ Foxservice

@ Historyservice
© sudithistoryse

@ Searchservice

vy vVvYveYTvvryvrvyvvvvvesvvwvwrvvvw

- Palette
W [X] B § webchat
> @ chart

+ @ circularcauge

© Station (Dema_Station)

File Edit Search Bookmarks Tools Window  Help

: config  : Services  : BackupService

Backups

Timestamp.
D) 12-Apr-17 8:27 AM CEST
D) 12-Apr-175:33 PM CEST

¥3) 13-Apr-17 10:31 AM CEST

Service

@ Hierarchyservice

rvice

Q) LogHistoryService
@ Programsenvice

Q) TegbictionaryService

TemplateService

@ websenvice

3 Saia PG5 Data Import Wizard
 platformServices

{ ] pashboardservice

Host Path

127.0.0.1  files/C:/00_SBC/01_Projects/Niagara_user_manual_pictures/backup_Demo_Station_170412_0826.dist admin
127001 file:/C:/00_SBC/0L_Projects/Niagara_user_manual_pictures/backup_Demo_Station_170412_1732.dist admin

127.004  file:/C:/00_SBC/01_Projects/Niagara_user_manual_pictures/backup_Demo_Station_170413_1030.dist admin

#  Backup Manager -

3objects

User [

D) Backup

7. Click Backup. The File Chooser dialogue is displayed.

> File Chooser

L File Spaces

@) My File System

N Bookmarks

OA
OA

~backups

bed

(oA E||E

Filename: backup Demo_Station_170501_1647.dist

Files of type: Distribution File

RSN -

Save

Cancel

8. If required rename the backup in the File name box.

9. Click Save.

10. Ensure the backup file is stored securely.
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6.8.3 Restore the Configuration
6.8.3.1 Restore Using the Station Copier

To restore a station copy follow the procedure described in chapter
6.8.1 Backup the Configuration but copy the station from left to right.

6.8.3.2 Restore the Station Using the dist file
1. Rename the backup.dist file to a zip by renaming the extension and unzip it.

2. Copy the unziped station to the User home station folder.

| 9 = | stations
n Home Share View
x u o Cut ] x I % New item ~ :4 Open E Select all
w-| Copy path = ﬂ Easy access Edit 10 Select non
Pin to Quick Copy Paste _ Move Copy Delete Rename Mew Properties
access E] Paste shortcut ta to - folder - ) History DD Invert seleq
Clipboard Crganize Mew Open Select
“ v P » ThisPC » OSDISK(C:) » Users » EB1 » Miagarad.3 » tridiurn » stations »
# Quick access MName Date modified Type
[ Desktop - DDC_Suite_27_EN_06 17/07/2017 14:52 File folder
; Downloads P Demo_Station File folder
Docurnents P Derno_Station_from_backup File folder
. SBC_SUP_TrainingCenter_SBUS File folder
[&] Pictures o
3. Use the station copier to copy it to the daemon home and start.
< Saia PCD® Supervisor had - [m| X

File Edit Search Boockmarks Tools Window  Help

My Host : 5Z43LTJ06GWF2.global.ds.honeywell.com (Demo_Station) . Platform / Station Copier «

Station Copier

h@ O @ N @ Stationson this computer AT Stationson "localhost”

/C:/Users/E8l4666/Niagarad.3/tri 0 ~3tationa
v (@ MyHost:Sz43LTI0

v @ iy File System DDC_Suits_27_EN_D6 DDC_Suite_27_EN_06

h SysHome Demo_Station Demo_Station

Demo_Station_from_backup b co Demo_Station_2
Py
SBC_SUP_TrainingCenter_SBUS SBC_SUP_TrainingCenter_SBUS
4 copy

ERE'IHI'I'IE
- Palette -1 m
w X 3
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6.9 SBC S-BUS driver in Optimizer Advanced Controller

The driver support within the Optimizer Advanced Controller is positioned with respect
to the SBC portfolio. It is intended to provide means for the SBC partners to migrate the
existing PCD (Building Management) to a Niagara based Optimizer Solution which es-
tablishes a horizontal integrated solution. This will use the existing S-BUS- IP within the
Advanced Controller without any functional changes. Within the existing S-BUS driver,
the Advanced Controller can act as the S-Bus Primary device, which means it can read
and write from any PCD that has ethernet connection. This also allows the Advanced
Controller to be integrated into the existing SBC PCD® networks.

The image below is the representation of the horizontal integration of the Advanced
Controller with the existing Saia PCD® Supervisor.

6.9.1 System Architecture n
6.9.1.1 Focus on Enhancing Connectivity with Optimizer Suite Hardware

Saia PCD Supervisor

No S-Bus
FOX
BACnet
Etc.

Optimiser Advanced i

No S-Bus Controller

BACnet
Etc.

T1L Switch [N
PCD Controller

BACnet™ IP BACnet™T1L BACnet™MS/TP L 1 ] 1
Unitary Controller Unitary Controller Unitary Controller =
RS-485 -> PCD Sub-Stations

Ethernet communication to Sub-PCD Stations over RS-485 which are connected behind
a gateway.
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6.9.1.2 Focus on Enhancing Connectivity with Saia PCD Hardware

Saia PCD Supervisor

No FOX No S-Bus
S-Bus FOX
BACnet BACnet
Etc.

Optimiser
Advanced
Controller

Etc.
PCD Controller -
&:‘W ,:) .
| 3

g
Sy, %
Im'"’”\/ No S-Bus
PCD7.D410DT5F
PG5 programmable
MB Web-Panel

S-Bus
RS-485
Modbus Modbus

2 o -
2o o Ny e e e - -
& -l N v &;ﬂ
. ” PCD 1 E-Line - -> Optimiser Suite HW
PCD 1 E-Line PCD1.M2110R1 programmable 1/0 modules PCD1.M2110R1

programmable I/0 modules as Sub-Station as Sub-Station

Ethernet communication to Sub-PCD Stations over RS-485 which are connected behind
a gateway.

6.9.2 Optimizer Advanced Controller communication with existing PCD.
6.9.2.1 Prerequisites

1. The user should ensure that the below listed modules/software version is available
before starting the Advanced Controller integration with SBC.

- List of compatible modules/software
- SBC PCD Workbench
- SBC Supervisor Package

2. The first step is to configure and commission the Advanced Controller, that needs to
communicate with the existing SBC PCD network. This controller needs to be in the
same Subnet or LAN as that of the Saia PCD® Supervisor. In case otherwise, the
firewall needs to be opened between different Subnets.

3. Follow the below listed procedure to configure the Optimiser Advanced Controller:

v

To install the Advanced Controller, refer the Mounting Instructions document (31-
00553).

Connect the power Supply.
Connect the controller to workbench.

Ensure that the supported modules are available in the workbench

N2 2 2 2

Copy the station/Create a station/Open a station.
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Refer to the Advanced Installation Instruction and Commissioning Guide - 31-00584 for
following the above listed procedures.

4. Once the controller is completely set up the S-BUS station needs to be created in
the application director, and it should be up and running. Please refer to point 6.1.3
for creating the station.

5. Under this station the S-Bus IP driver needs to be added. Lastly all the S-Bus de-
vices need to be added under this driver to start the communication with the Opti-
mizer Advanced Controller.

6.9.3 Procedure to add the S-BUS IP driver:

1. This procedure can be referred from section 6.2 in the Saia PCD® Supervisor V3.0 n
Configuration Manual.

6.9.4 Procedure to add the S-BUS IP driver (SBClpNetwork)

1. The SBC-IP driver needs to be added under the station file. As shown in the Fig
below navigate to drivers under the desired station.

$9.63.33.63 (SBCIP_BeatsAdv_AdvContTempd10UT) Station (SBCIP_BeatsAdv_AdvContTemp410UT)
~ Nav [ station (SBCIP_BeatsAdv_AdvContTemp410UT)
#H O () My Network Name Description
P Leacon instalier A alarm Alarm Database
© LicenseManage: © Config  Thestation configuration database

Q platform Administration =

@ Files File System accessed over Fox session
O software Manoger
@ station Copler

@ rce/P Configuration

2 sey Disgnostics information for remote VM

Hierarchy Hierarchy views of remote station

¥ Coo @ nHistory  History database
& station (SBCIP_BeatsAdv_AdvContTemp410UT)
& alsrm
* © config
@ Services
k6 orivers
A 5 )
O asp Summary Properties
& Files
Property Value
»  [B] Hierarchy ’
. @ History Station Name SBCIP_BeatsAdv_AdvContTemp4l0UT
Host 199.63.33.63
" Palelic . Host Model ADVCTLR
HostModelVersion 1.0
- T
Host Product ADVCTLR
» O secipnetwork Host Id HON-NADV-0AZE-CB00-E896-163E
Qoo MNiagara Version 4.13.2.18
O R

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05 §-159



Creating/Engineering a project Saia-Burgess Controls AG

Backup & Restore

2. Click on drivers to add the SBC-IP driver as shown below. The driver section can
have multiple drives such as Niagara, BACnet etc.

-
= Nav A
#H O G} My Network
& Station Lopler
6 TCP/IP Configuration
4 e Remaote File System

v ’ Station (SBCIP_BeatsAdv_AdvContTemp410UT)
! Alarm
v etonfig
» @ services

« ¢ Drivers
n b ijiaiaroNE.éwork
v ) sBc_s.a0u7

» 6 secipNetworkl
» O sacipNetwork2
MDS
b QFiIes
b @H:erarch}-

» @ History

- Palette (A

3. From the palette, look for module SBC (SBC IP DRIVER) in the search window and
drag and drop it under the driver section of the station.

E— -

& Open Palette x
Select one or more palettes to open, or just start typing: Browse...
| Y =od
Module Description "
sbe Lec i oriver
sbdoonGallery SBC GRAFHICS
sbdconGalleryvd SBC 20 GRAPHICS V4 - EASY WIDGETS (EASY BINDING]
sbeOfflineEngineering SBC Offline Engineering UX

OK I l:inhll

Host Product ADVCTLR

Host id HON-NADV-0A2E-CB00-EBSE-168E
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4. Name the S Bus IP driver as desired name, when the below window pops up.

ase

“ Name

5. Once created, click on the SBC-IP network that is added and go to the property
sheet as shown below.

P S——
Py
v © Contig

= Palette

| E D E=

AX Property Sheet
3

6. Once created, click on the SBC-IP network that is added and go to the property
vsheet as shown below. Check for status it should be {ok} and enable tab should be

True.

v_AdvContTempd 10UT)

Config

Drivers

SBC_4.10U7

S8CIpNetwork

roperty Sheet

- Status
(Ml Enabled
(@ Fault Cause

b CJ Health

» ) Alarm Source Info

¥ C Monitor

¥ X Tuning Policies

(@l Channel Type

Y sBCipNetwork (SBCIpNetwork)

[olk}

. true

Ok [29-Oct-24 12:16 PM IST]
Alarm Source Info

Ping Monitor

Tuning Palicy Map

S5-Bus TCE/IP

To enable the service, make the service true

service.

. True is to Enable and false is to disable
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7. After enabling the services, we need to add the devices that needs that need to
communicate with the Advanced Controller. For this go to the pallet and look for the
PCD device. Drag and drop the PCD device under the S-Bus IP as shown in the

image below.
¥ W unvers
@ NisgaraNetwork
© sec_sa0u7
€ secipNetworkl
 secipNetwork2
 secipNetwork
X TuningPolicies
©rco
.~ n Anne
* Palette B
n W x 3 #sbe
6 SBCIpNetwork
© e

»  © PCDsubstation
» P2 PCDDeviceFolder

B secPointFolder

O Points

8. After adding the required PCD, device we need to configure the IP address and
station ID for the device. Click on the device and navigate to the property sheet as
shown below.

Property Sheet  I—

© PCD (SBCHeadStation)

While commissioning the PCD the IP address, Port number and station ID’s are as-
signed, same details need to be filled in this property sheet as well.
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9. In similar way, using the drag and drop method we can add the points to be moni-
tored under the head PCD station.

I P
* B reen

-:ii

EEEEE

s000000000ede

L !
[E%§afei8d4

N

=T

O FYee

v Qe

v I e rages

| e

o e b

10. Once added, go to the property sheet view to add the memory address of the
points that has just been added. After adding the memory address, this will start
communicating.

i

EENEEN

| e e wnw
FRFr i ¥y E

TER

fgedg

joocooooOoDO00G00
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7 Using Saia PCD® Supervisor

This section covers the general procedures for day-to-day use of Saia PCD® Supervi-
SOor.

Once configured Saia PCD® Supervisor needs to be running all the time to enable to
collect logged data, control occupation times, process alarms and allow users to ac-
cess information.

If AUTO-START was selected when the Saia PCD® Supervisor station was created, the
Station will be running whenever the PC is started and running.

If this is not the case the Saia PCD® Supervisor station must be started manually
see chapter 7.3 Manual start the Saia PCD® Supervisor Station

Go to ..

7
7.1 Access Saia PCD® Supervisor .
7.2 Use Saia PCD® Supervisor”

7.3 Manual start the Saia PCD® Supervisor Station
7.4 HTML5 Enhancements

7.5 Cloud Connector

7.6 Bulk deploy

7.7 VvykonPro modules (on reguest)

“7.8 Setting customized login and background logo”

7.9 Headstation and Substation Ping Read Timeout”

“7.10 Setting up the S-Bus clock”

“7.11 Use of UDP config slot from the Property sheet in every headsta-
tion”
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71 Access Saia PCD® Supervisor

Saia PCD® Supervisor can be accessed from a PC using the Saia PCD® Supervisor ap-
plication or from a web browser.

n When accessing Saia PCD® Supervisor from a web browser not all features are avail-
able.

711 Launch the Saia PCD® Supervisor Application
1. Click Start and choose All Programs.

2. Navigate to the Saia PCD Supervisor folder
3. Click Saia PCD Supervisor v1.0R
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4. The Saia PCD® Supervisor application window will open:

::-J Windows Update
‘ Wireshark Legacy
‘ Wireshark Attila
< XPS Viewer

| T-Zip Documents
. Accessories

, FileZilla FTP Client Pictures

. Games

. LonMark

. Maintenance

Music

Notepad++ Computer

. PG5 Suite V2.2.221
. SaiaPCDSupervisor
L4 Alarm Portal

B Conscle

=] Demo Station Default Programs
[ Install Platform Daemen
® Saia PCD Supervisor Beta (Console) — [EEERIERT IR
“#> Saia PCD Supervisor Beta

&% Uninstall
7

4 Back

Control Panel

Devices and Printers

| |Search programs and files

g8

#  WebBrowserView -

SAIA BURGESS CONTROLS

008
supervisor

Saia PCD*

- Palette
® X 3 § honnisgsraani
O service
AuthenticationSchemes
Host ID: Win-7735-8ADC-FCAS-6C6B
Version: 4.10

niagara®
Version: 4.10.1.36

Copyright Tridium, Inc 1996-2021
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7111 Log on

(of course the Platform must be running always).

1. In the Nav tree double click on Station. The Authentication dialogue box is dis-
played with a default user selected:

File Edit Search Bookmarks Tools Windoew  Help

127.0.0.1 [Demo_Station)

- Nav 127.0.0.1 (Demo_Station) 1 objects

¥ O &) My e Name Description "

@& Station {Demo_Station] Foxsession to a Miagara station
@ MyHast: SZ43LTJOEGWF2 5

127.0.0.1 {Demo_Station)

@ Station (Demo_Station “®r Authentication x

|
‘ \
| K Authentication
I Logon required for access
7 Realm
Name ip:127.0.0.1 [fozs:
Scheme  Fox(n4digest) ‘

Credentials
Username

Change User
Password  [EERXIEN

[ Remember these credentials

OK Cancel

2. To select a different user click Change User, otherwise go to step 5.

4 Authentication M
.
\ Authentication
Logon required for access
Realm

Name ip:127.0.0.1|foxs:
Scheme  Fox

Credentials

Username |

[#] Rememberthis user

OK Cancel

ﬂ Select the Remember this user tickbox to make this the default username.

3. Enter a new Username.

4. Click OK.

5. Type the appropriate password in the Password box.

6. Click OK The user associated navigation (and start page) will be invoked

71.1.2 Log off

1. When you have finished using Saia PCD® Supervisor it is important to log off from
Saia PCD® Supervisor to ensure that the system cannot be accessed by unau-
thorised users. Logging off requires you to disconnect from both the Platform and
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Station.

2. In the Nav tree right-click on My Host and select Disconnect. The Disconnect
dialogue box is displayed.

ﬁ Saia PCD® Superviso

File Edit Search Bookmarks Tools Window Help

127.0.0.1 (SBC_SBus_Project) . Station (SBC_SBus_Project)
- Nav 5% Station (SBC_SBus_Project)
¥ O ) My Network Name Description

A Alarm Alarm Database
b (@ MyHost: WIN-IFE3JGTEIU

Disconnect The stati f tion d
b (@ 127.0.0.1(SBC_SBus_Proj i (= LI

File System accessed over Fi
Diagnostics information for

«m» Disconnect ‘ u
Hierarchy views of remote

. SIS @ Disconnect from host "My Host : WIN-IFE3J6TEIU1"?
h Tree Node
Go Into ¢ Yes No 7

3. Click Yes to disconnect.

7.1.2 Access Saia PCD® Supervisor from a Web Browser

1. Go to the IP address of the PC running Saia PCD® Supervisor. The Saia PCD®
Supervisor log on page is displayed.

=
[ Privacy error x W

| & &) | A Mot secure | batpg//localhost/ord T ‘ :

Your connection is not private

Attackers might be trying to steal your information from localhost (for example,
passwords, messages, or credit cards). NET:ERR_CERT_AUTHORITY_INVALID

O Automatically report details of possible security incidents to Google. Privacy policy

HIDE ADVANCED) Back to safety

This server could not prove that it is localhost; its security certificate is not trusted by your
computer's operating system. This may be caused by a misconfiguration or an attacker
intercepting your connection. Learn more.

Proceed to localhost {unsafe

n Please contact your local IT-department to get certificate!
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2. Proceed to localhost

— [} x
<@ Login x
< C 1Y | A Notsecure | b#pE//127.0.0.1/prelogin +r -
an
~r
SAIA BURGESS CONTROLS
Demo_Station
Username: | |
Use of this e is subject to the
End User License Agree: nd other Third Party Licenses
© 2017 Saia Burgess Gontrols. All Rights Reserved | Data privacy and Imprint
- [m] x
«®» Config x
< C Y | A Notsecure | heps//127.0.0.1/0rd/station:%7Csloty/ g -

Config

Display Name
(@ Station Name
(@ Sys Info
@ Services
 Drivers
Apps
© Schematics

Value Commands

Demo_Station

Service Container
Driver Container
App Container
Folder

1} Property Sheet v [X]

QActions & Topics  [8 Slot Details

3. Enter your user name.
4. Click Login.
5. Enter your password.

6. Click Login.

If the correct certificates, are installed then the security warning is not
coming up. The connection is immediately built from the browser to the
server.
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71.21 Log off
1. Click “X”

/ % Config XN

= (& iy ‘A Not secure | b#tsE://127.0.0.1/ord/station:%7Csloty/ ﬁ‘ ® @
Config ® t} Property Sheet

Display Name Value Commands

@ Station Name

Service Container
Driver Container
App Container

Folder

Are you sure you want to log off?

2. Click Yes.
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7-8

7.2

7.2.1

7211

7.21.2

Use Saia PCD® Supervisor

Once you have accessed Saia PCD® Supervisor it can be used in two different ways:

- 7.2.1 Using Saia PCD® Supervisor via Operator Views

> 7.2.2.2 Nav Tree

The method you use will depend on how Saia PCD® Supervisor has been configured,
your level of access and the tasks you want to do.

Using Saia PCD® Supervisor via Operator Views

Use of Saia PCD® Supervisor via Operator Views (PX Pages) requires more initial
configuration, but enables users to access the system using graphical pages tailored to
their requirements in a controlled way.

The Operator Views will have been designed to provide clickable links to either move
between pages or select particular controls (e.g. to change a set point, change occu-
pancy times, etc). When you log in you will be taken to a landing page from which you
can navigate to the required information and, if allowed, make adjustments. Simply
click on the links provided; the user interface should make it obvious what the link does.

Access the Operator Views
When you log on a PX Page will normally be displayed allowing you to navigate to
parts of the system that you have access to.

If a PX Page is not displayed and you want to navigate the system using Operator
Views you will need to display the required page from the Nav tree.

1. In the Nav tree open
127.0.0.1(localhost) > Station(Demo_Station) > Files > PX > and navigate to the
required PX Page (start page).

2. Double click the page.

Use the Operator Views
Navigation

Once a PX Page is displayed you will be able to navigate to other parts of the system
by clicking on the links provided. These links may be in the form of text hyperlinks but-
tons, or graphics with hyperlinks depending on how the page has been configured. The
display should make it clear the function of each item on the page.
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7.21.3

Use Saia PCD® Supervisor

File Edit Search Bookmarks Tools  Window He

The next and previous buttons ( ¢ * ) can be used to move between the pages you
have already viewed.
Adjustments

If you have the authority and the page has been configured appropriately you may be
able to make adjustments by clicking on various graphical elements, e.g. sliders and
buttons.

I s |

The meaning and use of such items should be intuitive.

Use Dashboards

A Dashboard is an item on a PX Page that enables you to choose the information that
is displayed. Once you have set up the item it can be saved so that next time you visit
the page your selections are visible. Selections made by other users do not affect
yours. A PX Page may contain one or more dashboard items.

There are two types of dashboard item; Gauges and Charts.

Gauge

A gauge type dashboard appears as shown below and enables an analogue value to
be represented in a graphical way.

pi)

48600°C

o Physi/al &

Un configured Configured
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7.21.4

Chart

A chart type dashboard appears as shown below and enables values to be represented
as a graph, e.qg. histories. Time schedules can also be added enabling you to view the
occupancy state and when a parameter is at a certain value.

) B Today @ e ABO® = ® B Today @ ABOoO® ®©
Heatingl_Outside_Temperature_@hysVal

45.000

Un configured Configured

Configuring a Dashboard

Configuring a dashboard requires access to the Nav free.

Adding an item to a Dashboard

- Use the Nav tree to locate the point required.

- Drag the point onto the dashboard. For charts you can add more than one value.
Save a Dashboard
« Click [ on the dashboard.

» Saia PCD® Supervisor

File Edit Search Bookmarks  Tools
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7.2.2

7.2.21

7.2.2.2

7.2.2.3

7.2.2.4

Use Saia PCD® Supervisor

Using Saia PCD® Supervisor via the Nav Tree

Basic Controls and Navigation

To see the location of the following Saia PCD® Supervisor controls and features, refer

to the diagram on chapter “2.2 User Interface Application (Host PC)”

Nav Tree
To show the side bar:

- On the menu bar select Window > Side Bars and ensure Show Side Bars is
checked.

To add a Nav tree to the side bar:
- On the menu bar select Window > Side Bars > Nav.
To remove a Nav tree from the side bar:

- Click the arrow to the left of the Nav tree title and select Close.

Palettes
To show the side bar:

- On the menu bar select Window > Side Bars and ensure Show Side Bars is
checked.

To add a Palette to the side bar:
- On the menu bar select Window > Side Bars > Palette.

- Click the file icon and select the Palette type from the displayed options.

To remove a Palette from the side bar:

- Click the arrow to the left of the Palette title and select Close.

Locator Bar
To navigate down the hierarchy:

- Holding the mouse over an item: a small arrow will appear.

- Click the arrow to reveal a drop down box and select the required option.

To navigate up the hierarchy:

- Click on an item in the bar to navigate back to that level.
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7.2.2.5

7.2.2.6

To navigate to specific location:

- Click in a blank area of the locator bar and type the path directly into the box.

View Pane & View Changer
To change the view of a selected item:
- Click the view changer box and choose the required view.

Or

Right-click the item (e.g. in the Nav tree), then select Views > and the required
view.

Viewing and Changing values of a Point
To view a point value:

- Use the Nav tree to locate the point required.

- Double click the point (or right-click and select Views > AX Property Sheet) to view
its Property Sheet. The Out item will indicate the current point value.

To change a point value (writable points only):

1. Use the Nav tree to locate the point required, right-click the point and select
Actions > Set Value.
Or
Click the button that allows the value to be adjusted.

The Set dialogue box is displayed.

im» Set b4
c
oK | Cancel ‘

2. Type the required value.

As default Saia PCD® Supervisor does not check that the value entered is
valid. The limits can be set for Numeric Writable. When the operator types
value outside of the limits the value will not be accepted.

3. Click OK.
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7.2.2.7

Use Saia PCD® Supervisor

Viewing Alarms

Viewing Alarms Using the Alarm History

1.
2.

In the Nav tree open the Services folder (under Station > Config).

Right-click AlarmService and select Views > Alarm Db View. The Alarm History
is displayed in the view pane.

[«@> Saia PCD® Supervisor — X

File Edit Search  Bookmarks ools  Window  Help

4 B O- o a O 0 - B ayY 2 ®

2 o @ My Network

& My File System
@ My Modules

Alarm History 9 Alarms

Timestamp Source State AckState Source Alarm Class Priority Message Text B

A 02-May-17 7:21:26 AM CEST  Normal Unacked  172.23.13.19:19/myAlarmList/7 DefaultAlarm Class 255 Error 7

A 02-May-177:2127AM CEST  Normal Unacked  172.23.13.19:15/myhlarmList/8 DefaultAlarm Class 255 Errors

A 02-May-17 7:23:57TAM CEST  Normal Unacked  172.23.13.19:19/myAlarmList/5 DefaultAlarm Class 255 General error

A 02-Moy-177:24:00AM CEST  Normal Unacked  172.23.13.19: 19/ myAlarmList/3 Class 255

M 02-May-177:24:0L AM CEST  Normal Unacked  17223.13.19:18/myalarmList/2  DefaultAlarm Class 255 short circuit

A 02-May-178:14:13AM CEST  Normal Unacked  SBClpNetwork Demo Devicel  DefaultAlarm Closs 255 Ping Success

A 02-M3y-178:3ISTAMCEST  Offnorma | Unacked  Alarm Critical Alarms 255 Pump Error

A 02-Moy-179:33:52AM CEST  Offnormal  Unacked  172.23.13.19:19/myAlarmList/4 DefaultAlarm Closs 255 Window open

A 02-M5y-17 933152 AM CEST  Offnorma | Unscked  172.23.13.19:19/myAlsrmList/1 DefaultAlarm Clsss 255 Errorin Pump Heating

b © LogtistoryService
- Palette =A

W X B | @ webChat
@ chart

[Jl whViewBinding

@ CircularGauge

Use the selector box (top left) to choose the required period.

It is recommended that the Saia PCD® Supervisor user need to use the
updated station in order to load the SBC Alarm Console page correctly.
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7.2.2.8 Using the Alarm Console

The Alarm Console allows you to view details of each alarm, acknowledge an alarm or
add notes to alarms. Notes are useful to record actions (particularly for critical alarms)
such as who has been notified, contact numbers and agreed timescales for fixing the
problem.

To view specific alarm details:

1. In the Nav tree open the Station > Config > Services folder.

2. Double click AlarmService. The view pane will display the Alarm Service wire
sheet.

3. Double click on the required ConsoleRecipient to open the Alarm Console:

® Saia PCD® Supervisor

File Edit Search Bookmarks  Tools  Window Wire Sheet  Help

127.0.0.1(Demo_Station)  © Station (Demo_Station)
- Nav 7 | wire Sheet
P O () My Network
File Alarm Bb Cortlz
) wyFile system I
O vy Modules Default Alarm Clazs
Alarm Class A
¥ MyToals [Marm
. 1
& Platform
@ 127.0.0.1 (Demo_Station) [c T ‘I s Tre =
& siation (Demo_station) w“:"“c"” BrrieR e
m I
! Alarm L 1 Status {ﬂclJ
© config
@ services
O Alarmservice
@ BackupService
@ categoryservice
@ Jobservice
-
SBC Alarm Console
Time Range Tto 7 @
Timestamp Source State  Ack State Source Alarm Class Priority Message Text
A 02-May-179:33:52 AMCEST  Offnormal OAcked/1Unacked 172.23.13.19:19/myAlarmList/4 Default Alarm Class 255 Window open
A 02-May-179:33:52 AMCEST  Offnormal OAcked/1Unacked 172.23.13.19:19/myAlarmList/1 Default Alarm Class 255 Errorin Pump Hesting
.‘ 02-May-17 8:33:5TAMCEST  Offnormal OAcked/11Unacked Alarm Critical Alarms 255 Pump Error
! 02-May-17 8:14:13 AMCEST  Mormal OAcked /2 Unacked  SBClpMetwork_Demo Devicel Defsult Alarm Class 255 Ping Success
! 02-May-17 7:24:01 AMCEST  Mormal OAcked/1Unacked  172.23.13.19:19/myAlarmList /2 Defsult Alarm Class 255 Shortcircuit
! 02-May-17 7:24:00 AMCEST  Normal OAcked/1Unacked 172.23.13.19:19/myAlarmList/3 DefaultAlarm Class 255 Power breakdown
! 02-May-17 T:23:5TAMCEST  Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/5 DefaultAlarm Class 255 General error
‘ 02-May-17 7:21:27TAMCEST ~ Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/8 Default Alarm Class 255 Error@
‘ 02-May-17 7:21:26 AM CEST Normal OAcked/1Unacked 172.23.13.19:1%/myAlarmList/7 Default Alarm Class 255 Error?
A 01-May-17 10:00:37 AM CEST  Offnormal 0Acked/1Unacked BacnetNetwork Trainingscenter Defsult Alarm Class 255 Ping Failed
A 01-May-178:32:22 AMCEST  Normal OAcked/1Unacked 172.23.13.19:19/myAlarmList/6 Default Alarm Class 255 Erroré
1_. 18-Apr-17 7:50:44 AM CEST Normal OAcked/1Unacked SBCIpMetwork CPUOOL Default Alarm Class 255 Ping Success
‘ 13-Apr-17 4:19:14 PM CEST Normal OAcked /36 Unacked slot:/Drivers/BacnetNetwork/Trainingscenter/alarms  DefaultAlarm Class 255 Narmal
.‘ 12-Apr-17 12:47:14PM CEST  Offnormal 1Acked /0 Unacked  172.23.13.19:19/myAlarmList/1 Default Alarm Class 255 Errorin Pump Heating
.‘ 12-Apr-17 :43:29 AM CEST offnormal 1Acked /0Unacked  172.23.13.19:19/myAlarmList/2 DefaultAlarm Class 255 Shortcircuit
.‘ 12-Apr-17 ::43:29 AM CEST Offnormal 1Acked /0Unacked  172.23.13.19:1%/myAlarmList /& Default Alarm Class 255 Erroré
.‘ 12-Apr-17 4323 AM CEST Offnormal 1Acked /OUnacked  172.23.13.19:1%/myAlarmList/5 DefaultAlarm Class 255 General error

Current alarms are indicated by a red icon, retuned to Normal alarms are
indicated by a green icon.
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4. Double click an alarm line to open the Alarm Viewer. This will list all current and

cleared alarms related to the same alarm condition:

@ locals| sloty/ Drivers/SBCS2 SBCIp  Demo/Devicel/points/Heating/Supply/Pump/Alarm/Alarm x
Timestamp Source State AckState Source Alarm Class  Priority Message Text ®

M 02-May-178:33:5TAMCEST  Offnormal  Unacked  Alarm  CriticalAlarms 255 Pump Error

A 13-Apr-17 10:45:40 AM CEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 18-Apr-17 10:37:45 AM CEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 18-Apr-179:33:09AM CEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 18-Apr-179:3144AMCEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 13-Apr-179:08:39AM CEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 18-Apr-178:38:09AM CEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 18-Apr-178:06:38AM CEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 18-Apr-1TT5853AMCEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

A 13-Apr-174:14:29PM CEST  Normal Unacked  Alarm  Critical Alarms 255 Pump Ok

A 13-Apr-172:3T:58PMCEST  Normal Unacked  Alarm  CriticalAlarms 255 Pump Ok

& Acknowledge . vyperlink 7 Notes [} Review Video [¥] close

7
5. Double click an alarm to open the Alarm Record, giving full details of the alarm. .

“® Alarm Record

Timestamp b2-May-17 8:33:57 2M CEST
Uuid 11£20d495-73ab-4601-82d8-8e650d54cabd
Source State Offnormal
Ack State Unacked
Ack Required true
Source Rlarm
Alarm Class Critical Alarms
Priority 255
Normal Time null
Ack Time null
User Unknown User
Alarm Data Alarm Value true
Count 21
Escalated
From State normal

Message Text Pump Error

Notes >>

Numeric Value 1
Offnormal Value true

Present Value true

Source Name Rlarm

Status {ok}l @ def

Time Zone Eurcpe/Berlin (+1/+2)
To State offnormal

Alarm Transition OCffnormal
Last Update 02-May-17 8:33:57 EM CEST

{ | a Acknowledgze | I Hyperlink E Notes

local: |station: |slot:/Drivers/SBC Systems/SBECIpNetwork Demo/Devicel/points/Heatingl/Supply/Pump/Alarm/Alarm

[¥] close 4

To acknowledge an alarm:

1. Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record

for a specific alarm.

2. Click the Acknowledge button.

Multiple alarms can be selected and acknowledged at the same time in
the Alarm Console or Alarm Viewer by clicking in conjunction with CTRL

and/or Shift keys.
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To view or add notes for an alarm:

1. Click the alarm in the Alarm Console or Alarm Viewer or open the Alarm Record
for a specific alarm.

2. Click the Notes button. The Notes window is displayed and any previously added
notes will be shown with a timestamp in the top section:

» Notes X

## 02-May-17 8:39 BM CEST - admin ##
There i3 a serious bug in the syatem. Do not panic!

My shift is over. I drink a beer.

P Add Note | E] Close |

3. Type any new details in the lower section and click the Add Note button to save, or
click Close to close the window without adding a new note.

ﬂ You cannot add notes to multiple alarms.

7229 Viewing and changing Occupation Times (Scheduler and Calendar)
in Saia PCD® Supervisor

Changing the Weekly Schedule

The weekly schedule determines the occupation times for a normal week, i.e. no Spe-
cial Events apply.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired WeeklySchedule.

2. Double click the WeeklySchedule. The Scheduler is displayed in the view pane.
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3. Select the Weekly Schedule tab.

4. Specify the required occupation times:

To add a new time period:
Drag the mouse in the required white area of the grid.

To make adjustments to existing time periods:
Drag the top or bottom edge of the green rectangles to the required time.

To set all day occupation:
Right click the day and select All Day Event.

To a apply a period a day’s times Monday to Friday:
Right click the day and select Apply M-F.

To remove a time period:
Right-click the rectangle and select Delete Event.

To remove all time periods for a day:
Right click the day and select Clear Day.

To copy a day:
Right click the day and select Copy Day then right click the day the times
are to be copied to and select Paste Day.

5. Click Save.

Editing Special Events

Special events enable different occupation times to be used on specific days.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the re-
quired BooleanSchedule.

2. Double click the WeeklySchedule. The Scheduler is displayed in the view pane.
3. Select the Special Events tab.
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Name Summary [ =3
‘SwissS2420NationsIS24200sy  Dste: 1 Aug201T

7 m o,
o
BB numscheduleselector

4. Specify the required Special Events:

@add  @Edit o prioity ¥ Priority [ Rename X velete

B eskySchedule | B speciaEvents B Provertes @ summary

Add a special event
1. Click Add. The Add dialogue box is displayed.

o Add bt

Name Christmas

Type |DateRange

25 Dec Any Year m
Through
26 Dec Any Year m
OK | Cancel ‘

2. Specify a name for the special event in the Name box.

3. Select Date or Date Range in the Type box.

Specify the date(s) the special event applies to:

Date: Specify the day month and year in the appropriate box.

Date Range: Specify the day month and year for the beginning of the range in the
appropriate box in the top row and specify the day month and year for the end of
the range in the appropriate box in the bottom row

4. Click OK.
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Edit the times
» Click the special event for which the times are to be edited.
To add a new time period:
Drag the mouse in the required white area of the grid.

To make adjustments to existing time periods:
Drag the top or bottom edge of the green rectangles to the required time.

To set all day occupation:
Right click the day and select All Day Event.

To remove a time period:
Right-click the rectangle and select Delete Event.

To remove all time periods:
Right click the rectangle and select Clear Day.

To ensure non-occupancy outside the specified periods
Right click the day and select Schedule Defaults.

Rename a special event

1. Right click the special event that is to be renamed.

2. Click Rename. The Rename dialogue box is displayed.

Name Summary

Christmas = g nge: 25 Dec- 26 Dec
Add

Swiss52420Mational 524 Aug 2017
Edit
Rename

Priority
Delete

3. Enter the new name.

4®» Rename *

@ EnterMame

OK | Cancel

4. Click OK.
5. Delete a special event

6. Right click the special event that is to be deleted.
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7. Click Delete. The Confirm dialogue box is displayed.

™ Confirm x

@ Delete "Swiss52420National52420Day"
Yes ’ No

8. Click Yes.

9. Click Save.

Editing the CalendarSchedule

If a CalendarSchedule has been added to specify days different occupation times are
used, these days can be edited by add or removing events from the CalendarSchedule.

1. In the Nav tree open Localhost > Station(Demo_station), navigate to the required
CalendarSchedule.

2. Double click the CalendarSchedule. The Scheduler is displayed in the view pane..

[c> Saia PCD® Supervisor - X

- Nav [] A Preveage  { Prevhonth Today | NextMonth b NextPage b

e Sz Sz prr e ez ey Secan
smtwt tsflsmiwe o s|lomiwetslfsmiwe i s|fsmiwits|[smiwttsffsmiwets|lsmiwers
N - B0 EE) : T2 iy e s e I 2

7sowunnmnlles s 7509|2365 678 [6780wnunl|sess7509[sonwnnnnlssrssnnllsessas
1615 16 17 18 19 20| |1 12 13 16 15 15 17| |9 10 1 12 15 16 15| (13 16 15 16 17 15 19 [10 1 12 13 26 15 16| |15 16 7 15 19 20 21 |12 13 26 15 16 17 18| [0 W 2 B w15 16
nasussu|jpvnazsx|ltrssnnn|narsess|ltssnans||lasess sl nrses|lvssnans
52 %0 a 5% u s ||52856a 86 |08n0n %25 2% 7 % 2 2| |2 05 52880 %25 2% 75 » B
EX El

Name  Summary

BB enumscheduleselector
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Add a date
1. Click Add. The Add dialogue box is displayed.

@ Add X

Name Event

Type |Date

Any Weekday 2 May 2017 ]

OK Cancel

2. Specify a name for the special event in the Name box.

3. Select Date or Date Range in the Type box.

Specify the date(s) the special event applies to:

Date: Specify the day month and year in the appropriate box.

Date Range: Specify the day month and year for the beginning of the range in the
appropriate box in the top row and specify the day month and year for the end of

the range in the appropriate box in the bottom row.

4. Click OK.

Edit a date
1. Double click the date that is to be edited.

2. Edit the date as required.

Rename a date
1. Right click the date that is to be renamed.

2. Click Rename. The Rename dialogue box is displayed.

Name Summary

Christmas i rioe: 25 Dec- 26 Dec
Add

Swiss52420Mational 524 Aug 2017
Edit
Rename

3. Enter the new name.

<®» Rename X
@ EnterMame

OK Cancel

4. Click OK
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Delete a date
1. Right click the date that is to be deleted.

2. Click Delete. The Confirm dialogue box is displayed.
3. Click Yes.
4. Click Save.

7.2.210 Viewing a History (Graph)
1. In the Nav tree open the History folder (Station > History).

2. Open the folder for the required controller.

3. Double click on the history that you wish to view. The Chart view is displayed.

. [> Saia PCD® Superisor = .
s " . 2

B © B Today @ ABDoo &
Heatingl_Outside_Temperature_PhysVal @ Heatingl_Outside_Temperature_Physval

40.000

20.000

20.000

10.000

0.000

110000

20.000
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Viewing Multiple Plot Graphs

To add another plot to the same chart:
Drag the required history from the Nav tree onto the Chart view.

Adjusting the Displayed Information

To change the displayed time period:
Use the selector (at the top left of the Chart view) to choose the required
time period.

To change the horizontal scale:
Mouse over the appropriate scale until the cursor changes to a double ar-
row.
Drag the mouse left or right to change the scale.

To change the vertical scale:
Mouse over the appropriate scale until the cursor changes to a double ar-
row.
Drag the mouse up or down to change the scale.

Viewing the Source Data

To view the source data in table form:
Click the View Changer and select History Table.

Exporting a Graph or Data Table

1. In the Nav tree, right-click on the required history and select Export. The Export
dialogue box is displayed.

2. In the Select Exporter box select the required export type and file format.
3. Choose the export method (e.g. Save to File).
4. Click OK.

Viewing Live Updates

1. View the desired plot (as described above) and change the view to History Chart.

2. Click the Play button » to start getting history updates. At the bottom right corner
of the window the message ‘Waiting on first Live Update...” will appear.

3. When the time period has elapsed the message will change to show ‘Last Live
Update’ with the date and time of the update.

If you zoom in on the chart, live updates will not be visible anymore. If you
need to see values that are not visible on the chart you need to switch to
History Table view
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1

2.

Manual start the Saia PCD® Supervisor Station

In the Nav tree open
My Host > Station(Saia PCD® Supervisor) > Platform > Services.

Double click Application Director. The Application Director is displayed in the
view pane.

[@ Saiz PCD® Supervisor -8 x
File Edt Search Bookmarks Tools
4 D-o A O o =~ B b B
My Host: SASLTIOSGHR2 gobsldshoneywellcom © Platforn 7/ pplcationDirector -
- Nav [ Applicat rector
"] ® nyNetwork Connecedtolocathost
Name Type Status  Detals AutoStart Restarton Fallure "
My Host: SZE3LTJOSGHF2 gobalds honeywell.com
° Blatie_tes saton Idle fornafommniohtpniofitpsna  fale tue
@ wyFlesystem
Certiab 04 saton dle foenlafosn/shtpnlaitpena s tue
O wywodies B cetan S il
£ iyTonts 5 bemo_Station soton ldle  foelSitfosSIhtipn/ahtipts tue e
e plaiom SN sation dle  fornafomsniohtpn/ofitpna  false  tue
® applicston birector 5 sacee final sation idle  foen/afosmn/ahtip=n/shtpsn/s  folse e
© Certiicate Management 5 sec._sBus Testt station Idle false e
O Loscaninsaler S sec_Tua0us Wrkshop saton ide e e
License Manager
° g [Srm— soton 1dle e
©Q platform Administration =
Triing Center V1 sttion Idle e e
@ station opier
6 1cpiP configuration 10 {10: a'u nz my-n c:sr) Shelpiriver] *e4es Signed value in converclybekuy‘lnsiwnedmc i 3 -ie B autostart
3 Fo 10 Shclpbriver] *++++ Signed value in co Er
© remoteriesysien o 10 Shctabeiver] oo Sioned velue i comvertor [Ertr s
v 127,00, (Deme_Staton) 10 Sbclpbriver] +++++ Signed value in mnver:!ycekuv‘lnsmedl‘n:
= Fo 10 Shclpbriver] *++++ Signed value in cor osignedln:
& Station (Demo_Sation) o 10 Soclpbriver] 444+ Signed value in cor SignedInt 13 ==
10 Sbclpbriver] 444+ Signed value in conver:lvceknvl‘nsiwneal‘n:
Fo 10 Sclpbriver] *++++ Signed value in co edlnt Restart
meo 10 e in co guedla 13
10 Sbclpbriver] +iees in convertbvzeknvxnsmeamt RebooE
1E0 (10! Selpbriver] e in o 19 ::: 167
R0 10 = il
Sbclpbriver] tiees in
1E0 Selpbriver] +ier in Dump Threads
e e in
1E0 Sbclpbriver] tiees in Sarcbod]
1E0 Selpbriver] +eers in S
) = ety
Soclpbriver] tiee ue in
1F0 Selpbriver] +eer in o
e e in
- Palette Sbclpbriver] e in Pause output |
U Shclpbriver] +eers in =
e e e in Output Dialog
® X D § e e Soclpbriver] e e in
ScTpbriver] weses in Stream To File
BB Bookeanschedule e iy wn =
BB Enumschedule mE0 Soclpbriver] seers in converclym:nﬂusiwnedlnc Output Settings
e ToSign
BB humericschedule e Soclpbriver] e i comercoceRsavIosimealnt 52
£0 Shclpbriver] seees in converclyukuv‘iusiwnedlnc
BB stingschedule e yeehrrayToSignedlnt
e Soclpbriver] s o e tiee rasiiee e
BB calendarshedue 0 Shclpbriver] tiees in convertBycerzayToSignedInt 13 1:: ~191
s mro Soclpbriver] *++++ Signed value in converthyrehrrayToSignedlnt t)
(et e console] Quic
B8 BooleanScheduleselector 0 23] Seving station...
mro sy3] Saved C: ¥ bog (22283
BB Numericshedueselector e fox] Closed: 1 < Workbench @
BB suingscheduleseector = o s e
R e fox] FOK server stopped on port
BB umschduleslet 20 fox) Rk servar stopped on port 14911
mE0 veb] devey seepped.
e s3] Services stop
e Genkay-17 CosT] (sya] o Seacion shetdom +++

Click Start.
The station will be started, check that a ‘Station Started’ message is shown.

[ Saia PCD® Superisor

Flle Edit Search Bookmarks Tools Window Help

My Host: SZ43LTIOGGNF2 global.ds.honeywell.com Platform /  Application Direct]

- Nav [ Application Director
¥ o © o evwarc Connectedtolocathost
Name Type  Sttus  Detais AutoStart Restarton Faiure "
My Host: SZE3LTI0SGHF2 globilds haneywellcom
Cry < “ 5 atia tes2 sation e foenjsfoseniahtpen/ahtpns  fase tue
@ wyFilesystem
© wymodies 5 centab_os sation e fon/sfouenahtpen/ahtpen  fase tue
) = permo_staton sation Running for911 foxmiSLL ttpen/e hitpenid3 true  tre
& Flatform S sncene station Idle foxsn/a foxsen/ahtipen/apttpsnfa false true
© Applicstion Director 5 saceos s station idle  foxen/aon tpmnishtps=n/s  false true
© certfcate Management S sec_sBus_Testt station Il forn/afoxs=n/ahttp=n/ahttpsn/a  false true
© Loscon ander S SeC_TM2016 Workshop station Ide  for/aforn/ahtpeniahtosa  folse tre
S S sttionsupos saton e foejsfosnahtpenahtpsna  fase e
© PlttormAdministation
Eronng centerys ston de  foen/sfoxniampnahona  fose tue
@ station Copier
e 580 (rze) tamncnies Mison fanciee sovizorsene B vtostat
a1 fnee] Bootiog
@ remoteFiesystem 5] Logging inicialized Restarton ilre
2. regiatey) Up-to-date (139
127003 (0emo_Staton) el 5 B e start

e ——— Soe meered (rcx -2.36.347) on (834129)

3y2] Loading "C:
Spclphsives] +eess BSbcbpComiontiy ie initialissd

siver] *eses BSpcUdpComConfiy is initislised

alorn. davabase] loaded [32ms, 90 alarms, 164 pages]
sye] Services Inivialized (375ms)
sys.mixin] Updated [0ms]
Sagdictionary] Niagara tagdictionary is out of date or has been modified.
cagiicrionazy) Misgazs agsicrionasy has been reloaded.

g e |
Jetty veb serves started on HITES port 4
sbcmnnvexl L Now i BShelipComContia- Baketesaagetactory +1ts TR

(Spclpbriver] Device pingis

Pause Output

~ Palette
R D chede

BB Booleanschedule
BB Enumschedule.

BB Numericchedule
BB singschedule.

B Calendarschedule
BB Triggerschedule

[ To— INFO [10:04:04 02-May-17 CESI] [sys] Niagara Runtime Environment: 4.2.36.34
B numercsedulsdecr INFO [10:04:04 02-May-17 CEST][sys] *** Station Started (1344ms) [11855m3 total] ***
BB stingscheduleselector

BB EnumscheduleSelector

20x] FOX server started on port [1911] utput Dialo
fox] FONS server started on porc [4911] Output Dialog.

Stream To File

u: Funtize Envizonpenc: §.2.36
(5ys] *++ Station Started (134dms) [11655ms total] ++%

TNEO (10:04:05 02-May-17 CEST) [nistory.db] s cory confiq index warmup completed in Output Settings.
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7.4

HTML5 Enhancements

HTML5 Enhancements

Improved and newly created base templates for improved usability, also for mobile
devices.

B Time program view improved
® (complete in HTML5)

E
]
i
i

[r
ST o . T

B Alarm console new
® (complete in HTMLS5)
® Improved use of available space
® Responsive: details fold-out, automatic scaling

B Role manager new
® (complete in HTMLS5)
® |Improved use of available space

Weekly Schedule

H
i
i
i

[re
T o fropr. jet
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Cloud Connector

7.41 New reporting functions

B All reporting visualizations are fully inte-

grated in HTML5 - Palette 7

- El @ ir(-port

0 ReportWidgets

B Responsive design for mobile devices %) Canvaspane
E BoundLabel
m BoundTable

. 0 Reporting

B Can now also be used in the dashboard © revorsenice

D ExportSource

B2 EmailRecipient

B Improved export functions D) FileRecpient
[l eqlerid

E ComponentGrid

0 GridExamples

B Predefined examples in the palette 1] Atpointseqlcrid

E AllPointsNeqlGrid
7 E RelativeBqlGrid
B NEQL and BQL can be combined S

E PointListComponentGrid

—

7.5 Cloud Connector

Enables station to establish secured connection to the cloud

service

B Included in installation and at no ad-
ditional cost - Part of Software Mainte-
nance Service (SMA)

B Reduction of operating costs
B Improved uptime, reliability and energy
efficiency
B Reduce data loss with automatic backup
Ty

B First cloud offers: Cloud Connector Device Registration

® Backup as a Service (BaaS) - offers
secure and scalable backups in the
cloud (Available from Tridium)

® Action management - manage com-
mon priority problems from anywhere
using the app

® Performance Analysis - Automatic Er-
ror Detection and Notification

Device Registered (£]
Cloud Connector Enabled ]
Device Connected Q
System Type Plant

System GUID - none -

REGISTER DEVICE
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7.6

7.7

Bulk deploy

Bulk deploy

A single action can create multiple instances of one or more templates on a station

B The mass provision process includes these primary steps:
® Select a template and create an Excel file from it
® Each Excel worksheet contains a row with the unique information required by
each Device
® This “customized” Excel file is selected for mass implementation and extracts all
configurations into the respective Devices

[ Draw '8ge Lyout Ormuiss  Data PTG oot ot yous yeand 40
e = 5
S w - & & P wepTen Ganers E p |y € x m| X ‘%"_' p
- # - - T
Paste . o €0 go Conditionsl Formatss Cel nsert  Delete Format Sot & Find &
5 B I U. -Mn-A- € 35 SiMegedConer - B9- 96 9 G N fommattng- Tabler siles- . lter - Select -
Oipboasd - Fort Angrarent 5 Hurmiar g Stytes ol Fektirg ~
G2 o f: hs:geaAdds v
A B c D E F G H 1 ] K L L
1 Template Deseription 1 Configs
2 Slot Name he-gecAddr hs:geoCity hs:geoState
3 User Tip
4 Slot Type baja:String " baga:String " baja:String
5 Default Value
& Parent Companent Slot Path " Deployed Name “Display Name " Position "Unique Device 7 Description
7 Drivers/BacnetNetwork Floor2 Floor 2 Thames Hotel Nisw Orieans Lousiana
8 Drivers/BacnethNetwork Floord Floor 3 Thames Hotel New Orieans Louisiana
9 Drivers/BacnetNetwork Floord Floor 4 Thames Hotel New Orieans Louisiana
10 Drivers/BacnetNetwork FlooeS Floor 5 Thames Hotel New Orleans Louisiana
"
12
Tridium-Floorntpl Tridi pl | Tridum Standard ntpl 2
Beady : count3 R - (] + '_v-\J

VykonPro modules (on request)

The VykonPro module is a collection of station components and px widgets that are
provided as a value add to the Vykon channel partners. The station components and
px widgets only function in a station whose license is branded Vykon (brandld="vykon”
or brandld="vykon.security”). There are no extra features required in the license file for
the components to function.

B These tools are designed to save - Palette & + Palette 5]
programming time, extend the standard Ao X B @ wkeorroTansom
offering, and help with system develop- @ whoneroeula (3 TebleTotistory
ment O PR HistorySourceDelts

B WykonProservice TransformChartPane
B A demonstration station called "vy- (=)
" X . Q conversion - Palette =
konProTest" is available from Niagara O enerry
) W [x] 5 | § vwkonproutil
Central g:'m .
. . IVaC atch CategoryAssignmentTool
® The station shows how each single O e S
component can be implemented in g°°'"‘5“ 81 BatchProxyConversionEditor
report arms
the vykonPro modules O serestransiom 8:0.,“”""3“5
Q timer ) )
O © AbsTimeOverrides
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7.8

Setting customized login and background logo

This chapter describes how an user can add and save the customized station login
design with customized background logo.

Adding slots for customized login and background logo

1. In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Services.

Nav

# O & My Network

© searchsenvice
» ) TagDictionaryService
» @) Templateservice
@ webservice
» 4 BatchJobService
» = EasyDatabaseManagerservice
» T PlatformServices
» [ SeiaPGs0ataimportiizard
Galileoservice
- @ privers
» O nisgaraNetwork
» O sacnetietwork
» @ ModbusTepNetwark
» @ apps
b @ Files
» (&) Hierarchy
B
- Palette

W X B @ sslicosupervisor

b Galileoservice

- Easy Templating

2. Click on WebService.

Property Sheet

@ webservice (Web Service)
[ status
[ Fault Cause
[l Enabled

» [ Hitp Port
[ Http Enabled

» [l Hitps Port
[l Https Enabled
(@ Https Only
(Ml Https Min Protocol
[ Cipher Suite Group
(gl Hitps Cert
[l Require Https For Passwords
(@l X Frame Options
[l Remember User Id Cookie
(W Allow Username Autocomplete

[ Login Template

B

(3l LogFile Directory
» [Ji Client Environments

(Wl Show Stack Trace

[ web Launcher Module Caching Type
» [l Web Launcher Config

» [l Cache Config
» [l Hostname Redirect Settings
b @ sertywebserver
» & user Data Storage
[ force Custom Login Settings at Restart

fok}

@ true

80tcp

[ ™
443 tcp

[ I

@ true

TLSvL.0-
Recommended
tridium

@ true

Sameorigin

@ true

@ rrue

@ oull

file:~ weblogs
Client Environments
@ false

Host

Web Launcher Config
Cache Config
Hostname Redirect Settings
Jetty Web Server (started)
User Data Config

@ false

3 Refresh |

[M) save

3. Go to the AX Slot Sheet view from the View Selector.

4. Right click on the page and select Add Slot.

5. The Add Slot dialogue box is displayed. Type the correct and same name in the
Name area. Select the required Type. User can select baja Ord or baja String.

Click OK.

(O Property 3 httpPort ™ Add Slot |aja:serverPart
(O Property 4  httpEnabled | |aiz:Boolean
Name
O Property 5 httpsPort logo @ja:ServerPort
Q) Property &  httpsEnabled |aia:Boolean
Type
Frope: 7 httpsOnly aja:Boolean
O Property el baja string m - P
O Property 8  httpsMinProtocol _ aja:SelTIsEnum
O Property 9  dpherSuiteGroup | Flags OrdList gja:TlsCipherSuite
O Property 10 httpscert ([ operator [0 Mo Audit  OrdToCategoryMap |aia:string
'y ) -, Password
O Property 11 requireHttpsForPa [ Readonly (| ' o |gia:Boolean
[ T PasswordAuthenticator
(O Property 12 xFrameOptions (JEmrrRear) [ [ieover oot ok yeb:xXFrameOption
[ Execute On Change [] Metadata :
O Property 13 rememberlserdC PasswordHistory |aia:Boalean
|| [CINEasEnt [Tk Tsree :
QO Property 14 allowUsernameauf . L PasswordSirength |aia:Boolean
O summary [ Non-Critic SRR o
(O Property 15 loginTemplate I T SN ORRITO aja:Typespec
LIRS [ Userbefin Permissions
Property 18 ipEnabled lja:Boolean
O Rery B4 O Fanin [ userDefin PermissionsMap e
O Property 17 logFileDirectory E' Hidden D UserDefin puoview aja:0rd
O Property 18 cientEnvironment [C] et n [ userDefin RelTime yeb:ClientEnvironr
(O Property 19 showStackTrace Relxtior |sia:Boolean
.................. o ninl
) Property 20 appletModuleCach rebiappletModule
O Property 21 webStartConfi ok | _cancel febiebstartConfi
O Property 22 cacheConfig Cache Config Frozen web:CacheConfig
O Property 23 warmupConfig Warmup Config Frozen hN web:WebWarmupCi
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6. Similarly, create one more slot for the css login. Click OK.

For more details on how to add or edit a Slot, refer to Tridium Niagara
documentation docuser file which is available in the Niagara workbench.

7. Go to the AX Property Sheet view from the View Selector.

To set the customized logo background colour:

1. Go to the newly added logo property.
2. Click Folder icon. The File Chooser dialogue box is displayed.

3. Select the required logo image file.

Property Sheet
@ webService (Web Service)
[ Status {ok}
. Fault Cause
@i Enabled ® true
b [ Http Port 80 tcp

9 Aty Fnabied | ® File Chooser X

» [l Https Port

[l Https Enabled i D FileSpaces [
Alogin
4

= |
[ Https Only &) Files on Station (SBCImpe =
I o A B SRERCIES -l

[l Https Min Prota | @) My Modules

— favico.png
.l Cipher Suite Gri =

[ Https Cert R e
— login.css

(W Require Https F 0 toer

= logo.svg

Ml X Frame Option E h

[ Remember Use d
o Loading Preview
(@ Allow Usernam R Bookmarks [ ¢
[ Login Templata
[ Log File Directo| [ 4
» [ Client Environn]

[ Show Stack Tra

?. Web Launcher K Filaname: [Togoravg Open
: . Webaunchey Files of type: AllFiles(".") Cancel
» U Cache Config
b [l Hostname Redirect Settings Hostname Redirect Settings
r & JettyWebServer Jetty Web Server (started)
» & User Data Storage User Data Config

[ force Custom Login Settings at Restart | false
. logo null - M

[ loginCss null - b

4. Click Save to apply your changes.

To set the customized css login:

1. Go to the newly added css login property.
2. Click Folder icon. The File Chooser dialogue box is displayed.
3. Select the required css file with login details.

4. Click Save to apply your changes.
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7.9

In order to access Force Custom Login Settings at Restart property, user
must add the GalileoService in the Nav tree under the Services portal from
Palette. For more details, refer to Tridium Niagara documentation docuser

To retain customized css login and logo after the station restart:

1. Go to the Force Custom Login Settings at Restart property.

file which is available in the Niagara workbench.

2. To retain customized css login and logo even after the station restart, select the

Force Custom Login Settings at Restart property to true.

- Nav B
tf+ C () My Network

O Auditristoryservice
O LogHistoryService
@ Programsenvice

O searchsenvice

© Tegbictionaryservice
B) Templateservice
© webservice

4 BatchJobservice

O Bascnetnetwork
© ModbusTepNetwork
0 snne
- Palette 5l

W X B @ sslicosupervisor

[ catileoservice

- Easy Templating Fa

Property Sheet

© webservice (Web Service)
(8 Status
[ Fault Cause
(W Enabled
(@ Http Port
(J Http Enabled
[ Https Port
[ Https Enabled
[ Https Only
[l Https Min Protocol
[ Cipher Suite Group
(gl Https Cert
(g Require Https For Passwords
(W X Frame Options
(i Remember User Id Cookie
[ Allow Username Autocomplete
(J Login Template
[l LogFile Directory
[J Client Environments
[l Show Stack Trace
(gl Web Launcher Module Caching Type
[ web Launcher Config
(3 cache Config
[ Hostname Redirect Settings
@ JettywebServer
& User Data Storage
[ force Custom Login Settings at Restart
(g logo

[ loginCss

& rull
file:~~wenLogs

Client Environments

@ false

Host

Web Launcher Config
Cache Config

Hostname Redirect Settings
Jetty Web Server (started)
User Data Config

@ foie

@ false 1ogo.svg - -

file:~1lyin/login.cas -

7 Refresh | [M] save

3. To override customized css login and logo on station restart, select the Force

Custom Login Settings at Restart property to false.

Headstation and Substation Ping Read Timeout

The communication between the headstation devices and substation devices is critical
and need to ne consistently synchronous. Particularly for the substations, it takes more
time to get the response for the request sent compared to the headstation.

To overcome this difference, a new “Headstation Ping Read Timeout” property slot is
introduced in Headstation devices. Similarly, a new “Substation Ping Read Timeout”

property slot is introduced in Substation devices and the read timeout is increased from
250 millisecond (ms) to 4000 millisecond (ms) by default.

This conversion is only valid for SBC specific media types.

Using a Headstation Ping Read Timeout property slot:

1. In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Drivers.

2. Go to SBCIpNetwork and select the Headstation.
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3. Go to the AX Slot Sheet view from the View Selector.

Headstation and Substation Ping Read Timeout

4. Select the Headstation Ping Read Timeout property from the Slot list. Right click
on it and select Config Flangs.

5. The Config Flags dialogue box is displayed. Remove the selection of Hidden flag.

For more details about Config Flags, refer to Tridium Niagara documenta-
tion docuser file which is available in the Niagara workbench.

() Froperty Z7 deviceName Frozen h BajacString
< Config Flags X
O Property 28 isProgramCH Frozen h baja:Boolean
O Property 29 programCRC) (] iGperaton [ No Audit Frozen baja:String
ot
O Property 30 statusErrorM ] Rea 17 Y te Frozen baja:5tring
o Property 31 wuid ired! | [ ] RemoveOn Clone Frozen rhd baja:Uuid
O Property 32 statusUuld i e D Metndsta Frozen rhd baja:Uuid
[l ianksarget
O Property 33 pingRetryCol - Frozen bajainteger
O Non-Critical
O Action 32 readAlarms [ = Frozen haL woid (void
[ I Nestn ] UzerDefined 1
O Action 35 readMultiPoi D Fan In Frozen ha void (void
O Property 36 dataPollFreq Hidden Frozen h control:TimeTrigger
O Property 37 udpConfig a D&Q‘;uonclone er Defined 4 Frozen h sbesboldpCommConfig
O Property 38 headstationy || Aeiic Frozen h bajacinteger
O Property 39 SheSubStati Dynamic sbesSbeSubStation
0K I Cancel |
O Property 40 displayNameé. e ——— Dynamic bajaNameMap

6. Click OK.

7. Go to the AX Property Sheet view from the View Selector.

A €3 ork/Bacli/points/Loop$200

) Addition76 @) Head_01_SBCIP Device_IPTS

v @ orivers
b 6 NizgaraNetwork
w  seCipNetwork
» X TuningPolicies
« (@) Head_01_SBCIP Device_IP78
b © Alarm Sourceinfo
» B+ Datapoints Poll Scheduler

& Points
b (@ alarms
b Histories
» [l Device Information
b @ SBC subStation 01 ATE
» @) secsubstation 02_a78
b @ sBCSubStation 03_ATS
» @ sBCSubStation 04_aTS
¥ @ sBCSubStation 05_ATS
» ) sBCSubstation 07_aTS
b @ s8Csubstation 06_ATE
b Q) SBCSubstation 08_aTS
b © s8Csubstation 09_ATE
» @ secsubstation 10_AT8
b 0 Booleanwritable
b (D RegisterwritePointsub
b & Head_02_SBCIP Device_IP151
~ Palette

mE D [§em

b+ © printerRecipients
» O alsrmsenvice

b Lm AlarmClass

b B AlsrmClassFolder
b O Recipients

b O extensions

Property Sheet

© Head_01_SBCIP Device_IPT8 [SBCHeadStation)
(@ Status {ok}
(M Enabled @ tre

(@ Fault Cause
» O Health
» @ Alarm Source info
» [+ Datapoints Poll Scheduler
(@l Datapoints Poll Frequency
» (@i \p Address
(@ station id

Ok [04-Now-20 2:36 PM IST]
Alarm Source Info

N Poll Scheduler

Hormal

199.63.33.78:5050

78

(Ml Read Timeout 3000 ms [200- 60000]
» Q Points SBCPointDeviceExt
» @ Alarms Alarms
» () Histories Histories

» (M Device Information

(M Ftp Username

(M Ftp Password

(@ Http Password

" Program C R C Mismatcherror

(W Status Error Message

{J Ping Retry Count

'. Headstation Ping Read Timeout

© SBC SubStation 01_A78

'. displayNames

@ SBC Substation 02_A78

© SBC SubStation 03_ATS8

» ) SBC SubsStation 04_AT8
SBC SubStation 05_AT8

© SBC SubsStation 07_A78
SBC SubStation 06_A78

© SBC SubStation 08_ATS
SBC SubStation 09_AT8

» @ SBC SubStation 10_A78

» @ Booleanwritable

» () REgisterWritePointSub

S8CDevicelnformation
root

esessens
Program Version 4DCBC2C3 imported from B

3 [t-5]
250 I ms [250 - 20000]
$BCSubstation
{SbcSubStation20=5BC SubStation 05_A78:51
SBCSubstation
SBCSubsStation
SBCSubstation
SBCSubStation
SBCSubstation
SBCSubStation
SBCSubStation
SBCSubsStation
SBCSubStation
false {ok} @ def
56.0 {ok} @ def
) Refresh |

[ save

8. The Headstation Ping Read Timeout property slot is now listed in the Property
sheet with default value of 250 ms. This value is user configurable ranging from
250 ms to 20000 ms.
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Using a Substation Ping Read Timeout property slot:

1. In the Nav tree, open 127.0.0.1(localhost) > Station > Config > Drivers.
2. Go to SBCIpNetwork > Headstation > Substation.

3. Go to the AX Slot Sheet view from the View Selector.

4

. Select the Substation Ping Read Timeout property from the Slot list. Right click
on it and select Config Flangs.

5. The Config Flags dialogue box is displayed. Remove the selection of Hidden flag.

For more details about Config Flags, refer to Tridium Niagara documenta-
tion docuser file which is available in the Niagara workbench.

6. Click OK.
7. Go to the AX Property Sheet view from the View Selector.

- Nav A £) ork/Bacla/points/Loops200 () Addition76 | (@) SBC SubsStation 01_ATS
t O & My Network Property Sheet
P SE.-‘F,‘QAW,F © SBC SubStation 01_A78 (SBCSubStation)
X TuningPolicies [ stats {ok}
) Head_01_SBCIP Device_IP73 M Enabled @ tue
© alarm source info W Fault Cause
B+ Datapoints Poll Scheduler L2 Health Ok [04-Nov-20 2:36 PM IST]
@ Faints © Alarm Source Info Alarm Source Info
& Alarms e+ Datapoints Poll Scheduler N Poll Scheduler
® Histories [M Datapoints Poll Frequency Normal
[ Device Information (@ 1p Address 199.63.33.78:5050

© s8¢ substation 01_ATS (M Station Id 1

© secsubstation [l Read Timeout 250 ms (200 - 60000]
© sBCsubstation & Points SBCPointDeviceExt

© sacsubsts @ Alarms Alarms

© secsubstation M Device Information SBCDevicelnformation

@ secsubstation M Ftp Username

© s8C substation 06_AT8 M Ftp Password

© s8Csubstation 08_ATS M Http Password
+ @) s8Csubstation

@ s8C substation

(@ Program C R € Mismatcherror

. Status Error Message

Q Booleanwritable (M Ping Retry Count 3 -5
© RegisterwritePointsub M Substation Ping Read Timeout 4000 ms [250 - 20000;
@ Hesd_02_SBCIP Device_IP181
@) Head_03_SBCIP Device_IP183
@ Hesd_04_SBCIP Device_iP185
» & Head_05_SBCIP Device_IP187
~ Palette [Fa

L AR = I R

© printerRecipients
© alarmservice

# AlarmClass
B AlarmClassFolder
© recipients
© Extensions

7 Refresh [M] save

8. The Substation Ping Read Timeout property slot is now listed in the Property
sheet with default value of 4000 ms (4 seconds). This value is user configurable
ranging from 250 ms to 20000 ms.
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Setting up the S-Bus clock

Setting up the S-Bus clock

A new SBC Clock feature enables you to set the seven day clock which captures 14
times. Each day can be assigned with two values, On or Off. Also the same set SBC
Clock points can be read and write to the Saia PCD devices.

To add a S-Bus clock

1. Click on the folder icon under Palette. Open Palette dialogue box is displayed.

2. Select SBC IP Driver from drop down list. “Points” palette will be displayed under

Palette window area.

3. Go to Points. Select SBCClock and then drag and drop it to the Points folder of
required station or device under Nauv. tree.

= Nav
tt O (D My Network

O valuers
© valuezo
Q wiFile
QO win
© writ=:
QO write2
E Alarming
EA Holog
EA Hplogs
EA Holog?
Hs

» Hs

» @ sBCClock

@ alarme

M Device Information

= Palette
mE A E=
 saciphetwork
@ e
© Pcosubstation
» Ml PCDDeviceFolder
» B secPointFolder
O roints
© sacclock
@ secriag
@ secrlagvolatile
) secRegister
© secregisterflost

0 secinput
0 e

A € ..ork/Baci3/points/Loops200 () AdditionTe ) SBCClock

Property Sheet
© sBcClock (SbeClock
[ Facets
[F Proxy Bxt
(@ status
[ Fault Cause
(@l Enabled

[l Device Facets

(@ Conversion

(@ Tuning Policy Name
== Read Value

= Write Value

[l Memory Address
@ Data Format

= Dut

» o-

SBCProxyExt

{ok}

@ e
> O-
1= Default
Default Policy
1.00 [ok},0.00 [ok]},0.00 [ok],0.00 [ek],!
{ok}
B!
Signedint

1.00 [ok},0.00 {ok],0.00 [ok],0.00 [ok],!

@ Seclected Day ToWrite | Monday On

| M valueForSelectedDay 1220l

comments

[ mediaType dock
I_" MondayOn 1.00 {ok}
= MondayOff 0.00 {eok}
TuesdayOn 0.00 {ok}
TuesdayOff 0.00 {ok}
= WednesdayOn 0.00 [ok}
* WednesdayOff 0.00 {ok}
= ThursdayOn 0.00 {ok}
ThursdayOff 0.00 {ok}
* FridayOn 0.00 {ok}
 FridayOff 0.00 {ok}
== SaturdayOn 0.00 {ok}
SaturdayOff 0.00 {ok}
= Sundayon 0.00 {ok}
SundayOff 0.00 {ok}

7 Refresh ‘_mhve |

4. Now, the SBCClock Point is added under tree. Click SBCClock.

5. Set On or Off status for selected day (Monday to Sunday). Then, add the time in
the form of integer number type.
For example: Selected Day to Write - Monday On

Value for Selected Day - 1220.

6. Click Save to save data to supervisor.

7. To write the saved values into the controller/device, right-click on the AX Property
Sheet. Go to Actions > Set.
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7.1

Use of UDP config slot from the Property sheet in every headstation

To overcome the issue of exception from the overfilled stack, every workstation is

added with one UDP channel from version 3.0. Now, each headstation can process
32 transaction threads which can help to process received and sent requets. This will
enhance the communication speed and performance.

= Nav |Ea
#H O ) My Network
:l: Tuning Policies
@) Head_01_SBCIP Device 1P78
O Alarm 5c Views
IQ- Datapoi
o
& Points New
@ Alarms
(E) HistoricJRSIRETS
il 12ke Template
© sBcsub
Cut
Copy
Paste
Past
Duplicate
a SBC Sub|
Delete
9 SBC Sub
© sac sub LG Spy Remote
© secsub
9 Link Mark
© sscsub
© secsub
(=B oo jotion Mark
© secsub
D eoalea
L) REgister
- Palette Rename
SERR T
O PrinterRecipients
o AlarmService
A AlarmClass
9 AlarmClassFolder
D Recipients
O Extenzions

—

(O Property 33 pingRetryCount Ping Retry Count Frozen bajaiinteger

I::J Actian 34 readAlarms Read Alarms Froaen hal void (void

D Action 35 readMultiPoints Read Multl Points Frozen ha vold [void

Q Praperty 36 dataPollFrequency Alarms Poll Frequency Frazen h control:TimeTrigaer

O Property 37 wudpConfig Udp Config Frozen h shesbeldplommConfig
(:] Property 38 "e.}-cs:_\:mr{‘:sﬁgl-:eau'.u“-.e-'.-d: Headstation Ping Read Timeout Frozen bajasinteger
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8.1
8.1.1

Introduction

Saia PCD® Supervisor - Point View Widget

Introduction

Purpose and Deliverables of the Point View Widget

The Point View Widget is a browser-based interface designed for BEMS (Building
Energy Management System) users in order to perform the most common operations
requested to maintain and run any BEMS system efficiently.

The point view widget is interconnected with the standard Niagara user administration.
This provides a customized solution considering individual user requirements (restric-
tions) when working with point lists. The Niagara user administration allows any kind of
deep-structured definition for users. As an example, 3 typical BEMS user types (pro-
files), each having specific prerequisites and operational needs, are described in the
following:

Operator

» Familiar and comfortable with software based on standard browser technology
* No knowledge of BEMS internals

* Individual user access possible by user privilege management

» Viewing core information of points: value, status, alarms, and logs

» Search for names using wildcards

» Operations applicable to multiple points in one step

* Quick filtering for points in alarm, in overridden state, and with logs

» Saving point lists as favourites

Service Manager

* The service manager can apply all functions of the operator. In addition, the servic
manager can:

- Apply multi-string search with no need to know SQL
- Present and extract data as Excel report
- Easily access historical data and display point logs

- Convert complex schematics into an easy understandable tabular format for
a comprehensive overview of system health status

Partner

* Has super-user (admin) rights and can apply all functions of the operator and ser-
vice manager

* As a superuser having excellent expertise, he is able to design individual user
profiles (e.g. operator, service manager, etc.) which allow these users to take out
the required information from the BEMS effectively based on the usage of the point
view widget

* Needs less pre-engineering and post-customization to support the users

For detailed instructions on how to create user profiles using the Niagara user adminis-
tration, we recommend a training that can be provided by the corresponding Honeywell
TAC department.
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8.2 Prerequisites

In order to run the Niagara Supervisor and make use of the point view widget, make
sure, that the following prerequisites are fulfilled:

* Niagara 4.7 is installed on the PC
* The Modules folder contains the following Galileo modules:
- galileoPointListWrapper-rt
- galileoPointViewer-rt
- galileoPointViewer-ux
- galileoSignalR-rt
* The Niagara Workbench is started
* The platform is connected
» The station is running and connected

» The Galileo services “PointListViewService” and “SignalService” are available in
the “Services” folder. If the station is originally created based on a Tridium template,
n please refer to the “Selecting the Right Station Template “, page. 6 section for add-
ing the missing services to the station.

8.2.1 What's new with Niagara 4.7?

Point-List-View

» Standard view is now selectable

* PLV at global system level (no more missing data points)

» Tooltip for description

» Points are updated after station restart

» History extensions are also displayed via the log icon

» Set/ Override are configurable

* The PLV correctly displays the decimal places defined in the lexicon file

Default View w Actions -

Label ¥ Value ¥ Log Status ¥ Path = DataFormat ¥
© Register
& Flag

Alarm

ILamp_DO

IMaintenance

a

IPushButton_Di

a

Forwarded false down,stale, @ef DriversMerwark/AH... Boolean

Register
Qutput

© Fag

© Register
Prio8va

& Flag
Prio16En

© Register
Value
IntTirre

W4 W M 20 Updating point details_. |

8-2 Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05



Saia-Burgess Controls AG Saia PCD® Supervisor - Point View Widget

Prerequisites

8.2.2 Selecting the Right Station Template

In order to apply the point view widget, select the brand-specific template when creat-
ing the station, e.g. the Saia PCD Supervisor System template for the Saia Burgess

Controls AG brand. This adds the required services to the Services folder automatically.

If the station is created using a Tridium template, you must manually add the required

services from the “galileoPointViewer” and “galileoSignalR” palettes to the Services
folder as described in the following:

Procedure
1. In the Palette pane, open a new palette by clicking the Open icon.

= Palette

x E B | § wtcontrol
VI TERTRIPabette

b 0 Alarm
k 0 Constants
¥ O Conwersion

W

RESULT: The Open Palette dialog box displays.

s il
"= Open Palette g
Select one or more palettesto open, or just start typing: Browse...
% galil
Module Description B
galileoPointViewer Galileo point list view
galileoSignalR Honeywell Push Server for Niagara
galileoSupervisor IQVISION 2.20[ALPHA-1] - Galileo Common Supervisor- WB
OK | Cancel |

2. Enter ‘galileo’ or the first part of the string in the search field.

RESULT: The galileo items are displayed.

» Palette
w E] E i galileo PointViewer

B history N

i alarm

i galileoSignalR

[l PointListvie

i galileoSupervisor
i kitControl

3. Select e.g. ‘galileoPointViewer™ at first.
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Prerequisites

RESULT: The "PointListViewService" is displayed.
- Palette

w [EI E . galileoPointViewer

» [l PointListviewService

4. Select the "PointListViewService' in the Palette, and then drag&drop it to the Ser-
vices folder in the Nav tree.

* Nav

l:' o) X @M'JNew-ork

‘. Alarm

v e Config

) @ BackupService
@ categoryService
} G JobService

9 RoleService

o UserService

) 0 AuthenticationService
3‘ DebugService
@ BoxService

¥ Foxservice

@ Hierarchysenvice
@ HistoryService

v v T T OFT OFY OFT W

O auditHistoryservice
o LogHistoryService

G ProgramService
b O SearchService
° TagDictionaryService
TemplateService
@ webservice
T PlatformServices
» rivers
¥ gﬂus
» ° File
3 E Hiegprchy
4 @ Hisbry

- Palette

- E @ galileoPointViewer

» [l PointListviewService

RESULT: The Name dialog box displays.
5 Name u1

@ PointListWViewServic

0K | Cancel ‘

-

5. If desired, change the name, and then click the OK button.

RESULT: The PointListViewService" is added to the Services folder in the Nav tree.
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P @WebSemice
b T PlatformServices

b U PointListViewService

6. Add the "SignalService™ in the same way to the Services folder (see the following
screenshots).

-+ Palette Z
W X 3B |#§ selileosignalr

» % signalService
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Starting Niagara Supervisor

8.3 Starting Niagara Supervisor

Procedure

1. Open your browser and enter the IP address, URL, or hostname into the address
field.

2. If your browser does not allow a secure https connection, continue by applying the
unsecure mode provided by the browser.

RESULT. The Login dialog box displays showing the name of the station, in
this case “Demo”, in the title line.

! Username:|\admin

s Change User
Password:| |

n

Use of this software is subject to the

End User License Agreement and other Third Party Licenses

To connect using Java Web Start click here

3. If not already displayed in the Username field, enter your user name, and in the
Password field, enter your password.

4. Click the Login button.

RESULT: The Station window displays. The Nav tree is shown on the left and the
Config folder is pre-selected.

Config o® th PropertySheet v [3]

O actions & Topies  [B Slot Details

Display Mame Value Commands

(M StationMame  Demo

(W Sysinfo '
@ services Service Container

6 Drivers Driver Container

@ Apps App Container

QO Exercise Folder

Q Home Folder
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Starting Niagara Supervisor

8.3.1 Enabling Point View Widget

The points of the station to be displayed via point view widget can be located in any
driver and/or Niagara folder.

Procedure

1. After login (see “Starting Niagara Supervisor” section), expand the Config folder
and browse to the Home folder which typically displays the building graphically.

2. Double-click the Home folder.

RESULT: On the right pane, the building graphic displays.

Nav HomeDashboard HomeDashboard * E]
(M Station
© Config
gz Home N N N N
© Apps
© Exercise 2
| éOH«m Innovative | Performant | Scalable | Secure
e
A Histories
B Hierarchy

4 superwsor ¥}

3. Navigate to the plant by clicking the Plant button in the graphic.

RESULT. On the right pane, the plant graphic displays.

051082019 13:32 | User Demo |

Forward p [l 4 Total Building Alarms Unach Open A Logout

AHU 2D >
@ 189°C
OoN
@ 17.8°C
TimeRange |~ @ ?to? 1 Source(s) / 2 Alarmis) -
AT 050820191149 AirHandling-Unit general alarm  Offnormal Mir-Handling-Unit has at least one alarm eo... 255 OAcked /2 Unacked  AHU 3D

"B ACKNOWLEDGE B nores ® suewce Y s
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Starting Niagara Supervisor

Orin 2D:

05/08/2019 13: 1 |
& Tool g Ao imes o

Q AHU 2D

" Logout

| 5
—®
7V

\
100.0 % A @
0.0 % A‘( ‘- 178°C
HEM@ 00% HE® o07% L
v vl

4. On the upper right corner, click the drop-down listbox and then click on Point View
Widget in the menu.
AHU v [X
AHU
Point View Widget

Property Sheet®
AX Property Sheet
AX Slot Sheet

RESULT. On the right pane, the point list displays. By default, the list is displayed in
the Default View.

Building PaintView Widget (]
21 Points | Q) search by Point Label ] |{JH]LI@| ’ Default View - | Actions v
Label * Value * Log Status # Path
©  NumericWritable
SupplyTemp 20.88°C ol ok o, P
] OaTemp 115°C ol Lo, DaTemp
RecoveryTemp 16.00°C ak iD o1
MixedTemp 8.00°C ok 01 g
ReturnTemp 19.00°C ok o1 gl
H FLI_AI 21.00pf .0, g 141
FLI_AIR 30,00 % ok 01 112
OaDamper 100.00 % ak .01 logOutp
HeatValve B0.00 % ak o1 UAnalogo
ExhaustDamper 100.00 % ak /D1 (] AUrAnalagDy Damy
ReturnDamper 20,00 % ak o U/ AnBIogO
CoolValve 0.00% ok o, T CoolValve
FL1_AO1 3.80 ok logOutpuLFLY_ACT
FLI_ADZ B.00 ok IrAnalogOUtpULFLY_ADZ
HeatSetpoint 23.00 °C ok g
CoolSetpoint 18.00°C ok Dy _01, g
&  BooleanWritable
| ReturnFan (@ OFF alarm o1 LrBinaryO
SupplyFan & on ok Ursinaryc
RecWheel LW OFF ok o U/Binaryo
©  EnumWritable
PlantMode Auto ok o

n«.z»u

For a detailed description of the point view widget screen, please refer to the subse-
quent “Point View Widget Description” section, page 146.
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8.3.2

Starting Niagara Supervisor

Engineering Mode

When PointListViewService is activated the detail pane on the right side uses as de-
fault the PointView Widget.

Niagara default views assigned to the hierarchy elements listed in the tree on the left
side are inactive. During engineering activities this is not always an advantage. To
activate the Niagara default views assigned to the hierarchy elements the engineering
mode has to be activated.

Procedure

At the PointListViewService hierarchy element use right click Actions menu and select
Change Mode.

o LogHistoryService

@ Progra

0 Search Views

© Tagoictic Actions Add Configuration
!
: ad Configurations
&) Templa o Load Configurations

© webse Change Mode
T Edit Tags

H Pointuis Make Template

T Platfor Cut
© orivers Copy

Select Engineering Mode

% Change Mode X
Engineering Mode

OK | Canoell

RESULT: Standard Niagara default views assigned to the hierarchy elements listed in
the tree on the left side are active.

Engineering mode can be deactivated using the same menu selecting Live Mode.

£¢ Change Mode X
Live Mode

OK | Canoell

Engineering Mode will automatically be deactivated when user logs off or station is
restarted.
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Point View Widget Description

8.4

Point View Widget Description

This section briefly describes the components and functions of the Point Widget View.
For descriptions of the numbers assignment, please refer to the corresponding table
below and on the next page.

Building @ @ @ mmm? L]
e 21 Poinis | QO Searcn by Point Label ] O dh| & Default View - | @ @
ﬂ 6 Label ® Value # Log Status * Path @
e ©  NumericWritable
SupplyTemp 20.88°C olly ok
ol OaTemp @ 1154 0 ok X
RecoveryTemp 16.00°C ok X g
e MixedTemp B00°C ok 7
ReturnTemp 19.00 °C ok X og
e ¥y FLI_AI 21.00 pf 1A
FLI_AZ 30.00 % ok I 12
OaDamper 100.00% ok P
@ HeatValve B0.00 % ok K iR
ExhaustDamper 100.00% ok X
ReturnDamper 2000% ok
Coolvale 0.00% ok oolvalve
FLI_ADY 380 ok X 1800
FL1_AD2 800 ok X 1ACZ
HeatSetpoint 200 ok
CoolSetpoint 19.00°C ok X 8
® © BooleanWritable
| ReturnFan - OFF alarm
SupplyFan - on ok
Rectheel C OFF ok
@ EnumWritable
PlantMode Aute ok
Mo« . 2w W [m7]
®

Fig. 1. Point View Widget Overview

Table 1. Functions of the Point View Widget

No. Name Functional Description

1 Point View Widget Here you select the Point View Widget from the drop-down listbox for
Enable displaying the point list.

2 Plant / Folder Name | Shows the name of the plant/folder selected in the Nav tree or accessed
via plant graphic

3 No. of Points Shows the number of points included in the point list

4 Point List In the area below, the point list is displayed

5 Point Properties Shows the point properties as configured via column toggler (17).
Point properties can be:
* Label
Point name
* Value
Point value
* Logs
Graphic history icon in case point has a history (11)
« Status
Auto, manual, or alarm
* Path
Location of the point
* PointType (disabled by default)
Point type such as NumericWritable, BooleanWritable, etc.

6 Point Group Shows the point category to which the points belong
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8.4.1

Point View Widget Description

7 Alarm Status Indicator | If displayed, the point is in alarm
8 Override Status If displayed, the point in in manual state and its point value is overridden
Indicator

9 Label Name / Proper- Shows the point name. By clicking the blue name, the propertysheet displays for

tysheet editing

10 Point Value Allows the direct change of a writable point’s value

11 History Indicator If displayed in the Logs column, the point has a history (history extension as-
signed). By clicking the blue History icon, the chart displays.

12 Point View Mode Allows selecting the source of the points to be displayed. Points can originate in
the Points folder or its subfolders, or any other folder underneath the driver/net-
work (default view), in a graphic (PX page), or in a favourite

13 Filtering by Status Allows quick display of points which are overridden, or in alarm, or which have
histories.

14 Filtering by Label Allows searching points by name (label) by entering concatenated strings using
wildcards.

15 Actions Menu Provides the following actions:

« Setting points into manual mode

« Setting points into auto mode

« Setting points to fallback value / relinquish default value
» Export points to a CSV file

» Saving points to a favourite

16 Point Selection Here you select the point(s) by clicking the checkboxes

17 Column Toggler Allows configuring the point properties to be displayed columnwise.

18 Group Toggler Allows toggling the point group (showing/hide)

19 Page Browser Allows setting the number of displayed points per page and browsing through the
list pages

20 Column Sorter Allows ascending and descending sorting of the corresponding column

For detailed descriptions on each component and function, please refer to correspond-

ing

subsequent sections.

Basic Working Techniques

This section describes general functions of configuration, display and navigation of list.

Setting Columns Display
The Column Toggler (17) allows the configuration of the point properties to be dis-
played per column.

1. On top right corner, click the ColumnToggler icon E&.

2. In the drop-down menu, check the point property you want to display in a column. To
hide aéint property, uncheck the property.

Select All
[ Value
3 Log
[ Status

v] Path

PointType
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8-12

Expanding and Collapsing Point Groups

Points are arranged in point type groups (6) such as NumericWritable, BooleanWritable
etc. If a high number of points are arranged in a group and you want to optimize the list
display for viewing other point type groups on one page, you can use the Group Tog-
gler (18) to collapse a group. As required you can expand the group again by using the
Group Toggler.

Label ¥
@0 NumericWritable @
@ BooleanWritable
ReturnFan

SupplyFan

RecWheel

1. To collapse a point group, click the down arrow @ in front of the group name.

2. To expand a collapsed point group, click the horizontal arrow © in front of the group
name.

Setting Point Count Display and Page Browsing

At the bottom of the list, the Page Browser (19) allows setting the number of displayed
points per page and browsing through the list pages.

n 2w M 20

1. For adjusting the number of displayed points per page, click the right-handed Page
drop-downlist 12" and select the number from 20, 40, or 60.

20
40
60
2. For browsing through the list pages, click the forward » » and backward ¥ « but-
tons or click on the page number.

Sorting Point Properties in Column

Point properties can be sorted ascending and descending in their columns by using the
upward/downward arrows (20) right to the column title (property name).

Value ¥ @

20.81°C
257°C
16,00 °C
8,50 °C

19.00°C
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8.4.2

Point View Widget Description

1. To sort the properties in ascending order, click the upward arrow a .
2. To sort the properties in descending order, click the downward arrow w.

Selecting Point View Mode

Points can be located or included in any of the following places in your station:

* Points folder and subfolders underneath the device and/or network
* Individual folders underneath the device and/or network

* Any Niagara folder

* Graphic (PX) file

» Favourites (must first have been created in the Point View Widget)
Referring to this, the following point view modes are selectable:

* Default View
shows all points of the station

* Graphic Views
shows all points used in the selected graphic

+ Favourites
shows all points saved in the favourite

When selecting the point view mode, only the points included in the selected Point
View are listed in the point list.

By default, the Default View mode is preselected after the points are loaded in the Point
View Widget.

Procedure

1. In the control bar, click the “Point View Mode” drop-down listbox (12), and then click
the view.

Floor_l

22 Points C t Labe O dh ' N Default View @ {':7
Default View L
Label © Value ¢ Graphic Views
@ NumericWritable AHU
SupplyTemp 1955 °C Favourites
OaTemp 2.30°C Digital10
RecoveryTemp 8.00 °C
MixedTemp 8.50°C
ReturnTemp 19.00 °C

FL1_AI 10,00 pf

RESULT. The point list is updated according to the selected view.
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8.4.3

8.4.3.1

Filtering Points

Points can be filtered by their label (hame) and status. The filtering functions apply in
all point view modes: Default view, Graphic views and Favourites.

Please refer to the subsequent sections for detailed descriptions for the two methods.

Filtering Points by Status

By applying predefined filters (13), points of the current point list can be filtered by the
following status:

* Overridden points
* Points with histories (trend points)
* Points in alarm

Multiple predefined point filters can be used simultaneously.

When using more than one filter, the filters will be logically linked with AND.
That is, for example, when searching for overridden points and points in
alarm, only those points which fulfil both filter criteria, will be listed. Filters can
also be applied additionally to the search function as described in the “Filter-
ing Points by Label”. In this case, that filtering logic will be considered addi-
tionally.

Applying a Predefined Filter

1. To apply a predefined filter, click the icon, e.g. the Alarm icon &

RESULT: The filter is enabled and the icon toggles to active state indicated by the
blue color &,

2. To release a predefined filter, toggle the filter by clicking the Alarm icon B again.
Example: Filtering for overridden points

Procedure

1. To filter for overridden points, click the Overridden icon |9 in the control bar.
RESULT: The icon toggles to active state . In the list, only points that are in “over-
ridden” status are displayed. The overridden status of a point is indicated by the
hand symbol - in front of the point label and by the message “overridden” in the
Status column

2 Points m L N Default View T Actions

Label ¥ Value # Logs Status ¥ Path *

© NumericWritable

FL1_AIN 10.00 pf overridden

HeatSetpoint 21,00°C overridden

For filtering for points in alarm or with histories, apply the corresponding filter functions
in the same way.
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Point Status Indications

Point View Widget Description

The status of a point is indicated graphically (override hand symbol, alarm rectangle) in
front of the point label and descriptive in the Status column. As an exception, for a point
with a history, the graphic indication is displayed in the Logs column by a chart symbol.

Graphic Point Status Indications

- Overridden point

Label ¥ Value ¥

© NumericWritable

FL1_AI 10,00 pf

- Pointin alarm

Label Value ~

& BooleanWritable

I FrostProtect

- Point with history

Label ¥ Value ¥

& MNumericWritable

SupplyTemp 19,12°C

Logs Status ¥

overriggen

Logs Status ~

unackedAlarm

Logs

ol

The different colors and status descriptions for alarm points are described in the follow-

ing table (see below):

Table 2. Alarm Status and its Color Indications

Color Status Text | Cause

Red UnackedAlarm | < The current state of the alarm source is OffNormal and the alarm is not
acknowledged

Alarm » The current state of the alarm source is Fault and the alarm is not

acknowledged

B UnackedAlarm | The current state of the alarm source is Normal and the alarm is not

I acknowledged

Orange Alarm The current state of the alarm source is Normal and the alarm is acknowl-
edged

S llar Alarm » The current state of the alarm source is OffNormal and the alarm is
acknowledged
» The current state of the alarm source is Fault and the alarm is acknowl-
edged

White Ok The current state of the alarm source is Normal and the alarm is acknowl-
edged

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05

8-15



Saia PCD® Supervisor - Point View Widget Saia-Burgess Controls AG

Point View Widget Description

8.4.3.3 Filtering Points by Label

In the current point list, points can be filtered (searched) by point label (14). This can be
done by entering simple or concatenated text strings using wildcards.

8.4.34 Procedure

1. In the Search by Point Label field, enter the string.
RESULT: The point list is updated with the found points instantly as you type the
string.

When using a concatenated text string, the text string parts will be logically
linked with OR. That is, for example, when entering “temp+set”, any points
having either “temp” or “set”, or both in their label will be listed. The search
function can be applied additionally to the status filtering function as de-

n scribed in the “Filtering Points by Status” section. In this case, that filtering
logic will be considered additionally.

Examples: Filtering for points that contain “temp” in its label. In a second step, filtering
for points that contain “set” in its label.

Q temp ‘

5 Points

Label ¥

© NumericWritable
SupplyTemp
OaTemp
RecoveryTemp
MixedTemp

ReturnTemp

Fig. 2. Searching in point labels using single text string

RESULT. All points containing “temp” in its label are listed.

7 Points | Q) temp+seq |
L I

Label ¥

@  NumericWritable
SupplyTemp
OaTemp
RecoveryTemp
MixedTemp
ReturnTemp
HeatSetpoint

CoolSetpoint

Fig. 3. Searching in point label using concatenated text string

RESULT: All points containing “temp” and all points containing “set” in their labels are
listed.
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8.44 Setting Point Values

The value of a point is set by one of the following causes:

* Automatic update
executed by the running application, see “Relinquishing Points” section

* Manual override
Explicitly done by the user, see “Manual Override (Direct Point Editing)” section and
“Manual Override (Enhanced Point Editing)”.

» Fallback value / Relinquish default
Pre-setting defined by the user, see “Setting Point to Fallback / Relinquish Default
Value” section.

8.4.41 Manual Override (Direct Point Editing)

You can manually override the value of a single writable point by changing its value di-

rectly in its Value field (Direct Point Editing). The overridden status is indicated descrip-

tive in the Status column (overridden) and graphically by the hand symbol -  in front of

the point label. In the priority array, the changed value is written to the slots "In8" and

‘Out’. n
Direct point editing allows changing the value of a single writable point in one step. For
changing values of multiple writable points simultaneously, please refer to the “Manual

Override (Enhanced Point Editing)’section.

Label Value * Log Status *

© NumericWritable

CoolSetpoint 19.00 °C ok
® BooleanWritable @ \
ReturnFan @ on ok
Procedure

In the following steps, NumericWwritable and BooleanWritable points are described as
examples for direct point editing.

1. Overriding Value of NumericWritable Point
For overriding the value of a single NumericWritable point, click the value in the
Value column (for overriding the value of a BooleanWritable point, see step 3).

Label * Value *
© NumericWritable
CoolSetpoint 16,0|
Fig. 4. Example “Manual Override of NumericWritable Point”
2. Enter the value, and then press ENTER key.
Label = Value Log Status ¥

© NumericWritable

CoolSetpoint 16.00 °C overridden

RESULT: The value is overridden. The overridden status is indicated descrip-
tive in the Status column (overridden) and graphically by the hand symbol - in front
of the point label. At the bottom, the history of point editing is shown in the Updating
point details... window (see step 4).

3. Overriding Value of BooleanWritable Point
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For overriding the value of a single BooleanWritable point, click the left and right
edge respectively (depending on the current status) of the binary switch icon @ in
the Value column.

Label * Value ¥ Log Status *

© BooleanWritable
ReturnFan @ on ok

Fig. 5. Example “Manual Override of BooleanWritable Point”

RESULT: The value is overridden. The overridden status is indicated descriptive in
the Status column (overridden) and graphically by the hand symbol - in front of the
point label. At the bottom, the history of point editing is shown in the Updating point
details... window (see step 4).

Label * Value * Log Status *

© BooleanWritable

ReturnFan OFF overridden

4. Viewing Point Editing History
The Updating point details... window at the bottom shows the actions performed to
the points and their point labels.

Updating point details... E
Editing CoolSetpoint v
Editing ReturnFan v

5. To view details of an edited point, click the down arrow . The point path is displayed
and a green arrow indicates that the point value has been successfully changed.

Updating point details... |£
Editing CoolSetpoint ~

CoolSetpoint
fDrivers;’BacnetNetworkaHU_O1f|)ointszHUfAnalogVa\ueECoo...

Editing ReturnFan ~

ReturnFan
/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryOutput/Re...

6. To hide the Updating edit point details... window, click the Hide icon [~.

7. To re-display the Updating edit point details... window, click the View icon ~1.
Updating edit point details... ﬂ
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8.44.2 Manual Override (Enhanced Point Editing)

You can manually override a single writable point or multiple writable points of the
same group with the same value simultaneously by using the Set to Manual action (En-
hanced Point Editing) in the Actions menu. In addition, enhanced point editing allows
applying a certain duration the points should stay in manual override.

The following options are available:

* Permanent

* 1,15, or 3 minutes

* 1,2 o0r 3 hours

* Override expiration: discards current duration

The overridden status is indicated descriptive in the Status column (overridden) and
graphically by the hand symbol -  in front of the point label. In the priority array, the
changed value is written to the slots 'In8" and "Out’.

Multiple writable points can have the same or different facets.
Multiple writable Enum points must have the same Enum range. n

- Set To Manual
Label ¥ Value ¥ Log Status Path Set To Auto
©  NumericWritable Set
OaDamper 100.00 % ok oriv Exportto CSV
ExhaustDamper 100,00 % ok /Driy Saveto
ReturnDamper 20,00 %
© Booleanwritable

I ReturnFan

=

SupplyFan

Procedure

In the following steps, NumericWritable and BooleanWritable points are described as
examples for enhanced point editing.

1. Overriding Value of NumericWritable Points
Select the points you want to override manually by checking the checkbox at the
point label (for overriding the value of BooleanWritable points, see step 5).

Label # Value # Log Status ¥
© NumericWritable

OaDamper 100.00 % ok
ExhaustDamper 100.00 % ok

Fig. 6. Example “Manual Override of NumericWritable Points”

2. Click the Actions menu (15) on the top, and then click Set to Manual.

Actions | -

. Set To Manual
Set To Auto
Exportto C5V

Save to Favourites

Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05 8-19



Saia PCD® Supervisor - Point View Widget Saia-Burgess Controls AG

Point View Widget Description

RESULT: The Override dialog box displays and shows the number of selected
points.
Override: 2 points

Override Value

Duration

Permanent

Cancel Save

3. In the Override Value field, enter the value, and from the Duration drop-down list,
select the duration.

Override: 2 points

Override Value

85

Duration
Permanent

Parmanent
1 Minute
15 Minutes Cancel
30 Minutes
1 Hour

2 Hours

3 Hours

ot Feomfmio o

Override: 2 points

Override Value

95

Duration

1 Hour

4. Click the Save button.

RESULT: Any selectable points are overridden with the new value as indicated in
the Value column. The overridden status is indicated descriptive in the Status col-
umn (overridden) and graphically by the hand symbol -  in front of the point label.
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Label ¥ Value Logs Status ¥

© NumericWritable
OaDamper 95.00 % overridden

ExhaustDamper 95.00 % overridden

At the bottom, the history of point editing is shown in the Updating point details...
window.

Updating edit point details... IZ.
Editing OaDamper + 1 points ~
OaDamper

/Drivers/BacnetNetwork/AHU_01/points/AHU/AnalogOutput/OaDamper

ExhaustDamper
/Drivers/BacnetNetwork/AHU_01/points/AHU/AnalogOutput/ExhaustDamper
For detailed description of the Updating point details... window, please refer to step
“Viewing Point Editing History”.
. Overriding Value of BooleanWritable Points
For overriding BooleanWritable points, please apply the previous steps 1 and 2 in
the same way as described for the NumericWritable points above.

Label * Value # Log Status ¥
© BooleanWritable

ReturnFan & on ok
SupplyFan @ on ok

Fig. 7. Example “Manual Override of BooleanWritable Points”

. In the Override Value field, select the “false” state, and from the Duration drop-down
list, select the duration.

Override: 2 points

Override Value

false

Duration

15 Minutes

Cancel Save

7. Click the Save button.

RESULT: The points are overridden with the new value as indicated by the toggled
switch icon in the Value column. The overridden status is indicated descriptive
in the Status column (overridden) and graphically by the hand symbol -  in front of
the point label.
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[ Label Value * Log Status ¥
© BooleanWritable

@ ReturnFan OFF overridden
SupplyFan OFF overridden

At the bottom, the history of point editing is shown in the Updating point details... win-
dow.

Updating point details... |£

Editing ReturnFan + 1 points ~

ReturnFan
/Drivers/BacnetNetwork/AHU_01/points/AH U/BinaryOutput/R...

SupplyFan
/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryOutput/s...

For detailed description of the Updating point details... window, please refer to step
n “Viewing Point Editing History”.

8.4.43 Inline Command Editing

The Inline Command option allows to edit point values in the Point View Widget.
Click on the point value opens edit field where new value can be entered.

© NumericWritable

Analog_Out_1 200% ok,@def /Drivers/NiagaraNetwork/
Analog_Out_2 12.0 ok,@def /Drivers/NiagaraNetwork/...
Analog_Out_3 200% ok @def /Drivers/NiagaraMNetwork/
Analog_Out_4 20.0% ok,@def /Drivers/NiagaraNewwork/

By pressing the enter key value will be set and point state changes to overridden.

© NumericWritable

Analog Out_1 200 % ok, @def fDrivers/NiagaraNetwork/
Analog Out_2 120% overridden, @8 fDrivers/NiagaraNetwork/
Analog_Out_3 200% ok, @def fDrivers/NiagaraMetwork/
Analog Out_4 200 % ok, @def /Drivers/NiagaraNetwork/

8.44.4 Inline Command Configuration

8.4.4.41 Disable Default Override state by Network point type configuration
Point state changes by default to override after point value editing. Automatically de-
fault setting can be disabled via configuration of Point Types.

Procedure

1. At the PointListViewService hierarchy element use right click Actions menu and
select Add Configuration.

© Tagoice

@ webser Actions » Add Configuration

urations

Change Mode
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In case if new Drivers or Point Type definitions were added to the configu-
ratons.xml file before starting the configuration press Load Configurations
at the PointListViewService right click Actions menu.

2. Configuration of Point Types
- Enter a configuration name,
- Select the Network Type

- Select Point Types where the default override state should be disabled
(multi selection via ‘ctrl’ key)

- Press “Save”.

& Add Configurstion x

The in-line edit action for the point viewer defaults to override,
Use this dialog to change this to "set” for specific driver/point types.

Configuration Name  €BUS_network_NisgarePoints

Network Type CBusetwork

= n
u

Point Types

Digstal Remate

Save | Load Configurations | Clase |

RESULT: For the selected Point Types the default override state after editing the point
value will not be set. The point state will stay unchanged. l.e. This is the same opera-
tion as in Action Set menu of single point

@ Analog_out

@ ansiog_out JIME
@ Analog_out
© Binary_oul
0 sinary_out
O einary_out_JEIERS
© Binary_out
BacnetAwsNetwork
* Local Device

B ssenetcomm

Points can be configured only grouped per point types not per single point.
Only one configuration per network is possible. i.e. all applying point types
within the same network have to be in one configuration.
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8.44.5 Edit existing Configurations

Added Configurations are displayed under the PointListViewService.

E] TemplateService
9 WebService
¥ signalservice
E rointListviewservice
[ BACnet_A0_BO_Default_To_Set
. CBUS_network_NiagaraPoints
CarelmportWizard Service

T PlatformServices

6 Drivers

For changes double click on the entry and use dialog on the right pane

) My Network Property Sheet
P T— - X
M BACnet_AC_BO_Default_To_Set (Point List View Configuration)
b ) AuditistoryService
v © LogHistoryService
b @ Programservice Network Type

b D searchservice

i sints
» Q) TagDictionaryService :
B, Anslog Output
b @ websenice I i
. M Configuration Pt Types Binary Input

¥ signalservice

B pointListviewservice i
= Binary Value
UM BACnet_AQ_BO Default To_Set ¢
- alendar
Ul CBUS_network_NiagaraPoints

B CBUS _Niagar command

CarelmportwizardService

I PlatformServices

In case if new Drivers or Point Type definitions were added to the configu-
ratons.xml file before starting the configuration press Load Configurations
at the PointListViewService right click Actions menu.

8.4.4.6 Relinquishing Points
When setting the point value of a point that is in manual override to Auto, the point
value will be relinquished. In the priority array, the slots In 8 and "Out’ will be cleared.
You can relinquish a single writable point or multiple writable points of the same group
simultaneously.

Relinquishing multiple points belonging to different groups (e.g. Numer-
icWritable and BooleanWritable) simultaneously is not possible.

5 Points kL | {1 Default View ~ @ Actions ~
- Set To Manual
Label ¥ Value * Log Status ¥ Path Set To Auto )
©  NumericWritable Set
& o©Oabamper 100.00 % ok Driv EXportto CSV
B ExhaustDamper 100.00 % ok
ReturnDamper 20,00 % ok o

© BooleanWritable

| ReturnFan & ox overridden,unackedalarm HU_O1
SupplyFan & on ok o
Procedure

In the following steps, NumericWwritable and BooleanWritable points are described as
examples for relinquishing points.

1. Relinquishing NumericWritable Points
Select the points, you want to relinquish by checking the checkbox at the point label
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(for relinquishing the value of BooleanWritable points, see step 4).

Label ¥ Value * Logs Status *
NumericWritable

OaDamper 95.00 % overridden
ExhaustDamper 95.00 % overridden

2. Click the Actions menu on the top, and then click Set to Auto.

Actions

Set To Manual

Set To Auto

Set

b

Export to C5V

Save to Favourites

RESULT: The Relinquish dialog box displays and shows the number of selected

points.

Relinquish: 2 points

@ Auto

Cancel

Apply

3. Click the Apply button.

RESULT: The points are relinquished to Auto as indicated in the Value column. The
auto status is indicated descriptive in the Status column (ok). At the front of the

point label, the overridden hand symbol - is removed.
Label = Value ¥ Logs Status ¥
© NumericWritable
OaDamper 100.00 % ok
ExhaustDamper 100.00 % ok

4. Relinquishing BooleanWritable Points
For BooleanWritable points, apply the previous steps 1 through 3 in the same way
as described for the NumericWritable points above.

Qe @

a

Label Value * Log Status
BooleanWritable

ReturnFan OFF overridden
SupplyFan OFF overridden

RESULT: The points are relinquished to Auto as indicated by the toggled switch icon
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@& in the Value column. The auto status is indicated descriptive in the Status col-
umn (ok). At the front of the point label, the overridden hand symbol = is removed.
Label * Value ¥ Log Status ¥

@ BooleanWritable

M ReturnFan ON ok

&«
SupplyFan @ own ok

8.4.4.7 Setting Point to Fallback / Relinquish Default Value

By using the Set action of the Actions menu (15), you can write a value to the Fallback
value (Niagara points) or Relinquish Default (BACnet points) in the priority array. This
function can be applied to a single writable point or multiple writable points of the same
group simultaneously. Multiple writable points of the same group can have different
initial values (true or false).

Points which are already in the desired state, remain in this state, the others are up-
dated accordingly.

n Applying the Set action simultaneously to multiple writable points of differ-
ent groups (e.g. NumericWritable and BooleanWritable) is not possible.
21 Points M dh,| 4 Default View ~ @ Actions -
Label # Value Log Status ¥ Patt ‘,: “: _;I“

©  MNumericWritable

SupplyTemp 20,66 °C ills ok
QaTemp 1.09°C olle ok
RecoveryTemp 16.00 *C ok
B MixedTemp 12.00 *C
M ReturnTemp 19,00 *C ok
Procedure

In the following steps, NumericWwritable and BooleanWritable points are described as
examples for the Set action application.

1. Setting NumericWritable Points to Fallback / Relinquish Default Value
Select the points, of which you want to set the fallback value and relinquish default
respectively (for setting the value of BooleanWritable points, see step 5).

Label Value * Log Status *

<& NumericWritable
MixedTemp 12.00 °C ok

ReturnTemp 19.00 °C ok

2. Click the Actions menu (15) on the top, and then click Set.

Actions v

Set To Manual

Set To Auto

Set {t')
Exportto C5V

Save to Favourites
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RESULT: The Set dialog box displays and shows the number of selected points.
Set: 2 points

Set Value

Cancel
3. Enter the value.
Set: 2 points
Set Value

14 ‘

Cancel

4. Click the Apply button.

RESULT: The value is set as indicated in the Value column.

Label = Value * Log Status =

© NumericWritable
MixedTemp 14.00 °C ok

ReturnTemp 14,00 °C ok

At the bottom, the history of point editing is shown in the Updating point details...
window.

Updating point details... |£
Editing MixedTemp + 1 points ~
MixedTemp

/Drivers/BacnetNetwork/AHU_01/points/AHU/Analoginput/Mixe...

ReturnTemp
/Drivers/BacnetNetwork/AHU_01/points/AHU/Analoginput/Retu...

For detailed description of the Updating point details... window, please refer to step
“Viewing Point Editing History” above.

. Setting BooleanWritable Writable Points to Fallback / Relinquish Default Value
Please apply the previous steps 1 and 2 in the same way as described for the Nu-
mericWritable points.

Label = Value * Log Status *

© BooleanWritable
ON ok

ReturnFan

SupplyFan ON Gk
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RESULT: The Set dialog box displays and shows the number of selected points.

Set: 2 points

6. Select the other value.
Set: 2 points

Set Value

false

n a

7. Click the Apply button.
RESULT: The value is set as indicated in the Value column.

Label = Value = Log Status ~

© BooleanWritable

I ™ ReturnFan OFF alarm, unackedAlarm

SupplyFan OFF ok

At the bottom, the Updating edit point details... window displays and shows the actions
performed to the points and their point labels.

At the bottom, the history of point editing is shown in the Updating point details... win-
dow.

Updating point details... |£

Editing ReturnFan + 1 points A

ReturnFan
/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryQutput/R...

SupplyFan
/Drivers/BacnetNetwork/AHU_01/points/AHU/BinaryOQutput/s...

For detailed description of the Updating point details... window, please refer to step
“Viewing Point Editing History”.
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Saving Points to Favourites

Points of particular interest which should be viewed more often, can be saved into a
favourite for quick display (fast access list).

The points to be saved to a favourite can be assorted from any accessible source (see
“Selecting Point View Mode*“ section) and by using any available point filtering method
(see “Filtering Points* section).

Procedure

1. Select the points (16), you want to save to a favourite, then click the Actions menu
(15), and then click Save to Favourites.

Label % Value # Logs Status ¥

©  MumericWritable Exp
@ SupplyTemp 20,96 *C olly ok [Dri Save tr_\F.'u«')l.-uu:s{':J
B oaTemp 1.55°C il X e

RecoveryTemp 16.00 *C ok

B MixedTemp 8.50°C
ReturnTemp 19.00°C ok
FL1_AN 0.00 pf
FL1-A12 15.00 ok
FULAZ 5.00
B oOaDamper B0.00 % overridden
B Heatvalve B0.00 %
ExhaustDamper 100,00 %
ReturnDamper 20,00 %
B Coolalve 0.00%

RESULT: The Save to Favourites dialog box displays.

Save to Favourites

Saved favourite will only be available for current node.

Cancel

2. In the Name field, enter the name.

For the name, any alphanumeric characters and the following characters
are allowed: -, _. The following characters are not allowed: @ , !, #, %,

$ ..

3. Click the Save button.

RESULT: The favourite is saved under Favourites in the View Point Mode menu. To
view a favourite, please refer to the “Viewing Favourites” section.
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8.4.51 Viewing Favourites

Procedure

1. To view a favourite points list, click the Point View Mode menu, and then click the
favourite under Favourites.

Default View

Default View

Graphic Views
AHU

Favourites

Supply Line V2

RESULT: The favourite point list is displayed.

Path ¥

Label ® Value * logs  Status

@® NumericWritable

DaTemp 1.93 *C ok
SupplyTerp 20,06 °C ol ok
OaDamper 80.00 % overridden
RecoveryTemp 16.00°C ok
MixedTemp 8.50°C ok
HeatValve 80.00 % ok
CoolValve 0.00 % ok

8.4.5.2 Renaming Favourites

Procedure

1. To rename a favourite points list, click the Point View Mode menu, and then click
the Rename icon # right to the favourite.

Supply Line
Default View

Graphic Views
AHU

Favourites

Supply Line VT

O

RESULT: The Rename Favourite dialog box displays.

Rename Favourite
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2. In the Name field, change the name, and then click the Save button.

Rename Favourite

Supply Line Add

RESULT: The favourite is saved with the new name and available in the Point View
Mode menu.

8.4.5.3 Deleting Favourites

Procedure

1. To delete a favourite points list, click the Point View Mode menu, and then click the

Delete icon i right to the favourite. n
Default View v

Default View

Graphic Views
AHU

Favourites

Supply Line

RESULT: The Delete Favourite dialog box displays.

Delete Favourite

Do you want to delete Supply Line ?

2. Click the Delete button.

RESULT: The favourite is deleted in the Favourites menu.
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8.4.6

8.4.7

Exporting Points to CSV
A point list can be exported to an Excel CSV file.

Procedure

1. To export a points list to a CSV file, click the Actions menu (15), and then click Ex-
port to CSV.

Actions E

Set To Manual

Set To Auto
Export to CSV {ID

Save to Favourites

RESULT: The complete point list is exported to the CSV file.

ﬂ Particular individual points cannot be exported to a CSV file.

Viewing Point Histories

If a single point has a history assigned by the Niagara history extension, its history can
be shown graphically.

Procedure
1. To view the history of a point, click the History icon ol in the Logs column (11).

Logs

0ls

RESULT: The chart of the point is displayed in standard Niagara format.
Chart =

SupplyTemp
® [ Today @ a ADO@ o]
AH U_Ol SupplyTemp (@) AHU o1 SupplyTemp

21.0
20.8
20.6
20.4
20.2
200 ,
19.8
19.6
19.4

19.2

1210 12:11 12:12 12:13 12:14 12:15 12:16 12:17 12:18 1219 12:20 12:21 12:22 12:23
29-Jan-18 pm

2. For detailed information on working with charts in Niagara, please refer to the Nia-
gara online documentation.
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Editing Point Properties

The detailed point properties of each individual point can be shown on the property
sheet. The point properties are shown in the corresponding default view of the prop-
erty sheet. The default views of property sheets are different depending on the origin
(controller, driver) of the points. That is, the property sheet of a generic Niagara point
is shown in another default view as a point based on a specific driver. In the following
procedure, a Niagara point is used as an example.

Procedure
1. To display the properties of a point, click the name of the point in the Label column.

Label

© NumericWritable

Sup@Temp

RESULT: The property sheet of the point is displayed in its default view.

Property Sheet o
O t
SupplyTemp Q Actions & Topics [H) Slot Details
Display Name Value Commands
(W Facets units="C,precision=1 °C,min=-inf °C,max=+inf °C s
[3 ProxyExt null
Out 19.9°C {ok} @ 10
Inl - {null}
In2 0.0 'C# null - {null}
= |n3 0.0 *C#null - {null}
= |n4 0.0 °C®null - {null}
In5 0.0 'C® null - {null}
In6 0.0 'C ™ null - {null}
In7 0.0 'C®null - {null} =

Fig. 12. Example “Default View of Niagara Point Property Sheet”

2. For detailed information on working with the various property sheets, please refer
to the corresponding Niagara documentation and the proprietary driver and controller
documentation.
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8.4.9 Delete Points View

* The Delete Point View shows an overview of all data points that are not used in the
project
- Not on a PX page
- No alarm/trend extension
- Not on the wire sheet
- From another application

* Applicable for any communication driver

* Under Files an xml file is stored, which shows all unused data points including a
mark if it has already been deleted

Remove Unused Points si7unusedpoints

NAME PATH
CLKON_ slot/Drivers/BacnetOws Netwark/DS_SupNa_AHU./points/AHUL/CLKS 3a0M..
COO-CP_ALM-FLC shot/ Drivers/BacnetOws Network/D5_Supia_AHU/points/AHU1/CO0$3aCP_$3aALMS3aFLT
COO-CPoALM-MAN skot/Drivers/BacnetOws Network/DS_SupN4_AHU/paints/AHUL/CO0$3aCP S 3aALMS 3aMAN
COO-CPoALM-MOT slot/Drivers/BacnetOws Network/D5S_SupN4_AHU/points/AHUL/CO0$3aCP_S3aALMS 3aMOT
COOCPoALM-MSW shot/Drivers/BacnetOws Network/D3_SupNa_AHU/pointsAHUL/CO053aCP_$3aALMS 3aMSW
COO:CP_CNT:HRS slot/Drivers/BacretOws Network/DS_SupN4_AHU/points/AHUL/CO0%3aCP_$3aCNTS$3aHRS
COO:CPLMNT slot/Drivers/BacnetOws Network/DS_SupNa_AHU/points/AHUL/CO0$3aCR_$3aMNT
COO:FD slot/Drivers/BacnetOws Network/DS_SupNé_AHU/points/AHUL/CO0S3aRID
COOPIDY_ slot/Drivers/BacnetOws Network/DS_Suphé_AHU/points/AHUL/CO0S3aPIDS JaY_
COON_ALMFED slot/Drivers/BacnetOws Network/DS_SupNa_AHU/points/AHUL/CO0S3aY_$3aALMS2aFBO
COON_ALMMAN slot/Drivers/BacnetOwsNetwork/DS_SupNa_AHU/points/AHU1/CO0$3aY_$3aAL M$3aMAN
{1 pointsaml 7] pointsaaml L

>

2 ame="CLK:0N_" pathe"slot:/Drivers/BacnetOwshetwork/D5_Suphd_AHU/points /AHUL/CLKS " handle="h:1758f" delete="8"/>
3 FLC™ path="slot:/Drivers/BacnetOwsMetwork/DS_Suphd _AHU/points/AHUL/CO0S3aCP_$3adLMS3aFLC™ handl
4 slot:/Drivers/BacnetOushetwork/DS_Suphd_AHU/ points/AHUL/CO083aCP_S3aALME 3aManN~
5 slot:/Drivers/BacnetOusNetwork /DS_SupNd_AHU/points/AHUL/CO0S3aCP_S3aALME 3aMOT=
& ers/BacnetOwsNetwork/D5_Suphd_AHU t5/ARUL Q005 30CP_S3aALME3aMEN™
7 : ivers/BacnetOwsNetwork,/DS_Suphd_AHUSpoints /AHUL/CO0S3aCP_$3aCNTS3aHRS 175a0" deletes®1® sti
8 <Py name="C00:CP_:¥ Drivers/BacnetOwsNetwork/DS_Suphd_AHU/ nts/AHUL/CO0E3aCP_$3aMNT" handle="| Sb3" deletes="@"/:
] <Py name="C00:PID" p. ers/BacnetOwsNetwork,/D5_SupNd_AHU/points/AHUL/CO053aPID™ handle="h:17505" delete="@"/>
1@ t name="C00:PID:Y__" path t:/Drivers /BacnetOwshetwork/DS_Supha_AHU/points/AHUL/CO0S$3aPIDE3aY__" handle="h:175b7" delete="@"/>
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8.5
8.5.1

@ My Host: GESILTY

» @ uayFilesystem

oy Tools

Procedure
Under Station — Files — config double click on configurations.xml.

See right pane to edit the configuration text.

o ) My Network

IM2.global.ds.honeywell com (RXSupervisor
) uyModules

& Platform
[ T —

B slam

D config

& Files

O config
1) configurationsaml
b [ Hiersrchy
@ History

79

SearchSe
@ searchservice i
© tagnictio i 81

\ 82
Templateq £

© webservic Actions

Add Configuration
Load Configurations
E peintui Change Mode

Make Template

T Platforms ik

Point View Widget Description

Advanced Documentation/Information Section

Inline Command Configuration adding new Drivers and Point Types

In case if further drivers or data point types are needed for Inline Command Configura-
tion, definitions of further Point Types can be added via editing the configurations file.

To apply the changes the file has to be saved and explicit be loaded to the station.

To load the configuration file, go to the PointListViewService hierarchy element use
right click Actions menu and select Load Configuration.

"Structured View"™ Cor
ccess Door™ Conditi
Inassigned31” Condit
ccess Credent
Access Point
"Access Rights”
"Access User” Conditi
="Access Zone" Conditi
redential Data Inpu
="Network Security” Cc
="Bitstring Value™ Con
"Character String val
"Date Pattern Value"
"Date Value™ Conditic
="Date Time Pattern Ve
="Date Time Value™ Cor

N Tmbansn Walaa® Famdi
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Icons | Related documents | Software-Versions

A Annex

A1 Ilcons

In manuals, this symbol refers the reader to further information in this man-
ual or other manuals or technical information documents. As a rule there is
no direct link to such documents.

This sign accompanies instructions that must always be followed.

A.2 Related documents

Document number | Document type | Document name

26-062 ENGxx Leaflet Release Notes

26-658 GERxx Quick Start FindSymbolsAndMacros

27-668 ENGxx User Guide Point List Widget

27-669 ENGxx Manual Easy Templating for Saia PCD® Supervisor

31-061 ENGxx Flyer Saia PCD® Supervisor

31-703 ENGxx Brochure Saia PCD® Supervisor

34-001 ENGxx Data Sheet Saia PCD® Supervisor

31-702 ENGxx Brochure Saia PCD® Supervisor EM

34-002 ENGxx Data Sheet Saia PCD® Supervisor EM

Easy Features Documentation References

41-0001 User Guide Easy Templating - Installation and Operations Guide

41-0002 User Guide Easy Binding - Installation and Operations Guide

41-0003 User Guide Easy Database Manager - Installation and Operations Guide

41-0004 User Guide Point List View - Installation and Operations Guide

41-0005 User Guide Easy Alarm Management - Installation and Operations Guide
A.3 Software-Versions

Book-Version Saia PCD® Supervisor Niagara

27-651 ENGO1 Version V1.1 Based on Niagara V4.3

27-651 ENGO02 Version V1.2 Based on Niagara V4.7
27-651 ENGO03 Version V2.0 Based on Niagara V4.7U1
27-651 ENG04 Version V2.0 Based on Niagara V4.7U1
27-651 ENGO05 Version V2.0 Based on Niagara V4.7U1
27-651 ENG06 Version V2.1 Based on Niagara V4.8

27-651 ENGO7

Version V2.1 Patch release

Based on Niagara V4.9

27-651 ENG08

Version V3.0

Based on Niagara V4.9

27-651 ENG09

Version V4.10

Based on Niagara V4.10

27-651 ENG10

Version V4.14

Based on Niagara V4.14
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Annex A

What's new?

Saia-Burgess Controls AG

A4 What is new in V1.2

Name Description See section
Enhanced PG5 Import Wizard Including filtering based on tags from PG5 6.3.8
Point-List-View For straightforward display and management of see document
filtered data points 27-668
Delete Points View Enables simple deletion of all unused data see document
points 27-668
Bulk deploy Mass provisioning of data points in Excel 7.6
(export/import)
Cloud Connector Action management, performance analytics 7.5
Cyber Security In-depth cyber security measures see document
(especially for connecting to the cloud) 26-624
Energy Monitoring Add-on (including 1-hour demo runtime)
Alarm Consolen Improvments Trend charts and role manager are fully inte-
grated in HTML5
HTMLS extensions Including new Px elements 7.4
Px Editor tools For example for ensuring a responsive design
Improved BACnet Alarming
SMA Reminder Software maintenance reminder
New reporting functions 7.4.1
Multilanguage EN/GE/FR at Niagara level
Profinet driver 3rd-party module — licence can be acquired
from Tridium
What is new in V2.0
Name Description See section
Point List View Allows to build a basic Supervisor in few minutes See manual:
27-668 ENGxx
Easy Templating To automate recurrent tasks and maximise reuse Ch. 6.6.5
for Simple Objects SBC Application templates for HVAC to match PG5
symbols (DDC Suite)
Easy Binding Allows the creation basic schematics with lower engi- Ch.6.6.5.2
neering effort
YvkonPro modules The vykonPro modules are an comprehensive collec- Ch7.7
tion of components and px widgets

A-2 Manual Saia PCD® Supervisor V4.14 | Document 27-651 ENG10 | 2025-05



Saia-Burgess Controls AG

Annex A

What's new?

A.6 What is new in V2.1
Name Description See section
Latest Niagara release Niagara 4.8
Easy templating Tool for complex objects See new manual 27-669_ENGxx
Template Library Single Objects
Mapping table for S-Bus import
Aliasing table for BACNet import
3rd Party Module Signing Requiring all third party modules
to be signed increases security
posture of a Niagara installation
Analytics 7 existing standard reports for
meaningful output
E-Signature Supports site procedures typically
when controlling the manufactur-
ing of food or pharmaceuticals
JSON Toolkit Enables the connection to loT
Software and 3rd Party applica-
tions, cloud services and data-
bases
Milestone Camera Driver Milestone Systems is a leading
provider of open platform video
management software
Point Database Manager Saves overall license costs
(PDM)
Easy Binding Own graphics (design agency) can
be quickly integrated
Predefined application and | Decreases the engineering time
project templates
Multilanguage EN/GE/FR At Niagara level.
Guest access / Kiosk mode Available from Core Niagara but is
IEEE 802.1x Registration in computer networks | Not usable by SBC
- (Usable for Niagara based control-
Security Dashboard lers).
A.7 What is new in V3.0

Name

Description

See section

Next Niagara release

Niagara 4.9

Easy Templating tool

Tool for complex objects

See new manual 41-00001

Easy Binding tool

Own graphics (design agency) can be

quickly integrated

See new manual 41-00002

Easy Database Manager

Remove unused data points to reduce
license costs. Saves overall license cost.
Enables optimal station performance for
critical infrastructure projects (data centre)

See new manual 41-00003

Point List View

Tool for complex objects

See new manual 41-00004

Easy Alarm Management

Tool for complex objects

See new manual 41-00005

User login preferences

Option to define & save customized login

parameters as per user reference

See section 7.8

Enhanced BACnet support

Added BACnet driver with server and client

support.
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List of known issues with the version V3.0

A8 Using the Extended Support Options

Saia PCD® Supervisor is now provisioned with multiple extended support options that
can be purchased:

Refer to the Saia-PCD-Supervisor Data Sheet (34-001) to know more about available
extended support options.

In order to use these options it is necessary to license Saia PCD® Supervisor with the
appropriate license.

See chapter 5 Licensing Saia PCD® Supervisor

For details of configuring and using these option refer to the Saia Burgess Controls
documentation.
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Saia-Burgess Controls AG Annex A

List of known issues with the version V3.0

A.9 Contact

Saia-Burgess Controls AG
Route Jo-Siffert 4

1762 Givisiez,

Switzerland

Phone........cccoeviiiiieeee +41 265803000

Phone support......................... +41 265803100

FaX ..o +41 265803499

Email support: .........ccccvvneeen. support@saia-pcd.com
Supportsite: .........cccevviieieeeennn. WWW.sbc-support.com
SBC site: .oooiiiiieeeieeeeeee WWW.Saia-pcd.com

International Represetatives &
SBC Sales Companies: ......... WWW.Saia-pcd.com/contact

Saia PCD® Supervisor and the Saia Burgess Controls driver features described in this
manual. They are unable to provide support for 3rd party drivers and undocumented
aspects of Saia PCD® Supervisor’s operation.

n Saia Burgess Controls Technical Support are only able to provide support for
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